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1 Welcome 

MAXQDA 12 is a high-performance program for professional social science oriented data analysis – 

ideal not only for researchers but also for students and for teaching at universities and high schools. 

MAXQDA is used in a variety of disciplines: the social sciences, education, health sciences, the hu-

manities, economics, marketing, and many others. In short, MAXQDA is the ideal software for those 

who require a program for the effective management and systematic evaluation of texts, documents 

and all kinds of media data. 

MAXQDA 12 is a result of more than 25 years of continuous development that began with MAX for 

DOS in 1989. MAXQDA 12 is groundbreaking as it is the world's first QDA software that provides the 

same functionality for Windows and Mac and allows you to switch effortlessly between the two plat-

forms. The user interface is almost identical; aside from the ever-present Mac menu bar at the top of 

the screen that is unknown in Windows. The menu, icons, shortcuts and functions are nearly identical, 

eliminating the need for two different user manuals. 

This guide provides a detailed overview of the features of MAXQDA. The “Getting Started Guide” 

offers a brief introduction. The manual explains all the functions and features of MAXQDA rather 

than following the logic of learning the program. Further help can be found on the website 

www.maxqda.com, including online tutorials, textbook references and information on the annual 

user conference in Berlin, the “MAXQDA International Conference” (MQIC). 

In our continuous effort to improve and troubleshoot MAXQDA, we are always interested in your 

feedback and suggestions on how the program could be enhanced. Simply send us an email or watch 

for issues of interest in the MAXQDA forum and propose your contributions. 

http://m22.maxqda.com/
http://conference.maxqda.com/


MAXQDA Screens and Menus 

 

11 

2 MAXQDA Screens and Menus 

2.1 Starting the Program  

After opening MAXQDA, a window will appear with the MAXQDA logo and then the following wel-

come dialogue, which allows direct access to instructions to help get you started in MAXQDA: 

 

The quick introduction to MAXQDA: direct access to online tutorials, and sample projects 

A click on the Open Examples button lists the example projects included in the installation of 

MAXQDA, allowing you to explore the features of MAXQDA in detail. First click on a project from the 

list, and then click OK to open the selected sample project. 

After clicking Next, the following start and login window appears. If you selected Open Examples, 

the startup window appears immediately. 
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The MAXQDA start window: choose user name and projects 

You can enter your name or initials in the user field, so that all of your actions, whether they be 

importing documents, coding segments, or writing memos, are marked with your user signature. This 

user system is especially helpful when you are working in a team. You can then look to see who in 

the team did each action. 

To create and open a new project, click OK. Otherwise select Open Existing Project. In the bottom 

pane select a recent project, or click on OK to open another project. 

Important: It is strongly recommended that you regularly create project backups and save them on 

external hard drives or flash drives, in order to minimize losses in case of computer problems. 

Project files from MAXQDA 12 have the extension MX12. If your computer system hides file exten-

sions, you can identify data by the MAXQDA symbol and by the file type “MAXQDA 12 Project File.” 

You can now enter your data including interview transcripts, reports as PDF files or video clips, as well 

as import documents into the created or opened project. 

2.2 The MAXQDA Interface and the Four Main Windows 

After opening or creating a new project, you will see the MAXQDA interface: 

 At the very top of the screen, you will see the project document name including the location where 

it is saved. 
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 Underneath the file name, you will see the drop-down menus and various toolbars with buttons 

that offer quick access to frequently-used functions. 

 A status bar is found at the bottom of the screen. 

MAXQDA's four main windows occupy the main part of the workspace: 

 

The four main MAXQDA windows 

The four windows have the following functions: 

• The “Document System” provides an overview of all the texts, PDF files, tables, pictures and media 

files of your project. You also have the option of organizing these documents in document groups, 

which act as folders. 

• The “Code System” displays all the codes, subcodes and code memos along with the number of 

associated coded segments. 

• The “Document Browser” displays one of the documents from the “Document System,” where 

it can then be worked on. You can highlight, edit, code, create links, or attach memos in this 

window. Geo-Links are also displayed in the Document Browser. 

• The “Retrieved Segments” window is a results window. Here you can display a selection of coded 

segments (Retrieval). 

Small Toolbars in the Windows 

Each window has a toolbar, which gives you quick access to frequently-used functions. By hovering 

over each symbol, you can see what each symbol does. Symbols that are found in more than one 

toolbar always have the same function, such as: 

  prints out the content of the window 

  exports the content of the window 

  allows for search in associated window 
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  undocks the window 

  maximizes the window to the largest possible size 

  closes the window 

 

Small toolbar within a window 

Hide and Show Main Windows 

All four windows can be shown or hidden in various ways so that you can control the arrangement 

of windows on your screen and optimize your work space. 

1. You can hide or show the windows by selecting View > Windows in the main menu. 

 

Hide and show four main windows in the menu 

2. You can hide or show the windows by clicking on the appropriate icons in the “MAXQDA stand-

ard” toolbar: . 

3. You can close the windows by clicking on the appropriate icon  in the upper-right hand corner 

of each window. Next to the close icon, you also have the option of clicking to maximize the 

window to its largest possible size. 

Note: You can hide or show all windows, but at least one window must be shown at all times, which 

means it isn’t possible to close all four windows. 
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Optimize interface: Customize Window Width 

The optimal setup of your windows in MAXQDA depends largely on the size of your monitor and the 

set resolution. It is not recommended that you use a resolution smaller than 1024 x 768. 

The size of each window in comparison to the others can be adjusted as you wish by clicking with 

the left mouse button on a border and dragging it in the appropriate direction. 

 

Window height and width can be adjusted by clicking and dragging borders with the mouse 

Optimize Interface: Customize Coding Columns 

The “Document Browser” window includes the coding column, a gray area left (or right) of the text 

document in which codes are displayed. To adjust the width of the coding column, move the mouse 

pointer to the top of the line separating it from the document, press the left mouse button, and drag 

the column to the left (or right) side of the text. 

 

Adjusting the width of the coding column 

You can choose whether or not to display the names of each code by clicking on an empty spot in 

the coding column and right-clicking. A window will then appear that allows you to change this 

setting. 

Optimize Interface: The Two-Column and Three-Column Layout 

With a screen width of over 1,440 pixels, MAXQDA 12 uses a three-column layout by default. This 

takes advantage of the widescreen format of modern monitors better than the traditional four-win-

dow layout, which has long been a characteristic of MAXQDA. You can easily change back to the 

traditional four-window view with the help of the “Screen Layout Manager.” This is appropriate for 

screens with normal formats. 
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To call up the Screen-Layout-Manager, select: 

1. In the opening window View > Screen Layout Manager; or 

2. The  icon in the main toolbar. 

The Screen-Layout-Manager allows you to select from among four options: 

 

The Screen-Layout-Manager 

Top left: The new default layout in three columns for wide screens. The “Document Browser” is 

found in the middle and “Retrieved Segments” in the third column on the far right. 

Top right: Alternative three-column layout with the “Document System” and the “Code System” on 

the right side. 

Bottom left: The classic two-column layout with the “Document System” and the “Code System” 

on the left side. 

Bottom right: Alternate two-column layout with the “Document System” and the “Code System” 

on the right side 

Optimize Interface: Small Screens 

When coding a document, it is sometimes helpful to close the “Document System” and “Retrieved 

Segments” window, so the “Code System” and “Document Browser” are larger. The “Document 

Browser” can then be made even bigger by dragging the border in the direction of the “Code Sys-

tem.” 



MAXQDA Screens and Menus 

 

17 

 

Optimal window setup when coding 

It is similarly helpful to close the “Document Browser” when you are doing retrievals (Coding Query), 

so you have access to the three necessary screens while maximizing the size of your “Retrieved Seg-

ments” window. Whenever you now click on the text information box in the “Retrieved Segments” 

window, the corresponding text will be open in the “Document Browser” window. 

2.3 The Main Menu  

The main MAXQDA menu includes the following menus: 

 

The main MAXQDA menu 

The main menu options offer the following functions: 

Project Menu 

In the Project menu, you can choose to create a new project, open an existing project, or complete 

other project management functions like printing, exporting, and importing. This makes it possible, 

for example, to print out the “Document System,” the “Code System,” the “Retrieved Segments” 

window, and the currently opened document in the “Document Browser.” You can also change the 

user name or access the admin settings for teamwork options on a project. 

View Menu 

This menu allows you to hide or view each of the four main MAXQDA work area windows. Further-

more, you can open the Screen Layout Manager to arrange the four main windows. 

The MAXQDA toolbars can be turned on or off in this menu. After turning on a toolbar, you can 

move the toolbar around, freely placing it anywhere on your screen. If a toolbar is closed and then 

opened again, it will reappear where it had last been placed. 
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Documents Menu 

In this menu, you can import documents, create a new document group, or a new document. A 

special function also allows you to import structured document forms. Furthermore, you can import 

data from Twitter, SurveyMonkey and MAXQDA’s Web Collector as well as focus group transcripts. 

The document shown in the “Document Browser” can also be printed or exported, and the “Over-

view of links” can be called up. 

Codes Menu  

This menu offers functions that connect to your codes, and some of the functions can also be accessed 

by right-clicking in the “Code System” window. 

The available functions allow you to create a new code, view an overview of code frequencies, or 

create a complete index of all codes assigned to all document segments. 

You also have the option of printing the “Code System,” importing or exporting the “Code System.” 

The list of all coded segments can be printed or exported. 

Variables Menu  

The variables menu allows you to create, edit, and set values for document variables, as well as switch 

between the various variable views. You can also import or export variables from this menu and call 

up code variables. 

You will also have access to MAXQDA's Statistics and Graphics functions, which can be called up for 

both document and code variables. 

Analysis Menu 

This menu offers options related to the lexical search and retrieval functions for coded segments 

(called “Coding Query”). Furthermore, you can access the functions to create and display summaries 

for coded segments.  

The Analysis menu also offers access to the intercoder agreement functions and the memo functions, 

especially the “Overview of memos” window. This overview includes all memos (document memos, 

document group memos, code memos, in media memos, and free memos) and can be filtered for 

various criteria. 

Mixed Methods Menu 

This menu includes various functions for the combination of qualitative and quantitative data using 

documents and variables. The activation via variables allows you to activate documents or document 

groups based on their assigned variable values, thereby limiting the retrievals to certain document 

segments. The Quote Matrix and Crosstabs functions are different visualizations that show connec-

tions between coded segments and selected variables or variable categories. The Typology Table is 

similar and shows percentages and/or mean values and standard deviations for qualitatively-designed 

typologies. 
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Visual Tools Menu 

This menu offers several visualization function options: MAXMaps, the tool for qualitative modeling; 

the Code Matrix Browser (documents by codes); the Code Relations Browser (code co-occurrence); 

and the Document Comparison Chart are all for numerous or all of your documents; and the Docu-

ment Portrait and Codeline visualizations apply only to one document at a time, which means that 

they can only be selected when an appropriate document is opened in the “Document Browser”; the 

tag cloud vizualises the 50 most-frequent words of all text, PDF and table documents and can be 

adjusted with a stop list. 

Stats Menu (optional) 

This menu is only available if you are running a license for “MAXQDA Analytics Pro”. “Stats” is a 

module, which offers frequently used descriptives and inferential statistic functions, like frequency 

tables, crosstabs, one-way analysis of variance, correlation and creating scales. 

MAXDictio Menu (optional) 

This menu is only available if you are running a license for “MAXQDA Plus” or “MAXQDA Analytics 

Pro”. “MAXDictio” is a module, which offers many functions for word frequencies, word combina-

tions, and other tools for text exploration as well as quantitative content analysis based on a diction-

ary. 

Help Menu 

Here you will find the Getting Started Guide in PDF format, which may be helpful to print out. You 

will also find detailed help and links to the online and video tutorials, which give you a quick intro-

duction to the program. You can also search for an update and download the update if you don’t 

have the most recent version.  

2.4 The Toolbars  

MAXQDA's main toolbar is called “MAXQDA standard” and should always be visible. It contains icons 

that provide quick access to frequently used program functions. By default, the toolbar is located 

directly below the main menu: 

 

“MAXQDA standard” toolbar 

The icons represent the following: 

http://m22.maxqda.com/products/maxqda-analytics-pro
http://m22.maxqda.com/products/maxqda-plus
http://m22.maxqda.com/products/maxqda-analytics-pro
http://m22.maxqda.com/products/maxqda-analytics-pro
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Overview of the buttons in the “MAXQDA standard” toolbar 

In addition to the main toolbar (”MAXQDA standard”), there are four other toolbars that can be 

shown or hidden as necessary. These toolbars can be hidden or displayed in the View menu. 

 

The “View” menu 

The “Code” toolbar offers quick access to functions for coding, linking text segments, and turning 

on/off Edit Mode. 

 

“Code” toolbar 

The “Media player” toolbar makes it possible to play audio and video files connected to texts and 

insert time stamps. 

 

“Media player” toolbar 
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The “Visual tools” toolbar has seven symbols, giving you quick access to the mapping tool MAX-

Maps as well as the visualization functions “Code Matrix Browser,” “Code Relations Browser,” “Doc-

ument Comparison Chart,” “Document Portrait,” “Codeline,” and “Tag cloud.” 

 

“Visual tools” toolbar 

The “MAXDictio” toolbar makes it easy to access six of the most common functions in the add-on 

module MAXDictio for quantitative, dictionary-based content analysis. 

 

“MAXDictio” toolbar 

Position Toolbars on the Screen 

All toolbars can be positioned anywhere on the screen. Simply click on the four points on the left 

edge of a toolbar or the title of a free-floating toolbar and place the toolbar at the desired position. 

 

Position toolbars 

2.5 The Context Menus and Toolbars in the “Document 

System”  

In addition to the various menus accessible from the menu bar, MAXQDA can be controlled using the 

toolbars and context menus in their respective windows. The functions that relate to the handling of 

documents are available in the “Document System” window. 

Toolbar 

The toolbar at the top of the “Document System” window offers quick access to the following fre-

quently-used functions: 

  Reset activations – resets current activations 

 Activate by document variables – allows activation of documents based on their variable values. 

 Display only activated documents 

  Activate by color – allows activation of documents based on their assigned color. 

  New document group – creates a new document group directly above the document group, 

displayed in the highest position. 
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  Import document(s) – allows you to insert text, PDF files, spreadsheets, images and media files 

into the project. 

  Display search toolbar – allows you to search for a specific document name. 

  Undock window 

  Maximize window 

  Hide window 

Documents and Document Groups 

In order to better organize your documents, it is possible to create document groups. In MAXQDA, it 

is, however, not absolutely necessary that each document is put in a document group. Documents 

can simply be left in the root of the “Document System” window. 

Documents can also be temporarily grouped together from various document groups for certain as-

pects of your analysis. In MAXQDA, these groupings are called document sets. 

Example: In an interview-based study on kindergartens in which teachers, administrators, and par-

ents are interviewed it makes sense to make three folders, one for each category of interviewees. All 

interview transcripts would be imported into the project (perhaps called “Kindergarten study”) and 

then assigned to one of three document groups, named “Administrator,” “Teachers,” and “Parents.” 

In the “Document System,” it is possible to differentiate between three levels, each level offering a 

different context menu: 

 the project level 

 the document group(s) level 

 the document level 

 

Three levels in the “Document System” window 
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The Upper Level 

The upper level in the “Document System” hierarchy is the project level. After creating a new project, 

the “Document System” is empty except for the “Documents”-entry. By right-clicking on its icon, 

you will call up the following context menu: 

 

Context menu for the upper level in the Document System 

The menu contains the following functions: 

Activate all documents – activates all documents in the entire project. 

Deactivate all documents – deactivates all documents in the entire project. 
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Activate by document variable – allows you to create logical conditions based on the existing doc-

ument variable values for selecting and activating documents. 

Invert activation – activates all documents that are not currently activated and deactivates all those 

documents that are currently activated. This is especially helpful when doing logical activations; you 

can then very quickly call up segments from documents with the contrasting document variables. 

----------------------------- 

Collapse all document groups – collapses all document groups for a better overview. Thus, the 

individual documents of the document groups will not be visible. 

----------------------------- 

Memo – creates a memo that can hold information about the entire project. 

----------------------------- 

New document group – creates a new document group. 

Sort document groups (ascending) – sorts all document groups in ascending alphabetical order. 

Sort document groups (descending) – sorts all document groups in descending alphabetical order. 

Move activated documents here – moves all activated documents to the top level of the “Docu-

ment System” window. This function is only visible if at least one document is actually activated. 

----------------------------- 

Create document – inserts a new, empty text or table document with a default name into the “Doc-

ument System.” 

Import document(s) – allows you to import document(s) into the project. They will be inserted at 

the highest hierarchical level of the “Document System”. When choosing this function, a standard 

file dialog appears to choose a file for import. The documents can be in TXT, RTF, DOC/X, PDF, JPG, 

GIF, TIF and PNG format. You can also select media files; however, due to their size, they are not 

imported into the project file, but stored externally and assigned to a text document. 

Import documents from Excel spreadsheet – allows import and automatic coding of cases as doc-

uments from a table structure, which is very useful for survey data. 

Import structured documents (Preprocessor) – facilitates the import of a pre-structured text that 

may marked passages for automatic coding during import. The text may also be split up into several 

documents during import. 

Import focus group transcript – imports a transcript of a focus group interview, which will auto-

matically be coded. 

Import f4/f5 transcript – imports a transcript, created with the software f4/f5. After selecting the 

transcript, MAXQDA automatically asks for a media file to assign to the transcript. 

Transcribe audio/video file – facilitates the import of an audio or video file to be transcribed within 

MAXQDA. The new document name will be that of the chosen audio/video file. 

----------------------------- 
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Overview of coded segments – lists all coded segments in the entire project in table form. 

Overview of variables – shows the data editor of the document variables for all documents in the 

project. 

Overview of memos – lists all memos in the entire project in table form. 

Overview of codes – lists all codes in the entire project in table form. 

Overview of links – lists all links in the entire project in table form. 

Overview of summaries – lists all summaries in the entire project in table form. 

----------------------------- 

Tag cloud – creates a visualization of the 50 most frequently-used words in the entire project. 

----------------------------- 

Export teamwork – allows export of all coded segments, memos, summaries and variables of the 

project. 

Import teamwork – allows export of all coded segments, memos, summaries and variables of the 

project. 

----------------------------- 

MAXDictio Coder – opens the MAXDictio Coder (will be displayed only if MAXQDAplus, which con-

tains the MAXDictio functions, is installed). 

The Middle Level: Document Groups 

A project can contain as many different document groups as you wish to create. A context menu is 

also available at the document group(s) level, which offers functions that only affect that specific 

chosen document group. 
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Context menu for the middle (document group) level in the Document System 

The following options are available in the context menu of a document group: 

Activate all documents – activates all documents in the document group. 

Deactivate all documents – deactivates all documents in the document group. 

----------------------------- 

Memo – creates a memo that can hold information about the document group. 

----------------------------- 

Delete document group – deletes the document group, including all documents, coded segments, 

memos, summaries and variables that are associated with it. MAXQDA only completes the deletion 

after confirming that you do indeed wish to carry out the action. 

Rename document group – lets you give a new name to the document group. 
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----------------------------- 

Sort documents (ascending) – sorts all documents in the document group in ascending alphabetical 

order. 

Sort documents (descending) – sorts all documents in the document group in descending alpha-

betical order. 

Move activated documents here – moves all activated documents to this document group, thus 

resorting the “Document System” accordingly. This function is only displayed if at least one document 

is actually activated. 

----------------------------- 

Create document – inserts a new, empty document with a default name into the document group. 

The document is automatically opened and put in Edit Mode, allowing you to immediately type con-

tent into the document. 

Import document(s) – allows you to import document(s) into the document group. When choosing 

this function, a standard file dialog appears to choose a file for import. The documents can be in TXT, 

RTF, DOC/X, PDF, JPG, GIF, TIF and PNG format. You can also select media files; however, due to their 

size, they are not imported into the project file, but stored externally and assigned to a text document. 

Import focus group transcript – imports a transcript of a focus group interview, which will auto-

matically be coded. 

Import f4/f5 transcript – imports a transcript, created with the software f4/f5. After selecting the 

transcript, MAXQDA automatically asks for a media file to assign to the transcript. 

Transcribe audio/video – facilitates the import of an audio or video file to be transcribed within 

MAXQDA into the document group. The new document name will be that of the chosen audio/video 

file. 

----------------------------- 

Overview of coded segments – list all coded segments from the document group in table form. 

Overview of variables – shows the data editor of the document variables for all documents in the 

document group. 

Overview of memos – lists all memos in the document group in table form. 

Overview of codes – lists all codes used in one of the documents of the document group in table 

form. 

Overview of links – lists all links in the document group in table form. 

Overview of summaries – lists all summaries in the document group in table form. 

----------------------------- 

Tag cloud – creates a visualization of the 50 most frequently-used words in the document group. 

----------------------------- 
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Export teamwork – allows export of all coded segments, memos, summaries, and variables of all 

documents in the document group. The exported file can be imported in a project on a different 

computer. This function enables you to work in a team and divide the work on the documents of a 

document group among team members. 

Import teamwork – allows import of all coded segments, memos, and variables to the document 

group. 

----------------------------- 

MAXDictio Coder – opens the coding tool MAXDictio (will be displayed only if MAXQDAplus, which 

contains the MAXDictio functions, is installed). 

----------------------------- 

Document sets are handled similarly to document groups. They are a temporary grouping of docu-

ments, but only contain links to the documents instead of the documents themselves. The context 

menu that appears when you right-click on a document set is similar to the document group context 

menu, but it does not contain the options to import documents. 

The Lower Level: The Document 

A context menu is also available at the individual document level and contains a variety of functions 

connected to the chosen document. 
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Context menu for the lowest (document) level 

The menu contains the following functions: 

Activate – activates the document; if the document is already activated, the option will be to deac-

tivate it. 

----------------------------- 

Open document – opens the document in the “Document Browser”. The document which is cur-

rently opened in the “Document Browser” is indicated in the “Document System” with a special 

symbol (document with a pen). 

Open document in a new tab – opens the document in a new tab in the “Document Browser”. 

The document which is currently displayed is indicated in the “Document System” with a special 

symbol (document with a pen). 
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Open document in second Document Browser – opens the document in an undocked “Document 

Browser”. The document which has last been focused is indicated in the "Document System" with a 

special symbol (document with a pen)." 

----------------------------- 

Memo – creates a memo for the document. 

Color – opens a window that allows you to select a color for the document. 

----------------------------- 

Delete document – deletes the document including all connected information, including memos, 

coded segments, variables, etc. MAXQDA only completes the deletion after confirming that you do 

indeed wish to carry out the action. 

Rename document – allows you to modify the document name. 

Export document – the selected document will be exported and saved in the location of your choice. 

----------------------------- 

Overview of coded segments – lists all coded segments from the document in table form. 

Overview of variables – shows the data editor of the document variables for the selected document. 

Overview of memos – lists all memos in the document and the document memo in table form. 

Overview of links – lists all links in the document in table form. 

Overview of summaries – lists all summaries of the document in table form. 

----------------------------- 

Document Portrait – opens a visualization of the document that uses the code colors of the coded 

segments in the document to create a picture of the document. The size of the coded segment acts 

as the weighting factor, meaning that the longer the coded segment, the more space that color takes 

up in the visualization. 

Codeline – opens a visualization of the coded segments of the document. A matrix is created with 

the codes on the y-axis and the paragraph numbers on the x-axis. It is then possible to see which 

codes were used in each paragraph of the document. 

Tag cloud – creates a visualization of the 50 most frequently-used words in the document. 

----------------------------- 

Export teamwork – allows for the export of all coded segments, memos, summaries, and variables 

for the document. The exported file can be imported in a project on a different computer. This func-

tion enables you to work in a team and divide the work on a single document among team members. 

Import teamwork – allows for the import of coded segments, memos, summaries, and variables for 

the document of an earlier exported file. 

----------------------------- 

MAXDictio Coder – opens the MAXDictio Coder (will be displayed only if MAXQDAplus, which con-

tains the MAXDictio functions, is installed). 
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----------------------------- 

Properties – opens a window with all the properties of the document, which can then be edited (e.g. 

whether or not the document should be opened in read-only mode). You can also link a media file 

to the corresponding document (e.g. an audio file with the corresponding transcribed interview) to 

either code the transcript or the media file itself. 

2.6 Context Menus and Toolbar in the “Document Browser”  

Toolbar 

The “Document Browser” is MAXQDA's main work window: This is where you can code text and 

images, write memos, link text and images together, add external links and more. The majority of the 

functions you will carry out in the “Document Browser” are available in the context menu, which you 

can access by simply right-clicking in the window. The most commonly-used functions are also avail-

able in the toolbar at the top of the “Document Browser.” It contains the following functions: 

  Edit mode on/off – allows you to edit the text of a text or table document. 

  Print document – allows you to print the document displayed in the window, optionally along 

with memo symbols and coding stripes. 

  Export displayed document – saves the open document in a location of your choice. 

  Filter visualized coding stripes – allows you to choose which coded segments should be visu-

alized in the coding column based on their color. 

  Display search toolbar – allows you to search within the open document. 

  Undock window 

  Maximize window 

  Hide window 

Context Menu 

If you highlight a segment of text or select a section of a picture opened in the “Document Browser,” 

a context menu will appear with a large selection of various functions. 
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Context menu of a highlighted segment of text in the Document Browser 

Most of the available functions are self-explanatory, but they will still be explained quickly in the 

following section. 

Note: For PDF and image documents some functions such as cut and paste are not available because 

these file formats do not permit modification. Some functions are also unavailable for spreadsheets. 

Code with a new code – codes the highlighted text or section of an image with a new code. 

Code in-vivo – codes the highlighted text with a new code created and named with the highlighted 

text. 

Code with “xyz” – codes highlighted text or section of a picture with the most recently used code. 

Code with activated codes – codes highlighted text or section of a picture with all activated codes 

in the “Code System.” 

----------------------------- 

New memo – creates a memo for the highlighted text. 

Search for highlighted text – opens the lexical search, with which you can search for the selected 

text in all or part of the project. 



MAXQDA Screens and Menus 

 

33 

List assigned codes – displays the codes assigned to the selected segment. 

----------------------------- 

Convert to line-numbered text – cuts each line after a pre-defined number of characters into a 

new line, which will be treated as a new paragraph. Since this function changes the text altogether, 

it is only available in Edit mode. The function is not available for texts in read-only mode; the write 

protection needs to be disabled to use it. 

----------------------------- 

Insert document link – sets an anchor for a link, which is a connection between two sections of a 

text or image. 

Insert external link – opens a file dialog to allow you to choose a file to be linked to the highlighted 

section of the text or image. 

Insert weblink – allows the insertion of a link to a website. 

Insert geolink – allows to insert a geolink; a file dialog will appear to open and import a KML file, 

that contains the geo information. 

Remove link – deletes a link from the selected text. 

----------------------------- 

Cut – cuts the highlighted text from the document as in Microsoft Word. 

Copy – copies the highlighted text as in Microsoft Word. 

Paste – pastes the contents of the clipboard as in Microsoft Word. 

----------------------------- 

Undo text changes – undoes the most recent change to the text (only works when in Edit mode). 

Undo all text changes – undoes all changes to the text that have been done since Edit mode was 

turned on (only works when in Edit Mode). 

----------------------------- 

Display geolink column – displays the geolink column next to the memo and code visualization 

column on the margin of the “Document Browser.” All geolinks are visualized with a symbol in this 

column. 

Display timestamp column – displays the timestamps column on the margin of the “Document 

Browser”. This option is only visible if a media file is linked to the document. 

2.7 Context Menus and Toolbar in the “Code System”  

Toolbar 

The toolbar at the top of the “Code System” window offers quick access to the most commonly-used 

functions in this window. These functions are: 
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  Reset activations – resets current code activations. 

  Activation by code variable – allows the activation of codes depending on their variable values. 

  Activation by color – allowing codes to be activated based on their assigned colors. 

  Display emoticodes only /  Display codes and emoticodes – reduces the display in the 

“Code System” window to emoticodes. 

 Change to table view /  Change to standard view – switches between tree view, and table 

view of the code system. 

  New code – adds new code into the code system. 

  Display search toolbar – allows you to search for a specific code. 

  Undock window 

  Maximize window 

  Hide window 

The Upper Level in the “Code System” 

When you create a new project, the “Code System” is empty except for the “Code System” icon and 

label. This represents the root directory or folder, the upper level of the “Code System” hierarchy. If 

you right-click on the symbol or the label next to it, you will see a context menu. Since most selectable 

functions only apply to a non-empty Code System, some codes have already been inserted into the 

following illustration. 
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Context menu for the upper level of the Code System 

This menu offers access to the following functions: 

Activate all codes – activates all codes in the entire “Code System.” 

Deactivate all codes – deactivates all codes in the entire “Code System” (except focus group partic-

ipant codes). 

Activate by code variables – allows activation based on code variable values. 

Invert activation – activates all currently deactivated codes and deactivates all currently activated 

codes in the entire “Code System.” 

Load activation – code activation status will be imported from a file previously created in MAXQDA. 

Save activation – the current activation status of the code system is stored in a file that can be called 

up at a later time in order to establish this specific activation status. 

----------------------------- 

Collapse all subcodes – to the better overview all subcodes are collapsed, so that only the codes of 

the uppermost level are visible. 

----------------------------- 

New code – creates a new top level code in the code system.  
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Sort codes – sorts all codes in the upper level of the “Code System” hierarchy by code frequency or 

in alphabetical order. 

Move activated codes here – moves all activated codes to the top level of the “Code System” 

window. Subcodes of activated codes will keep their position as subcodes as long as they are not 

activated. This function is only visible if at least one code is actually activated. 

----------------------------- 

Code Alias table – lists all codes in a table view where you can edit the code alias of each code. 

----------------------------- 

Overview of coded segments – lists all coded segments in the entire project in table form. 

Overview of linked memos – lists all memos that are linked to any code in the “Code System.” 

Overview of variables – shows the data editor of the code variables for all codes in the project. 

Statistic of subcodes – calls up the statistics and graphics functions which generate frequency tables 

and charts with the number of encodings. 

----------------------------- 

Export Code System (MAXQDA format) – exports and saves the “Code System” as a file with the 

extension MTR (MAXQDA TRee). This function can be used for transferring code system from one 

project to another. 

Import Code System (MAXQDA format) – import a “Code System” from a previously created MTR 

file. 

----------------------------- 

Code with activated codes – the currently highlighted text or image segment, or video or audio 

clip, is encoded simultaneously with all activated codes. 

The Lower Level: Individual Codes and Subcodes 

There is also a context menu for the single code/subcode level, which offer functions that affect the 

code you right-clicked on. 
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Context menu on the code/subcode level 

The following functions are shown in the context menu: 

Activate incl. subcodes / Deactivate incl. subcodes – the code including all its subcodes are acti-

vated or if it is activated, it is deactivated together with the subcodes. 

Activate/Deactivate – only the code itself, without its subcodes, is activated. 

----------------------------- 

New code – creates a new subcode for the selected code. 

----------------------------- 

Memo – creates a memo for the current code. 
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Color – opens a window where you can set a color for the code. 

Code highlighted segment – codes the currently highlighted text or image segment in the “Docu-

ment Browser” or the highlighted audio/video clip in the “Multimedia Browser” with the current 

code. 

----------------------------- 

Delete code and subcodes – the selected code is deleted after confirmation. In the alternative view 

of the “Code System” as Table, several codes can be deleted simultaneously. When a code is deleted, 

every association to coded segments will be deleted. Subcodes will also be deleted. The removal of 

codes from a code system can be visualized as the cutting of branches from a tree: when a branch 

(code) is cut, all attached subcodes and subcodes of subcodes are also cut. 

Rename code – allows you to create a new name for the code. 

----------------------------- 

Sort subcodes – sorts all subcodes of the current code by alphabetical order or by code frequency. 

Copy subcodes – copies all subcodes so that they can be pasted into another code. 

Move activated codes here – inserts all activated codes as subcodes of the chosen code. Subcodes 

of activated codes will keep their position as subcodes as long as they are not activated. This function 

is only visible if at least one code is actually activated. 

----------------------------- 

Copy coded segments – copies all coded segments for the code, so that they can be copied into a 

different code. After choosing this option, right-click on the code that you would like to paste these 

coded segments into and select Insert coded segments from … 

Move coded segments – cuts the coded segments from the current code, so you can insert them in 

a different code. After selecting this option, right-click on the code where you want to move the 

coded segments to and select Move coded segments from … A window will appear confirming 

that you really wish to move the codes, and after you confirm this, the coded segments are moved. 

----------------------------- 

Overview of coded segments – opens a table with all coded segments coded with the current code, 

offering an overview of the text and image segments assigned with the code. 

Overview of linked memos – opens a list of all memos that are linked to the current code. 

Overview of variables – opens a table with all code variables of the code and its subcodes. 

Overview of documents – opens a table with all of the documents in which the code was used. 

Overview of summaries – lists all summaries in the entire project in table form. 

----------------------------- 

Transform into a document variable – creates a numerical document variable with the name of 

the current code in the variable list. The number of times the code appears in each document is 

entered as the variable value for each document. 
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Transform into a categorical document variable – creates a new string variable whose value for 

each document is the subcode that appears most often in that document (only works for codes that 

have subcodes). 

Statistic for subcodes – 

Intersections – shows a list of all codes that intersect with the current code. The code that intersects 

most often is listed first. Clicking on an entry in the list displays the corresponding intersecting seg-

ments in the “Retrieved Segments” Window. 

Crosstab – 

----------------------------- 

Add code to code favorites – adds the current code to the list of code favorites. 

Properties – opens 

2.8 Context Menus and Toolbars in the “Retrieved Segments” 

Window  

Toolbar 

The following commonly-used functions are available in the toolbar at the top of the “Retrieved Seg-

ments” window: 

  Change to table view /  Change to standard view – switches from list view to table view 

and back. 

  Print retrieved segments – prints segments along with indications of their origins. 

  Open as Excel table – opens the retrieved segments in an Excel document in XLS/X. 

  Open as HTML table – opens the retrieved segments in your standard browser. 

  Export retrieved segments – the segments can be exported in text format RTF (text format), or 

as tables in XLS or HTML format. Memos attached to coded segments, other codes assigned to the 

segment, as well as tooltip variables, can be included in the exported material. 

  Overview of retrieved segments – shows overview of all retrieved segments in table form. 

Overview will be displayed in a new window. 

  Code retrieved segments – all coded segments that are currently in the “Retrieved Segments” 

can be coded additionally with an existing code. 

  Code retrieved segments with a new code – all coded segments that are currently in the 

“Retrieved Segments” can be coded additionally with a new code. 

  Context search – allowing for searches within the retrieved segments. 

  Undock window 
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  Maximize window 

  Hide window 

Context Menu 

All coded segments in the activated documents that were coded with the activated codes are shown 

in the “Retrieved Segments” window. 

To the left of each of these segments is an info box with information about that segment. The info 

boxes tell you in which document group, document, and position the segment is found and which 

code was assigned to it. 

 

Clicking on the yellow info box opens the original document in the “Document Browser” and highlights the 

document segment 

If you right-click in the gray area on the left side of the “Retrieved Segments” window (not on an 

info box), a context menu appears. 

This menu offers access to a number of different features that affect the way segments are received 

in this window. You can, for example, set how retrieved segments should be sorted or how activated 

codes are linked to each other. 

The retrieved segments can be sorted according to the document in which they are found (according 

to the order of documents in the “Document System”), according to the code they are coded with 

(according to the order of codes in the “Code System”), or according to the weight assigned to each 

coded segment. 

 

Context menu in the gray area of the “Retrieved Segments” window 
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Here are all the available functions in the context menu: 

Complex Coding Query – opens the Complex Coding Query tool, which proposes numerous re-

trieval options. 

----------------------------- 

Ordered by Document System – the segments in the “Retrieved Segments” window will be sorted 

in order of the “Document System.” 

Ordered by Code System – the segments in the “Retrieved Segments” window will be sorted in 

order of the “Code System.” 

Ordered by weight score (ascending/descending)– sorts retrieved segments according to the 

weight assigned to them. 

----------------------------- 

Include subcodes – automatically includes all subcodes in the retrieval for each code activated in the 

“Code System.” 

Use weight filter – displays only those retrieved segments that are within a certain weight range. 

Edit weight filter – opens a window where you can change the range of weight scores included in 

the “Retrieved Segments” window. 

2.9 The Status Bar 

At the bottom of the MAXQDA screen, you will see a status bar that includes information about 

various aspects of your current workspace (e.g. the number of activated documents and codes, the 

number of retrieved segments, the current retrieval option, etc.) 

 

Status bar at the bottom of the MAXQDA screen 

  Activated Documents – number of currently activated documents 

  Active codes – number of currently activated codes 

  Coded segments – number of coded segments, which are displayed in the “Retrieved Segments” 

window 
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  Default weight – displays the current standard weight, with which each new coded segment is 

provided. The icon is interactive! Click the icon to customize the standard weight. 

  Include Subcodes – displays the current status of the retrieval: If there is a checkmark on the 

icon, the subcodes are included in the retrieval; if no checkmark is displayed, the subcodes are not 

included. The icon is interactive! Click the icon in order to determine whether subcodes will be 

included or not. 

  Use Weight Filter – displays the current status of the weight filter for the retrieval: If there is no 

checkmark displayed on the icon, the weight filter is switched off and all segments will appear in the 

“Retrieved Segments” window, regardless of their weight. If a checkmark appears on the icon, the 

weight filter is active and only the segments which satisfy the conditions of the filter will appear. The 

icon is interactive! Click the icon to turn the weight filter on and off. 

  Sort sequence – shows the sequence of the coded segments in the “Retrieved Segments” win-

dow, which can be sorted by Document System, Code System, or weight. The icon is interactive! 

Click the icon to toggle between the various sorting options. 

   Coding Query – displays the selected mode of retrieval, such as “Simple Coding Query” or 

“Overlapping.” The icon is interactive! Click the icon to call up the Complex Coding Query. 
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3 Use of Table Overviews in MAXQDA  

3.1 The Toolbar in Table Overviews 

There are many situations in MAXQDA where table overviews are used to display information, and 

they are similar in how they can be worked with, which is similar to the handling of tables in Excel. 

All table overviews have a toolbar offering quick access to frequently-used functions. 

The overviews include various icons depending on their function and purpose. The following icons 

are found in nearly all of these toolbars: 

  Only activated documents – Displays only the rows in which activated documents appear. The 

symbol can only be clicked when at least one document is activated. 

  Only activated codes – Displays only the rows in which activated codes appear. The symbol can 

only be clicked when at least one code is activated. 

  Filter – Turns the filter for the columns on and off. The symbol can only be clicked when a filter 

has been set for at least one column. Set the filter by right-clicking on the column header. 

  Delete filter – Deletes the defined filter for all columns of the table. 

  Search – Turns the search toolbar for the table on and off. 

  Excel table – shows the current table in an Excel document. This does not happen within 

MAXQDA, but can be printed out or saved as a separate file. 

  HTML table – shows the current table in an HTML document. This can also be saved or printed 

out, but is no longer connected to your MAXQDA project. 

  Export – saves the content of the table in diverse formats including Excel (XLS/X) or Website 

(HTML) and opens the file. Unlike the two functions above, you can choose the file name and location. 

This exported file is also no longer connected to your project file. 

3.2 Managing Table Overviews 

Tables in MAXQDA can be customized as in Excel or other similar spreadsheet programs. For the 

following example, we’ll use the table view of the document variables in MAXQDA: 
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Table view of an example project’s document variables 

The heading of each column has the name of each variable, although the standard MAXQDA system 

fields are written in a different font color: 

 Document group – the name of the Document group in which the document is found 

 Document name – the name of the document 

 Creation date – the date on which the document was imported 

 Author – the user that was logged in when the document was imported 

 Number of coded segments – the number of coded segments in the document 

 Number of memos – the number of memos in the document 

Adjusting column width and position 

The width of each column can be changed by clicking and dragging the border between the columns. 

Double-clicking on the column header border to the right of the column resizes the column to its 

optimal size, so that the contents of each row can be fully seen. 

 

Adjust column width and position 
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It is also very easy to change the order of the columns. You just need to click on a column header 

and drag it to the place you wish to have it. 

By right-clicking on a column header, the context menu appears for that particular column. This 

includes various options, including the option to hide the column or search within the column. The 

Select field option opens a window where you can select which of the columns should be viewed 

in the standard view. 

Sorting Tables 

Tables can be sorted very easily. Just click on the column header of the column that you want to sort 

the rows by. 

 

Sorting a table 

Tables can be sorted alphabetically or in reverse alphabetical order. Clicking once on the column 

header sorts it alphabetically; clicking a second time sorts it in reverse. A small triangle appears inside 

the column header of the column that is currently being used to sort the table and whether it is sorted 

alphabetically or in reverse alphabetical order. 

Tables in MAXQDA contain both editable (blue) and un-editable (black) columns. The system varia-

bles, for example, cannot be edited. You would therefore need to change the document name in the 

“Document System” and change the document group of a document by dragging it to a different 

document group in the “Document System.” 

In the editable cells of the table, you can enter or change a value by double-clicking on the cell and 

then typing the value. 

Selecting Rows in the Table 

The table contents can also be selected and copied into the Windows clipboard. The selection of one 

or multiple rows, or a section of the table, is done as follows: A single cell can be selected by simply 

clicking on it, and additional cells can be added to the selection by holding the Ctrl key (Windows) or 

Command key (Mac) and a section of the table can be selected by clicking the first and last rows to 

be included while holding down the Shift key. In MAXQDA, the selected sections of a table are high-

lighted in green. 
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You can also search for certain values within each column of tables in MAXQDA. You only need to 

right-click on the column in which you want to search and select Search. In string fields, the search 

will start with the initial character. If you wish to search for a certain word or phrase that does not 

have to appear at the beginning of the value, you can use the asterisk (*) at the beginning of your 

search. 

Context Menus for Tables 

All overviews in MAXQDA have context menus that can be called up by using the right mouse button. 

The number of options that appear in the context menu depends on the overview. It is usually possible 

to delete a selection (e.g. a coded segment or memo). In the “Overview of coded segments,” you 

also have the option to change the weight score of each segment. The most options are available in 

the document variables table. 

 

Context menu in the document variables table 

Table overviews with detailed view 

The "Overview of coded segments" differs from, for example, from the "Overview of variables" in 

that it is divided into two parts. The lower section is used just as in other tables. The upper section 
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serves as a detailed view. Here, the coded segment, or text or image segment itself that is selected in 

the bottom section appears. The same applies to the “Overview of Memos”: Here the detailed view 

of the memo will appear. 

 

Detailed view of the “Overview of Coded Segments” 

3.3 Searching inside Table Overviews 

To browse a table overview, click on the  symbol at the top of overview. Another toolbar will 

appear, in which you can enter the search term. 

 

Browsing table overviews 

  Highlight all rows with hits – Highlights all the lines in which the search term appears. 

  Choose search columns – Allows you to select which columns will be searched. 

Tip: If you want to limit your search to a single column in the table, right-click on the column heading 

and select the Search option. MAXQDA automatically selects only the indicated column for the 

search. 
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Limit search to one column 

3.4 Filtering Table Overviews  

Table overviews can easily be filtered. For example, in the Data Editor you can display only the rows 

with documents containing more than 20 codes or whose names begin with “B”: 

1. Right-click on the heading of the column you wish to filter, and select the Filter option. 

 

Set filter by column 

2. Set the desired filter options in the window that appears. 
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Filter window 

In all four input fields, you can define criteria to filter. The following criteria are available: 

• Contains 

• Doesn’t contain 

• Starts with 

• Greater than or Lesser than (applies to both numbers and the alphabet) 

• Earlier than and Later than (available only in columns containing a date) 

OR/AND: Here you can select the manner in which the four input fields are combined. With OR, the 

rows in which at least one of the criteria applies are listed. With AND, the rows in which all of the 

criteria apply are listed. 

Case sensitive – When this option is selected, you can differentiate based on whether the text in the 

text column appears in upper or lowercase. In this case, if “interview” in lowercase appears in the 

filtered column, “Interview” beginning with an uppercase letter would not be taken into account. 

After clicking OK, MAXQDA filters the table overview according to the defined criteria. At the top 

right MAXQDA indicates how many of the originally existing rows are currently displayed. 

 

Filtered table overview 

If you set a filter for multiple columns, they are combined with the AND function. 
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You can switch a filter for a table overview on or off at any time using the Filter  symbol, to toggle 

the view between all rows and filtered rows. 

If you wish to delete all defined filters in an overview, click on the Reset all filters  symbol. 

Note: Each time an overview is reopened, filters in table overviews will automatically be set to “off”. 

The filter settings are saved individually for each overview in the project, so if you have defined a filter 

and reopen the project at a later time, you can turn on the filter by simply clicking the Filter  

symbol. 
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4 Documents and the “Document System” 

4.1 General Information about Importing Documents in 

MAXQDA 

With MAXQDA you can 

 import all types of DOC/X, RTF and TXT files without using any special formatting options unless 

you want to use certain MAXQDA functions or achieve a specific document appearance, 

 import all DOC/X and RTF documents with a certain structure (e.g. forms), 

 import PDF documents, 

 import XLS/X table documents, 

 import pictures and graphics in JPG, GIF, TIF and PNG format, 

 import web pages in HTML format, 

 manage audio and video files in order to analyze them and the transcripts at the same time or to 

code them yourself, 

 create new text or table documents and input the data yourself, 

 create new blank documents that are freely editable by typing or pasting content from the Win-

dows clipboard. 

Important: DOC/X documents can only be imported in MAXQDA if you have Microsoft Office (for 

Windows!) 2003 or later installed on your computer. Otherwise, the documents can be saved in RTF 

format and then be imported into MAXQDA. 

All text and table documents imported into MAXQDA can be edited in the “Document Browser.” 

This means you have the option of fixing typos, deleting or adding text, etc. This is also possible once 

you have done some coding and/or creation of memos. This means you don’t have to have a com-

pleted document to start your coding. PDFs, images, and audio/video files cannot be edited in 

MAXQDA. 

4.2 General Information on the Preparation of Text 

Documents 

If you want to import text documents into MAXQDA you should think of their preparation before 

importing them. It does not matter which word processor you use as long as you can save the docu-

ment in RTF or DOC/X format, which is almost always the case. There are almost no limits to the 

options available in RTF and DOC/X format when creating a document.  
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If you wish to handle certain sections of text as a single unit, though, it makes sense to have them 

together in the same paragraph. A new paragraph number is inserted automatically in MAXQDA after 

each hard return. It is also easier then to automatically code these paragraphs in MAXQDA. 

Here are the things to remember when importing a text document:  

 All formatting aspects – like bold, italics, etc. – are carried over to MAXQDA. 

 All fonts and text sizes are carried over. 

 Paragraph formatting (e.g. right-justified, line height) is also carried over. 

 The text can contain tables, pictures, graphics, etc. 

 If objects like graphics are imported or not can be selected in the global options menu (Project > 

Preferences … for Windows and MAXQDA12 > Preferences for Mac …). 

As listed, MAXQDA can handle tables in a text document, and you code parts or whole cells of these 

tables. The only limitation is that the size of the table can no longer be changed once it has been 

imported. 

Note: Principally, it is recommended to use tables in text documents sparingly. This not only increases 

the options for analysis (e.g., automatic coding on a paragraph level), but also enhances the perfor-

mance of display. In particular, it is advisable not to place interviews in a table structure in which each 

speech contribution forms a separate row. 

4.3 Importing Documents into MAXQDA 

Importing Documents with Drag-and-Drop 

Importing files into MAXQDA is simple and intuitive: you can simply highlight the documents in Win-

dows Explorer or Mac Finder and drag them with the mouse into the “Document System.” They will 

then be inserted on the upper level of the “Document System” hierarchy, directly under the “Docu-

ments” icon. In the following screenshot, you can see that eight documents (Teresa, Joanna, Jon, 

etc.) have been imported. 

 

Visualization of eight imported documents in the “Document System” 
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By moving the mouse over a document name, you will see a tooltip that gives you information about 

the document, including its size, the author (MAXQDA user logged in at the time of import), the date 

of import, and the number of coded segments and memos in the document. 

Ordering the documents in document groups 

All you have to do is drag documents into the “Document System,” and you’re ready to start your 

analysis of those documents. Most people don’t start with the analysis immediately, though, and 

prefer to organize the documents in folders, as they might do on their computer’s hard drive. Rather 

than using folders, MAXQDA uses document groups. They work just like folders do in Windows Ex-

plorer or Mac Finder – you can name them and drag documents into them. The number of document 

groups is not limited in MAXQDA; you can make as many of them as you want. When you create a 

new document group, it will automatically be named “Group 2,” “Group 3,” etc. 

 

Newly created document groups are automatically named “Group 1,” “Group 2,” etc. 

Import of documents into document groups can also be done via drag and drop. You just need to 

highlight the documents in Windows Explorer or Mac Finder and drag them onto the document group 

name. You’ll see that the documents are imported into the document group when the file names 

appear under the document group icon and name. 

Tip: To import an entire document folder into MAXQDA, drag the folder from Windows Explorer or 

Mac Finder into the “Document System” window. MAXQDA will then create a new document group 

with the same name as the folder, into which it will import all MAXQDA importable documents. 

In addition to Drag & Drop, documents can be imported into MAXQDA in the following ways: 

 Select a Document Group, then click the Import document(s) button  in the “Document Sys-

tem” toolbar. 

 or you can also import documents by using the keyboard shortcuts Shift+Ctrl+T (import to the 

upper level) or Alt+T (import to the selected document group). 

 Or you can right-click on the root in the “Document System” and select Import document(s). 
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 or you can right-click on the document group that you want to hold the imported documents 

and select Import document(s) from the context menu that appears. 

 

Importing a document via the context menu 

A dialog box will appear that allows you to select the documents that you would like to import. 

Newly imported documents are put at the top of the list of documents in the document group. They 

are given the same name as the original file, but you have the option of renaming them at any point. 

If you want to import several files at once into the same document group, you can select more than 

one document by holding the Ctrl (Windows) or the cmd button (Mac) while clicking on the docu-

ments to import. 

Note: The document group into which the document will be imported will be highlighted in blue. 

When no document group is indicated, MAXQDA will insert the newly imported document at the top 

of the document system. 

The order of document groups in the “Document System” can also be changed at any time. You 

simply need to click on the document group icon and drag it to the location you would like to 

have it. In other words, it is not necessary to know how you will organize all of your documents when 

you import them. 

Note: In MAXQDA, it is not absolutely necessary that you create at least one document group. 

MAXQDA works with document groups similar to the way Windows Explorer or Mac Finder work 

with folders. You can create document groups/folders to better organize your documents, but each 

document doesn’t have to be put in one. Documents can be moved freely from one document group 

to another without having it affect the document in any way. 

Document variables generated automatically during import 

Each document contains a data record of variables ("Document variables"). When you import a doc-

ument, a record is simultaneously generated - much like during your first visit to a new doctor. If at 
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the time of import a data record containing variables is generated, firstly only certain internal 

MAXQDA variables will be saved. 

To view these internal variables (“System Fields"), click Overview of Variables in the context menu 

of the document. Here, you can see the date, time, and user name (author), among other information. 

In the Number of Coded Segments and Number of Memos columns, MAXQDA will display the 

existing coded segments and memos for this document. 

 

“Overview of variables” for a newly imported document 

This information will appear as a tooltip if you hover the mouse over a document name in the Docu-

ment System and wait a moment. 

4.4 External Files  

In general, all documents will be imported into the MAXQDA project file, meaning the original file 

remains in place. You can modify or delete the original file without affecting the imported document 

in MAXQDA. This concept holds a great advantage over other QDA software, in which the primary 

files are constantly at risk of being modified “from the outside.” 

Since MAXQDA 10, it has been possible for you to connect audio or video files to their transcriptions 

and import PDF and image files, which means that the “one project = one file” concept is not always 

optimal. If you were working with many audio/video, image, or PDF files, for example, your project 

file would quickly become very large, which would slow down processes in MAXQDA and make it 

almost impossible to move the file, either online or on a DVD. 

For this reason, versions from MAXQDA 10 onwards do not save imported PDF and image files that 

are larger than a certain size (default 5 MB) in the project file. Instead they are saved in an external 

folder. You won’t notice any difference in the way you work with the documents in MAXQDA; the 

icons in the “Document Browser” look just like they would if the documents were saved in the project 

file. 

The default maximum size for PDFs and image files can be changed under Options in the Project 

drop-down menu. You can also set the location where external files are to be saved. If you do not 

change it, the default location for all external files will be as follows: 

 for portable license installations: [installed folder]\MAXQDA_Externals 

 for Windows normal license installations: [My documents]\MAXQDA_Externals 

 for Mac normal license installations: [My documents]\MAXQDA\Externals 
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Note: All your external documents will be saved in a global external folder. If you wish to save exter-

nals in a project-specific folder, you should create a folder for the designated project. However, it can 

be useful to work with a global external folder from which external files can be accessed by multiple 

MAXQDA project files. For this reason, when you delete a document, the associated media file will 

not be deleted (without prompting), as the file could still be linked to other documents. 

What actually happens when a PDF or image file larger than the set maximum size is im-

ported into the “Document System”? 

1. The document is added to the list in the “Document System” just as it would be if it were a smaller 

file. 

2. The document is visualized with the PDF or image icon as is the case with smaller files. 

3. The document is copied into the “MAXQDA_Externals” folder unless you have chosen to have 

external files saved elsewhere. The original document remains in its original location. 

It is import to remember that unless you change the default folder for external files, this folder will 

hold externals for all projects. You will only have a separate folder for the externals of a certain project 

if you change the external folder in the Preferences … window. It often makes sense to use the 

same folder for all of your projects, so that several projects can access the same external file. It is for 

this reason that audio/video files are not deleted from the external files folder automatically when the 

linked document is deleted; this audio/video file could also be linked to other documents. 

What happens to a document in the “Document System” when it is linked to a media (au-

dio/video) file? 

1. The location of the original file is saved in the Properties menu of the document. 

2. The original media file is never saved as part of MAXQDA project file, even if it is smaller than the 

maximum file size. 

3. The media file is copied into the “MAXQDA_Externals” folder or whatever folder you have chosen 

for this purpose. The original document remains in its original location. 

4. When importing a text file with timestamps, MAXQDA also looks through the file for timestamps, 

creates a List of timestamps synchronizes the text with the audio/video file. 

Which file is actually used – the original or the copy? 

MAXQDA always looks for the original first – it looks for the file based on the path that is saved in 

the properties menu of the document. If the original is not found, the copy of the file in the external 

files folder is used. This file is then loaded. In other words, the original file can be moved or deleted 

without it affecting the proper functioning of MAXQDA. 

Be careful when using the same file name for different files! 

It is possible to import several documents with the same name into the “Document System” (e.g. 

three files named “Interview 1”). This is only a problem if the file is larger than the set maximum and 

must be saved in the external files folder. When the most recently imported file is saved, it automat-

ically replaces the older file with the same exact name. 
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What happens when you change the external files folder for a project that already has ex-

ternal files saved in the default external files folder? 

In this case, MAXQDA will ask you if you would like to move the documents from the previous location 

to the new external files folder. The documents are only moved once you confirm this. Since this 

action changes the global setting for all projects, all files are moved from the former external files 

folder to the new. 

What happens if a project with external files is passed on to a different computer/MAXQDA 

installation? 

To share the project with team members and colleagues, including the external files, follow these 

steps 

1. Send the MAXQDA (MX12) project file. 

2. Bundle all external files with the appropriate function in the Project drop-down menu. MAXQDA 

then compresses all external files associated with the current project into a Zip archive, which is 

named after your project (e.g. “Projectname.mx12.zip”) and saved in the same place as your pro-

ject file. 

3. Send this newly created Zip file. 

Procedure on receiving end: 

1. Open the MX12 project file. 

2. Choose Unpack bundle files from the Project drop-down menu and select the Zip archive in 

the Windows dialog box that appears. MAXQDA then unpacks the archive and moves the linked 

files to your external files folder. 

If a document is linked to an audio or video file, the original location of the audio/video file will be 

listed in the document properties. If a document with this name isn’t found in the appropriate folder, 

the copy in the external files folder will be used. 

Careful! The location settings for your external files (Windows: Project > Preferences …; Mac: 

MAXQDA 12 > Preferences …) are global, meaning for all of your projects. You can also select 

project-specific locations, but this requires great discipline when working. In this case, select a specific 

external folder at the beginning, when you create the project. This location will consequently be used 

for all projects, meaning when you open other projects you must first re-select the applicable location. 
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Global options for MAXQDA 

4.5 Objects Embedded in Text 

MAXQDA for Windows supports Windows OLE (Object Linking and Embedding), which means that 

audio file, PowerPoint slides, hyperlinks, and video files can be embedded in an RTF or DOC/X file. 

The connection between the text document and these objects remains in effect even after import 

into MAXQDA. 

There are two ways to deal with these embedded objects, which will be explained with the example 

of a PowerPoint slide. 

The first variation works as follows: 

Highlight a PowerPoint slide (e.g. from the sort view) and copy it into the Windows clipboard. You 

can then paste it into a MAXQDA document by pressing Ctrl+V; the slide can then be viewed in the 

document in the “Document Browser.” By double-clicking on the slide, you will open it in PowerPoint, 

where you have the option of editing the slide. You can also code the slide, but MAXQDA handles it 

as a single object, so lines of text in the slide cannot be coded separately. Depending on the type and 

size of the object, it may take up quite a bit of memory to code it, so only code such objects if it is 

important for your analysis. 
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Second variation: 

Here there is only a link created for the embedded objection. These work like hyperlinks in a web 

browser; you will be able to tell that a link exists, because the text will be blue and underlined. By 

hovering the mouse over the link, you can see the name of file linked to that spot. Clicking on the 

link opens the file in the appropriate program, assuming that program is installed on the program 

you are working with (e.g. PPT files are opened in PowerPoint, audio files in a media player, etc.). The 

program that will be opened depends on the computer’s settings. 

With the second variation, it makes absolutely no difference how big the linked file is. With the first 

variation, though, it is important to be aware of the object size, so the project file doesn’t become 

too large. MAXQDA is first and foremost designed for analyzing text documents, so it is not recom-

mended that you use it as a photo archive or as a multimedia program. 

4.6 Hyperlinks Embedded in Texts 

Thanks to the expansion of the Internet, everyone knows what a link and what happens when you 

click on one. Documents imported into MAXQDA can also have hyperlinks in them. Clicking on the 

link in MAXQDA brings up the webpage or HTML file in the default browser. 

Hyperlinks are always made up of two parts: the visualization (whether it be a button, picture, or text) 

and the URL, which is the information about the location of the file, which may be a WWW address. 

By hovering over the link, you can see the location/URL in the tooltip that appears. Usually, this is not 

otherwise visible. 

 

Hyperlink in a text 

Note: When you enter an Internet address in a text in MAXQDA, it will automatically transform into 

a clickable hyperlink when you close Edit Mode. 

If you want to work in MAXQDA with pictures or other objects that require a lot of memory, it is 

recommended that you don’t import the pictures into the project file, but just link to them. The links 

can still be coded and called up in the “Retrieved Segments” window, but they don’t affect the size 

of the project file. Since MAXQDA 10, it has been possible to import pictures into the “Document 

System” and save them either in the project file or externally as external files. Limits for the file size 

of imported objects are set under Projects > Options. 



Opening and Editing Documents 60 

4.7 Opening and Editing Documents 

To view and edit a document, it must be open. MAXQDA will automatically open the most recently 

imported document. To open a specific document in MAXQDA, you can: 

 double-click on the document in the “Document System,” or 

 right-click on the document in the “Document System” and choose Open document. 

The document is then opened in the “Document Browser,” and the icon next to the name of the 

document in the “Document System” changes from a sheet of paper to a sheet of paper with a pencil 

on it. 

 

Symbol in the “Document System” for a document open in the “Document Browser” 

You can now begin to work with the document in the “Document Browser.” You can code document 

or picture segments, attach memos, link segments, insert external links, edit text, or add new text. 

There are two different modes for working on a document: 

 ”Code Mode” – allows you to code segments of texts or images, create internal or external links, 

and write memos. 

 ”Edit Mode” – allows you to edit text in documents imported from RTF or DOC/X format as well 

as table documents. You can type new content, fix typos, and delete text. 

Code Mode is active by default when a document is opened in the “Document Browser.” Click the 

Edit Mode button in the Document Browser toolbar to switch to Edit Mode. In Edit mode, the usual 

formatting functions such as selection of font color and size are available. 

 

Button for turning Edit Mode on and off 

Note: Documents that are opened in Edit mode are automatically cached on demand. You can set 

the time interval under Project > Preferences (Windows) or MAXQDA12 > Preferences (Mac) (by 

default, the open document will be saved every 5 minutes). The edited text will be saved automatically 

when you switch back to coding mode or close MAXQDA. 
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Set interval at which project will be automatically saved in Edit Mode. 

When working in Edit Mode, you have the option to undo actions. The Undo function operates in 

the same manner as in Word. You can undo actions such as, for example, deleting a text passage or 

adding a new one. To undo an action, either right-click on the context menu in the “Document 

Browser” and select Undo text changes or click “Edit” in the MAXQDA main menu and select Undo 

text changes. 

Alternatively – so long as you are working in Edit Mode – you can click the  symbol in the Edit 

Mode toolbar. 

You can reverse your actions one by one using the Undo function. Alternatively, you can select the 

option Undo all text changes to reverse all changes since the last time Edit Mode was activated. 

Important: The undo function is only available when you are working in Edit Mode. As soon as you 

go back to Code Mode or open another document, all changes that you have made in the current 

document are saved and can’t be undone. The deletion of a coding in Edit Mode cannot be reversed. 

4.8 Opening two documents simultaneously 

MAXQDA 12 offers the possibility of opening two documents simultaneously, each in in a separate 

document browser. This is helpful notably for conducting literature reviews: Open a publication as a 

PDF in one window and code thematically, directly from the document. You can simultaneously open 

and code a text document in which you have made your notes in the second window. 

To open a document in its own document browser, right-click on the document in the “Document 

System” and select and select the option Open document in second Document Browser. The 

second document browser will open and display the selected document. The second document 

browser is particularly helpful if you work with a wide monitor or with two monitors. 
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Opening a document in the second Document Browser 

What are the rules for working with the second document browser? The following functionalities will 

make your work easier: 

Document Links 

• When you click on a document link within a document, it will open in a second document 

browser, while the original document or section remains displayed. This allows you to view both 

linked document sections at the same time. 

Coding and Coding Stripes 

• The drop-down “Code” toolbar is always displayed in the first document browser. The second 

document browser will display its own Code toolbar. 
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Code toolbar in the second document browser 

• If the same document is displayed in both the document browsers, newly added codes are dis-

played immediately in both browsers after they are created; the display is thus synchronized. 

• The filter settings for the displayed coding stripes are saved separately for each document 

browser. In this way, you can display, for example, only red coding stripes in one document 

browser, and only coding stripes by a specific author in the other document browser. Once you 

close the second document browser, the selection of the coding stripes is reset: that is, the next 

time you open the second document browser, all coding stripes will be turned on and visible (of 

course, only if they were created while coding the document.) 

Jump from segments to the “Retrieved Segments” and “Overview of Coded Segments” 

• Clicking on the source data in the "Retrieved segments" window always brings up the selected 

segment in the standard document browser, not in the new second document browser. The same 

is true for browsing the segments in the "Overview of Coded Segments". 

Editing documents 

• In the second document browser, you can switch to edit mode at any time by clicking the  

button, to make changes to the document. Please note that only one of the two open documents 

can be in Edit mode at a time. 

Note: If the same document is open in both MAXQDA document browsers, it is not possible to edit 

the document. 

4.9 Opening Documents in Tabs 

MAXQDA includes the option of opening more than one document in the “Document Browser” at 

once, each opened in a separate tab. This allows you to switch quickly back and forth between doc-

uments. Once you have opened documents in tabs, you can switch to any of them by clicking on the 

appropriate tab at the top of the “Document Browser.” Documents can be opened in tabs by holding 

the Shift key and double-clicking on the document or by right-clicking on the document and selecting 

Open in a new tab. 
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Once a document has been opened in this way, tabs will appear at the top of the “Document 

Browser” with the names of each of the documents open. You can switch between the documents 

by clicking once on the appropriate tab. The tabs can be closed individually. 

If tabs are already open, a document opened in the normal fashion from the “Document System” 

will appear in the currently selected tab in the “Document Browser.” 

Tip: To open all documents in a document group in Tabs, drag the document group into the Docu-

ment Browser with the left mouse button, then release. 

4.10 Renaming and Deleting Documents 

Document groups, document sets, and individual documents can be renamed at any point. Simply 

right-click on any of these objects and select the appropriate entry from the context menu. It is not 

recommended that you have more than one document with the same name. It is possible, but it can 

be very confusing. 

Right-clicking on documents opens the context menu, giving you the option Delete document, 

which also deletes the coded segments, memos, and links associated with it. In the context menu for 

a document group, you also have the Delete document group option, which deletes all the docu-

ments in a group in one single action. 

Note: An unintentional deletion cannot be undone. For this reason, you should always back up your 

data on a regular basis. 

4.11 Moving and Sorting Documents 

You can change the order of the documents in the “Document System” as desired. To do so, click 

and drag the document into the desired position. To change the order of multiple documents at the 

same time, click on the selected documents while holding down the Ctrl key to activate them. Next, 

right-click on the document group and select Move activated documents here. 
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Move all activated documents at once to a document group 

To sort documents in a document group, right-click on the document group and select Sort docu-

ments. There are two options with the same text, but the icons next to them are different. The first 

indicates that the sorting will be done alphabetically (A to Z), and the second indicates the sorting will 

be done in reverse alphabetical order (Z to A). 

To sort the document groups by name, simply right-click on the word Documents at the top of your 

“Document System” and select the appropriate Sort document groups option. 

Tip: Researchers often work with document names that include numbers (e.g. Interview 1, Interview 

2, etc.). If you are going to have more than 10 documents, it is recommended that you make each 

single digit number into a two-digit number (Interview 01, Interview 02, etc.). When sorting the doc-

uments, you will then have them in the correct order. Otherwise Interview 20 would come before 

Interview 3. If you are working with more than 100 documents, all numbers should be written with 

three digits (e.g. Interview 001, Interview 002, etc.). 

4.12 Creating a New Document in MAXQDA  

To create a new document without the help of a word processor, you should start by deciding where 

you want the document to be placed. You can then right-click on the document group where you 

want the document to be created and select Create document. Alternatively, you can call up this 

function from the menu Documents > Create document. 
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Creating a new document via the context menu of a document group 

The following dialog window will appear. Click OK to confirm. The option “Text document” is set by 

default. 

 

Creating a text document in MAXQDA 

MAXQDA will automatically assign the document a name in the form of “Document nn,” where nn 

is a consecutive number. Of course you can change the name later on. After creating a new docu-

ment, it is automatically opened in the “Document Browser” and put in Edit Mode, so you can start 

to type or paste text from another program into it. 

There is no need to save your new document. As is the case when editing an imported document, 

everything is saved in the new document once you leave Edit Mode, view a different document in the 

“Document Browser,” or close MAXQDA. 

Tip: Use the keyboard shortcut Ctrl+T (Windows) or cmd+T (Mac) to create a new text, which will 

be added to the currently selected level in the "Document System". 
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4.13 Assigning Colors to Documents  

You have the option of assigning a color to each of your documents. This color is then used in all 

tables and visualizations, including in MAXMaps. 

To assign a color, right-click on the document and select Color from the context menu that appears. 

A dialog window appears which lists the colors used in the project. Standard colors, (i.e. for color 

coding) are indicated by name (here "GREEN"). 

 

Selecting a color 

There is an almost endless number of colors that you can pick from for your documents, and you can 

theoretically mix your own by entering values into the fields on the right side of the window, although 

it makes sense to limit the number of colors you use in a single project. 

The document colors are usually listed in the first column of tables in MAXQDA, which means you 

can then use them as sort criteria. By clicking on the column header, you will sort that column, group-

ing together those documents with the same assigned color. 

4.14 Creating Document Sets  

MAXQDA makes it possible for you to create and save a temporary grouping of documents. While 

each document can only be in one document group, it can be in as many document sets as you wish, 

because document sets are only made up of shortcuts to the documents. In other words, a document 

set can be deleted without it having any effect on the document. If that same document were deleted 

from a document group, however, it would be deleted from the project along with all of its memos, 

coded segments, links, etc. 
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Document sets are created via activation. You can activate a document by right-clicking on it and 

selecting Activate from the context menu. You can tell that a document has been activated, because 

it turns red and a red arrow appears just to the left of the document icon. 

Tip: For quick, easy activation, hold the down Ctrl key (Windows) or cmd key (Mac) and left-click on 

the selected documents. In this way, you can also activate an entire document set. 

After activating all the documents that you want to create a set out of, you can create that set as 

follows: 

1. Right-click on the word Document sets at the bottom of the “Document System.” 

2. Select New set. 

MAXQDA then creates a new set with the name “Set 1” and adds all activated documents to this 

set. You can click on the name with the right mouse button and choose another that is more appro-

priate. Document sets are manipulated like document groups; you can activate all the documents in 

a document set at the same time and use all the options for working with document groups (Codes, 

Memos, Variables, Links, etc.). 

Modify Document Sets at a later time 

Individual documents can be deleted from a document set or placed in another document set; the 

easiest way is by using the drag-and-drop function. 

Tip: You can drag a document into a set at any time. Drop the document into the desired set and 

MAXQDA will insert it directly at the top of the set. 

When you want to analyze a certain selection of documents, using a document set is a very practical 

method, allowing you to avoid a more complicated selection procedure. Forming a document set is 

also an easy way to save the result of a complex variable activation process. 

4.15 Inserting Line Numbers in a Text Document 

In some cases, you may wish to analyze documents based on line number rather than paragraphs. 

There is a MAXQDA function that allows you to set the number of characters that should make up 

each line, which will then be treated as a paragraph. To do so, open the document in the “Document 

Browser” and switch to Edit Mode. Then right-click in the document and select Convert to line 

numbered text. You can then enter the number of characters that should make up each line (nor-

mally a range of 50-70 characters is appropriate). This option is only available for text documents that 

do not contain photos, tables, or external links. 

The result of the procedure is a line-numbered text with a fixed number of characters per line and 

the insertion of a paragraph mark at the end of the line. 

Careful: This action can only be undone while you are in Edit Mode. Once you have left Edit Mode, 

opened a different document in the “Document Browser,” or closed MAXQDA, the changes are 

automatically saved and irreversible. 
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4.16 The Document Properties Window  

If you right-click on a document in the “Document System” and select Properties, the following 

window will appear, which lets you view and change certain settings for that document: 

 

Document properties window 

Read-only – if this box is checked, the document will no longer be editable, even in Edit Mode. This 

is the default setting for PDFs. 

External Document – If this box is checked, it means that the document is not actually part of the 

MAXQDA project file. Instead it has been copied into the folder for externally-linked files. In this case, 

the file name is also indicated under Original Path. 

Media file – If you want to link a document to an audio or video file, you can insert the path to that 

document in this field. To do so, click on the line, then the button with the three dots at the end of 

the line… 

External link 1/2/3 – Click in this field to link to another document that can be accessed on your 

computer and has pertinent information, for example, about the interviewee or the project in general. 

4.17 MAXQDA supports Unicode: Analyzing texts in different 

languages 

The fact that MAXQDA supports Unicode makes it possible not only to import and analyze documents 

in any script, from Japanese to Cyrillic to Arabic), but also to create codes and variables in these 

languages. This Unicode functionality is available in every MAXQDA function 

Unicode is an international standard with the goal of standardizing all known languages and charac-

ters. This makes it possible to work with various languages in the same document. One sentence can 

be in English, the next in Mandarin, and the next in Arabic. This is possible because Unicode (unlike 
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more common computer character systems like ASCII or ISO Latin) can deal with more than 128 or 

256 different characters. In MAXQDA, even codes and variable names can be created with “foreign” 

characters, and searches and in-vivo coding are possible with any language. 

4.18 Notes on PDF Documents 

PDF documents, like normal text documents, can be imported into a MAXQDA project and coded. 

However, there are some special considerations when working with PDF documents, as the PDF for-

mat was not conceived for text editing but rather as a layout format for printing: 

Saving PDF files outside the MAXQDA project file 

By default, all PDF files smaller than 5 MB will be saved in the project file upon insertion. PDF files 

larger than 5 MB are not saved in the MAXQDA project itself, but rather in the folder for externally 

saved files, and generate only a reference to the the externally saved data. You can customize the 

maximum file size as well as the location for externally saved files under Project > Preferences … 

(Windows) or MAXQDA 12 > Preferences … (Mac). 

Tip: If you are working with many large PDF files (e.g. with a total size of more than 1 GB), it makes 

sense to store them externally so that the MAXQDA file remains small and can be easily secured. For 

optimal performance it is recommended that externally saved files be located on the local hard disk 

and if possible not on a network, although the acceleration of network speeds mean that this poses 

less and less of a problem. 

Text and image segments in PDF documents can be coded with the mouse. Select and create a frame 

around the desired segments to subsequently code them. MAXQDA does not distinguish between 

text and image encodings in regards to code frequency; however in the Coding Query when searching 

for overlap, the query will search independently for overlap/intersection in text and image documents. 

Overlap between text segments and image segments will be ignored. The “Near” function for image 

segments always returns a result of 0, both in the Complex Coding Query and the Code Relations 

Browser. 

If a text is in the format of a scanned PDF file, Optical Character Recognition or OCR, a text recognition 

process, must carried out beforehand. This process makes it possible to mark and code the text, 

otherwise it would be possible only to mark images. 

Multipage Coding 

Beginning in MAXQDA 12, it is now possible to code text and image segments which fall over multiple 

pages, without dividing them. If the project is transferred to MAXQDA 11, the segments will once 

again be divided and the number of coded segments may increase. 

Absence of paragraphs in PDF files 

PDF documents, unlike text documents, have no paragraph structure per se. MAXQDA functions that 

rely on the paragraph structure can therefore not be used in PDF documents. These functions include, 
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among others, automatic coding with the parameters “Sentence” or “Paragraph”, as well as the 

“Near” function for segments in the Complex Coding Query and Code Matrix Browser. 

Navigating the Document Browser 

As soon as a PDF document is displayed in the Document Browser, several clickable icons will appear 

in the toolbar. You can flip forward and backward, adjust the zoom and use the bookmarks for 

navigation (many PDF files have several bookmarks, e.g. one per chapter). 

Tip: If you want to display a PDF in MAXQDA that contains data in form fields, you should print your 

document into a new PDF before importing it. Otherwise it may happen, that the data inside the form 

fields is not displayed. 

4.19 Notes on Image Documents 

Image documents can be imported and coded in a MAXQDA project, as with normal text documents. 

There are, however, certain special considerations when working with images: 

Saving Image Documents outside of the MAXQDA project 

Normally all image documents of less than 5 MB are saved directly in the MAXQDA project. Image 

documents larger than 5 MB are not saved directly in the project, but rather in the folder for external 

files, and only a reference referring to the externally saved file is generated. You can customize the 

maximum file size as well as the location for externally saved files under Project > Preferences … 

(Windows) or MAXQDA 12 > Preferences … (Mac). 

Tip: If you are working with many large image files (e.g. with a total size of more than 1 GB), it makes 

sense to store them externally so that the MAXQDA file remains small and can be easily secured. For 

optimal performance it is recommended that externally saved files be located on the local hard disk 

and if possible not on a network, although the acceleration of network speeds mean that this poses 

less and less of a problem. 

Coding Image Segments 

In image documents, borders can be drawn around the selected area with the mouse which can be 

subsequently coded like text segments, meaning they can be dragged and dropped into a code. With 

the Complex Coding Query and Code Relations Browser, the “Near” function for image segments 

always returns a result of 0. 

Rotating and Zooming Images 

As soon as an image document is displayed in the „Document Browser“, several icons for viewing 

the image will appear in the toolbar. You can zoom in or out of the image as well as rotate it clockwise 

(images imported from digital cameras and mobile phones should, as a rule, rotate to the right, pro-

vided the correct information has been saved in the image.) 
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4.20 Notes on Table Documents 

Importing Table Documents 

MAXQDA makes it possible to insert and analyze files in XLS or XLSX format, to code the data and 

attach memos. As with other file types (DOC, DOCX, PDF etc.), you can import table documents in 

the following ways: 

 Drag & Drop the file from Windows Explorer or Mac Finder into the “Document System,” 

 with the menu function Documents > Import Document, 

 with the Import Document(s)  button in the “Document System.” 

What happens when a table document is inserted into a MAXQDA project? 

 The first worksheet in the Excel workbook will be imported. 

 Hidden columns in Excel will also be imported. 

 The columns are numbered according to their order, whereby the contents of the first row will be 

used as the column header. 

 The row order will remain the same when imported. 

 The font will be conformed. 

 

Imported table document in the “Document Browser" 

Table documents are indicated in the “Document System” with a  symbol. 
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Creating Table Documents 

From the menu function Documents > Create document, you can create a new table directly in 

MAXQDA and select the number of columns and rows. 

 

Select the number of columns and rows when creating a new table document 

Note: Once a table is created, new columns cannot be added or deleted at a later time. 

The Table View in the “Document Browser”  

Table documents in MAXQDA will be automatically formatted. It is not possible to modify the text 

format. 

You can zoom in to the table using the zoom icon in the “Document Browser” toolbar. The font will 

appear accordingly larger or smaller. The height of the rows will be automatically set to the height of 

the largest cell. 

Notes on the Columns 

Columns will be numbered according to their order in the Excel table when imported. The column 

number appears at the beginning of each column header and cannot be modified after the import. 

The column numbers for coded segments, memos and references are assigned as page numbers, so 

there is no risk of ambiguity. 

When the table document is imported, the first row of the imported document will become the 

column header. This column header can be modified by right-clicking on the column and selecting 

Edit: 
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Modify column header 

When you import a table each column will be assigned a type automatically: 

 Text 

 Numeric 

 Date/Time 

To change a column type, open the drop-down menu “Type.” 

Note: It is not possible to modify the column type if the column contains coded segments. 

The column widths and column positions can be modified using Drag & Drop. Like overview tables, 

table documents in MAXQDA can be sorted by clicking the column header. The original order can 

always be restored by right-clicking on the column header and selecting Reset sorting. Alternatively, 

you can click on the empty column header just above the row number. 

 

Modify table view 

You can access the following options by right-clicking on the column header: 
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Context menu of a column header 

Hide – hides the column. 

Edit – allows the modification of column name and column type. 

Select fields – opens a window in which the columns to be displayed can be selected. 

Reset Sorting – restores original order after import. 

Notes on Table Rows 

The row numbers are fixed when the table is imported into MAXQDA, and cannot be modified. 

A row in the table corresponds to exactly one paragraph. Within a cell, there is no differentiation 

between paragraphs. 

Edit Table Documents 

The contents of individual cells can be modified. In order to do so, click on the Edit mode on/off  

button in the toolbar of the “Document Browser”. 

Tip: To insert a paragraph within a cell, hold down the Alt key and press Return. 

The Windows clipboard can also be used with table documents. To copy the contents of an activated 

cell onto the clipboard, right-click on the cell or press Ctrl+C. In Edit mode, you can paste the contents 

from the clipboard into an activated cell by right-clicking the mouse or by pressing Ctrl+V. 

Coding Table Documents 

Any text segment of any cell can be coded. First, double-click on the cell in order to select the con-

tents. The cell will then be outlined in yellow, and you can mark a text segment. All of the usual 

MAXQDA coding options, including color-coding and coding with emoticons, are now available. It is 

not possible to code across multiple cells. 
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Coded text in a cell 

Note: When you hide a column, the corresponding coding stripe in the “Document Browser” will 

also be hidden. 

Notes on Retrieval Functions in Table Documents 

The retrieval options for coded segments in table documents are identical to those for text documents. 

For example, overlap will be handled in the same way as it is with normal text. The retrieval functions 

also include hidden columns and are based on the current configuration of the table. Retrieval func-

tions for a single row correspond to those for a single paragraph. 

The Near function in the Code Relations Browser and Complex Coding Query applies to columns in 

table documents. This means that only the vertical proximity of two codes, and not the horizontal or 

diagonal proximity, will be taken into account, and that coded segments in different columns will 

never be found, when using the Near function. 

Click on the source data in the “Retrieved Segments” to indicate the coded text in the “Document 

Browser” and display the corresponding column. 

Memos in Table Documents 

As with all documents in MAXQDA, you can assign memos to table documents. Memos can be as-

signed to individual cells. There are two ways to assign a memo to a cell: 

1. Double-click in the grey memo field next to the table, or 

2. Right-click on a cell or marked text segment within a cell and select New Memo. 
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Inserting memos into a table document 

When you click on a menu symbol, MAXQDA will indicate to which cell this memo is assigned. 

Note: When a column is hidden, the memos assigned to the cells in this column will also be hidden. 

Table Documents and Visual Tools 

In principle, hidden columns in table documents will be taken into account when using Visual Tools. 

Code Matrix Browser functions as with any other type of document, as only the number of coded 

segments for a particular code will be analyzed. 

Code Relations Browser functions as with overlapping in normal text. Overlap can only occur within 

a particular cell. The “Near” function will search only for coded segments in the same column. 

Codeline Each row represents a paragraph in the Codeline - the column structure is ignored in this 

case. Hidden columns will be taken into account. Paragraphs will be sorted in their original order. 

Document Comparison Chart As with the Codeline, each row in the table represents a paragraph 

- the column structure is ignored. Hidden columns will be taken into account. Paragraphs will be 

sorted in their original order. 

Document Portrait This tool operates differently than with regular documents. Columns will be 

more or less ignored; cells will be processed from left to right, then top to bottom. A one-dimensional 

structure is then created, which is displayed as usual in the Document Portrait. 

Exporting Table Documents 

Table documents cannot be printed directly from MAXQDA; they can however be exported in Excel 

format. Click the Export Displayed Document button  in the Document Browser or select Project 

> Print > Displayed Document from the main menu. Alternatively, you can right-click on the docu-

ment in the “Document System” and select Export. 
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4.21 Converting a Text Document into a Table Document  

It is possible to automatically convert a text document into a table document. To do so, double-click 

on the selected text document in the “Document System” to open it, then choose Documents > 

Insert displayed text as a table document from the menu. A menu will appear in which you can 

select the number of columns. 

 

Select the number of columns for the table 

Note: The original text remains after the conversion 

A new table document will appear in the “Document System,” which can be recognized by the  

symbol, and has the same name as the original document. Each paragraph of the original text is 

placed in an individual row of the table. If the table contains more than one column, the text will be 

placed only in the first column. 

 

The original text is placed only in the first column. 

As shown in this image, original text can be easily paraphrased or summarized using this function. By 

switching into Edit Mode you can fill the empty columns of the new table with the corresponding 

summaries. 
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5 Importing Structured Documents  

5.1 What are Structured Documents? 

Often you may wish to import documents that are structured and pre-coded. Examples for this kind 

of document include: 

 Forms – in this case, text passages should be pre-coded according to the heading field of the form. 

 Answers to open-ended questions in survey research – here you may wish to code the answers 

with a question number or an abbreviation of the question. 

 Results from database retrievals, such as a list of references, should be pre-coded with author, 

title, abstract, etc. 

It is often clear even before you start your analysis that certain sections of text are going to pertain to 

a certain subject. So, to save the work of manually coding them, you can have them automatically 

coded during the import process. 

As an example of this type of document, consider the answers to open-ended questions in question-

naires. Unlike narrative interviews, a document of this kind does not contain thirty or fifty pages but 

rather only a few lines, perhaps 10 to 15. Often there will be a large number of documents, maybe a 

few hundred or more. Another characteristic of such a document is that it is pre-structured: certain 

answers correspond to certain questions. The normal method of transcription and import into 

MAXQDA would make importing the documents a very time-consuming job. Every questionnaire 

would have to be transcribed with a word processing program and saved as a separate file. Attaching 

a question to its answer as a code to its corresponding text passage would not be possible when 

importing the text. 

Also when working with focus groups, it saves a lot of time to code the text passages with their 

speakers before importing the text into MAXQDA. The MAXQDA Preprocessor offers a solution for 

this type of data. 

There are three options for coding during import: you can use the Preprocessor, the Excel table import 

option or you can import bibliographical data in RIS format. 

5.2 Importing Structured Documents with the Preprocessor  

The Preprocessor allows you to enter a large number of documents into a single file and have them 

separated out into different documents when imported into MAXQDA. The syntax rules are as fol-

lows: 
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#TEXTtextname 

this is the content of the 1st text 

... 

#TEXTtextname 

this is the content of the 2nd text 

... 

#TEXTtextname 

... 

Formatting documents for the Preprocessor 

Every document must start with the “#TEXT” without a space between “#” and “TEXT,” and “TEXT” 

must be written in capital letters. 

The name that you want to give to the document should come immediately after the “#TEXT” with-

out a space in between. If you do not enter a name, MAXQDA will automatically assign one when 

the document is imported. The first imported document will be called “Document nn,” and the fol-

lowing documents will be named in sequential order in the “Document System.” This automatic 

numbering is useful when, for example, you enter the answers to open questions in a partly stand-

ardized survey. The answers must then simply be entered in the order of the standardized data in the 

SPSS file. It is not necessary to enter a name for each text. Both texts will have the same name. 

Document names are handled by MAXQDA as follows. You can enter any kind of string (up to 63 

characters) as a document name – spaces are also allowed. If you enter a document name with more 

than 63 characters, MAXQDA will truncate it automatically. Once the document has been imported 

into MAXQDA, you can change the name to include up to 64 characters. 

An Example 

In the example project, various interviewees were asked about their level of satisfaction with various 

aspects of their life. Their answers were transcribed and imported as Word documents. 

The resulting Word file appears as follows:  

#TEXT 4(26,f,0k,sin) 

I've gained too much weight over the last several years and I don't seem to be doing anything to get 

rid of it. I have high cholesterol levels, but I don't attempt to change my eating habits. I'd like to jolt 

myself into becoming more physically active, so I can lose the weight and feel more energetic. I keep 

saying I'm going to do something about it, soon. 

 

#TEXT 3(34,f,2k,mar) 

Overall I am pretty happy with my mental, social and physical health. I would like to improve my dedi-

cation to working out. I am the type of person who will work out 5 times a week for a month straight 

and then is slowly turns into less days a week until it is none. I get distracted by school work, my job or 

just being tired. 

 

… 

Excerpt of the Word file 
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After each #TEXT entry is the name being given to the document. For the purposes of this project, it 

made sense to assign a number for each of the interviewees in addition to some basic information 

about that person, including age, gender, number of kids, and marriage status. 

The Word file was then saved with the name “HealthSatisfaction” in RTF or DOC/X format. It could 

then be imported by using the menu option Documents > Import structured document (Prepro-

cessor). This option can also be accessed from the top level of the “Document System” window. 

Tip: MAXQDA automatically creates a new document group in the „Document System“ during im-

port and inserts all texts into this document group. 

All texts will appear in the “Document System” after being successfully imported. The documents are 

named as previously specified followed by #TEXT as an identifying agent. In the above example, the 

document name consists only of a text number and the personal data indicated in parentheses. 

 

Documents after being imported with the Preprocessor 

Pre-Coding text segments during import 

The document is then imported, separating out each individual document and assigning the given 

name for each in the “Document System” from the original RTF document. 

In this way, it is possible to very quickly import and separate out many different documents formerly 

contained in a single file. The Preprocessor is able to do significantly more than this simple action, 

however. In many cases, you will already be able to code aspects of the document, and the Prepro-

cessor can do that automatically during the import. To do so, you simply need to use additional syntax 

words. 

For each section of the document that is to be coded, you simply need to type “#CODE” before and 

“#ENDCODE” after. In the case of a standardized survey or questionnaire, you could, for example, 

code each answer with the question number that it connects to. The answer to the first question, 

then, could be coded with the code “Question1” as is shown below: 



Importing Structured Documents with the Preprocessor 82 

#TEXTinterviewee1 

#CODEquestion1 

answer to question 1 

#ENDCODE 

#CODEquestion2 

answer to question 2 

#ENDCODE 

 

#TEXTinterviewee 2 

#CODEquestion1 

answer to question 1 

#ENDCODE 

#CODEquestion2 

answer to question 2 

#ENDCODE 

 

… 

Using syntax rules to prepare for import with the Preprocessor 

It is important to remember that there should be no space between “#” and “CODE” and that the 

word is written in capital letters. 

To avoid typos when entering “CODEquestion1,” it is possible to simply use a place holder, such as 

“§1” for the first question, “§2” for the second, etc. You can then later do an automatic search and 

replace, finding all instances of “§” and automatically replacing it with “CODEquestion.” This can 

save you a lot of time in addition to helping you avoid typos. 

It is also possible to define and code with a subcode in a document prepared for the Preprocessor. To 

do so, use the following syntax: 

#CODEcodename\subcodename 

You are giving the complete information about the subcode, including its name and the code it is a 

subcode of. The code and subcode are separated by a “\” symbol, but no spaces. As with any codes 

used in a document imported with the Preprocessor, MAXQDA will first check whether the code 

already exists, and if it does not, it will be created. 

Important: As soon as “#CODE” appears in the text, the new code will be used, automatically ending 

the coded segment of the previous code. 

Text excerpts, as well as full paragraphs, can be pre-coded with the help of the preprocessor during 

import, as shown by the following example: 
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#TEXTtextname 

Here is a text. Encoding begins here with #CODECode 1\Subcode#. In the next sentence it ends with 

#ENDCODE# in the middle 

#CODECode 2 

Here is another text. The encoding ends here #ENDCODE# in the middle of the text.… 

Using keywords to code various text excerpts 

For a preliminary encoding of keywords from various text excerpts, the following rules apply: 

 When the keywords #CODE or #ENDCODE appear alone in a row, it is not necessary to insert # at 

the end. If these keywords appear within a text, or at the end of a line of text, they must be 

enclosed with #. 

 It is not possible to “layer” encodings. When a new #CODE# command comes before an #END-

CODE# command, the previous code is automatically closed. 

Tip: To assign several codes to a text part you can combine the codes with two “&&” characters, e.g. 

#CODEFirst code && Second code && Third code 

Mark participants of a focus group 

If you use the tag #SPEAKER inside a text section, MAXQDA will import the text as a focus group 

transcript and will code the text after the tag with a speaker code. The tag #ENDSPEAKER closes the 

speaker coding. The tag may be inserted within a sentence, but then a # has to be added after the 

name of the speaker. 

#TEXTFocus group 1 

 

#SPEAKERModerator 

A warmly welcome to our session … 

#ENDSPEAKER 

 

#SPEAKERParticipant 1 

#CODETheme 1 

I have the following opinion 

#ENDCODE 

#ENDSPEAKER 

Use of tags for pre coding speaker in focus group documents 

This function is very interesting for exporting data that have been collected online with the tool 

http://www.kernwert.com. 

http://www.kernwert.com/
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5.3 Importing Text from a Table/Spreadsheet (e.g. Answers 

to Open Questions)  

With MAXQDA you can import structured documents from an Excel spreadsheet in XLS/S format, 

during which individual table cells will be automatically coded. In addition, variable values can be 

assigned to the individual texts. This is particularly useful when importing (online) surveys with stand-

ardized and open answers. 

How must the Excel table be structured? 

When imported into MAXQDA, each row of the table becomes a new document, wherein the con-

tents of the cells form the document content and are coded with the respective column header. The 

structure of the Excel table corresponds to the principle of a data matrix of a standardized survey. 

This logic is illustrated in the table below: 

Document Group Document Name Question 1 Question 2 $Variable 

Document Group A Person 1 Answer to question 1 Answer to question 2 Variable value 

Document Group A Person 2 Answer to question 1 Answer to question 2 Variable value 

Document Group B Person 3 Answer to question 1 Answer to question 2 Variable value 

Document Group B Person 4 Answer to question 1 Answer to question 2 Variable value 

Each row of the table contains a case, and the columns "Question 1" and "Question 2" contain the 

respondent’s responses to the respective questions. The column "$Variable” contains additional var-

iable values for each case. Of particular importance are the first two columns "Document group" and 

"Document Name", which assign the individual rows of the table to documents in MAXQDA’s “Doc-

ument System”. 

Note: It is not absolutely necessary to have a column for the “Document Group” as MAXQDA can 

also create a new document group, into which all documents are imported, during the import pro-

cess. However, at least one column is required, which contains the document name. 

Starting the Import 

To import the Excel file, proceed as follows: 

• Select the menu function Documents > Import documents from Excel spreadsheet 

or 

• select the same option from the context menu of the “Document System”. 

Setting Import Options 

After calling up the function, the desired Excel file must be selected from the file dialog box. This 

opens a window where you can enter the settings for the import. 
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Settings for importing documents from an Excel spreadsheet 

The two top settings determine which columns contain the Document Group and the Document 

Name. If the names "Document group" and "Document Name" are used in your table as column 

headings, MAXQDA will automatically select them, but this choice can be changed at any time. 

If you select [Create new document group] for the entry "Document group", MAXQDA will automat-

ically import all documents into a new document group. MAXQDA automatically selects this option, 

if your table doesn’t contain a column with the heading “Document Group”. 

Tip: When importing answers to open questions, it is recommended that you select the ID’s of the 

respondents as a column for the document names. In this way, you can avoid any ambiguity in the 

association of responses to cases, even during the subsequent export of data into statistical software. 

In the middle section you can select the columns to be imported as coded text or as variables. 
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Tip: By default, columns whose heading begins with a "$" will be imported as variables and all other 

columns except the Document Group and Document Name will be imported as coded text. 

If both “Code” and “Variable” are selected, MAXQDA will import the contents of this column as 

both as coded text and as a variable. This may be useful, for example, you do not wish to view the 

variable information of a document each time as a tooltip over a document name or in the Data Editor 

for document variables, but rather view, for example, how old a respondent is and whether he has 

children, directly in the text. 

If neither “Code” nor “Variable” are selected, MAXQDA will ignore the column during the import 

process. 

In the lower section, further options are available: 

Code empty cells: When this option is selected, MAXQDA will import and code cells without content 

as empty paragraphs; these cells would otherwise not be coded. 

You can also decide how MAXQDA should handle documents that were already included in the pro-

ject before the import. MAXQDA considers that a document already exists in the project if the docu-

ment name and document group are identical. 

Import: When this option is selected, existing documents will be included in the import, and therefore 

may appear twice in the respective document group. 

Ignore for import: Select this option if documents that already exist in the project should not be 

taken into account during the import. 

Add text to existing documents: It is also possible to add text to existing documents. For example, 

data from different points in time in a longitudinal study can be added to the original document. 

Existing variable entries in existing documents will be updated. Empty variable values in the Excel table 

are ignored when importing. 

Note: For documents whose name appears repeatedly in a document group, the text will be added 

to the first document of the same name. 

Setting other options for the import of variables 

If you choose to import variables, a second window will open after you click OK. 

Source: By selecting this option, you can again decide which variables will be imported. 

Target: If there is already a document variable with the same name in the project, MAXQDA assigns 

the variable to it automatically and no other choice is available. If there is no variable with the same 

name in the project, you can specify the type of variable. Options include: Boolean (true/false), 

date/time, floating-point number, integer, and text. 

Preview data type: This column displays a preview of how an entry will appear in the appropriate 

column in the data editor. 

A final report window confirms the import of documents from the table and lists how many texts, 

codes, and variables were imported, as well as how many documents may have been ignored during 

the import. 
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Imported Text in MAXQDA 

After importing the table from the example into an empty MAXQDA project, it will appear as follows: 

 

Imported texts in MAXQDA 

When importing, MAXQDA proceeds as follows: 

• Document groups that do not yet exist will be created. 

• The headings of the code columns will run from left to right and will be inserted from top to 

bottom in the code system as new code names, as long as they do not yet exist. All text segments 

from the code columns will be coded with the respective column headings. 

• If a variable does not yet exist, it will be created. Each document will be assigned the variable 

value from the variable column. 

5.4  Importing Bibliographical Data from Endnote, etc.  

MAXQDA allows you to import bibliographical data from reference management software such as 

Endnote, Citavi and Zotero.These programs are used mainly in the scientific fields to manage refer-

ences and create bibliographies in the objective of supporting the creation of scientific texts. Refer-

ence management programs are similar to MAXQDA in that they work with projects and contain 

collected bibliographical information. The units of the project include Title, Author, etc., and may also 

include links to websites and related information. 

MAXQDA is compatible with all reference management programs that can export their databases in 

RIS format, which is the standard format for bibliographical data. RIS format biographical reference 

entries will be subsequently listed one after the other as simple text data. RIS files contain two-letter 

“tags” which are followed by the relevant information. The most important tags include: 
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TY – Type of reference, always marks the beginning of a new entry 

ID – Unique identification number for each entry 

AU – Author 

TI – Title 

PY – Publication date 

ER – Closes entry, always located at end of entry 

A detailed description of all RIS format tags can be found on Wikipedia under http://en.wikipe-

dia.org/wiki/RIS_(file_format). An example of RIS source data is listed below: 

TY  - BOOK 

AU  - McLuhan, Marshall 

AU  - Fiore, Quentin 

TI  - The medium is the message 

PY  - 1967 

CY  - New York 

PB  - Bantam Books 

ER  - 

Calling up the Function 

To import RIS data, select Documents > Import bibliographical data. A dialog window will appear 

which lists only file types ending in RIS or TXT. Select the desired file and click OK. 

Importing and Automatically Pre-Coding Data 

Data is imported in the following steps: 

 A new document group is created, which is named “RIS_” followed by the name of the imported 

file. 

 All bibliographic entries in RIS format are added to the new document group as single documents; 

entries remain in their original order. The imported documents are indicated with a book icon in 

the Document System. 

 The document name appears as follows: <First Author> - <Year> - <ID>. Blank fields may be 

marked with a “?" If there are several authors, only the last and first name of the primary author 

will be included, followed by “et al.” 

 The newly created documents contain the information listed to the right of the tags. The tags 

themselves will not be imported. 

 A new top-level “RIS” code will be created in the Code System. The top-level code contains all RIS 

tags that were used in the import as subcodes (e.g. “TY - Type of Reference"). 

 When imported, all documents will be automatically pre-coded, during which each text segment 

will be coded with the corresponding tag code. 

 A display will appear which indicates the progress of the import. 

http://en.wikipedia.org/wiki/RIS_(file_format)
http://en.wikipedia.org/wiki/RIS_(file_format)
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RIS data after being imported into MAXQDA 

Adapting Selected Information as Variables 

The following variables will be automatically adapted as follows upon import of bibliographical data, 

for each newly created document: 

 RIS_Type (Type of reference) – String 

 RIS_Author (First author) – String 

 RIS_Title (Title) – String 

 RIS_Reference-ID (Identification number) – Integer 

 RIS_Year (Year of publication) – Integer 

These variables are created by the system and cannot be modified by the user. 
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Adapted variable values for each document 

Working with Bibliographical Data in MAXQDA 

After import and automatic pre-coding, a normal text view of the bibliographical data is available in 

MAXQDA. This means that the data can be searched, coded, linked, and edited, and that memos can 

be attached. All Visual Tools and other functions (e.g. Statistics and Graphics) can also be employed. 

Automatic pre-coding makes it is possible to isolate specific document types for analysis, e.g. journal 

articles only or anthology entries only. 

Export Bibliographical Data in RIS-Format 

Bibliographical data in RIS format can be exported from MAXQDA, i.e. for import into a reference 

management program. The export function is located under Project > Export > Bibliographical 

data as RIS file. 

After selecting an export location, all documents in the project that contain bibliographical data (in-

dicated with a book symbol) will be exported as RIS data (UTF-8 coding). 
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6 Import Web Pages with MAXQDA Web Collector 

6.1 Save Web Page with Web Collector 

The MAXQDA Web Collector is an add-on for the Internet browser „Google Chrome“. It allows you 

to save entire websites and import the files as pdf, picture, or text documents into MAXQDA. Among 

other things, this tool is useful to compare websites from various organizations, or to collect and edit 

content from websites for analysis with MAXQDA. 

Install the MAXQDA Web Collector 

In order to work with the MAXQDA Web Collector the installation of the Internet browser “Google 

Chrome” is required. As soon as  “Chrome” is installed on your computer you can start the installa-

tion of the “MAXQDA Web Collector”: 

1. Open „Google Chrome“. 

2. Navigate to the website https://chrome.google.com/webstore/detail/web-collector-for-

maxqda/jclikkcolnhlpnlcecldfigfdeocdgpf, or search the Chrome Web Store for „Web Collector for 

MAXQDA“. 

3. In order to add the add-on to your browser click „+ Add“. 

4. After a successful installation you can see a tiny MAXQDA icon top-right in your browser window: 

 

MAXQDA icon to open the MAXQDA Web Collector in „Google Chrome“ 

If you want to open the Web Collector just click on the MAXQDA icon: 

 

MAXQDA Web Collector 

https://chrome.google.com/webstore/detail/web-collector-for-maxqda/jclikkcolnhlpnlcecldfigfdeocdgpf
https://chrome.google.com/webstore/detail/web-collector-for-maxqda/jclikkcolnhlpnlcecldfigfdeocdgpf
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The Web Collector offers three modes:  

• Entire web pages can be saved. The layout remains optimally maintained. 

• Web pages can be saved in a simplified version. The website will be reduced to text and 

pivotal pictures. 

• Selected segments can be saved in order to transfer only a chosen section of a website. 

Save Entire Web Pages 

If your research is based on the analysis of every visible item of the website it is recommended to safe 

the entire website in order to import it to your MAXQDA project as true to the original as possible. 

For doing that proceed as described below: 

1. Open the website you want to safe in Google Chrome. 

2. When the website is fully loaded open the Web Collector by clicking the tiny MAXQDA icon. 

3. Make sure the tab „Web Page“ is open. 

Note: In case the pictures are not displayed after you switched to the tab “Simplified Web Page” 

and back, please reload the website in the browser. 

4. Assign a name to the document. This name will later be inherited into the MAXQDA project. 

5. If required, you can fill in a text in the “Document Memo” box. This text will later be connected 

to the imported document as a document memo. 

6. Click Collect. 

The MAXQDA Web Collector informs you about the progress and saves the website in the selected 

download folder of your browser. By default, it is the download folder of the logged in user. The web 

page is saved in a format that was specially developed for a further processing in MAXQDA. 

Note: Time for saving can vary depending on the scope and complexity of the website. 

Websites that are saved this way can be imported into MAXQDA as a pdf or picture document. 

Save Simplified Web Pages 

In case the focus of your website analysis lies on text you can safe it as “simplified” website. The 

website will be reduced to text and pivotal pictures which can be compared to the read mode of your 

smartphone. This is particularly useful for big newspapers and magazines. In order to import a “sim-

plified” website proceed as described below: 

1. Open the website you want to import in Google Chrome. 

2. When the website is fully loaded open the Web Collector by clicking the tiny MAXQDA icon. 

Note: Some websites cannot be simplified due to technical reasons. You will be informed if this is 

the case via a message in the Web Collector window. 

3. If required adjust further options such as font type, font size, and margin. This is particularly im-

portant if you want to import the website as a pdf document later.  
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4. Assign a name to the document. This name will later be inherited in the MAXQDA project. 

5. If required, you can fill in a text in the “Document Memo” box. This text will later be connected 

to the imported document as a document memo. 

6. Click Collect. 

The MAXQDA Web Collector informs you about the progress und saves the website in the selected 

download folder of your browser. By default, it is download folder of the logged in user. Websites 

that has been saved this way can be imported into MAXQDA as a pdf or text document. 

Save Certain Segment of a Website 

In case you are only interested in a certain segment of a website there is a possibility to save single 

units of a website. 

1. Highlight the segment you are interested in with your mouse. 

2. Right-click the highlighted segment and choose Collect selection. 

The highlighted segment will be downloaded immediately. It will be saved in your selected download 

folder. 

3. Segments that have been saved this way can be imported into MAXQDA as a pdf or text docu-

ment. 

 

Copyright notice: the MAXQDA Web Collector uses “Single File”, a Chrome extension created by 

Gildas Lormeau. 

6.2 Import Websites into MAXQDA  

After saving the websites in the Web Collector (see Save Web Page with Web Collector) you can 

import them into your MAXQDA project: 

1. Open the MAXQDA project you want to import the saved websites in. 

2. Mark a document group in the “list of documents” in order to import the website in a selected 

document group. 

3. Select Documents > Import web pages from MAXQDA Web Collector in the main menu.  

The following dialog window appears: 

https://github.com/gildas-lormeau/SingleFile
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Dialog window for the import of documents that have been saved with the Web Collector 

4. If you open the dialog for the first time the standard folder for downloads is selected and displayed 

in the top of the box. Every single website located in this folder will be listed in the center of the 

dialog. By clicking the three dots … you can choose any other folder to import saved websites 

from the MAXQDA Web Collector. 

5. Select every website you want to import with the mouse. It will be highlighted green. 

Tip: Double click a row to open the downloaded file in the Internet browser. This allows you to 

check single websites for their content. 

6. Two options are provided at the bottom of the dialog: first, you can select whether websites should 

be imported as pdf or picture documents. Second, you can select whether simplified websites or 

segments should be imported as pdf or text documents. 

In order to start the import, click Import selected files. The time for import can vary depending on 

the scope and format of the selected document. A progress bar informs you about the import pro-

gress of each document. 

In case you selected pdf or picture format and you want to import big files, MAXQDA asks you 

whether you want to import them as externally saved files or in the project (see External Files). 

Note: The main layout will be adopted in the import process. Intentionally, the website’s changed 

print layout won’t be imported. Deviations from the website’s original layout might occur especially 

as far as complex websites are concerned. 
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7 Import Online Surveys from SurveyMonkey 

Which Possibilities does MAXQDA Offer for the Import of SurveyMonkey data?  

With MAXQDA you can import survey data directly from SurveyMonkey into an open MAXQDA pro-

ject in order to analyze the data with all MAXQDA tools. The use of another software such as Excel 

for export and import is no longer required. While importing the data every case of the online survey 

becomes a MAXQDA document. You can code the answers of the open-ended questions automati-

cally with the question text. Additionally, you can transform the standardized information into docu-

ment variables. 

Note: In order to use this MAXQDA tool access to your own SurveyMonkey account is required. Not 

all SurveyMonkey plans allow access to the data by third-party applications like MAXQDA. Please 

check the website of SurveyMonkey, if your plan allows to export data (at present at least a GOLD 

plan is necessary). 

Start the Data Import 

To start the data import, proceed as described below: 

1. Select Documents > Import data from SurveyMonkey in the main menu. 

2. You will be redirected to the login page from SurveyMonkey in your Internet browser. Fill in your 

login data and click Login. 

 

Login page for SurveyMonkey in the Internet browser 

Note: If it is the first time you connect with SurveyMonkey a window might appear asking for free 

access through your firewall. Please confirm that MAXQDA is allowed to contact the Internet. 

Otherwise the import is not possible. 

3. Another SurveyMonkey window opens and you are asked to authorize MAXQDA to get data from 

SurveyMonkey. 

https://www.surveymonkey.com/pricing/details/
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Authorization of SurveyMonkey in your browser window 

Note: MAXQDA uses the connection to SurveyMonkey only for importing the survey data. When 

you close MAXQDA the authorization from SurveyMonkey for MAXQDA is cancelled meaning you 

must reauthorize the import of further data from SurveyMonkey each time you restart MAXQDA. 

Import data 

4. After a successful authorization of SurveyMonkey MAXQDA loads an overview of your surveys and 

displays the dialog below. In this window you can select the survey you want to import: 
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This dialog window allows you to select a survey you want to import  

5. Via the selection at the bottom you can choose whether you want to import every case or a random 

sample of the cases. After doing that click Continue. 

6. A new dialog window appears. Here you can choose on the top which question shall be applied 

as document name. In order to guarantee a unified definition of the documents the case-ID is 

selected by default. In general it is advised to keep this selection. 
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Tweaking the settings for the import 

In the center of the window you can choose the columns to import as coded text or as a variable. 

If you tick both marks MAXQDA imports the content of this column as both, a coded text and a 

variable. This can be useful if you want to read the information of the variable directly in the text 

(e.g. how old a person is or whether she has kids). By doing that you can avoid receiving this 

information only via the tooltip or the data editor of the document variables. 

If you don’t place a tick mark on a column MAXQDA ignores this column for the import. 

The selection at the bottom allows you to set the option Code empty answers. If you mark this 

option, MAXQDA imports and codes cells without content as empty paragraphs. Otherwise empty 

cells would not be coded. 

After clicking OK the data will be imported: 

 A new document group labelled with the name of the survey will be created. 

 Every imported case in this document group will be imported into an own document. 
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 For each question that had been ticked in the column to import as a “code” a new code will be 

created in the “Code System” window 

 The imported documents contain answers to those questions that are selected automatically in the 

column “Code”. The answers are coded automatically with the particular question code. This gives 

you the opportunity to get an overview of every answer of a question just by using the Coding 

Query functions in MAXQDA. 

Note: In case you use a free SurveyMonkey account you can import not more than the first 100 cases. 

 

Data from SurveyMonkey after the MAXQDA import 

Information About the Single Question Types 

The question types from SurveyMonkey are imported into the MAXQDA project as described in the 

following table. You can determine whether an answer will be imported as an automatically coded 

answer to an open-ended question or/and as a document variable in the dialog that is shown before 

starting the import (see above). 

Question type Standard import in MAXQDA 

Multiple Choice 1 variable 

‘Other’ answer: automatically coded text 

Dropdown 1 variable 

‘Other’ answer: automatically coded text 

Star Rating 1 variable 

Matrix/ 

Rating Scale 

1 variable per item 

‘Other’ answer: automatically coded text 

Matrix of Dropdown Menus 1 variable per answer cell 

‘Other’ answer: automatically coded text 

Ranking 1 variable per rank 

Net Promoter® Score 1 variable 
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Slider 1 variable 

Single Textbox Automatically coded text 

Multiple Textboxes Automatically coded text per textbox 

Comment Box Automatically coded text 

Contact information 1 variable per box 

Date/time 1 variable 
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8 Links: Document Links, External Links, Web Links, 

and Geolinks 

8.1 Links in MAXQDA 

MAXQDA distinguishes between four types of links: 

1. Document links represent a connection between two text or image segments (e.g. to show the 

contrast between two interviewees’ responses to the same question, you could link them with 

each other). 

2. External links create a connection between a text or image segment and an external document 

(e.g. a picture, document, audio/video file, etc.) that is not part of the MAXQDA project. 

3. Web links are connections between a text or image segment and a webpage. By clicking on this 

link, you can open the website in your standard browser. 

4. Geolinks create a connection between a text or image segment and a place on the globe. This 

place is based on GPS coordinates and is shown in Google Earth or other similar programs. 

You can create or delete links in MAXQDA’s “Document Browser” or in MAXMaps, the modeling 

add-on that allows you to create visualizations of your data and concepts and show connections 

between them. 

The four types of links are visualized with various symbols in the “Overview of links.” 

8.2 Document Links  

It is possible to link documents or positions in documents with the help of document links. Document 

links are used in the same way as hyperlinks in the Internet; they link two document or positions in 

document together. Clicking a document link causes the corresponding document link to be loaded. 

In MAXQDA, document segments that are in the same document or in different document can be 

linked. To link document, select at least a single character from a document in the “Document 

Browser” – normally a word or more is suitable. 

Document segments are linked as follows: 

1. Select the first document segment (the anchor) and click the Set link start/target in the coding 

toolbar, or choose the option Insert Document link from the context menu. You can also use 

the keyboard shortcut Ctrl + L (Windows) or cmd + L (Mac). In text documents, the selected 

segment will appear underlined and in blue, or in PDF or image files, in a blue frame. 

 

Toolbar button for creating a document link 
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2. You can now choose the document or document segment that the anchor should be linked to. 

This second segment can be in the same document or in a different one. Simply go to the docu-

ment or document segment and highlight a section of text. 

3. To complete the link, simply click again on the Insert link symbol in the toolbar or right-click on 

the highlighted text and choose Insert link. 

If, after the first step, the user decides against creating the link or wants to change the text that had 

been selected, clicking the Remove last link symbol removes it. 

 

Toolbar button for removing a document link 

Document links appear underlined and in blue in the “Document Browser.” Holding the mouse cur-

sor over the text causes a screen tip to appear with information about the linked document seg-

ment: the name of the document and the actual text selected when the link was made. 

 

Blue underlined document link with tooltip 

For this reason, it is sometimes a good idea to select not only a word, but a whole sentence or 

paragraph as the link. 

Simply clicking a document link allows one to jump from the link in the “Document Browser” to the 

other linked segment. The document containing the link appears at the position of the linked seg-

ment. 

To delete a document link, click the link with the right mouse button and choose Delete Link from 

the context menu. 

Tip: If the second document browser is open (>> LINK), MAXQDA automatically jumps to a link in 

the other document browser window. In this way, you can view the two linked document sections at 

the same time. 
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8.3 External Links  

External links are links between a segment of a text or image in MAXQDA and a document outside 

of the project (e.g. to link part of an interview transcript in MAXQDA with a picture of the person 

saved elsewhere on your computer). 

To insert an external link, simply highlight a section of text or image, right-click on it, and select Insert 

external link. A window will then appear where you can select the appropriate external document 

to be linked. This can be on your internal hard drive, an external medium like a flash drive, or a 

network location. 

External links, for text documents, are blue and underlined like the document links, or in a blue frame 

for PDF and image documents. When you hover the mouse over the link, a tooltip appears with the 

name and location of the linked document. Clicking on the link opens the document in the appropri-

ate program. For example, clicking on a link to an image file in JPG format will open the file in an 

image viewer program. 

8.4 Web Links  

Web links in MAXQDA are links between a text or image segment and a website. A web link can be 

created as follows: 

1. Highlight the text or image segment to be linked with the web address. 

2. Right-click on the highlighted segment and select Insert web link. 

3. A window will appear and you will be able to enter a web address. 

 

Window to insert Web link 

Note: If a link was saved to the Windows clipboard, it will be automatically displayed in the input 

field. 

As is the case with the external links, you can hover over the web link and see the linked website in 

the tooltip. Double-clicking on the link brings up the website in your standard Internet browser. 



Geolinks 104 

8.5 Geolinks  

With the creation of programs like Google Earth and Google Maps, it has become possible to view 

any point on the globe with the appropriate coordinates. Geolinks or Georeferences are links between 

elements in MAXQDA and a selected place on the globe. You could, for example, choose to link each 

interview transcript in MAXQDA with the place the interviewee lives. 

With the help of these geolinks you can also show geographic aspects of sociological research data. 

The use of georeferencing tools, especially Google Earth™, in combination with software for quali-

tative data analysis is fairly new. Cesar Cisneros, professor of sociology at Universitaria Autonoma 

Metropolitan Iztapalapa in Mexico, was one of the first to use this technique. In 2006, he used geo-

links in MAXQDA for a research project in South America. MAXQDA includes a column in the “Doc-

ument Browser” specifically for these geolinks. To create one, follow these steps: 

1. Go to the location in Google Earth™ that you would like to link to. You can then save the location 

by right-clicking on it and selecting Save Place As … 

2. Highlight the text or image segment to be linked in MAXQDA, right-click on it, and select Insert 

geolink. Simply select the saved KML file in the window that appears, and the geolink has been 

created. 

3. The KML file contains the coordinates to the saved place and everything else that Google Earth™ 

needs to take you directly to that location. When you click on the geolink in MAXQDA, Google 

Maps will open in your Internet browser and the location will be marked with a red dot. 

4. By hovering your mouse over the geolink visualization, you will see the coordinates that are saved 

for that location. The screenshot below shows you this below. It is a geolink in the interview tran-

script “Teresa,” linking to the place that she lives in “New York, NY, USA” at the exact coordinates. 

5. Geolinks are visualized similar to other links (blue and underlined), but they also have their own 

visualization column next to the opened document. If the column is not shown, right-click some-

where in the document in the “Document Browser” and select Show geolink bar. This bar makes 

it easy to differentiate between regular document links and the geolinks. 

 

The green ball symbol to the left of the paragraph number visualizes a geolink 

Note: When you add a geolink, the KML file is imported into the MAXQDA project itself. Storing it in 

the project file makes it easier to pass on the entire project with all the associated KML files to the 

other members of the research team. 

Segments that contain geolinks can be coded just as any other segment can. 
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Geolinks can be easily viewed in the “Overview of links” table, available in the “Document System” 

at multiple levels (project, document group or document). In the first column of the chart, geolinks 

are marked with an orange locator symbol. If you click on the column header of this column, the 

entire column will be sorted by the symbols, so it is possible to obtain a successive list of all geolinks. 

 

“Overview of links” with geolinks indicated with the orange locator symbol 

Inserting Geolinks as Stand-alone Objects in MAXMaps 

Geolinks can also be inserted in MAXMaps by right-clicking in a map and selecting Insert geolink. 

You will then be able to select the appropriate KML file from the window that appears. 

The MAXMaps screen then looks as follows: 

 

A geolink inserted in MAXMaps 

The name of the location in Google Earth is automatically inserted as the label for the geolink in the 

map. This label is usually long and can be easily changed. 

The inserted geolink can then be set up, visualized, linked to other objects, and moved around just 

like any other object in MAXMaps. You can, for example, insert a picture to replace the blue circle, 

change its size, etc. 
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A geolink along with other elements in a MAXMaps map 

Geolinking for Codes, Documents, Memos and Coded Segments in MAXMaps 

All MAXQDA objects inserted in MAXMaps can be connected to a geolink. As with the free objects 

mentioned above, a blue ball appears in the top right of object’s frame when it is clicked on. Double-

clicking on the ball opens Google Earth™ and takes you to the assigned location. 

Using a Background Image with Geolinks in MAXMaps 

Google Earth™ allows you to save any view as a JPG file, which can be inserted in MAXMaps as the 

background. 

Invisible hotspots as well as all aspects of your MAXQDA project can then be inserted and placed on 

the newly-imported background. 

8.6  The “Overview of links”  

Document links, the most common form of link, are easily seen in the “Document Browser,” but if 

you have created many links, it is difficult to get an overview of them. For this reason, MAXQDA 
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makes it possible to view all links in an overview table. This overview table is similar to the one used 

for the “Overview of coded segments.” 

To view the “Overview of links,” right-click on a document, document group or the “Documents” 

icon (representing the entire project) in the “Document System” and select Overview of links. When 

right-clicking on a document or document group, only those links from that document or group will 

be shown. 

The overview contains the following information: 

Anchor point (Document 1), paragraph 1, preview 1, second location (Document 2), paragraph 2, 

preview 2. 

In other words, you see the document name, paragraph number, and a preview of each side of a link. 

Document links are not hierarchical, meaning they don’t have a specific direction. A link from Point 

A to Point B is also a link from Point B to Point A. If you view all links from the whole paragraph, you 

will therefore see each link listed twice: once as Point A to Point B, and once as Point B to Point A. 

 

“Overview of links” for a project 

In the “Overview of links,” each type of link can be distinguished by the symbol that appears in the 

column on the far left: 

  Document links 

  External links and web links 

  Geolinks 

The “Overview of links” table works like other MAXQDA tables. You can choose to sort it alphabeti-

cally or reverse alphabetically by clicking on the column headers. Clicking once on a link opens the 

linked document segment in the “Document Browser,” showing you where the link is located. You 

can also access several functions in the table toolbar: 

  Excel table – a table with the selected links is created and saved in XLS/X format and opened in 

the program (usually Excel) that handles this type of files. 

  HTML table – a table with the selected links is created and saved in HTML format and opened in 

the standard web browser. 

  Export – allows you to export the table in XLS/X, HTML, RTF, or TXT (tab delimited) format. 
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9 Codes and How to Code 

9.1 Information on Codes and Coding in MAXQDA 

One of the main functions of MAXQDA is the “coding” of document segments, that is, the assign-

ment of a code to particular document segments, e.g. enabling a systematic content analysis of a 

text. 

The codes themselves are simply text strings containing up to 63 characters, which are attached to 

segments of a document (text or picture sections). Codes are like drawers containing index cards with 

text and image sections and keywords. The name of the code is like the label attached to the front 

of a drawer. What you will find in the drawer is indicated here. The label itself has no effect on the 

contents, so you can attach another label without consequences. Codes can be ordered into a hier-

archical structure, a main code having several subcodes, for example. As you add codes, they can be 

organized in this window. By right-clicking on either of the icons in the “Code System” window, you 

will see a variety of functions that are possible there. 

9.2 The “Code System”  

Codes have a hierarchical structure, meaning you can create multiple subcodes, followed by subcodes 

of subcodes. All of the codes are shown in the “Code System” window. 

At the beginning of a project, this window is empty except for the “Code System” and “Sets” icons 

and their associated icons. If you right-click on the top line on the term "Code System", a context 

menu will open from which you can manage the “Code System” and access the various coding op-

tions. 

MAXQDA’s “Code System” has the following characteristics: 

 A code is a string with a maximum of 63 characters consisting of one or more words. A code can 

contain empty spaces and special characters. 

 The number of codes in unlimited. 

 The hierarchical structure can contain up to ten levels. 

 Codes can be assigned a color. 

 The so-called color codes play a special role. They are like text markers and change the background 

color of the marked text. 

 emoticodes also play a specific role. An emoticon symbol appears in the “Code System” in the 

place of the code symbol, with pre-defined names that can be changed. 

 Beginning with MAXQDA 12, there are also special codes for the participants of a focus group. 

These codes can be identified by this icon . These codes can perform special functions. 
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Working with coded segments (of text and images) and the “Code System” is a central aspect of 

computer-supported text and content analysis. This work is usually not done automatically by the 

software, but rather is controlled by the researcher, although this often requires a significant amount 

of time. The “Code System” is shown as a tree structure on the screen. It looks like the file/folder 

system in Windows Explorer or Mac Finder with which you are likely familiar. A plus or minus sign 

before the code name indicates whether or not a code contains subcodes. You can expand or close 

the sub-categories by clicking this button. 

 

Hide subcodes 

You can click on the triangle symbol before the code to reveal or hide its subcodes. 

Tip: With the function Collapse all subcodes, which is accessible from the context menu of the top 

level of the “Code System”, you can conveniently collapse all codes so only the top level codes will 

be visible. 

Moving codes within the “Code System” 

Note: In MAXQDA, the codes in the “Code System” can be moved or grouped together using Drag 

& Drop (by holding down the left mouse button). To transform a code into a subcode of another 

code, drag the selected code to the destination code by holding down the left mouse button, then 

“drop” it into place. To move a code in between two other codes, “drop” it between the two codes. 

It is easy to rearrange the “Code System” in a way that is useful for your work. It is often the case 

that you will find it helpful to arrange your codes in an order that follows your research process or 

argumentation. The possibility to arrange codes in a specific sequence makes it easy to minimize the 

need to move around within the category system during the coding process. 
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Tip: Using MAXMaps you can build a network structure of codes to be used during the coding pro-

cess, meaning you can code selected segments within a document and code them by dragging them 

onto a code in the network map. 

The “Code System” Toolbar 

The toolbar at the top of the “Code System” window offers quick access to the most commonly-used 

functions in this window. These functions are: 

  Reset activations – resets current code activations. 

  Activation by code variable – allows the activation of codes depending on their variable values. 

  Activation by color – allowing codes to be activated based on their assigned colors. 

  Display emoticodes only /  Display codes and emoticodes – reduces the display in the 

“Code System” window to emoticodes. 

 Change to table view /  Change to standard view – switches between tree view, and table 

view of the code system. 

  New code – adds new code into the code system. 

  Display search toolbar – allows you to search for a specific code. 

  Undock window 

  Maximize window 

  Hide window 

In addition to using the toolbar to access functions in the “Code System,” you can also use the 

context menus that appear when you right-click on various icons in the window (e.g. on a code or 

the “Code System” icon, etc.). 

9.3 Creating a New Code  

The word “Code System” at the top of the list represents the root of the “Code System” that you 

will build from this point. All codes can be created in this way. 

In order to create a new code at the highest level, we can do one of three things: 

1. The easiest option is to click on the New code  symbol in the “Code System” toolbar. 

 

Toolbar icon for inserting a new code 
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2. Another option is to right-click on the Code System row and select New code from the menu that 

appears. 

 

Creating a new code with the context menu 

3. The third option is to create a new code by using the keyboard shortcut Alt+N (Windows) or 

cmd+Alt+N (Mac). For this to work, however, the “Code System” window must be selected. 

No matter which way you choose to create a new code, the following window will appear: 
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The window that appears when creating a new code 

Type the name of the new code in the upper dialog field of the window. You can select a color 

attribute for the new code below. There is an almost unlimited number of colors that you can pick 

from or design on your own. The dialog field in the lower part of the window enables you to write a 

code memo, for instance a definition of the characteristics of the new code. 

If you select the option Use as default color for new codes, all newly created codes in the project 

will use the chosen color, e.g. In-vivo codes. Of course you can change this default color each time 

you create a new code using this dialog. 

Creating Subcodes 

If you would like to define subcodes, just right-click the parent code and choose the option New 

code. Again the same dialog window as mentioned above will pop up. If you want the subcode to 

have the same color attribute as the main code, just click the checkbox “Inherit.” 

Creating subcodes can also be completed using the Alt+N (Windows) or cmd+alt+N (Mac) key-

board shortcut or the New code  icon from the toolbar. It should however be noted that the code 

for which you wish to create a subcode should be highlighted in blue. 

If you have entered text into the memo field of the dialog box, a memo icon is displayed beside the 

new code in the “Code System” as soon as you close the dialog window. 

Note: Newly-created codes are always added at the top of the “Code System” unless created as a 

subcode, in which case it will appear as the top subcode. 
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9.4 How to code  

Assigning codes to segments of texts or images in MAXQDA is known as “coding.” 

A document or document segment can be coded with as many codes as you want. There is practically 

no limit to the number of codes that you can create and assign. Coded segments can also overlap, 

intersect, or be completely contained within other coded segments. 

Select the Segment to be Coded 

The action of coding can be done in many different ways, but you must always start by highlighting 

a section of a text or a picture to be coded in the Document Browser.” An example of highlighted 

text within the “Document Browser” is shown below: 

 

A highlighted segment of text 

Note: The smallest segment of text that can be coded is a single character. In most cases, you would 

want to code at least an entire word. The “Code” toolbar is especially helpful when going through 

the coding process. If it is not currently visible, you can activate it by clicking on it in the View drop-

down menu. 

 

The “Code” toolbar 

In PDF files, both text and image segments can be coded: 
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Highlighted text (above) and highlighted image segment (below) in a PDF 

Different Ways to Code 

MAXQDA offers several ways to code segments: 

1. Classic coding using Drag & Drop: A selected text segment or image segment can be dragged and 

dropped into a code (or vice versa) using the mouse. 

2. Classic coding using context menu: A selected text segment or image segment can be coded by 

using the context menu in the “Document Browser” window. 

3. Coding with newly defined (free) codes: As in Grounded Theory, a segment can be assigned a new 

(free) code. 

4. In-Vivo coding: Select and highlight meaningful terms in the texts and automatically add them as 

codes in your code system while coding the text segment with the code. 

5. Coding with selected codes from the Quick List: Documents are targeted based on the occurrence 

of one or more pre-selected codes, and coded where applicable. 
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6. Simultaneous coding with multiple codes: A segment is coded with the activated codes. 

7. Highlight coding: This works like highlighting a text passage in a book with a colored text marker. 

In MAXQDA, five different colors can be used for color coding: red, green, yellow, blue or ma-

genta. 

8. Coding with MAXMaps: Selected segments are dragged to codes on a map. 

9. Coding with code favorites: Selected codes are displayed in a separate window, from which they 

can be easily applied to segments to be coded. 

10. Coding with self-defined keyboard shortcuts: Up to nine codes can be assigned their own key-

board shortcut, which can be used to quickly code a marked segment. 

11. Coding with symbols and emoticons: Selected segments are coded with emoticodes, i.e. an 

emoticon or a symbol. 

Note on coding: Regardless of the function selected, MAXQDA ensures that the same code is not 

assigned more than once to the same passage. The overlapping of segments with the same code is 

not possible. When segment size is modified – made larger or smaller – and coded with the same 

code, MAXQDA will automatically correct the segment size to correspond to the new selection. 

The following section describes in detail how these techniques are used. The different options can be 

chosen from the context menu that pops up when you select a document segment and click the right 

mouse button. 

1. Classic Coding Using Drag & Drop 

Left-click and hold on the selected text and move the mouse pointer to the name of the code in the 

“Code System.” Release the mouse button to assign the segment to this code, as you can see in the 

gray column next to the document in the “Document Browser” window. The reverse also works, i.e. 

you can drag the code to the selected document segment. 

Tip 1: The same segment can be assigned multiple codes in a row. 

Tip 2: You can highlight and drag a text segment in the upper preview part of the “Overview of 

coded segments” window, too. 

2. Classic Coding Using the Context Menu in the “Code System” 

Right-click on the code in the “Code System” that you would like to use to code the highlighted 

document segment in the “Document Browser.” Select Code highlighted segment from the con-

text menu. 
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Using the context menu in the “Code System” 

3. Coding with newly defined codes 

An easy way to create a new code, i.e. a code that is not yet listed in the “Code System,” is to use 

the shortcut Ctrl+W (Windows) or cmd+Alt+W (Mac). A dialog window will open, and you can 

type in the name of the new code. The code will be added to the “Code System” at the highest level 

of the hierarchy. If necessary, you can later move the code to another level in the “Code System.” 

4. Coding In-vivo 

Another way of coding is with the so-called in-vivo coding. If you, for example, select the word “global 

village” and then click on the in-vivo coding button in the toolbar, the word “global village” is added 

to the “Code System” as the code for this short text segment. The shortcut Ctrl+I (Windows) or 

cmd+Alt+I (Mac) has the same effect. 
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Coding with the Quick List or the in-vivo button 

When you want to code a whole segment of text with the in-vivo coding function, and not only one 

or two words, code the one or two words with this function first. Next, select the entire text segment 

(including the word) and click Code highlighted segment (not the in-vivo coding button!). 

MAXQDA expands the coded segment automatically. 

Note: Other coding methods including color-coding, MAXMaps, code favorites and emoticodes are 

explained in separate sections. 

5. Focused Coding with the Quick List Coding Button 

The “Code” toolbar provides quick access to frequently used coding functions. The “Quick List” is 

located on the toolbar to the right of the Edit button. Whenever you click on a code in the Code 

System, or when coding is in process, the corresponding code appears at the top of the Quick List. 

Click on the Coding  button immediately to the right of the Quick List button to assign the code in 

the window to the selected segment. In this way, multiple areas of a document can be coded without 

having to select the code each time. 

You can also use the keyboard shortcut Ctrl+C (Windows) or cmd+Alt+C (Mac). 

6. Coding with Multiple Codes Simultaneously 

First, activate the codes in the “Code System” that you want to use to code the selected segment in 

the “Document Browser.” Then right-click on the segment and choose the option Code with acti-

vated codes. 

Note: The other coding options including highlight coding, MAXMaps, code favorites, keyboard 

shortcuts and emoticodes are discussed in separate sections. 

9.5 Highlight Coding / Color Coding 

Color coding text is a technique that is especially useful at the beginning of the analysis process. It is 

similar to the marking of text in a book with a highlighter. It allows you to mark the passages you 

find particularly interesting when reading through the text for the first time. Before you decide which 

codes to use and before you start analyzing your text in categories, this technique lets you keep track 

of what simply seems important. 

Before you begin color coding, you must ensure that the “Code” toolbar is visible. This toolbar can 

be activated via the “View” menu. The Code toolbar contains five highlight coding colors. 
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“Code” toolbar with five highlight coding buttons 

To highlight code a segment of text, you follow a similar process as with standard coding: highlight 

the text segment with your mouse and click on one of the five colors in the toolbar. The text segment 

will now be highlighted in that color, and it will be coded accordingly. A new coding stripe will be 

visible in the coding column next to the document. 

 

A section of text coded with “GREEN” 

In practice, then, the highlight coding does much more than just change the color of the text – it is 

also a coding action. This means that you can later call up all of the green-highlighted segments and 

work with those that are most important. This lets you code more specifically once the first general 

coding run is complete. Retrieving all codes with a specific color coding can be done by activating all 

documents in the “Document System” and activating the appropriate color code in the “Code Sys-

tem.” 

If at a later point, you delete the color code in the “Code System,” you are not only deleting the 

code. All coded segments for that code will also be deleted. In other words, all highlights of that color 

will be deleted from your documents. 

Color codes are marked with a specific symbol in the Code System: 

 

Symbol for a color code in the “Code System" 
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9.6 Coding with MAXMaps 

The “Code System” is organized in a hierarchical tree structure, which does not allow for multiple 

cross relationships between subcodes. In some cases, it may be necessary to create a non-hierarchical 

structure to form network relationships and organize codes in a different structure. 

This is possible with MAXMaps, the mapping tool that is part of MAXQDA. Open Visual Tools > 

MAXMaps to start the tool and create a new map. Use Drag & Drop or Alt+double-click to copy 

codes from your code system to the map. Codes can be freely arranged on the map, linked to each 

other with arrows or lines, and free symbols or images can be added to the map. 

Coding is simple: Drag a selected segment from the “Document Browser” to a code in the map. 

 

Coding using Drag & Drop on a code in a map 
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9.7 Coding with the Code Favorites  

If you are working with an extensive “Code System,” it can be difficult to work efficiently, since it is 

hard to find each code quickly in the large list. The coding Quick List offers on way of working around 

this, but there is another option that can be helpful in certain circumstances. It allows you to also 

code with more than one code at once. The function is called the code favorites. 

And how does it work? Simply right-click on a code and select Add code to code favorites. After 

you have added the first code, the code favorites window will appear. You can then continue to add 

more codes to the list in the same fashion: right-click on the code and select Add code to code 

favorites. 

Tip: You can also drag and drop codes from the “Code System” into the open “Code favorites” 

window. 

 

The list of code favorites 

You can now begin to code. Simply highlight the segment as usual and click on the code in your list 

of Code favorites. You can now see in the coding column on the left side of the “Document Browser” 

that the segments have been coded. 

Tip: You can also drag and drop a highlighted segment on a code in the code favorites window or 

vice versa drag and drop a code onto a highlighted segment. 

When you are finished using the code favorite window, simply close it by clicking on the x in the top-

right corner. To re-open the window, you can either add another code (via the context menu) or 

select Code favorites from the Codes drop-down menu. 

Rearrange Sequence of Codes or Delete Codes 

If you want to rearrange the sequence of the codes, click on the icon Edit code favorites. Now, 

highlight codes with the mouse and use the arrow up and down icons to move codes up and down. 

To delete a highlighted code, click on the red X labelled Remove selected codes from code favor-

ites at the top of the window. 

Click again on the Edit code favorites icon to continue with your coding work. If you drag a high-

lighted segment onto a code in the code favorites window the “Edit” modus will be switched off 

automatically. 
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9.8 Coding with Keyboard Shortcuts  

For quick coding using your keyboard, you can assign keyboard shortcuts for up to nine 

codes. To do so, select the menu option Codes > Keyboard shortcuts for codes: 

 

The “Keyboard shortcuts for codes” window 

In the left column you will see the available keyboard shortcuts Ctrl + 1 to Ctrl + 9 (Windows) or cmd 

+ 1 to cmd + 9 ( Mac ). You can drag and drop a code from the list of codes into one of the nine 

rows, thus assigning a keyboard shortcut to the code. If a shortcut already been assigned, it will be 

overwritten by this action. For clarity, the name of the code appears in the right column, along with 

the parent code if necessary – not the entire code hierarchy. 

To cancel the assignment of a shortcut to a code, click on the appropriate row and click the Remove 

shortcut button. 

For coding, it may be helpful to leave the keyboard shortcuts window open until you have memorized 

the shortcuts. It does not matter if the window is open or not when coding: Simply highlight a seg-

ment in the Document Browser and hit the selected shortcut keys. MAXQDA will then encode the 

selected segment with the associated code. 

Tip: When you right-click on a code and select Properties, a window will open in which you can 

assign the code directly to one of the nine available keyboard shortcuts. If the shortcut is already in 

use for a different code, MAXQDA will ask if you want to reassign the shortcut to this code. 
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Tastenkürzel über die Eigenschaften eines Codes zuordnen 

9.9 Emoticode: Coding with Emoticons and Symbols  

The “emoticode” function allows you to assign symbols and emoticons to text and image segments, 

as well as audio and video clips. It can generally be employed with the same functionality as “normal 

coding:” All the functions of conventional coding are supported, meaning emoticons and icons will 

be displayed in the overview tables of coded segments and in visualizations such as the Document 

Portrait. 

Emoticons and Symbols 

MAXQDA includes over 300 emoticons and symbols, which are organized into different thematic 

groups. Emoji icons are widely known due to smartphone use. They include different types of smileys 

as well as many other symbols. Each emoticon symbol has a name, which serves as code name. 

Calling up the Emoticode Window 

In order to code using emoticodes, you must first open the emoticode window. You can do so by 

clicking the corresponding button in the “Code” toolbar. 

 

Activate emoticode function 

After being called up, the window containing the collection of emoticons appears and can be moved 

anywhere on the screen. 
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The emoticode window 

Note: Each emoticon or symbol is assigned a name. This is visible when the mouse moves over an 

emoticon or symbol in the emoticode selection window. After coding, it will be listed as a code name 

in the code system. 

If more symbols are included in a thematic section than can be displayed in the window, you can 

scroll through all symbols in the section using the blue arrows at the bottom of the window. 

When you click on the clock icon, MAXQDA displays the most recently used symbols and emoticons. 

In addition, you can add frequently used symbols to favorites. To do so, right-click the symbol and 

select Add to favorites. The symbol is then shown additionally in the 2nd tab from the left, marked 

with a star. Symbols can be removed from the favorites list using the same method. 

 

Add and remove symbols from favorites 

Options for the emoticode Window 

Window and symbol size can be customized. Click on the Properties  button at the top of the 

window. 
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emoticode properties window 

Coding with Emoticons 

Coding segments with emoticons is just like color coding or coding with the toolbar. The segment is 

selected in the “Document Browser” or “Multimedia Browser,” then you can subsequently click on 

the desired symbol or emoticon in the emoticode window. If the emoticon has already been used in 

the existing “Code System,” the reverse is also possible – meaning the selected segment can be 

dragged into the code, or the code into the segment. 

Coding Display in the “Document Browser” 

In the “Document Browser,” the selected emoticon appears in the middle of the coding stripe, in the 

place of the code name. All segments coded with emoticons are displayed in the default coding color 

(grey); it is not possible to assign a different color. 

 

Coding stripe with emoticode in the “Document Browser” 

In the selection window for the displayed coding stripe (which can be called up with a right-click on 

the mouse in the visualization area), you can hide or show coding stripes with emoticodes in the 

“Document Browser.” 
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Select “Display emoticodes” to emoticodes on the coding stripe 

emoticodes in the “Code System” 

When the “Code System” is displayed in the normal tree structure, the emoticodes appear in the 

place of the usual code symbols. The display of codes in the code system can, if desired, be restricted 

to emoticodes by clicking on the corresponding button in the window's toolbar. 
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emoticode display in the “Code System” 

The figure shows the emoticode symbols “laughing,” “eye” and “ambulance” in the code system. 

The names, just like code names, can be replaced by another term. 

Emoticons in the “Retrieved Segments” and “Overview of coded segments” 

Emoticons, in most cases, replace code symbols, and are therefore found in the source list in the 

“Retrieved Segments.” In the table view, as in the “Overview of coded segments,” emoticons are 

displayed instead of the circle containing the code colors, allowing the entire table to be sorted by 

emoticons. 

Emoticons in MAXMaps and Visual Tools 

In MAXMaps, the appropriate emoticon will appear in the place of the code symbol. In the Code 

Matrix Browser, Code Relations Browser, and Codeline, the emoticon will also be displayed in the 

place of the code symbol. 

In the Document Comparison Chart each code that is present in the paragraph is represented by a 

colored section of the bar. Code colors, not emoticons, are used, with the color green indicating 

emoticodes. 

The Document Portrait is displayed with emoticodes rather than code colors if the “Mix” feature is 

turned off. When the “Mix” feature is turned on, it mixes the code colors where codes overlap. In 

this case the color grey is used to indicate emoticons. 

9.10 Displaying Code Frequency in the “Code System” 

Information on if and how many coded segments are assigned to a specific code can be found in the 

“Code System.” This information is displayed in the frequency column to the right of the code name. 
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In the following figure, the number 15 appears after the code “Day-to-Day Issues/Interests.” This 

indicates that up until this point, a total of 15 segments have been coded in this category. 

 

Information on the number of coded segments 

When you “collapse” a subcode into a code by clicking the „>“ symbol in front of the code, the 

frequency of the subcode will be added to the frequency of the top-level code. Therefore, for a col-

lapsed code, MAXQDA displays the number of segments that were coded with this code including all 

of its subcodes. To change this setting so that only the frequency of highest-level codes is displayed, 

go to Project > Preferences (Windows) or MAXQDA 12 > Preferences (Mac) and deselect Sum 

up subcodes in 'Code System' window. 

9.11 Assigning Colors to a Code  

Every code and subcode can be assigned a color. This color attribute is used for the display of coding 

stripes in the “Document Browser” and for visualizations. The colored coding stripes make it especially 

easy to find certain coded segments in documents in the “Document Browser.” 



Assigning Colors to a Code 128 

 

Coding stripes of various colors in the Document Browser 

The color is also seen in the bottom right of the icon next to each code in the “Code System.” 

 

Codes of various colors in the Code System 

The color attribute is also displayed in all MAXQDA tables that contain codes, e.g. in the “Overview 

of coded segments” table that is available for each document group and each document. There, the 

color attribute may be used as a criterion for sorting the table. This is done by clicking on the column 

header of the column containing the colored icons. Unless you have changed the order of the table’s 

columns, this column will be the first one in the table. 
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Color attribute in the first column of the “Overview of coded segments” 

The color attribute plays an important role in all visual tools of MAXQDA. For instance, the Document 

Portrait is based completely on the colors of the codes that are assigned to a particular document. 

Thus, the selection of colors is an important step: colors should be assigned according to the kind of 

analysis that you plan to conduct. For instance, a psychologist could assign red colors to aggressive 

statements and green colors to friendly statements. When analyzing documents in regard to the top-

ics mentioned a meaningful association of topics and codes is recommended. Thus, you are able to 

identify topics and combinations of topics with one glance. When working with focus groups, you 

should associate the speakers with the different colors, in order to quickly find out when a person is 

speaking. 

9.12 Visualizing Coded Segments in the “Document Browser” 

As soon as you have coded a document segment, a coding stripe appears in the gray area next to the 

document in the “Document Browser.” The standard color for this symbol is green, but you can 

choose another color for any code, causing all the code symbols for this code to appear in this color. 

The column for the coding stripes can be made bigger or smaller by clicking on the separator between 

the column headers and dragging to the right or left. Double-clicking on the column separator makes 

the column the optimal size. This optimal view can be impractical, though, if you have too many 

coded segments. In such cases, the text will be made so small that you won’t be able to read it easily. 

 

Visualization of coding stripes on the left side of the “Document Browser" 
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You can also choose whether code names should be shown in the coding stripe column. By right-

clicking in the gray area of the column, you will call up a window with various setting options. One 

of those options is to Show code name. 

You will always be able to see the code name in the tooltip that appears if you hover your mouse 

over the coding stripe. The tooltip also shows you the assigned weight, the author of the coded 

segment, and the date that the segment was coded. 

 

Tooltip appearing from the coding stripe 

This tooltip always displays the complete code name, even if it is a subcode. This is significant, because 

the coding stripes in the column only show the name of the codes, rather than including the codes 

that they are subcodes of. In other words, the code “Interests” is a subcode of “Day-to-Day Issues,” 

but that is only visible in the tooltip, not in the coding stripe column (see above). In the tooltip, it is 

shown as “Day-to-Day Issues\Interests.” 

If there are many coded segments, it can also be difficult to figure out exactly which codename be-

longs to which coding stripe. This can be immediately identified when you move the mouse over a 

coding stripe, at which moment the code name will appear brighter and the code assignment will be 

displayed. 

Often you will want to know which codes are assigned to a specific text or image segment. To do so, 

select the segment and choose Display assigned codes from the context menu. 
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"List assigned Codes” for selected text in the context menu 

This will display a menu in which all assigned codes are listed. Click on an entry in the list to high-

light the code in the “Code System.” 

 

List of assigned codes for a segment 

9.13 Coding Stripe Column Visualization Options  

By right-clicking in the coding stripe column, you can call up a window with various settings for the 

visualization of coded segments in the coding stripe column: 
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Option menu for the visualization of coding stripes 

Here you can adjust the following settings: 

 You can choose to only visualize activated codes. 

 You can choose to visualize coded segments created by certain users. 

 You can choose to only visualize coded segments of a certain color. 

 You can choose whether to change the text color of the text in the document to match the color 

of the code it was coded with. 

 As mentioned before, you can choose whether the code name should be shown or not. 

 Finally, you can choose whether the tooltips should include the information about the author and 

date of creation. 

The option to switch off codes with selected colors is particularly useful when you are working in a 

team with independent coders. In this case, the coders should be defined as codes on the highest 

level of the code hierarchy and the different coders should use the same code tree organized as 

subcodes of the coders. Now, while the training the coders, you can hide the visualization of other 

coders’ work. Later on, they can compare their coding with the coding done by the others. 
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The option to color the text according to code colors only makes sense if you do not have many 

overlapping codes. Overlapping codes cause the color of the text to be a mix of those overlapping 

codes, which can make it very difficult to interpret. 

9.14 The Properties Window for Codes  

You can right click on the name of any code and choose Properties in the drop-down menu in order 

to open the Properties window: 

 

Properties window for a code 

In this Properties window, you can… 

• Change the name of the code (max. 63 characters available), 

• Assign or adjust a Code Alias (max. 255 characters), 

• Modify the code color, 

• Assign a keyboard shortcut. 

Since the number of characters for a code is limited to 63, longer code designations can be assigned 

as code aliases. For example, they may be exported instead of the code names when using the 

SmartPublisher. 

9.15 Creating a Code Alias  

Code names in MAXQDA can be 63 characters in length. However, it is sometimes desirable to note 

a shorter or longer description in addition to the code name. This allows you to employ an automat-

ically generated report with selected coded segments, for example in Smart Publisher. 

To create a code alias for a code, right-click on the code in the Code System and select “Properties”. 

This will open a window where you can enter a code alias, among other options. 
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Creating a Code Alias in the “Code Properties” Window 

Alternatively, you can click Codes > Code Alias Table, which will generate a table in which you can 

conveniently enter multiple code aliases, and view for which codes an alias has already been assigned. 

 

Code Alias Table 

9.16 Deleting Coded Segments: The Undo Function  

Clicking on the code symbol with the right mouse button causes a context menu to appear, with 

which the coding of the text segment can be removed. Choose Delete and confirm the deletion by 

clicking Yes in the confirmation window that appears. 

If you need to first find the location of a coded segment in a document, deleting the code in this way 

may not be very convenient. A better way is to use MAXQDA’s Undo function. In the “Code” toolbar 

on top of the “Document Browser” window there is an Undo  button. Clicking on it opens a list 

containing the last codes assigned. 



Codes and How to Code 

 

135 

 

Undo function in the “Code” toolbar 

Note: The most recent coded segments are shown at the top of the list. 

Through certain functions, such as “Move coded segments” or autocoding, you may code dozens or 

even hundreds of segments at one time. In such cases, the Undo function can be very helpful. 

Codes can also be cleared through the “Retrieved Segments” window: Right-click on the information 

box and select Delete in order to delete the selected code. 

Note: If a code is deleted from the Code System, the code is removed from all segments that were 

coded with that code. 

9.17 Deleting a Coded Segment 

MAXQDA offers the option of deleting single or multiple codes simultaneously, from several locations. 

Deleting coded segments in the “Document Browser” window 

1. Move the mouse over the coding stripe or over the code name. 

2. Right-click and select Delete. 

3. MAXQDA will require confirmation before deleting the coded segment. 
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Deleting a coded segment in the “Document Browser” window 

Deleting coded segments in the “Retrieved Segments” window 

1. Right-click on the source data next to the coded segment. 

2. Select Delete. 

3. MAXQDA will require confirmation before deleting the coded segment. 

Caution: The segment is then removed from the “Retrieved Segments” window, and the deletion 

can not be undone. 

 

Deleting a coded segment in the “Retrieved Segments” window 

Deleting coded segments in the “Overview of coded segments” or in the “Retrieved 

Segments” window in table view 

1. Right-click on a row or select multiple rows while holding down the Ctrl key (Windows) or cmd 

key ( Mac) to simultaneously delete multiple coded segments. 

2. Select Delete. 
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MAXQDA will require confirmation before deleting the coded segment. 

 

Deleting multiple coded segments in the “Overview of Codes“ 

9.18 Deleting Codes  

Deleting a code from the “Code System” is somewhat like cutting of a branch of a tree. By deleting 

that code, you are also deleting any subcodes, which are like smaller branches attached to the bigger 

one you cut off. At the same time, all coded segments that had been created with those codes are 

deleted. 

You can delete codes in the “Code System” either in the classic tree structure view or in the table 

view: 

 In the tree view, right-click on the code to be deleted and select Delete code(s) from the context 

menu. Alternatively, you can left-click on a code and press the Del key (Windows) or cmd+Back-

space (Mac). 
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Deleting a code from the context menu 

 Alternatively, you can switch to the table view of the “Code System” (by clicking on the Change 

to table view icon on the toolbar), then delete the code via the context menu or by pressing the 

Del key (Windows) or cmd+Del (Mac). 

Attention: When deleting a code, you are also deleting all coded segments that were created with 

this code. 

If you want to delete more than one code at a time, it is necessary to switch to the table view of the 

“Code System.” To do so, click on the Change to table view icon in the “Code System” toolbar. 

You can now select as many codes as you wish by clicking on them while holding the Ctrl key (Win-

dows) or cmd key (Mac) and then right-clicking and selecting Delete code(s) from the context menu. 

Codes can also be deleted in this manner in the “Overview of Codes,” accessible via the Code menu 

or the content menu in the “Document System”. 

9.19 Modifying Coded Segments  

There are various ways to modify coded segments: 

1. By assigning a new code. 

2. By assigning another code in the place of an existing code. 

3. By modifying the segment boundaries, meaning enlarging or reducing the coded segment while 

the code remains in place. 

All three of these modifications can be easily carried out in MAXQDA. 

Coding a Segment With More Than One Code 

After having coded a segment, the segment remains selected (with the exception of highlight-coded 

segments). It is possible to attach more codes to the same segment, for example using drag & drop. 
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If you want to assign one or more codes later, the segment must be selected again. This is easiest if 

you click on the coding stripe of this segment with the left mouse button. The segment will be high-

lighted again as in the original text, and you can assign a code in the usual way, either with Drag & 

Drop, by right-clicking on the desired new code in the "Code System" and selecting Code high-

lighted segment, with the Code quick button, as well as other MAXQDA coding options. 

Another option is to highlight the document segment, activate the codes you want to code it with, 

and then right-clicking on one of the codes and choosing Code with selection. The segment will 

then be coded with all activated codes at once. 

Replacing a Coded Segment 

When reviewing your text analysis, you may decide that the wrong code was assigned to a text seg-

ment. Or you may decide that the “Code System” is not precise enough, so it is necessary to expand 

the “Code System” and distinguish between different codes. In both cases, you will need to replace 

one code assigned to a text with another. 

This can be easily accomplished, as long as the coded segment is displayed in the “Retrieved seg-

ments” window: 

1. Click on the source data next to the segment 

2. Drag the segment to the desired code. 

3. The new code will automatically be assigned to the coded segment. If the other code is not acti-

vated, it may be that the coded segment was removed from the “Retrieved segments” window. 

4. A coded segment can be moved from the table view or the “Overview of coded segments” in the 

same manner. 

Editing the Size of a Coded Segment 

Sometimes a segment may be coded outside of its logical boundaries, meaning it is too short or too 

long. The coded segment will therefore be difficult to understand because it is out of context. Seg-

ment boundaries can be adjusted in the following way: 

1. Select the segment by clicking on the corresponding coding stripe or code name in the “Document 

Browser”. The segment is now highlighted in the original text. 

2. The segment boundaries can now be redefined as usual using the mouse. Alternatively, you can 

right-click the coding stripe and select Recode with highlighted segment. 

MAXQDA automatically adjusts to the newly defined segment boundaries. 

Note: Existing coded image segments in image or PDF docments will only be adjusted when the 

newly selected area either completely includes the existing segment or when the newly selected area 

is completely inside the area of the existing coded segment. 
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Changing the size of the coded segment 

While the function “Recode” moves the segment borders of a coded passage to the highlighted 

segmemt you can also extend the borders of an existing coded segment: 

1. Highlight a passage that overlaps with the beginning or the end of an existing segment. 

2. Right click on the coding stripe and choose the entry Extend with highlighted segment. 

9.20 Moving and Sorting Codes in the “Code System” 

Moving Codes 

Changing the structure of the category system is not difficult. All codes can be moved with the mouse 

and the drag-and-drop function. 

In the following example, the “Code System” contains four codes (C, B, A, and D). 

 

Moving codes with the mouse 

To move Code D to the top of the list, you would need to do the following: 

Click on Code D and drag it in front of Code A while holding down the left mouse button, then, 

when a line appears, drop the code. 

It is also easy to make a code a subcode of another code. If you want Code B to become a subcode 

of Code A, for example, you would carry out the following actions: 
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Click on Code B, drag it to Code A, and release as soon as Code A has a blue background. Code B is 

now a subcode of Code A. 

Sorting Subcodes 

Subcode can be sorted in ascending and descending order by name and by frequency, by right-click-

ing the parent code and selecting Sort subcodes from the context menu. 

9.21 Creating Code Sets  

With MAXQDA, temporary combinations of codes can be saved as code sets, permitting the user to 

group the same code in different ways, or to group frequently used codes in a hierarchical tree struc-

ture for increased accessibility. The code sets are linked only to existing codes, meaning that the 

removal of a code from a set has no further consequences. 

To create a new code set, right-click on the word “Set” in the Code System, then select New set. 

 

Create a new code set in the “Code System” 

After you enter a name for the set, you can drag and drop the desired codes into the new set with 

the mouse. The codes can also be moved within the set or to another set using the mouse. 

Tip: If you activate codes before you creating a new code set, MAXQDA places the activated codes 

directly into the new code set. 
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9.22 Copying Subcodes 

In some cases, you will be setting up the same subcodes for various codes. You might, for example, 

have the codes “Childhood,” “Teenage Years,” and “Adult Life,” which should each have the sub-

codes “Education,” “Family,” “Friends,” and “Memorable Experiences.” So that you don’t have to 

create these four subcodes three times, you have the option of setting them up for one of the main 

codes, copying its subcodes, and pasting them into the other main codes. To do so, you would follow 

these steps: 

1. Create the three main codes: “Childhood,” “Teenage Years,” and “Adult Life.” 

2. Create the four subcodes for the main code “Childhood.” 

3. Right-click on the Childhood code and select Copy subcodes. 

4. Right-click on each of the other main codes and select Paste subcodes. 

MAXQDA then adds the copied sub-codes in the same order as the original code. The newly inserted 

sub-codes do not have a color assigned to them. 

9.23 Moving all Coded Segments of a Code 

If you move a code from one position in the “Code System” to another, the code references move 

automatically together with the code. This is like moving a drawer from one place to another in a 

cabinet; the drawer’s contents move together. 

To move a complete drawer is something other than to move only its contents. The same is true with 

code references. If you only want to move the code references to another code, you cannot use the 

procedure described above. There is another procedure that leaves the drawer in its place and merely 

shifts its contents. 

In MAXQDA, it is the Move coded segments option that does this job. This option is available in the 

context menu of the particular code from which code references are to be moved. 

The following figure shows the result of moving coded segments from Code B to Code A. Actually, 

what takes place is the merging of Code A and Code B: 

 

 

To move the coded references from Code B to Code A, follow these steps: 

1. Right-click on Code B in the “Code System.” 
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2. Select Move coded segments. This transfers the code references to an internal clipboard. (Up to 

this point, nothing has really changed in the “Code System.” The number of coded segments 

displayed to the right of Code B is still the same.) 

3. Right-click on Code A (the target code) and choose Move coded segments from ‘Code B.’ 

MAXQDA asks you to confirm the command before executing it. 

 

 

Moving coded segments 

Code B remains in the “Code System” until you delete it, but the number of its immediate code 

references is now zero. The contents of the “drawer” have been moved to Code A. 
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The subcodes’ references, however, will not have been moved. Be careful when deleting Code B now, 

since all subcodes – if there are any – will be deleted too, along with their code references. 

It is of course possible that some segments that you move from "Code B" to the target code "Code 

A" have already been coded with the target code. MAXQDA will handle these overlapping codes as 

follows. 

• The segment boundaries of the existing coded segments will be adapted to those of the moved 

coded segments. 

• If both coded segments have a comment, those of the target code will be retained. The comments 

of the moved coded segments will be deleted. 

• If only one of the coded segments has a comment, it will be retained. 

Because of overlapping codes, the number of coded segments in the target code may be lesser after 

they are moved. If you move 10 coded segments of "Code B" to "Code A" with 20 encodings and 

multiple overlap, fewer than 30 encodings will be displayed in "Code A". 

Tip: If you want to delete all code assignments but want to keep the code in the “Code System,” it 

is best to create a code named “trash” and then copy the code references to the “trash.” 

9.24 Copying all Coded Segments of a Code  

The function “Copy coded segments” is similar to the “Moving all coded segments of a code” func-

tion. The important difference is that the original code assignment will be retained; that is to say, the 

coded segment will be duplicated and assigned to a new code in addition to the original code. 

This action is performed as follows: 

1. Right-click on the selected code in the “Code System”. 

2. Select Copy coded segments from the context menu that appears. 

3. Move the cursor to the target code to which you want to copy the coding added and click on it 

with the right mouse button. 

4. Select Insert coded segments from xx from the context menu that appears 

It is of course possible that some segments that you copy from "Code B" to the target code "Code 

A" have already been coded with the target code. MAXQDA will handle these overlapping codes as 

follows. 

• The segment boundaries of the existing coded segments will be adapted to those of the moved 

coded segments. 

• If both coded segments have a comment, those of the target code will be retained. The comments 

of the moved coded segments will be deleted. 

• If only one of the coded segments has a comment, it will be retained. 
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Because of overlapping codes, the number of coded segments in the target code may be lesser after 

they are moved. If you copy 10 coded segments of "Code B" to "Code A" with 20 encodings and 

multiple overlap, fewer than 30 encodings will be displayed in "Code A". 

9.25 Creating a New Top-Level Code 

A common procedure when working with codes is to group previously defined codes under a new, 

more abstract category, as shown in the next diagram: 

 

 

MAXQDA’s hierarchical “Code System” makes it easy to group existing codes under new top-level 

codes. Reorganizing the “Code System” can be done at any time during the analysis process: 

1. Create a new code at the top level of the hierarchy (New Code in the example above). 

2. Drag Code B to New Code and release it; it will be inserted as a subcode. 

3. Do the same with Code D. 

 

Creating a new code to hold to former codes as subcodes 

9.26 Splitting up a Code 

Often when working with a “Code System,” it is desirable to differentiate between elements grouped 

under one code. In MAXQDA this corresponds to dividing a code in two or more subcodes. For ex-

ample, imagine you have created a code named “Family” and have assigned document segments, in 
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which an interviewee talks about his family, to this code. Then imagine that it becomes necessary to 

differentiate between “Mother,” “Father,” and “Brothers&Sisters.” 

The division of a code into subcodes can obviously not happen automatically, since you must decide 

which references of the code are to be placed in which subcode. You must read each coded segment 

and decide which of the subcodes is appropriate. In this case the subcodes will not be exclusive since 

a person could talk about his father and his mother in the same segment. 

 

 

Codes can be divided as follows: 

1. Activate all documents and the code “Family.” 

2. Create three subcodes for “Family”: “Mother,” “Father,” and “Brothers&Sisters.” 

 

Splitting up a code 

A convenient way to separate the code references into the new subcodes is to bring all the coded 

segments (in our example with “Family”) into the “Retrieved Segments” window. Then, beginning 

with the first segment, click the information box left of the segment for each segment. After having 

decided which subcode the segment belongs to, you can assign the segment to the appropriate sub-

code as follows: 

 The easiest option: Click on the information box and drag it to the chosen subcode. 

Tip: During this process, the segment will be additionally coded with the subcode. However, if you 

hold down the Alt key during this process, the code will be moved from the source code to the new 

code, meaning the top-level code will be deleted. 
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 When you click on the info box, the coded segment will also be selected in the “Document 

Browser.” It can now be coded as usual, for example using Drag & Drop. 

 Alternative Method: Right-click on the selected subcode in the “Code System” window (i.e. “Fa-

ther,” “Mother” or “Brothers&Sisters” in the example above) then select Code in the context 

menu. 

When you reach the end of the list you will all have worked through all the coded segments and 

these will have been assigned new subcodes. But all segments will still be coded with the original 

code “Family” too, which is obviously not what you want. To finish the job, you have to delete these 

code references, which may seem tricky, since now deleting the code “Family” would also delete its 

subcodes – including the three subcodes that you just created. 

In effect, you need to delete not the code itself but only its references. Since the command “Delete 

Code References” does not exist in MAXQDA’s “Code System,” you have to do a work-around to 

get the desired result: 

1. Create a new code called “trash.” 

2. Right-click on the code whose references are to be removed (in this example “family”). 

3. Select Move coded segments from the context menu. 

4. Move the mouse pointer to the code “trash,” click with the right mouse button, and select Move 

coded segments from ‘Family’. 

5. Delete the code “trash.” 

9.27 Transferring the “Code System” to another Project 

It is possible to export an entire Code System, and import it into another MAXQDA project file. This 

function is especially useful as it allows you to build a “Code System” in one project, then apply it to 

another. In this case, importing and exporting the “Code System” eliminates the need to enter new 

codes. 

 Right-click on the “Code System” root in the “Code System” window and select Export Code 

System (MAXQDA format). 

 or, select Codes > Export Code System (MAXQDA format) from the main menu. 

The “Code System” will be converted into a specific file format with the extension MTR. You can 

then import the “Code System” into a new MAXQDA project with the corresponding procedure 

Import Code System. 

9.28 Importing Codes and Code Memos from an Excel Table  

MAXQDA can create a code system from the rows in an Excel spreadsheet. The reading of a code 

system from a table is useful when you want to define multiple codes in advance. 
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The first row of the table must include the keywords "Code" and "Memo". Each additional row 

corresponds to a new code and associated Memo. In the "Code" column, you can define subcodes 

using a backslash "\". 

Tip: To insert a backslash on a Mac, press alt+⇧+7. 

Example 

Code Memo 

Codename 1 Here is a text, e.g. with the code definition 

Codename 1\Subcode 1.1 Here is a text with the code definition 

Codename 2\Subcode 2.1\Subcode 2.1.1 Here is a text with the code definition 

 

When importing a table, MAXQDA proceeds as follows: 

1. The defined codes are created (if they do not already exist), whereby "Subcode 1.1" is incorpo-

rated as a subcode of "Codename 1" and "Subcode 2.1" and "Subcode 2.1.1" are incorporated 

as subcodes of “Codename 2”. 

2. For each code, the corresponding text is assigned as a code memo and appears in the second 

column. Existing code memos are retained. 

3. Code and subcode names will be shortened to 63 characters if necessary. 

9.29 Weight Scores: Indicating Segment Relevance  

When coding a document segment, you are attaching a segment of a text or image to a code in the 

“Document System.” MAXQDA also allows you to assign a weight score to each of these coded 

segments to indicate how important that particular coded segment is. It may be that certain coded 

segments represent a typical argument or theoretical concept that you want to be sure and hold on 

to. In this case, these segments are a sort of signpost. 

MAXQDA allows you to indicate how important or appropriate a segment is for the code it is coded 

with by giving it a weight score between 0 and 100. This weight score could be described as a “fuzzy 

variable,” because it is not meant to give an exact numerical worth for the segment. Rather, it is 

intended to be a guide, so you can later sort your retrievals based on the weight assigned. 

Every newly coded segment automatically receives the default weight score, which is somewhere 

between 0 and 100. 

When you use MAXQDA for the first time, the default weight will be set to 0. This can be changed 

in two places in the program: 

• In the main menu under Project > Preferences (Windows) or MAXQDA > Preferences (Mac) 
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• In the status bar at the bottom of the screen, by clicking on the Default weight icon. A dialog 

window will appear where you can set a new default weight value. The current value is always 

visible in the status bar. 

 

Changing the default weight in the status bar 

The weight of a coded segment is shown in the top right of the info box that appears next to each 

retrieved segment in the “Retrieved Segments” window. 

 

Weight score 

The “Overview of coded segments” also includes the weight scores for each coded segment. This 

weight is saved automatically, so that you can use it later to limit the results of your segment retrievals. 

Assigning Weight Scores in the “Document Browser” Window 

1. Right-click on the coding stripe for the coded segment that you would like to alter the weight 

score for. 

2. Select Modify weight. 

3. You can then enter a number between 0 and 100. 

How the weight scores are used is completely up to you. You could choose to have a system where 

a weight score of 1 is the highest or where 100 is the highest. 
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Changing the weight score in the “Document Browser” 

Assigning Weight Scores in the “Retrieved Segments” Window 

A weight score can also be assigned and modified in the “Retrieved Segments” window. Right-click-

ing anywhere on the information box left of the coded segment opens the context menu, where you 

can select Modify weight and enter a number between 0 and 100. 

 

Changing the weight score in the “Retrieved Segments” window 

You will be able to see the newly-entered weight score in the top right of the info box with the blue 

header directly after you make the change. 

 

Updated weight score 

Changing Weight Score in the “Overview of coded segments” 

In the “Overview of coded segments” table, you will find a column for the weight score of each 

coded segment. By double-clicking on a cell in the column, you will be able to enter a new weight 

between 0 and 100. 
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9.30 Creating Comments for Coded Segments  

You have the option of creating a short comment (maximum of 127 characters) for each of your 

coded segments. This might be an overview of the coded segment or a comment about its signifi-

cance for your analysis. These comments are then shown in the tooltip that appears when you hover 

the mouse over a coding stripe. 

To create a comment for a coded segment, follow these steps: 

 In the “Document Browser”: Double-click on a coding stripe or on a code name. 

 In the “Retrieved Segments” window: Double-click on the source data of a coded segment 

 In the “Overview of coded segments” or the table view of “Retrieved Segments”: Double-click in 

the “Comment” column to add a comment directly in the table. 

You can easily see if a comment has been written for a coded segment when you look at the code 

symbol. Normally the inner part of the little circle is white in color, independent of the color of the 

code symbol. When a comment is attached, the inner circle appears in the same color as the outer 

line of the symbol. 

 

A coded segment comment shown in the tooltip when hovering over the circle in the middle of a coding stripe 

Finding your Coded Segment Comments 

As long as you haven’t changed the standard view, you can find all of your code comments in the 

“Overview of coded segments” table in the second column. You can also insert new comments and 

delete/change old ones from this view. By right-clicking on the column header, you will have the 

option of clicking on the Search function. You can then start typing the first word in the comment 

you are looking for. If you want to search for a word that appears somewhere in the comment, not 

necessarily at the beginning, you can simply start the search string with the “*” symbol. 
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9.31 Overview of Codes  

It might be of interest to take a look at how many times each code was assigned to individual, mul-

tiple, or all documents. This function is called the Overview of codes and can be found in several 

places in the program: 

• In the Codes drop-down menu, 

• In the context menu at the root of the “Document System”, 

• In the context menu of a Document Group or Document Set, or 

• In the context menu of an individual document. 

A table view of all of the codes that occur in the relevant documents will appear. The table may 

contain more or fewer lines depending on the place in the program from which it was called up. In 

the title of the overview you can see which documents the overview applies to and to how many 

(different) codes in the document a segment is assigned. 

Note: When the “Overview of Codes” is called up from the main menu “Codes”, it contains also 

codes to which no coded segment is assigned. Otherwise, only codes to which at least one coded 

segment is assigned will be displayed. 

 

Overview of codes for all documents (see top left) with 33 codes (see top right) 

The other columns consist of: 

 Code – the name of the code that appears in the “Code System” 

 Parent code – Here the parent code is displayed for the easier assignment of codes. If the “Parent 

code” column is empty, the code in this row belongs to the top level of the code system. 

 Coded segments of all documents – The number of segments in the analyzed documents that 

have been coded with a particular code or subcode. 
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 Coded segments of activated documents – Takes only activated documents into account. If this 

column displays all zeros, then presumably because no documents are selected. Once you can 

activate documents, you can directly observe how the values in this column change. 

 % Coded segments of all documents – The share of segments that have been coded with the 

particular code or subcode, in relation to the total number of coded segments in column "All 

coded segments". The sum of the column is 100%. 

 % Coded segments of activated documents – As in the “All coded segments %” column, but 

takes only activated documents into account. 

 Documents – Number of documents in which the code or subcode appears 

 Code alias – Alternative name for a code with up to 255 characters, that e.g. may be exported in 

the Smart Publisher report instead of the code name itself. 

Right-clicking a row opens a context menu with various options, you can open the Overview of 

coded segments or Overview of linked memos, for example. You can also change the color at-

tribute of a code from this menu. 

A toolbar is displayed above the “Overview of codes” from which the following special functions can 

be accessed: 

  Aggregate on 1st level – Only the codes at the top level of the code system will be displayed. 

Here, the code frequencies of the subcodes are added, as well as the number of documents in which 

the code occurs. 

  Statistic – Displays the values of the columns “All coded segments” and “Activated coded seg-

ments” as a frequency table or diagram. 

9.32 The „Overview of Documents“ for a Code  

To answer the question in which documents or document groups a certain code was used, MAXQDA 

gives you the option to use the “Overview of documents.” To show this overview, right-click on a 

code and choose Overview of documents from the context menu. It makes no difference whether 

the code has collapsed subcodes or not – the “Overview of documents” takes into account only the 

code in question. 
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The “Overview of documents” in the context menu 

A tabular list of all documents that have segments coded with the chosen code will open. In the 

following example, the code “Day-to-Day Issues\Emotions” was used in ten documents and two dif-

ferent document groups. The column “Number of coded segments” shows how many coded seg-

ments were found in each document. 

 

“Overview of documents” for a code 

In addition to the usual symbols above the overview, which include the functions for filtering rows 

and for export, the Aggregate to document groups  function is available. This function restricts 

the display to include only the document in which the selected code appears. 
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Taking the example above, after clicking the button, the table will consist of two rows with the doc-

ument groups “New York” and “Indiana.” The number of coded segments will be added up: 

 

Aggregating to document groups 
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10 Creative Coding: Arranging Codes in MAXMaps 

10.1 The Idea behind Creative Coding  

During open coding, researchers may create many codes, which, in hindsight, vary greatly in their 

scope and level of abstraction. Creative Coding effectively supports the creative process in which 

these codes are generated, sorted, and organized, and in which a hierarchical code structure is cre-

ated based on the relationships between codes. The function provides a large working surface on 

which you can move codes and form meaningful groups. You can place codes that belong together 

next to one another, insert parent codes, rename codes and adjust their color, and create a logical 

structure. As a rule, this results after a long period of open coding and working with the codes. 

The functionality of Creative Coding is fully integrated in MAXMaps and is carried out in three steps: 

First, drag the codes you wish to work with from the Code System onto the work surface of MAX-

Maps. 

Next, group and organize the codes, create parent and subcodes, create new codes if necessary, and 

adjust the color of the codes as desired. 

Finally, transfer the changed to the existing Code System. 

10.2 Starting Creative Coding and Selecting Codes 

To start Creative Coding, select Codes > Creative Coding from the main menu, upon which MAX-

Maps will open in Creative Coding mode and the following display will appear: 

 

Selecting Codes for Creative Coding 

Note: In Creative Coding only those top level codes will be displayed, that have a maximum of two 

subcode levels. All top level codes with more than two subcode levels are not available. 
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Now, single codes can be dragged from the code tree into the white work surface on the right with 

the mouse. If you select a code with subcodes, MAXQDA will insert the subcodes automatically on 

the work surface. 

 

Selected codes for Creative Coding 

To remove a code from the work surface, right-click the code and select Remove from map . 

After completing your selection, click the Start organizing codes button at the top left of the screen. 

Note: While MAXQDA is in “Creative Coding” mode, the MAXQDA application is blocked and no 

further changes can be made to the open project until Creative Coding is finished. 

10.3 Organizing Codes 

Once you click on the Start organizing codes button, the structuring and organization of the codes 

begins. Here the display will change: The code tree on the left will close and a color panel will appear 

on the right that displays all of the colors currently in use. 
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Organizing Codes on the MAXMaps work surface 

All codes can be freely arranged on the work surface with the mouse, as long as you are in Select 

mode . You can move multiple codes at once by drawing a border around them with the mouse 

and then positioning them as desired. 

The following options are available in Creative Coding: 

• Creating relationships between codes 

• Creating new codes 

• Merging Codes 

• Modifying code colors 

• Undoing changes 

• Displaying coded segments and code frequency of a code 

Creating Relationships between Codes 

As displayed in the image above, relationships between codes are shown with an arrow: When an 

arrow is pointing at a code, it means that this code is a subcode of the other. 

To make Code A a subcode of Code B, proceed as follows: 

1. Go into “Link” mode by clicking the Link  symbol. 

2. Click on the desired top-level code and draw an arrow to the desired subcode. 

To avoid the occurrence of circular references, existing assignments of the subcode to other codes 

are repealed. 

To delete an arrow, right-click on it and select Remove from map. 
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Creating new codes 

Users often wish to group multiple codes under an abstract concept. For this purpose, you can always 

create new codes by clicking Insert new code . MAXQDA will subsequently insert the new code 

in the top left of the work surface. 

As per usual, you can rename the code by double-clicking on its label. 

Merging Codes 

To merge two codes, proceed as follows: 

1. First, go into Select mode by clicking on the Select  symbol 

2. Drag the first code onto the second code so that the “Merge codes” tooltip appears. When you 

release the mouse button, the following confirmation message will appear: 

 

Confirmation message for merging of codes 

After clicking Yes, the moved code will disappear from the map and all its coded segments will be 

assigned to the target code upon exiting Creative Coding. 

If you choose Don’t ask again, the inquiry for the merging of codes will no longer appear in the 

current Creative Coding session. 

Changing Code Color and Appearance 

The color and appearance of codes can be modified as follows: 

1. First, go into Select mode by clicking on the Select  symbol 

2. Click the code whose color you wish to change. To select multiple codes at once, draw a border 

around the codes with the mouse or click on each code while holding the Ctrl key (Windows) or 

cmd key (Mac). 

3. Click on a color in the color panel on the right to select a color already in use. Alternatively, you 

can assign a new color from the color panel. 

If you change the color of a parent code, the color of the subcodes will also be changed following 

confirmation. If you create a new color, MAQDA will apply this new color to selected codes automat-

ically. 

To modify the appearance of an individual code, double-click on the code. A dialog window will 

appear in which you can define the font size, symbol size, etc. 
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Undoing changes 

Recent actions can be undone step-by-step by clicking the Undo changes  symbol. 

Displaying Code Frequency and Coded Segments of a Code 

In order to organize codes, it can be helpful to visualize the number of each of the associated coded 

segments. By clicking the Display code frequency  symbol, the code frequency will be automati-

cally displayed in brackets after the code name. 

When you right-click on a code, a context menu will appear from which you can access the following 

options: 

 Memo – Opens the associated code memo. 

 Overview of coded segments – Opens the “Overview of coded segments” where you can in-

spect the coded segments of the code. 

 Overview of linked memos – Opens the “Overview of memos” where you can browse all memos 

of the selected code. 

Note: Any changes you have made in Creative Coding mode have not yet been transferred to the 

MAXQDA Code System. The changes will be applied only once you quit Creative Coding. 

Save Current State of the Work as regular MAXMap 

Working on the code structure with Creative Coding may take some time and may include different 

stages of development. While you start with arranging codes in groups first, you possibly are merging 

codes and creating new higher level codes later on. To track these different stages MAXQDA allows 

you to save the current status of your work as a regular MAXMap: just click on the icon  Save copy 

of current Creative Coding map as standard MAXMap. The map will be available after quitting 

Creative Coding when you start Visual Tools > MAXMaps from the main menu. 

10.4 Quitting Creative Coding and Transferring Changes to 

the Code System 

Changes made in Creative Coding mode will be applied only once you quit Creative Coding. After 

completing the organization of your codes, you must quit Creative Coding in order for the changes 

to be applied to the Code System. To do so, click the Quit Creative Coding button in the top left of 

the window. The following message will appear: 
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Quit Creative Coding 

The following options are available: 

Yes – The code structure will be transferred to the existing Code System 

 All codes from the Creative Coding work surface that do not have a parent code will be 

sorted alphabetically and inserted at the top of the Code System. This applies also to newly 

created codes. 

 Subcodes will be inserted according to their hierarchical position. 

 Any color changes to codes will be applied. 

 Merged codes will be merged, i.e. the origin code will be deleted and its coded segments 

will be moved to the target code. If the deleted code contained a memo it will be converted 

to a free memo, that can be accessed in the „Overview of memos“. 

 The Creative Coding map will be converted into a normal MAXMap. 

No – Creative Coding will be closed without transferring the changes to the Code System. This means 

all changes will be lost! 

Cancel – Returns to Creative Coding. 
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11 Intercoder Agreement 

11.1 The Problem of Intercoder Agreement in Qualitative 

Research 

When assigning codes to qualitative data, it is recommended that certain criteria be set. You assume, 

for example, that coding is not arbitrary or random, but rather that a certain level of reliability will be 

reached. The MAXQDA “Intercoder agreement” function makes it possible to compare two people 

coding the same document independently of each other. In qualitative research, the purpose of com-

paring independent coders is to discuss the differences, figure out why they occurred, and learn from 

the differences in order to improve coding agreement in the future. In other words, the actual per-

centage of agreement is not the most important aspect of the tool. This percentage is, however, 

provided by MAXQDA. 

It is always the goal of qualitative analysts to achieve as high a level of agreement as possible between 

independent coders. It is not, however, focused on getting to a standard coefficient that is statistically 

necessary as in quantitative research. Rather, the focus is on a practical improvement of the coding 

quality. For this reason, one doesn’t focus on the coefficient or percentage of agreement. Instead, 

qualitative researchers want to address and edit the coded segments that do not agree, so that they 

can move on with more accurately coded material. 

The Intercoder Agreement tool is set up to compare and contrast a single document coded by two 

independent coders, highlighting the areas where the two researchers’ coded segments align and do 

not align. It is then possible for these two coders (or a larger research team) to decide which coding 

variation in each situation is most accurate. 

11.2 The Agreement Testing Concept in MAXQDA  

The Intercoder Agreement function in MAXQDA works as follows: 

1. Two people code the identical document independently of each other with the agreed upon codes 

and code definitions. This can be done on the same computer or on different computers. The most 

important thing is that the two coders can not see how the other has coded. It makes sense to 

name each document in a way that makes it clear, who has coded which (e.g. “Interview1_Mi-

chael” and Interview1_Jessica.” 

2. To test the two documents, they must both be in the same MAXQDA project. This can for example 

be accomplished using the function Project > Merge projects, as long as both coders have been 

working with the same documents in each project. 

You can now start the Intercoder Agreement function by selecting it from the Analysis drop-down 

menu. The Intercoder Agreement will show where the assignment of codes by the two coders match 

and do not match. 
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Starting the Intercoder Agreement function via the Analysis menu 

Caution: If you only want to check the agreement of certain codes, activate those codes before 

starting the test. 

1. Select the first coder’s document from the “Document 1” list and the second coder’s document 

from the “Document 2” list. 

2. If you only want to test the activated codes, you can check the box at the bottom left of the 

window next to Only for activated codes. 

3. You can then choose between three different analysis criteria for the agreement test: 

Variation 1 – Code existence in the document 

The criterion in this variation is the presence of each code in the document, meaning whether or 

not each code is found at least once in the document. This variation is most appropriate when 

the document is short, and there are many codes in the “Code System.” 

Variation 2 – Code frequency in the document 

The criterion in this variation is the number of times a code appears in each coder’s version of the 

document. 

Variation 3 – Segment agreement in percent 

In this variation, the agreement of each individual coded segment is measured. This is the most 

precise criterion and is used most often in qualitative research. You can set the percentage of 

agreement that is required in each segment for it to be considered in agreement (correlation). The 

tool takes each segment and evaluates the level of agreement between the two documents. 
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Testing intercoder agreement based on segment agreement in percent 

The screenshot above shows the Intercoder Agreement window, which shows that “Interview Mary 

_ Elizabeth” will be compared with “Interview Mary _ Ian.” The third variation is selected, meaning 

agreement will be tested at the segment level, and the required agreement percentage to be consid-

ered “in agreement” or “correlating” is 90. 

Results for Variation 1 

The Code Matrix Browser window will appear only for the two documents that are being compared. 

The Code Matrix Browser is set to visualize whether or not each of the codes exists in the two docu-

ments. If the code exists, a blue circle or square will be shown in that document’s column. 

 

Testing the existence of codes in two documents 

The screenshot shows the results. Codes such as “Day-to-Day Issues” and “Key Quotes” exist in both 

of the documents, but the code “Interview Guide Topics” only exists in the document coded by Ian. 

Clicking on one of the blue squares selects the corresponding document in the “Document Browser” 

and the corresponding code in the “Code System.” Double-clicking on the squares activates the 

document and the code, and lists the segment in the “Retrieved segments” window. 

At the top of the results window, you can see the percentage of agreement. In this case, there is a 

correlation of 57.14%. When calculating the percentage of agreement, the non-existence of a code 

in both documents is also considered a match. 



Intercoder Agreement 

 

165 

Note: If you have selected the option Only for activated codes and have activated only the subcodes 

of certain codes, the parent codes will be included when calculating the percentage match and in the 

display of information. 

Results for Variation 2 

The results for the second variation are also shown in the Code Matrix Browser for the two documents 

to be compared. Results can be viewed either as symbols or as numbers. It is then fairly easy to see 

where there is agreement between the documents. The correlation percentage is shown again in at 

the top of the results window. For each code, the number of times it appears in each document is 

compared. If the number is the same, there is agreement. If the number is not the same, there is 

disagreement. It makes no difference in this case whether the difference between the two numbers 

is 1 or 100. 

Tip: MAXQDA calculates Intercoder Agreement in percent for the first two variations as follows: 

Percentage of Agreement 

   = # of agreements / (# of agreements + # of non-agreements)  

   = # of agreements / # of rows 

Results for Variation 3 

This is the most complicated variation, since intercoder agreement is tested on the segment level. If 

the first document has 12 coded segments and the second document has 14, there will be 26 tests 

carried out and presented in 26 rows of a table. 

It is necessary to decide how similar the coded segments must be to be considered in agreement. As 

a match criterion, the percentage of the overlapping portion of the coded segments is defined. The 

percentage of agreement that results represents the relative share of the matching area in relation to 

the total area of two coded segments, which is illustrated schematically in the following diagram: 

 

The percentage threshold can be set in the dialog window. The default value is 90%. 

Two results tables are created: the code-specific results table and the detailed agreement table. 
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The Code-Specific Results Table 

 

The Intercoder Reliability results for the individual codes 

This table is made up of one row for each code that was included in the test. Codes that do not 

appear in either of the documents will be ignored. It shows the level of correlation between the two 

coders for each code. This can make clear, for example, if certain codes are in disagreement more 

than others. Every code is shown in a row with the number of times its use in the first document 

correlated with the use of the code in the second document, the number of times they did not cor-

relate, and the total percentage of correlation. 

The Detailed Agreement Table 

The second results table allows you to see exactly which coder coded which segment and whether 

the coded segments correlate. A red icon in the first column shows that the coded segments do not 

agree. Clicking on the column header sorts the rows, showing all the non-correlating segments first, 

so the coders can analyze and discuss each of them step-by-step. 

By double-clicking on the box in the “Document 1” column, you can open that document and call 

up the exact document segment in question in the “Document Browser.” Double-clicking on the 

square in the “Document 2” column brings up the segment in the Document Browser as well, show-

ing the place where the correlating (or non-correlating) coded segment is. You can now very easily 

switch back and forth between the documents to analyze which of the coded segment variations is 

the most accurate. 
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Results table for all coded segments 

Coefficient Kappa for exact segment matches  

In qualitative analysis, the analysis of the Intercoder agreement serves primarily to improve coding 

instructions and individual codes. Nevertheless, it is also often desirable to calculate the percentage 

of agreement, particularly in view of the research report to be generated later. This percentage of 

agreement can be viewed in the code-specific results table above, in which individual codes as well 

as the ensemble of all codes are taken into account. 

Researchers often express the desire to indicate not only percentage compliance rates in their research 

reports, but also to include chance-corrected coefficients. The basic idea of such a coefficient is to 

reduce the percentage of agreement to that which would be obtained in a random assignment of 

codes to segments. 

In MAXQDA, the commonly used coefficient “Kappa” can be used for this purpose: In the results 

table, click on the  Kappa symbol to begin the calculation for the analysis currently underway. 

MAXQDA will display the following results table: 
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Intercoder coefficient Kappa 

The number of codes that match is displayed in the upper left corner of the four-field table. In the 

upper right corner and the lower left corner you will find the non-matches, meaning one code, but 

not the other, has been assigned in a document. In MAXQDA the Intercoder agreement at the seg-

ment level takes into account only the segments to which at least one code has been assigned; there-

fore the cell on the lower right is, by definition, equal to zero (as document sections will be included 

in the analysis only if they are coded by both coders). 

P(observed) corresponds to the simple percentage of agreement, as it was displayed in the <Total > 

line of the code-specific results table. 

For the calculation of P(chance), or chance of agreement, MAXQDA employs a proposal made by 

Brennan and Prediger (1981), who dealt extensively with optimal uses of Cohen's Kappa and its prob-

lems with unequal edge sum distributions. In this calculation, the random match is determined by the 

number of different categories that have been used by both coders. This corresponds to the number 

of codes in the code-specific results table. 

For the calculation of coefficients such as Kappa, segments must normally be defined in advance, and 

are provided with predetermined codes. In qualitative research, however, a common approach is that 

not to define segments a priori, but rather to assign the task to both coders of identifying all docu-

ment points that they view as relevant, and to assign one or more appropriate codes. In this case, the 

probability that two coders code the same section with the same code would be lower, and hence 

Kappa would be greater. One could also argue that the probability of randomly occurring coding 

matches in a text with multiple pages and multiple codes is so insignificant that Kappa corresponds 

to the simple percentage agreement. In any case, the calculation should be carefully considered. 
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12 Memos: Managing Your Ideas 

12.1 About Memos 

MAXQDA makes it possible for you to create “Post-It”-like notes with your ideas, comments, etc. and 

to attach them to document segments, documents, document groups, images, or codes. These notes 

are called memos in MAXQDA. These memos can have various functions: they are commonly used, 

for example, as an integral part of Glaser and Strauss’s Grounded Theory analysis method. You can 

also differentiate between various types of memos within MAXQDA that then have different roles in 

your analysis. It is important to recognize the difference between memos and the qualitative data: 

documents are analyzed and coded, but they are usually not changed radically once the analysis has 

begun – most typographical errors have been eliminated. 

Memos, on the other hand, are a dynamic form of text. They are created by the user and can be 

modified and integrated at any time during the analysis process. 

In MAXQDA memos can be attached to 

 documents 

 document groups 

 audio and video files 

 codes. 

There is also the option of creating a “free memo,” which is not attached to anything other than the 

project. These free memos also come out of Grounded Theory, which has memos without any con-

crete connection to a part of the data. 

12.2 Memos Attached to Document Segments  

MAXQDA offers several different ways to create a new memo in the "Document Browser": 

Creating a Memo by double-clicking in the Memo column 

Move the cursor to the memo column, located to the left of the open document, then double-click 

at the height you wish to attach the memo. 
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Creating a new memo by double clicking in the memo column 

All memos in the document browser are associated with a position on the document. When you 

create a memo by double-clicking in the memo column, it will automatically be attached to the doc-

ument body at the level of the click position in the left margin. In MAXQDA, memos can be easily 

recognized by their yellow icon: 

 

Yellow memo icon in the memo column 

Creating Memos using the Context Menu or Quick Button 

Other ways to add a new memo are to select the position in the document, right-click with the mouse 

and select New memo from the context menu, or the Quick button  from the coding toolbar. 

MAXQDA will insert a memo in the memo column at the selected position in the document. 

Tip: In the “Document Browser,” memos can be moved using the mouse – of course, only within the 

memo column. MAXQDA will display the original position of the memo while it is being moved. The 

memo’s original position within the document will be cancelled when the move is complete. 

The number of memos per document and per position within the document is not subject to practical 

limitations, which means you can create several memos at the same level in the Document Browser. 

MAXQDA will automatically place the memos side-by-side. 

Note: If you delete text to which a memo is attached while in Edit mode, the memo will be retained 

and automatically assigned to the preceding text. This operation is intended to prevent valuable per-

sonal notes from being deleted unintentionally. 
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Recording Information in a Memo 

Immediately upon creating a new memo, the memo window will appear: 

 

The memo window 

You can now enter a title for the memo, so that you can easily find it later in the “Overview of 

memos”. Select a meaningful title for simple identification. 

Tip: The memo title also appears in the tooltip that appears when you hover the mouse over the 

memo symbol in the “Document Browser.” 

The memo text can be entered in the bottom field of the window. 

12.3 Viewing and Editing Memos  

Opening and editing memos 

When you move the mouse over a memo symbol in MAXQDA, a tooltip will appear with the title, 

author and creation date of the memo, as well as the label assigned to the memo type and the 

beginning of the memo text. 

To view and edit a memo, double-click with the left mouse button on the memo icon. The following 

memo window will appear:. 
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The Memo Window 

 

The Memo Window 

When creating a memo, you can simply move from one field to the next, entering all the information 

that is required. MAXQDA automatically inserts the currently logged in user as the “Author,” so that 

you can later find all memos by author. You also have the option, though, of changing the name in 

this field. The memo’s “Creation date” is also inserted automatically. 

Ever memo can be given the standard yellow “Post-It”-style symbol or one of the 10 other available 

symbols. These options allow you to indicate what type of memo it is. The following visualizations are 

available: 

 

Memo visualization options 

Choosing different visualizations for differing types of memos is up to each user. Those using 

Grounded Theory, for example, might choose to use the visualization with a “T” to represent theo-

retical memos, the visualization with an “M” for method memos, etc. 

Tip: Since the meanings of the memo visualizations are assigned individually, you can indicate the 

function or significance of each memo visualization in the current research project in the Type Label 

text box. Please note that it is possible to edit this field in any open memo; any memos of the same 

type will be amended accordingly. 

The memo itself is entered in the large text window. You can include the creation or modification 

date in the body of the memo by clicking the  symbol. 
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Using the Clipboard 

When working with memos in MAXQDA, the Windows clipboard can be used in the same way as 

with text documents. This makes it easy to exchange text between MAXQDA and word processing 

programs. 

The clipboard may be used in two ways: 

 Text can be imported into the text field of a MAXQDA memo. For example, a Word text file can 

be attached to a specific text passage as a memo and consequently managed by MAXQDA. 

 Text can be exported from a MAXQDA memo. Select the memo text or a part of it, copy it to the 

clipboard, and paste it into the word processing document. 

Tip: If you want to insert a section of text from another document, you can simply copy it and paste 

it into the memo field. You can also simply highlight the text and drag it in. 

The Toolbar in the Memo Window 

Wherever you see a memo, you can double-click on it to open it. In the toolbar at the top of the 

memo window, you have the following functions: 

 Display search toolbar – Opens another toolbar that allows you to browse the open memo. 

 Delete Memo – Deletes the memo after confirmation. 

 Link to code – Assigns the memo a code from the Quick list of codes. 

 Remove link to code – Removes selected codes from the “Linked Codes” window. 

 Print – Prints the selected memo. 

 Export – Exports the displayed memo as a text document in RTF format, which can be opened in, 

for example, Word. 

Save Memo Content 

MAXQDA saves all the information that was entered in the Memo window when you close it. In 

addition, the open memo window is saved automatically at regular intervals. You can adjust the de-

fault value of 5 minutes under Project > Preferences (Windows) or MAXQDA12 > Preferences 

(Mac). 

Open Multiple Memos as Tabs 

Tip: You can pull individual tabs out of the Memo window with the mouse, so you can view multiple 

memos at the same time, each in their own Memo window. Alternatively, you can click Dock win-

dow  symbol, which will also bring up a new Memo window. 
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Multiple open Memos in Tab display 

Copying Memos 

You can duplicate a memo by right-clicking on it and selecting Copy Memo. Then, right- click again 

in a space where a memo can be inserted – such as in the memo column or in the Document or Code 

System – and select Paste Memo. 

Deleting Memos 

You can delete an entire memo by clicking the corresponding Delete button. MAXQDA will prompt 

you for confirmation before the memo is deleted. 

Tip: You can delete a memo directly by right-clicking on the memo symbol and selecting Delete 

memo. 
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Delete a memo via the context menu 

12.4 Creating Document Memos in the “Document System”  

Memos can also be attached to all items in the “Document System”, including individual documents, 

document groups, document sets, or the entire project. However, only a single memo can be attached 

to an item, with the exception of within a document. 

There are several options for creating a new memo in the “Document System:” 

 Right-click on a level of the Document system and select the Memo option from the context menu. 

• Alternatively, you can create a memo for the currently selected document or level using the key-

board shortcut Alt+Shift+M. 

• The fastest way is to create a new memo is to double-click in the memo column to the left of the 

code frequencies. 
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Creating a memo for a document from the context menu 

The memo text field is exactly the same as that of a memo for a text passage, and the author and 

date will be entered automatically. The memo will automatically assume the document name as its 

title; this can be changed at any time. 

Once created, the memo icon will appear next to the entry in the “Document System” and can be 

opened and modified by double-clicking on it. 

 

Visualization of a memo in the “Document System” 

A memo attached to the top level of the project can be used to retain a description of the entire 

project. The memos of individual texts can be used to store immediately accessible summaries of these 

texts. You can see the first few lines of a memo by hovering your mouse over it until a tooltip appears. 

It is, therefore, a good idea to include the most important aspects of a memo in the first few lines so 

that they will be displayed immediately when you hover the mouse. 

12.5 Creating Code Memos in the “Code System”  

MAXQDA also allows you to attach memos to codes. These memos often contain category definitions 

and anchor examples. 

There are several options for creating a new memo in the Code System: 
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• Right-click on a code and select Memo from the context menu. 

• Alternatively, you can create a memo for the currently selected code using the keyboard shortcut 

Alt+Shift+M. 

• The fastest way to create a new memo is to double-click in the memo column to the left of the 

code frequencies. 

Example 

Let’s say that you wanted to create a memo with a code definition – and later for an anchor example 

– for the code “Insurance.” You would just need to right-click on the code in the “Code System” and 

select Code memo. The memo window then appears, where you can customize the memo as per 

usual. 

 

Creating a code memo 

After closing the memo, you will see a yellow memo symbol next to the code in the “Code System”, 

making it easy to recognize that this code has a memo attached to it. 

Tip: For code memos, you will often want to insert an anchor example or explanation of when the 

code should be used. To insert parts of an open text in a memo, simply highlight the desired text, 

then drag and drop it into the memo with the left mouse button. 

As with other memo types, you can choose another one of the visualization options in the place of 

the default yellow memo icon. The selected icon will appear next to the code in the “Code System”. 

12.6 Printing and Exporting Individual Memos 

Individual memos can be printed or exported. In the memo window, there are icons for both: Print 

 and Export . 
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Clicking the Print icon will open the print preview window, where you can define the header, mar-

gins, etc. The memo title is set as the heading, and the author and creation date/time are listed 

underneath it. 

It is also possible to export the entire memo as in RTF format for a word processing program. Click 

on the Export icon  to export the memo. In this case, you must select a file name under which the 

memo will be saved. 

NY Interview Notes 

 

Document group  New York 

Author  Marissa 

Creation date 11.02.2011 09:52:38 

 

There were very few interruptions during our interviews in NY. All of them took between 60 and 90 minutes, 

and none of the interviewees seemed overly nervous to be talking to us. 
 

An exported memo 

12.7 Managing Memos in the “Overview of memos”  

Memos aren’t only accessible from their location next to documents, codes, document segments, etc. 

They are also available as an “Overview of memos”. You can access these overviews in various ways. 

An overview of all memos in the entire project can be called up by selecting Analysis > Overview of 

memos or by clicking on the  symbol in the “MAXQDA standard” toolbar. 

In addition, contextual listings of memos in the "Document System" and “Code System” are availa-

ble. If you select Overview of memos from the context menu of a document group, MAXQDA lists 

all of the memos assigned to the documents themselves. In the context menu for a code, there is an 

Overview of linked memos option, which provides a list of all of the memos assigned to the se-

lected code. 

However you open the “Overview of memos,” a table will appear with a list of the requested memos. 

Each row represents one memo. 

Tip: If you click on the row of a text memo, the text to which the memo is attached will be displayed 

in the “Document Browser”, and will be positioned at exactly the point where the memo is located. 

Double-clicking on the row will open the memo for editing. 
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The “Overview of memos" 

The columns in the table contain all important information about the memo, including: 

 The name of the document and document group in which the memo is found (or the name of the 

code in the case of a code memo). 

 For memos attached to document segments, the paragraph number of that segment is listed. 

 The author of the memo. 

 The creation date. 

 A preview of the memo text made up of the first 63 characters 

 The origin of the memo (e.g. the document, document group, document segment, or code the 

memo is attached to). 

The upper section of the window displays the memo text, so that various memos can be scrolled 

though without opening individual memo windows for each. Memos cannot be modified or deleted 

in the “Overview of memos”. Instead, right-click on the line where the memo is listed and select 

Delete Memo. 

Note: To modify a memo, double-click on the line where it is located. The usual memo window will 

open, and from here you can modify or add to the memo text. 

Sort Overview of Memos and Customize View 

As with all tables in MAXQDA, the table columns can be moved into a different order. Simply click 

the column header and hold the mouse button as you move the column into the desired position. 

Table columns can be hidden by right-clicking the column header and selecting Hide. You can also 

choose which columns should be included in the table. By right-clicking on any of the column headers, 

you will have the option to choose Select fields. You can then check the box next to the columns 

that you wish to view and uncheck the boxes of any columns you want to hide. 
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The table can be sorted in ascending or descending order, using any column as the sort criterion. To 

access this function, click the column header. For example, if you click on the “Document Group” 

column header, the table will be sorted in ascending order of document groups, beginning with A. If 

you click the column header again, the table will be sorted in descending order of document groups 

beginning with Z. 

The same applies to all data fields: If you click on the “Creation date” column header, the memos 

will be sorted according to the dates they were created. If you click on the “Author” column header, 

all memos written by an author will appear in succession. 

Filtering the “Overview of Memos” 

As with all overviews in MAXQDA, the tabular Overview of Memos can be sorted according to diverse 

criteria. This is especially handy if you want to compile only the code memos of a project or user, or 

only the memos that were created after a certain date. 

For example, to compile all of the code memos for a project, proceed as follows: 

1. Open the “Overview of memos” with all memos. The fastest way to do so is to click on the  

symbol in the standard toolbar. 

2. Right-click on the “Origin” column heading and select Filter. 

3. In the dialog box that appears, select “Contains” and enter “Code”: 

 

Filtering the “Overview of Memos” 

4. When you click OK, MAXQDA will list the code memos of the project only. 
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Listing of all code memos in a project 

Browsing the “Overview of memos” 

It is also possible to search in the various columns. To search in a specific column, right-click on the 

column header and select Search. The instances where the search term appears are immediately high-

lighted, and the up and down arrows allow you to navigate between memos. To search multiple 

columns simultaneously, select the Choose search columns option. When you use the magnifying 

glass symbol  in the “Overview of Memos” toolbar, the search will automatically be carried out in 

all columns. 

Note: When you search the “Preview” column, only the only the first 63 characters of the memo will 

be included in the search. If you want to search the entire memo text, select the option Analysis > 

Lexical search. 

Creating a New Free Memo 

In the "Overview of memos" toolbar you will find the New free memo icon . You can create a new 

free memo, which is not assigned to any particular document, code, or text by clicking on this icon. 

Alternatively, you can create a new free memo by selecting Analysis > New free memo from the 

main menu. 

Free Memos are visible in the "Overview of memos" only when all memos from the project are in-

cluded. 

Jumping from the “Overview of memos” to a Memo 

From each memo displayed in MAXQDA’s “Overview of Memos”, you can jump to the position in 

the document that the memo is attached to. You need only click on the desired memo with the left 

mouse button. The source document immediately appears in the “Document Browser” positioned 

exactly at the place where the memo is found. 
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This option only works with memos attached to document segments, of course. If you click on a code 

memo, the “Document Browser” remains unchanged, but the code is highlighted in the “Code Sys-

tem.” The same happens with memos that are attached to objects in the “Document System.” 

 

Jumping from a memo to its position in a document 

12.8 Searching for Text in Memos  

While a targeted search for a specific memo based on attributes such as “Document name”, “Au-

thor”, “Creation date”, or “Memo title” is realized within the “Overview of memos”, the search for 

actual words or strings in the memos themselves is realized using the Lexical Search function - unless 

a standard search in the “Preview” column, which includes the first 63 characters of the memo, is 

sufficient. 

To search in the memo text, select Analysis > Lexical Search and enter the search word or words. 

If you want to search in the memos, you must specify In memos as the search criterion in the Lexical 

Search window; otherwise the search will take place in the documents themselves. 
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Searching for “health” in the project memos 

The results are shown as a list of all memos that contain the search string in the memo text. This table 

can be worked with as described above. You can sort, jump to the document, edit the memos, etc. 

Tip: A single click in the results table will highlight the memo in MAXQDA and in case of an In-

Document Memo the “Document Browser” will be scrolled to the memo icon. A double click will 

open the memo and highlight the search hit. 

12.9 Exporting a Selection of Memos  

The result of a search for specific words in memos is a table listing all the memos containing the 

words. The same type of result, memos in a table, is obtained through a search for linked memos or 

when viewing the memos attached to a document or document group, as described above. 

These tables of memos can be exported, that is saved as a file to be opened with another program. 

You can save the table in XLS/X, RTF, or HTML format. Click on one of the Export buttons located in 

the upper left corner of the dialog box, and choose appropriate the format. 

The exported RTF file appears as follows: 
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Title  Life strategy and mental health 
Document New York\Vincent 
Paragraph 9 
Author  Marissa 
Creation date 12.02.2011 
 
 
Again, this touches on Vincent's life strategy. He is able to maintain “strong mental health” and have a positive 
attitude even though he realizes he's “an accident waiting for a place.” Again, it seems like his previous life 
strategy enabled him to successfully deal with the situation. 
 
Is it just Vincent's PMA that enabled him to cope, or is there something more? Other people use religion or a 
support network (friends, family, etc.) to get through tough situations - is that the same sort of thing going 
on??? 

 

Part of an exported memo table in RTF format 

Here you see all the information contained in the memo, such as memo title, creation date, and linked 

codes as well as the memo text itself. The exported RTF file can be opened in your word processing 

program to add layout features like headers and footers. 

If you choose HTML or XLS/X as the export format, MAXQDA creates a table that is immediately 

opened in your default web browser such as Internet Explorer or Excel. It is also easy to print out the 

list in these formats. 

 

Results of a memo export in HTML format 

Note: The entire table with all of your memos will be exported unless you have selected some of the 

memos, which are then marked green. You can select a single menu by clicking on it with your mouse. 

If you want to select more than one, hold the Ctrl (Windows) or cmd (Mac) button as you click on 

them. If you want to select a number of memos that are right next to each other in the list, click on 

the first one, hold Shift, and then click on the last one. All of the memos in between the first and the 

last will also be included in the selection. 
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Selected memos are green in the memo table 

12.10 Linking Codes to Memos  

Similar to document segments, memos can also be linked to a code. You can do this via the Code 

Quick List, which is symbolized by the blue arrow in the memo toolbar. Clicking on this symbol opens 

the most recently-used codes, so you can choose which ones to assign to the memo. If the code you 

are looking for is not in the Quick List, simply click on the code in the “Code System” and try again. 

The code should now be listed at the top of the list. 
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Linking a memo to a code 

The linked code is then displayed with its complete path (code\subcode\subcode) in the Codes area 

in the top right of the memo window. 

If you later decide to remove a linked code, simply click on the code in the memo window and click 

on the toolbar symbol of the blue arrow with a red x on it. 

12.11 Viewing Memos Linked to a Code 

Codes can be linked to memos in order to indicate what the memo is about. Of course, you can 

choose a descriptive title for a memo, based on the content of the memo, but to attach codes is a 

more systematic way to attach more thematic topics than could be formulated in a memo’s title. 

To find all memos that are linked to the same code, right-click on the code in the “Code System” and 

select Overview of linked memos from the context menu that appears. 

The result is a table of memos. The table contains all the memos to which the code is attached. As 

usual, double-clicking on a row opens the memo and a single click brings the source document into 

the “Document Browser” window. 

The table can be sorted according to its columns and it can be exported to other programs. 
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12.12 Compiling Memos of a Specific Document or Document 

Group 

The memos belonging to a particular document group, document set, or document can be viewed in 

a table. Right-click on the selection and choose Overview of memos from the menu that appears. 

MAXQDA will then open a “Overview of memos” table containing all the memos attached to these 

document(s). As with the “Overview of memos”, it is possible to sort the table, search in the different 

columns of the table, jump to the source document, and export the table or parts of it to an external 

file or to the clipboard. 

12.13 Converting a Memo into a Document 

Since memos are used to assist in the development of ideas and hypotheses, it could happen that 

they quickly become very important to your analysis. In some cases, these memos may be important 

enough that you wish to convert them into documents, so they can be analyzed and coded. It is only 

possible to associate an entire memo with codes, while every single character of a document can 

theoretically be coded as many times as needed. 

To convert a memo into a document, follow these steps: 

1. Open the “Overview of memos” by selecting Analysis > Overview of memos 

2. Right-click on the memo to be transformed 

3. Select Convert to a document 

The newly-created document will now be listed as the first document in the “Document System.” 

The first lines of the document are the former memo’s title, author, and creation date. 

Tip: The function is also available in the context menu of any memo symbol. Right-click on a memo 

icon in MAXQDA and choose Convert to a document to transform the memo into a document in 

the „Document System“. 
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13 Variables 

13.1 Document and Code Variables in MAXQDA 

MAXQDA differentiates between “document variables” and “code variables”: 

Document Variables  

Document variables are associated with an entire document, (e.g. the person interviewed in an inter-

view transcript). In these cases, you can assign socio-demographic information like gender, age, ed-

ucation level, etc. that can then be analyzed in conjunction with the actual text. 

In the following example, the age and gender of all five respondents was noted, in addition to 

whether they were members of an NGO: 

 

Example of application of Document Variables 

Code Variables  

The development of code variables in MAXQDA makes it possible for you to define variables within a 

document and to use their values as selection criteria during the evaluation process. In this way, you 

can, for example, activate codes by defined criteria. 

13.2 The “List of document variables” and the “List of code 

variables”  

MAXQDA allows you to add variables to each document and code. 

Two views are available from which to manage variables: The “List of variables” and the “Data edi-

tor.“ In the “List of variables,” all variables defined within the project are listed in a table. The “Data 

editor“ presents the data table as a square matrix showing “Rows x Columns,” similar to a statistics 

program. The documents or codes are displayed in the rows of the table, with the variables being 

displayed in the columns. 
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The “List of document variables” 

The “List of document variables” can be called up from the menu Variables > List of document 

variables. 

When you open the “List of document variables” in a newly created project, the system variables 

displayed in the image are already defined: 

 Document group – contains the name of the document group that a particular document is a 

part of 

 Document name – contains the name of the document 

 Creation date – contains the date the document was imported/created 

 Number of coded segments – contains the number of coded segments in the document 

 Number of memos – contains the number of memos in the document 

 Author – the user that was logged in when the document was imported or created 

 

System Variables in the “List of document variables” 

The system variables are indicated with a red symbol in the first column of the list of variables. System-

defined variables cannot be modified or deleted. User-defined variables are indicated with a blue 

symbol in the first column - these variables can be modified or deleted as desired. 

The “List of code variables” 

The “List of code variables” can be called up from the menu Variables > List of code variables. 

When you open the “List of code variables” in a newly created project, the system variables displayed 

in the image are already defined: 

 Position – Position of the code in the Code System 

 Parent code – Names of the codes at the following (higher) level (if applicable) 

 Code – Code name 

 All coded segments – Number of segments coded with this code 

 Activated coded segments – Number of segments coded with this code in current activated 

documents (code needs to be activated) 

 Author – User who created the code 
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 Creation date – Date and time at which the code was created 

 All coded segments % – Relative frequency of “All coded segments” 

 Activated coded segments % – Relative frequency of “Activated coded segments” 

 Documents – Number of documents in which the code appears 

 

System variables in the “List of code variables” 

Sorting the “List of variables” 

The list of variables can be sorted in alphabetical or reverse alphabetical order just like any other table 

in MAXQDA. Simply click once or twice on the column header you would like to sort by. 

The Toolbar 

Both the “List of document variables” and “List of code variables” can be managed from the toolbar, 

which contains identical symbols for both lists. 

  Import data – allows import of spreadsheets in XLS/X format. 

  Data editor – switches from the Variable view to the Data view. 

  Liste of variables – switches from the Data view to the Variable view. 

  New variable – creates a new variable. 

  Delete variable – deletes selected variable. 

  Transform into binary variable – converts selected variables into dichotomous variables. 

  Transform into string variable – converts selected variables into string variables. 

  Statistic of document-/code variables – generates a frequency table or chart for the indicated 

variable. 
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13.3 Adding new variables  

You can add new variables to both the “List of document variables” and “List of code variables”: 

1. Select List of document variables or code variables from the Variables drop-down menu 

2. Click on the New variable  icon in the toolbar. 

 

Creating a new variable with the icon in the toolbar 

The following window will appear: 

 

Defining a new variable 

You can now insert a name for the variable and choose its type. There are five different types of 

variables to be chosen from: 

 Text 

 Integer 

 Floating point (number) 

 Date/time 
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 Boolean (true/false) 

When creating an integer variable, you also have the option of defining whether it is a metric or a 

categorical variable. The variable for age, for example, can be handled in various ways: if you want 

to enter the age in years, you are dealing with a metric variable, for which you may want to establish 

a mean. If you have defined ages into categories (e.g. 1 = under 18, 2 = 18-30, 3 = 31-50, 4 = 51+), 

then you are dealing with a categorical variable, for which you would not want to find a mean value. 

You can also select what value should be inserted automatically for those cases where there is a 

missing value. This is especially important if you are planning to later export the data to a statistics 

program. 

Tip: To avoid confusion, it is recommended that you do not create two variables with the same name. 

Statistics programs do not allow for this, which could cause problems later if you attempt to export 

data from MAXQDA to that program. 

If you are planning to later export the data to such a program, it is recommended that you choose 

integer as your variable type if you aren’t sure which to use. SPSS can now automatically transform a 

string into a numerical variable, though, which allows you to create a more user-friendly string varia-

ble. For example, it is easier to avoid confusion, when you see “Gender = Male” rather than “Gender 

= 0.” 

Note: Document variables are created for the entire project, which means you cannot create different 

variables for each document group. 

The number of variables is not limited; you may add new variables or remove them whenever you’d 

like. However, MAXQDA is not designed to be a statistical program, but rather a program for quali-

tative data analysis and mixed methods approaches, where working with more than 100 attributes is 

rather unusual. 

When creating a name for your variable, it is important that you think ahead. MAXQDA lets you 

create a name with up to 63 characters, and there aren’t any syntax rules, meaning you can use 

several words with spaces and special symbols. 

Tip: If you are planning on exporting your variables later to another program, though, you should 

check on this other program’s requirements. Many statistics programs are more restrictive; SYS-

TAT/MYStat, for example, only allows for variable names with eight or fewer characters, as was the 

case with earlier versions of SPSS. The variable names are also often used in MAXQDA’s visual tools 

(usually as column headers), so long variable names can also take up more space than you would 

want them to. 

13.4 Changing Variable Types 

MAXQDA allows for changes in variable types for existing variables: 
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 Document variables, which display how often a code exists (their source is acknowledged as 

“code”) can be transformed into a binary variable by clicking on the  button. After it is trans-

formed the variable only contains the values 1 and 0, stating if a code has been assigned in this 

document or not). 

 User defined variables “Integer,” “Floating Point,” “Date/Time” and “Boolean” can be trans-

formed into text variables by clicking the . 

Transforming a variable to binary or string cannot be reversed. 

13.5 Renaming and Deleting Variables 

Variables can be given a new name at any time. Double-click on the variable, and enter the new 

name. 

 

Renaming a variable in “List of document variables” 

Renaming a variable is possible at any time and does not affect the variable’s stored values. 

Deleting a variable is done in the same way as renaming it. Select the variable you want to delete 

with the mouse. Now the focused variable is highlighted in green. Then click the Delete variable  

button in the toolbar. When you delete a variable, the whole column including all its values will be 

removed from the table. 

13.6 The “Data editor”  

When working with variables, two views are available in MAXQDA: the variables view in the “List of 

document variables” or “List of code variables,” and the data view in the “Data editor (document 

variables)” or “Data editor (code variables).” The “Data editor” is similar to statistics programs in that 

the data is displayed as a rectangular matrix with a “rows x columns” structure. The variables are 
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displayed in the columns; while the rows display the document variables for documents or the code 

variables for codes. For document variables the table will contain as many rows as there are docu-

ments in the “Document System”; for example, in an interview study, the number of rows will corre-

spond to the number of interviewees. For code variables, the number of rows corresponds to the 

number of codes, and their subcodes for which code variables were queried. 

Calling up the “Data editor (document variables)” 

The “Data editor (document variables)” can be called up in 3 ways: 

1. from the menu Variables > Data editor (document variables), 

2. from the “List of document variables” by clicking on the Variable view  button, 

3. in the “Document System” window, by selecting Overview of variables in the context menu. 

When called up at the top level, the table contains all the documents; at the document group 

level, the data table contains only corresponding documents, and at the document level, only data. 

Alternatively, you can click on the quick button in the “MAXQDA standard” toolbar: 

 

Quick button for accessing the “Data editor (document variables)” 

A table will appear, in which the selected documents and their corresponding variable values are 

listed. System variables can be recognized by the black column heading; this cannot be modified in 

the table. User-defined variables are indicated with a blue heading; their values can be adjusted by 

double-clicking the appropriate cell. 

 

Data editor (document variables) 

In the “Data editor (document variables)” it is possible to access a document by right-clicking the 

appropriate row. A context menu will appear which lists options for opening the document. 
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Context menu in “Data editor (document variables)” 

Calling up the “Data editor (code variables)” 

The “Data editor (code variables)” can be called up in 3 ways: 

1. from the menu Variables > Data editor (code variables), 

2. from the “List of code variables” by clicking on the Data editor  button, or, 

3. in the “Code System” window, by selecting Overview of variables in the context menu of a code. 

If you click on a code, which does not contain subcodes, only the variable values for this code will 

be listed in the table. If the code contains subcodes, the variables of the subcodes will also be 

listed. 

Alternatively, you can click on the quick button in the “MAXQDA standard” toolbar: 

 

Quick button for accessing the “Data editor (code variables)” 
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A table will appear which lists the selected codes and their corresponding variable values. 

An extensive context menu, the same as in the “Code System”, is also available for individual codes. 

The “Data editor” Toolbar 

At the top of the “Data editor” there is a toolbar, which provides easy access to multiple functions 

including the following: 

  Import data – allows you to import a table for code variables 

  Data editor – switches from the Variable view to the Data view. 

  List of document variables – switches from the Data view to Variable view. 

  Open as Excel table – generates a table in XLS/X format and opens the program associated with 

this file format. If specific rows are selected (highlighted in green), only these rows will be displayed, 

otherwise the entire table will be displayed. 

  Open as HTML table – generates a table in HTML format and opens it in the selected default 

browser. If specific rows are selected (highlighted in green), only these rows will be displayed, other-

wise the entire table will be displayed. 

  Export – a table will be saved in XLS/X, HTML, RTF or TXT (tab-delimited) format, then opened in 

Excel or in the default browser. If specific rows are selected (highlighted in green), only these rows 

will be displayed, otherwise the entire table will be exported. 

Managing Tables 

If you have created a large number of variables, it quickly becomes difficult to see then entire table 

at one time. You can view more columns at one time by making the columns thinner (click and drag 

the separator between column headers), but eventually even this does not suffice. 

You do, of course, have the option of scrolling to the right, but you can also change the order of the 

columns by clicking on a column header and dragging it to the location where you would like to have 

it. It’s easier, though, to simply hide those columns that you aren’t working with. To do so, simply 

right-click on any column header and choose Select fields. You can then check the boxes next to the 

columns you would like to view and uncheck the boxes next to the columns you want to be hidden. 
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Variable selection of columns to be viewed 

Besides (un)checking the boxes one by one, you also have the following options: 

 select all fields 

 deselect all fields 

 only system fields (those automatically created by MAXQDA) 

 hide or show variables by checking or un-checking the box in front of the variable name 

13.7 Entering Variable Values in “Data editor” 

To insert variable values into the “Data editor:” 

Double-click on the cell of the table where you would like to insert a value. The values that have 

already been given to any of the cases in the column are in the drop-down list, sorted alphabetically. 

You can view this list and select a value from it by clicking on the triangle to the right of the cell you 

double-clicked on. 

If the value isn’t available in the drop-down list, you can simply type in the value after double-clicking 

in the cell. 

Tip: Drop-down lists are less useful when a variable has many different values (e.g. the exact income 

of every interviewee). Even if the value was in the drop-down list, it would be faster to type it in than 

to search for it. You can stop the program from displaying a column’s drop-down list by right-clicking 

on the column header and selecting (to uncheck) List of values. 
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Options for the variable value in the quick list 

13.8 Exporting Document and Code Variables 

MAXQDA provides basic functions for the statistical analysis of variables, and makes it possible to 

create frequency tables and diagrams for individual variable values. For further analysis, such as cluster 

or factor analysis, it is necessary to export the data table of document or code variables in order to 

perform the statistical analysis in the appropriate program. 

To export the variables: 

1. Click on the  Export button in the toolbar of the “Data editor” or choose Variables > Export 

data (document variables) or (code variables) in the drop-down menu. 

2. Give the exported file a name. You can also select exactly where you want to save the file. 

3. For the file format, you can choose between 

• Excel (XLS/X) 

• SPSS Data File (SAV), which is only available for the document variables and works fine in most 

statistics programs, 

• SPSS Syntax File (SPS), which is only available for the document variables, 

• Text (TXT, tab delimited) 

• Rich Text Format (RTF) 

• Website (HTML), and TXT (tab delimited). 

4. Select OK. 

Note: In some statistical programs, the variable names are limited in length. As the length of the 

variable name in MAXQDA can be up to 63 characters, it is recommended that you shorten the 

variable names for export in order to avoid potential problems during subsequent work with the 

statistics program. Choose variable names in which the first 8 characters of the variables differ in each 

case to avoid duplicates in the statistical software when you import the file. This will only be necessary 
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if you transfer data via Excel format – if you use the SPSS export, MAXQDA will use short variable 

names automatically. 

 

Exported data matrix in Excel 

Tip: The variable matrix can also be transferred via the clipboard. You can either select the entire 

matrix using the keyboard shortcut Ctrl+A (Windows) or cmd+A (Mac), or select individual rows by 

clicking on them while holding down the Ctrl (Windows) or cmd (Mac) button. Use the keyboard 

shortcut Ctrl+C (Windows) or cmd+C (Mac) to copy the selected data onto the clipboard. 

13.9 Importing Document Variables 

There are several situations in which you might want to import document variables into MAXQDA, 

such as: 

• If you want to analyze answers to open-ended questions in combination with the quantitative 

socio-demographic information that you acquired for each of those who filled out the survey. 

Usually, you will already have this quantitative data in a matrix of some sort, and re-entering that 

information into MAXQDA would just cause you unnecessary work. 

• If you and others in a research team each entered variable values for various documents and now 

want to bring them all together. 

• If you did statistical analysis on material that you exported from MAXQDA and now want to 

reimport the results of your statistical analysis into MAXQDA. You could, for example, have done 

a cluster analysis, and now want to import the information about which cluster each document 

belongs to as a variable into MAXQDA. If you want to avoid entering each one of these new 

values by hand, you can simply use the variable import option. 

Import Data from Excel  

MAXQDA can import data from XLS/X files. The data must be organized as follows: 



Importing Document Variables 200 

Document group Document name Variable 1 ... Variable N 

Group 1 Text 1 Variable value for Text 1  Variable value for Text 1 

Group 1 Picture 1 Variable value for Picture 1  Variable value for Picture 1 

 

The first two column headers serve as markers for assigning variable values to the documents and are 

required for successful import. Every row must have an entry for the document group and document 

name columns. Only if these exact group and document names are found in the “Document System” 

of the MAXQDA project, will the variables and variable values be imported. You can then include as 

many different variable columns as you wish. 

Note: The variable values for documents that do not belong to a document group can also be im-

ported. In order to do so, the appropriate cell in the “Document Group” column must be left empty. 

After preparing and saving the document, you can start the import procedure by selecting Variables 

> Import data (document variables) from the drop-down menu. Alternatively, you can click on the 

Import data (document variables)  symbol in the “List of document variables.” 

 

"Import data” button in the “List of document variables” 

A dialog field appears in which you can specify the source and target variables along with the type of 

variables to be imported. 

MAXQDA does the following during the import: 

1. All variables in the import file that did not yet exist in the MAXQDA project are created. 

2. Variables that already existed will be updated with the new values in the import file. 

3. Empty values (“system missings”) for variable types integer and floating point will be imported as 

-999. 

Tip: An easy way to set up an Excel file for importing new values is to first export the variable data 

matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable list. An Excel file with 

all of the current variables will open up, and you can then add new columns for new variables and 

update variable values that you want changed. All you have to do after that is save the Excel file and 

import it into MAXQDA. 
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Import Data from SPSS  

You can also import a data matrix for the document variables from a SPSS data file (extension SAV). 

For the import MAXQDA needs to match the cases oft he SPSS data file with the document names in 

the opened MAXQDA project. Therefor it is necessary, that the data file contains a variable (a column) 

for the document group as well as a variable for the document name. 

1. Please start the import procedure by selecting Variables > Import data (document variables) 

from the drop-down menu. Alternatively, you can click on the Import data (document variables) 

 symbol in the “List of document variables.” 

2. Then choose a SPSS data file in the appearing file dialog. 

3. A new dialog will appear, that allows you to set several options: 

 

Options for importing a SPSS data file 

4. In the upper part you can select which variables (= columns) contain the information about the 

document group and the document name to match the cases with the appropiate document 

name. MAXQDA will choose the first two columns of the SPSS data file, if the data file doesn’t 

contain variables that are labelled with “DocGroup” and “DocName.” You will find the variable 

labels in brackets behind the variable names for better navigation in the list of variables. 

5. Furthermore, you can switch on two additional options: 

6. Import variable label instead of variable name – If you choose this option, MAXQDA won’t 

import the variable names, but their labels, which are usually longer and easier to read and to 

understand. You should use this option, if you want to import a SPSS data file that has been 

created by exporting the document variables from MAXQDA. Then it will be easy to update a 

variable which values have been changed in SPSS. Please note that the length of variable names 

in MAXQDA is limited to 63 characters, so a longer name may be truncated. 

7. Import value labels instead of values – usually, standardized answers will be represented in 

SPSS by numbers, e.g. a 1 may be used for “female” and a 2 for “male”. If you see these numbers 

only in MAXQDA without knowing what a “1” and “2” means, it won’t be very useful, so this 

option should only be deactivated if you are sure you want to import the values instead. 

8. A dialog field appears in which you can specify the source and target variables along with the type 

of variables to be imported. 
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MAXQDA does the following during the import: 

• All variables in the import file that did not yet exist in the MAXQDA project are created. 

• Variables that already existed will be updated with the new values in the import file. 

• If you have defined missing values in SPSS only the first missing value (defined in section “Discrete 

missing values” in the SPSS dialog) will be imported (only for variable types integer and floating). 

• System variables won’t be changed. 

• If the import file contains identical document names in the same document group, the last case 

will overwrite the previous ones. 

• Empty values (“system missings”) for variable types integer and floating point will be imported as 

-999. 

13.10 Importing Code Variables 

MAXQDA can import data from XLS/X files. The data must be organized as follows: 

Code Variable 1 ... Variable N 

Parent code 1\Code 1 Variable value for code 1  Variable value for code 1 

Parent code 1\Code 2 Variable value for code 2  Variable value for subcode 2 

The first column heading is the unambiguous assignment of variable values to a code, so this column 

and its heading are mandatory. Each line must designate a code in the corresponding column. For 

subcodes, the entire path must be specified in the code system, in which the codes are separated by 

a backslash. 

Tip: To insert a backslash “\” on a Mac, use the keyboard command alt+⇧+7. 

Only when a code, which matches this information exactly, is found in the “Code System” will the 

variable be imported. You can add as many variables as required in the subsequent columns. 

After preparing and saving the import data, you can then start the import procedure by choosing 

Variables > Data import (code variables) from the drop-down menu. Alternatively, you can click 

on the Import data (code variables)  button in the “List of code variables.” 

A dialog field appears in which you can specify the source and target variables along with the type of 

variables to be imported. 

MAXQDA does the following during the import: 

9. All variables in the import file that did not yet exist in the MAXQDA project are created. 

10. Variables that already existed will be updated with the new values in the import file. 

Attention: If you don’t see the newly-imported code variables in the code variable list, it may be 

because they were toggled off. Simply right-click on a column header and choose “Select fields” to 

change which variables are viewed. 
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Tip: An easy way to set up an Excel file for importing new values is to first export the variable data 

matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable list. An Excel file with 

all of the current variables will open up, and you can then add new columns for new variables and 

update variable values that you want changed. All you have to do after that is save the Excel file and 

import it into MAXQDA. 

13.11 Importing and Exporting Variables from and to SPSS and 

other statical packages 

Importing Variables from SPSS 

You can import a data matrix from SPSS into the document variables directly from a SPSS data file 

with the extension SAV. You will find detailed information on this topic here: Import Data from SPSS 

Exporting Variables to SPSS 

MAXQDA also allows for exporting the document variables a SPSS data file (SAV), which can be read 

from most statics software packages, including the free SPSS clone PSPP. Also, you can export the 

document variables into a SPSS syntax file (SPS). Plesse see here for more information: Exporting 

Document and Code Variables 

13.12 Displaying Document Variables as Tooltips 

It is often necessary to call up background information on a document in the “Document System” 

(for example, the age or gender of a participant, or whether this participant works for an NGO). To 

this end, you can choose as many document variables in the “List of document variables” as you 

wish; their respective values will then be displayed as tooltips in the “Document System.” 

Check the box in the Display as Tooltip column in order to select the document variable to display`. 

 

Select tooltip display for document variable 
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When you click on a document in the “Document System,” a tooltip showing the value of the selected 

variable will appear. In the following image, the display shows that the respondent “Teresa” is female, 

over 25 years old and lives in New York. 

 

Tooltip display of variable value in a document 

The variable value will also be displayed in the source information in the “Retrieved Segments.” 

 

Variable value display in the source information of a coded segment 

When the “Retrieved Segments” is exported, the source information of each segment will also be 

displayed upon demand. 
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14 Searching for Text: The Lexical Search 

14.1 Lexical Search Options  

MAXQDA offers three main ways to search in the texts or within each main window. 

 Each of the four main windows has a toolbar at the top of it that contains a magnifying glass icon. 

Clicking on this opens a field where you can enter text to search for within that window. 

 With the lexical search tool (the magnifying glass in the “MAXQDA standard” toolbar), you can 

search within all documents, memos, or coded segments. You also have the option of limiting this 

search to certain activated documents or document groups. 

 The third option is to do an extended lexical search that offers several possibilities to search for 

combination of search items in definable contexts, like paragraphs or sentences. 

14.2 Search in the Four Main Windows 

All four main windows in MAXQDA have a magnifying glass icon in their toolbars. Clicking on this 

icon opens a search field. Below you can see the search field in the “Document Browser.” 

 

Search in the “Document Browser” 

MAXQDA begins searching as soon as you type the first character in the field. It carries out a classic 

search, meaning that it looks anywhere for that character combination, even if it’s not found at the 

beginning of a word. Searching for “sic” will bring up words like “musical” and “sick.” 

MAXQDA also shows you how often that particular search string has been found. 
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14.3 The Lexical Search: Options in the Dialog Window  

The lexical search function allows you to research your documents without first coding them. You 

can do searches of either 

 documents, 

 memos, or 

 coded segments, which are currently shown in the “Retrieved Segments” window. 

 The search can also be limited to activated documents. You can choose to search in a single doc-

ument, a document group, or all documents that have certain variable values. The lexical search 

function can be started by selecting Lexical search from the Analysis drop-down menu or by 

clicking on the magnifying glass icon in the “MAXQDA standard” toolbar. 

 

Lexical search icon in the “MAXQDA standard” toolbar 

After selecting to do a lexical search, the following window will appear: 

 

The dialog window for the lexical search 

When the dialog box first comes up, the left pane is empty. Click New to enter the word or string 

(called the “search string”) that you want to find. 

Search strings may consist of one word, multiple words, or only of a part of a word. For instance, you 

can search for “Tom Hanks,” “Hanks,” or only “anks.” Quotation marks are not necessary if a search 

string consists of more than one word. 
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Tip: If you highlight text in the „Document Browser“ then right-click on it and select the option 

Search for highlighted text, the highlighted text will be displayed directly in the Lexical Search 

window. 

Search strings may contain so-called “wild card” characters. The characters * or ? function as follows: 

 If the character “?” appears in a search string, MAXQDA finds, for instance, “Hanks” if the search 

string is “H?nks,” but “Hunks” or “Hinks” would also be found. 

 The character “*” stands for multiple characters, e.g. “H*ks” would find “Hanks” and also 

“Hawks.” 

 The beginning of a word can be delimited by the character “<().” The search string “<(inter)” 

would find “Interest,” “interesting,” but not “winter.” 

 The end of a word can be delimited by the character “()>.” Thus, the string “(ks)>” would find 

“Hanks,” “Banks,” and “thanks,” but not “Bankside.” 

Click the Delete button to remove search strings from the list. By holding down the Ctrl key (Win-

dows) or cmd key (Mac), you can delete multiple search strings at once. You can also modify your 

search strings at any time. 

You will find the options for the search procedure in the right pane of the Lexical Search window. 

First, you must specify where you wish to search: 

 If you select In documents, additional selection fields that were previously displayed in light grey 

will become available. These additional fields include “Only in activated documents” and “Only 

in retrieved segments”. If no texts are activated, these options will not be available. 

Other options: 

• Find whole words – Search only for strings that are exactly the same as the search string. For 

example, if you search for “teach,” the string “teacher” will not be included in the search results. 

If you turn this function off, “teach” would also give you the strings “teacher” or “teaching” as 

results. 

• Case sensitive – Search only for strings in which the same letters are capitalized as in the search 

string. 

• OR/AND combinations – For searches with more than one search string. With OR checked: search 

for segments containing only one of the search strings. With AND checked: search for segments 

containing all of the search terms (their required position with respect to one another can be 

defined). 

• Within x paragraphs – If this option is NOT selected (check box left blank), the search extends 

through the entire document. For example, if the search strings “Public” and “Citizens” are en-

tered, the entire document will be searched to see if each of the search strings occurs at least 

once. The results list will contain as many rows as there are documents in which the entered search 

strings do all appear. 

If the box is checked and the number of paragraphs is specified, the search will proceed as follows: 
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Within 1 Paragraph: The search strings must occur within the same paragraph. For the example 

above, the results list would contain two rows, one containing the search string “Public” and the 

second containing the search string “Citizens”. 

Within 2 Paragraphs: The search strings must occur within two paragraphs of one another. For the 

example above, if the search string “Public” occurs in paragraph 12, the search string “Citizens” 

must occur in paragraphs 11, 12, or 13 in order to register as a hit. 

Note: The interval between paragraphs can be as large as desired. PDF documents will be ignored 

when the option “Within x paragraphs” is selected. 

As soon as you click the Search button, the search will begin. 

In order to spare you the effort of typing in a long list of search strings again and again, MAXQDA 

can save the search settings. To do this, click on Save, enter a name, and click on Save again. This 

creates a search file with the file extension ”.sea,” which you can open and continue to use at a later 

time. 

Depending on how many documents you search and how complex the search is, it could take some 

time to find all of the results. 

14.4 Search Results  

Your search results will be shown in a table that appears as follows: 

 

Example search results 

Along with the usual filter functions, the toolbar at the top of the results window provides access to 

the following functions: 

  Autocode search results – codes search results with an existing code. All search results that have 

not been excluded from the selection (and which display a Stop  symbol in the first column) will be 

autocoded. 

  Code search results with a new code – codes search results with a new code. All search results 

that have not been excluded from the selection (and which display a Stop  symbol in the first 

column) will be autocoded. 
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   Autocode/Export: ignore hit – exclude selected rows from autocoding and exportation by 

clicking on this icon. 

  Open as Excel table – the search table will be opened in XLS/X format in the appropriate pro-

gram (usually Excel). If you have selected a section of the results table (marked green), only these will 

be included in the new table. 

  Open as HTML table – the search table will be opened as an HTML table in your standard inter-

net browser. If you have selected a section of the results table (marked green), only these will be 

included in the new table. 

  Export – The table will be saved in XLS/X, HTML, RTF or TXT (Tab delimited) format, then opened 

in Excel or in the default browser. All rows that do not display a stop symbol will be exported. 

The table of search results can be handled in the same way as other tables in MAXQDA: clicking on 

any column header will sort the table according to this criterion. For instance, clicking on Document 

will arrange the document names included in the table in alphabetical order. Clicking here again 

changes the sequence to descending order. A little triangle indicates the sort attribute and order 

(ascending or descending). 

The entire table or parts of it can be copied to the Windows clipboard (by selecting all or part of it 

and pressing Ctrl+C (Windows) or cmd+C (Mac). 

Below the title bar, you can see how many documents contain the search string and how many times 

the search string appears in those documents. 

Note: Once you click on a hit, the corresponding document is opened and positioned exactly where 

the reference is located. The search term found is highlighted. 

Search Results when Using the AND Combination for Search Items 

If you search for more than one search item whithin the whole document, a paragraph – or when 

using the extended lexical search whitin a sentence -, the search results table will not only list the hits 

for each search item separately. Instead, it will contain as many entries as combinations of the search 

iteams have been found inside the defined contexts, thus the number of documnets, paragraphs or 

sentences in which all the search items exist. The following screen shows this for the search for „hap-

piness“ AND „satisfaction“. In the column „Context“ MAXQDA informs you, if these search strings 

exist within a document, paragraph, or sentence. 

A click on a row highlights the first hit of an entered search item whitin the context. 

To get a list of each single hit of search items, click on the icon  Detaillied list of hits. 
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Search results when combining several search items with AND 

Note: When exporting the search hits or when autocoding them, MAXQDA uses the detailled list of 

search items. 

14.5 The Extended Lexical Search  

The Analysis > Extended lexical search function, as with the simple search option, allows you to 

analyze your documents to a certain extent without having to have already done any coding. The 

searches can be carried out in: 

 documents, 

 memos, or 

 the coded segments currently called up in the “Retrieved Segments” window. 

The search can also be limited to those documents that are currently activated in the “Document 

Browser.” 
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Extended lexical search dialog 

The dialog is separated into several parts. At first you can enter search items in the text fields 

 All these search strings (AND combination) 

 Any of these search strings (OR combination) 

 None of these search strings (search strings for exclusion) 

Please note, that you can separate different search strings with a space. If you want to enter a co-

mined search string you can use quotation marks like “Mahatma Gandhi” around your search string. 

Question mark “?” and asterisk “*” work as placeholders for a single character or for one or more 

charaters. Use <() for word begin and ()> for word end, <(inter) will find “interest” and “interesting”, 

but not “winter,” and (ks)> will find “banks” and “thanks”, but not “bankside.” 

In the upper right part of the dialog you can define, in which part of the project MAXQDA will search 

an in the options on the right you can define in which context the search items have to exist. 

All three search entries will be combined with AND. In the screen above MAXQDA will present all 

sentences in which “climate” and “energy” exist together, but not “politics.” 

Note: Sentences are defined by MAXQDA according to the following rules: A sentence always begins 

following a period, question mark, exclamation mark, or colon. The following exceptions apply:  
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# A number that is not four digits appears before a period (e.g. 1. or 2.). 

# A single character appears before a period (to exclude abbreviations).  

# Two identical characters appear directly before a period (e.g. ff. or pp.). 

# Literal speech in quotation marks belonging to the sentence itself.  

# First letter after a sentence is in small letters. 

# A number appears directly following the end of a sentence.  

# Quotation marks appear immediately after the end of a sentence. 

In text or table documents, a new sentence invariably begins after a paragraph.  

 

The recognition of sentences in PDF documents is optimized for left-to-right languages and may not 

work as expected with right-to-left languages. 

14.6 Exporting Search Results  

The results table of the lexical search tool offers the possibility to export search results by clicking on 

the Export  icon in the toolbar of the results window. The following options window will appear, 

where the range of the data to be exported in relation to the search term can be defined: 

 

Options for search results output 

The export window is divided into two parts. Options for the export of search results from a PDF 

document can be selected in the upper section, with the corresponding options for search results 

from text and table documents in the lower section. Exports of pure search results as a simple list is 

generally not useful; therefore you can define the range for the export of search results. 

For PDF documents, you can define how many words before and after the actual search term are 

exported. This option is also available for text and spreadsheet documents, in addition to Sentence 

and Paragraph options. When you select one of these two options, the name of the context options 
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will change and you can choose how many sentences or paragraphs before and after the search term 

you want to include: 

 

Setting the data range for export 

Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only paragraphs 

in which the search term is found will be exported. If the term appears several times in the same 

paragraph, the paragraph is still listed only once, whereas the search term or terms will be listed more 

than once. 

Setting 1 Paragraphs after means that the paragraph containing the search term, as well as the 

following paragraph, will be exported. 

When you click OK, a window will pop up in which you can select the file name, format, and location 

to be saved. The following options are available: 

• Excel (XLS/X), 

• Website (HTML), 

• Maintext in Rich Text Format (RTF) 

• Table in Rich Text Format (RTF) 

• Tab Delimited Text (TXT) 

The result as Maintext in Rich Text Format will appear as follows: 

Document: New York\Teresa (28 - 28) 

Search string: family 

to go to college straight from high school in 1964 and become a teacher.  I was a good student in high 

school graduating 19th in a class of 403.  I really wanted to go to college, but my family couldn't afford 

it.  Unfortunately, my mother had the attitude college was a waste for girls, because they got married 

and didn't put their college education to use.  So, I never pursued the issue.  I know, I shouldn't blame 

my mother for my not going to college.  I could have been more enterprising and tried to find a way to 

pay for it on my own.  I think never having been a teacher will always haunt me.  Now it's too late.   I'd 

have to take a large salary cut if I were to change professions at this stage in life. 

 

Section of an exported results table with the option +/- 0 Paragraphs 

Each search result consists of the source data, including the name of the document group and docu-

ment, and the position in which the search string was found (in brackets), followed by the search 

string itself. 

Note: The recognition of sentences in PDF documents is optimized for left-to-right languages and 

may not work as expected with right-to-left languages. 
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14.7 Autocoding Search Results  

Like the segments in the “Retrieved Segments” windows, lexical search results are automatically 

coded, meaning all text passages found in the search are coded with a specific user code. This auto-

matic coding has the advantage of being easy and reliable. The disadvantage, however, in comparison 

to human coding, is that there is no examination of the relevance of the text passage. The occurrence 

of a specified string in the text triggers the coding. For example, if the word "Mother" is automatically 

coded with the code "Family", references to "Mother Earth” would also be included. 

To code the search results automatically, follow these steps: 

1. The best way to code search results automatically is to click on the Autocode search results with 

a new code symbol. 

2. In the dialog box that appears, enter the new code and click OK. The new code will be inserted at 

the top of code system. 

 

Autocode search results: Define a new code 

3. In the ensuing options window you can set the range before and after the search term as well as 

the weight, which is established during the coding process. 
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Setting options for automatic coding of search results 

In the "Code" field, you establish with which code MAXQDA should encode the search results. 

The “Quick list of codes” – which lists the most recently used codes – is displayed in this window. 

The code that you created earlier is automatically selected here. Furthermore, a weight value can 

be set for all coded elements, that is to say, all segments will be coded with the same weight. 

In the “PDF documents” field, you can set whether only the respective search result should be 

encoded, or whether additional words before and after the search results should be encoded as 

well. These criteria applied only to PDF files. 

In the “Text and table documents” field, you can determine whether sentences or paragraphs 

before or after the search result should be encoded. 

 

Setting the parameters for Autocoding 

Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only the par-

agraph in which the search term is found will be coded. If the term appears several times in one 

paragraph, it will nevertheless be coded only once 



Keyword in Context (KWIC) 216 

The setting 1 Paragraph after means that the paragraph in which the search term is found as 

well as the following paragraph will be coded. Again, if the term appears several times in one 

paragraph, it will nevertheless be coded only once. 

Note: If you do not want to code with a new code, but with an existing code from the "Code Sys-

tem”, you can use the Autocode search results  option. Before you start the process, click on the 

desired code in the Code System, which will cause the code to appear in the list of recently used 

codes in the Autocode options window. 

Exclude Search Results from Autocoding 

Fundamentally, all search terms that appear in the results list will be autocoded. However, before 

executing the autocode function, you can review the list of search terms in order to decide whether 

each term should be included or not. Once one or more lines in the results table have been selected, 

click on the red icon  Autocode/Export: ignore hit in order to exclude the entry. 

The fastest way to exclude a term is to double-click in the first column. 

 

Exclude search terms from autocoding 

Note: The selected codes are incorporated into the undo coding list which can be accessed from the 

Code toolbar with the  icon. This action can be reversed with a single command if necessary. 

14.8 Keyword in Context (KWIC)  

Often, you wish to determine the context in which a given term is used. In this case, you can create 

and print a so-called KWIC (KeyWord In Context) listing. The procedure is as follows: 

1. Perform a lexical search by keyword. 

2. In the results window, click the Autocode search results with new code  symbol and set the 

range, for example 10 words before and 10 words after. 

3. After the autocoding is complete, double-click the newly created code in the “Code System”. 

In the next step, you have several options: 
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 Either you can generate and print the output data in XLS/X, HTML or RTF format by clicking the 

Export icon in the toolbar, or 

 Create a new code in the “Code System,” transfer it to the quick list, and autocode the search 

results with this code. 

The second method is more flexible, since you can then load the KWIC list into the “Retrieved Seg-

ments” window, check the list, and remove any undesired segments (by right-clicking on the infor-

mation box on the left of the segment and selecting Delete from the context menu). 

The final result, the corrected KWIC list, can be printed by selecting the menu option Print > Re-

trieved Segments from the Project drop-down menu. It is also possible to export or copy the KWIC 

list to the clipboard. A table view is also available. To view the results as a table, double-click on the 

newly inserted code, whereupon MAXQDA will open the overview of coded segments. This can be 

exported as an Excel or HTML table or in RTF format. 

The KWIC list has the following structure: each hit starts with the source data (document group, 

document name, and the paragraph number containing the hit). The next line indicates the search 

word or search string that has been found in that paragraph. Finally the text segment itself is listed. 

New York\Milly (23-23) 
family 
family 
Family, 09 : My family my parents, my children, are very close. We share dreams and holidays and have much 
warmth with each other. 
 
New York\Mary (7-7) 
family 
I am pretty happy with my health situation. I get sick very rarely and when I do, it is only for a short amount of 
time. I think this can be attributed to the fact that I eat right and exercise semi-regularly. However, my family 
has a history of breast cancer and diabetes and I worry very much about contracting them. 

Printout of search results from a file 
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15 Coding Query: Finding Coded Segments  

15.1 Activation: The Principle of Segment Retrieval 

In MAXQDA, you can search for information in your documents in a variety of ways. One method is 

to search for particular words or character strings with the lexical search function. You may be familiar 

with this search method from text-processing programs. The principle is basically the same in 

MAXQDA, with the advantage that you can search many documents simultaneously for the words. 

A lexical text search finds only those terms that actually appear in the text. Searching with theoretical 

concepts and subject categories, such as “Helper Syndrome” in a study of volunteers in social work, 

will naturally not provide any results. 

By assigning codes to appropriate document segments, you be able to find segments that relate to a 

certain theme. This finding of coded segments, also known as retrieval, requires only that you have 

created codes and assigned them to those document segments. After you have assigned codes to the 

document segments, you will be able to call up all segments that were coded with the same code. 

MAXQDA offers various ways to do this retrieval, but it is all based on activation of documents and 

codes. 

The following explanation applies not only to texts, but also to coded segments in images, PDF files, 

table documents, audio and video files. 

The retrieval principle in MAXQDA is very simple: 

All document segments from activated documents that were coded with any of the activated codes 

will be called up and shown in the “Retrieved Segments” window. 

Activating Documents 

First the documents: All documents and document groups are listed in the “Document System.” The 

starting point, then, is an inactivated document. The status of the document – whether activated or 

not – can be seen by its color. Inactivated documents are grey, and activated documents are red. 

      

An inactivated (left) and an activated (right) document 

And how do you activate a document? There are several ways to activate documents: 

1. Activation via the Context Menu 

The first way to activate a document is with the context menu. Simply right-click on the document 

and select Activate. 

You will know that the document is activated, because it will turn red. 

In the same way, you can activate entire document groups or document sets. Right-click on the doc-

ument group and select Activate all documents. 
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You can even activate all documents in your entire project at one time by right-clicking on the Doc-

uments icon at the top level of your “Document System” and selecting Activate all documents. 

2. Activation with the Ctrl or cmd Key 

A simple way to activate documents, similar to selecting files in Windows Explorer or Mac Finder, is 

to hold down the Ctrl key (Windows) or cmd key (Mac) and to click on the required documents with 

the left mouse key. An entire document group or all project documents can also be activated in this 

way. 

3. Activation with the Mouse 

Alternatively, you can activate a document simply by clicking on they grey circle to the left of the 

document symbol, or on the number of coded segments, which is displayed at the end of the line. 

Activating Codes 

Activating codes works in the same way as for documents. Either right-click on a code and click to 

activate or hold the Ctrl key (Windows) or cmd key (Mac) and click on the code you would like to 

activate. You can also simply click on the grey symbol to the left of the code, or on the code frequency, 

which is displayed at the end of the line. 

 

Activating a code via the context menu 

Non-activated codes are displayed in grey, activated codes in red. 

Tip: If you hold down the Shift key while clicking on a parent code, only the parent code, and not its 

subcodes, will be activated. 

The status bar at the bottom of the MAXQDA window gives you information about the number of 

activated documents, activated codes, and the number of document segments that are being called 

up based on those activations. 
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Activation information in the status bar 

When you activate a parent code, your settings will determine whether the subcodes are automati-

cally activated with it. You can change this setting by right-clicking on a code and clicking on Activate 

codes together with subcodes. If a checkmark was showing next to that line, selecting it will re-

move this checkmark, and subcodes will not automatically be activated with the parent code. Your 

settings for that code will be saved until you change them again. 

All of the document segments that were found based on your activations are called retrieved seg-

ments or coded segments and are shown in the “Retrieved Segments” window. 

 

Called up document segments (coded segments) based on activated documents and codes 

Example 

Let’s say that you wanted to know what certain interviewees (e.g. Joanna, Kim, and Vincent) said 

about other people in their lives. You would start by activating the appropriate documents in the 

“Document System:” 

 Hold the Ctrl key 

 Left-click on the document “Joanna” 

 Left-click on the document “Kim” 

 Left-click on the document “Vincent” 
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 Next, you will need to activate the appropriate code. In this case, the code is called “People.” If 

there are subcodes for this parent code, those subcodes will be activated as well (assuming you 

have not changed the default settings). 

 You can now see some basic information about your activations in the status bar. It shows that 

you have activated three documents and five codes (this includes the four subcodes of “People”). 

You can also see that 27 document segments were retrieved based on those activations: 

 

Activation information found in the status bar 

15.2 Activation by Color  

Documents and codes can be activated manually (by clicking on them), automatically (via activation 

by variable), and also by color. There are symbols in the toolbars in the “Document System”  and 

the “Code System”  that lets you select the colors to be activated. 

After clicking on this button, a dialog field appears with all the colors that have been used for docu-

ments/codes so far. You can then check the box next to the colors to be activated. The two radio 

buttons at the top also let you check or uncheck all of the colors with a single click. 

 

The colors representing codes or documents to be activated 

15.3 Removing Activations (Deactivation) 

Cancelling the activation of documents or codes operates on the same principle as activation: either 

via the context menu or with the mouse (eventually using the Ctrl or cmd key.) When you want to 
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start a new Coding Query, but already have documents and codes activated from a previous retrieval, 

the easiest way to proceed is to automatically deactivate all of those documents and codes. 

In the “MAXQDA standard” toolbar, you will find a Reset activations button, which fulfills this 

function. 

 

Button to “Reset activations” 

If you want to reset activations for only the documents or only the codes, you can do so with the 

button available in the “Document System” or “Code System” toolbars. 

 

Button to “Reset activations” for all documents in the “Document System” 

 

Button to “Reset activations” for all codes in the “Code System” 

It is also possible to deactivate all codes or documents by right-clicking on the Documents icon in 

the “Document System” or the Codes icon in the “Code System” and selecting Deactivate all doc-

uments or Deactivate all codes. 

15.4 The “Retrieved Segments” Window 

The “Retrieved Segments” window is a results window – it shows you all of the coded segments 

that were coded with any of the activated codes in any of the activated documents. 

 

The “Retrieved Segments” window 
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Next to each retrieved segment (default is on the left side), you will find an info box about each 

retrieved segment and a memo column, showing any memos that were attached to the retrieved 

section of the document. 

Tip: If you want, you can also move the info boxes to the right side of the “Retrieved Segments” 

window, but the memo column always remains on the left. 

 

Info box for a retrieved segment 

The info box above can be read as follows: the segment came from paragraphs 20-24 in the docu-

ment “Joanna,” which is in the Document Group “New York.” The segment was coded with the 

code “Friends,” which is a subcode of the code “People” and the weight score for the coded segment 

is “100.” 

Tip: If you click on any part of the info box, the associated document will automatically be opened in 

the “Document Browser” window at that part of the document where the associated coded segment 

can be seen (paragraphs 20-24). This segment is also highlighted. The associated code is also high-

lighted blue automatically in the “Code System” window. 

If you right-click on the info box, you will see the following context menu: 

 

Context menu for the info box in the “Retrieved Segments” window 

It is possible here to delete the particular coded segment, but that does not delete the actual code 

from the “Code System” or the document segment from the document. You will have to confirm 
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your deletion. You can also change the weight score for the coded segment. If you select Modify 

weight, the following window will appear: 

 

Modifying the weight score of a coded segment 

Sorting of “Retrieved Segments” 

You can also carry out other functions by right-clicking on a gray area of the “Retrieved Seg-

ments” window in which the info boxes appear. 

 

Context menu that appears when you right-click in a gray section of the column 

The next few functions in the context menu affect the sorting of the retrieved segments. There are 

three possible variations: 

 Ordered by Document System – this means that the segments are listed in the same sequence 

as in the “Document System.” The list starts with the segments of the first activated document in 

the “Document System,” then those of the second activated document are given, and so on. 

Search results in this order would let you compare what one respondent said to different selected 

topics. For example, given that the first respondent’s answers were contained in one document or 

interview, followed by a second respondent’s answers in a separate second interview, all of the 

retrieved segments from the first interview would be listed before those from the second interview. 

 Ordered by Code System – this means that the segments are listed in the same sequence as the 

codes in the “Code System.” All of the segments assigned the same code are listed one after the 

other. 
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 Ordered by weight – This sorts the segments according to the weight that has been assigned to 

them. 

Tip: In the status bar at the bottom of the screen, the currently selected sort sequence is represented 

by an icon. This symbol, for example, symbolizes sort by documents . To customize the sort se-

quence, simply click the icon. 

15.5 Include Subcodes in Retrieval 

A hierarchical system of codes can be constructed with MAXQDA. The program offers an easy way 

to make use of the hierarchical structure. 

Example 

Imagine you want to check if there are co-occurrences of Code A and Code B, and Code B has two 

subcodes, B1 and B2. If you activate these codes, in total four codes would be activated: A, B, B1, 

and B2. Now, when selecting the Intersection or Overlapping options, MAXQDA will search for 

text passages where all of the four codes are present. Obviously this is not what you want, since it is 

very unlikely that there are segments to which all four codes are attached. (Code B1 and Code B2 are 

likely exclusive: either B1 or B2 is attached but not both of them.) To get the desired result, you would 

have to split the analysis in three parts: 

1. Search for co-occurrences of Code A and B1. 

2. Search for co-occurrences of Code A and B2. 

3. Search for co-occurrences of Code A and B. 

This is obviously a very inconvenient way of getting results, particularly if a code has many subcodes 

or even different levels of subcodes. MAXQDA does, however, offer an easier way. Simply click to 

Include subcodes in the context menu. 

 

The “Include subcodes” option in the context menu of the “List of coded segments” 

It is also shown in the status bar, whether or not the subcodes (or “code children”) are included. If 

there is a checkmark on the symbol, the subcodes are included. You can also change this setting by 

clicking on this icon. 
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Subcode inclusion shown in the status bar 

Going back to the example above: if both Code A and Code B are active, and include subcodes is 

selected, MAXQDA will find all co-occurrences of Code A (or any subcode of Code A) and Code B (or 

subcodes of Code B) 

15.6 Finding Important Coded Segments Using Weight Scores  

All segments that appear in the “Retrieved Segments” window have their weight listed next to the 

source data. 

 

Weight score in the info box next to each retrieved segment 

These weight scores can be used for the retrieval process. The user can define a range for the weight 

scores in order to retrieve only those document segments with scores inside of that range. 

If you choose to activate the weight filter, the following window will appear. You can enter any 

numbers between 0 and 100. 

 

Setting the range for the Weight filter 

This will cause only those segments to be displayed in the “Retrieved Segments” window that have 

a weight score within the defined range. The weight filter affects all retrieval functions, including 

“Intersection” and all functions of the Complex Coding Query. 
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Display of weight filter in the status bar 

The status bar at the bottom of your screen contains information about the document and codes that 

are currently active as well as the weight option, symbolized by the paperweight. This icon tells you 

if the weight filter is active or not, as well as its range. By clicking on this icon, you can change the 

default value that is assigned when coding segments. 

15.7 The Simple Coding Query  

The Coding Query tool facilitates the retrieval process and the compilation of coded segments. This 

tool allows you to control all essential settings from within a dialog window. Before calling up the 

Coding Query tool, you should activate the selected documents and codes. You can call up the Cod-

ing Query tool: 

 From the menu Analysis > Coding Query or 

 By clicking on the Coding Query  button in the “MAXQDA standard” toolbar. 

The following window will then appear: 

 

Coding Query window 

You can determine various settings for the query from the dialog window: 

Only activated documents – Select whether all documents, or only activated documents, should be 

considered in the query. The number in brackets indicates how many documents are currently acti-

vated. 
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Only activated codes – Same options as for Documents. 

Include subcodes – If selected, subcodes of codes will be included in the query. 

Use weight filter – The output of coded segments can here be limited to segments of a specific 

weight range. 

Only segments of user – The output of coded segments can here be limited to segments that were 

created by a specific user. 

15.8 Jumping from Retrieved Segment to the Original 

Document 

It is possible at any time to jump from a coded document segment in the “Retrieved Segments” 

windows to the original source document. 

To the left of each segment, you can see from which document and paragraph the segment was 

taken, and which code was assigned to it. 

If you click anywhere in this box, the original document from which this segment was taken will be 

opened in the “Document Browser” window at the position of the segment in the document. 

When examining the results of a retrieval, you should arrange your desktop as shown below. The 

source document is in the upper window, and the “Retrieved Segments” window is below it. Then, 

whenever you click on a segment’s information box, the source document will appear in the “Docu-

ment Browser” window directly above it. 

 

Optimal view for jumping between retrieved segments and the source documents 
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15.9 “Overview of retrieved segments” 

An easy way to get an overview of the retrieved segments is by calling up the Overview of retrieved 

segments by clicking on the appropriate icon in the toolbar at the top of the “Retrieved Segments” 

window. 

 

Opening the “Overview of retrieved segments” in the toolbar 

This display combines a list view and a detailed view of the retrieved segments. The upper half of the 

window shows the segment that is currently selected in the lower part of the window. The lower part 

works in the same way as the other overview tables in MAXQDA. Clicking on the column’s header 

will result in sorting the table corresponding to the values of the selected column. You may also switch 

the different columns on and off. Just right-click on a column header and select Choose fields. You 

can then specify which columns should be shown (box checked) and which should not (box un-

checked). This kind of display makes it easy to browse through retrieval results. Just click on a line in 

the table and then view the segment in the upper part of the window. 

 

The two-section window in the “Overview of retrieved segments” 

Tip: It is possible to code text segments that are displayed in the upper part of the “Overview of 

coded segments” window. Highlight a text passage in this area with the mouse and drag it while you 

hold down the left mouse button to one code in the “Code System” window. A new coding stripe 

in the “Document Browser” window will indicate the newly created coded segment – as long as the 

window is visible and there no filter for coding stripes is active. 

The option to display the retrieved segments in a table in XLS/X or HTML format is particularly helpful. 

This gives a very good overview: not only the segment in plain text but all the information around it 

is listed, for instance the date when the segment was coded and the name of the person who did the 

coding. 
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Tip: The overview table is also the best place to write comments on your coded segments. You read 

the segment in the upper window and write your comment below. Just double-click the field for 

comments in the matrix and type in your annotation. 

The toolbar in the “Overview of Retrieved Segments” 

The following functions, among others, can be accessed from the toolbar: 

  Code retrieved segments – the selected coded segments (marked in green) from the list will be 

assigned to an existing code. It is possible to select multiple rows by holding down the Ctrl key. If no 

rows are selected, the entire table will be coded. 

  Code retrieved segments with a new code – the selected coded segments (marked in green) 

from the list will be assigned to a new code. It is possible to select multiple rows by holding down the 

Ctrl key. If no rows are selected, the entire table will be coded. 

  Show as Excel table – opens a table in XLS/X format with the retrieved segments and associated 

information. 

  Show as HTML table – A table in HTML format is created and displayed with the default browser. 

If nothing is selected, the entire table will be displayed. If individual rows are selected and highlighted 

in green, only these rows will be exported. 

  Export retrieved segments – allows for export of the retrieved segments in RTF or XLS/X format, 

including preceding source data. 

Calling up the “Overview of retrieved segments” 

Which retrieved segments are included in the overview depends on the context of the overview: 

All coded segments from the project: 

• Menu Code > Overview of coded segments, or 

• Right-click on the stem of the “Document System” or “Code System” and select Overview of 

coded segments 

Coded segments that currently appear in the “Retrieved Segments” window: 

  Click on the Overview of retrieved segments button  in the “Retrieved Segments” toolbar 

All coded segments of a code: 

• Double-click on the expanded code, or 

 Right-click on the expanded code and select Overview of coded segments 

All retrieved segments of a code and its subcodes: 

• Double-click on the collapsed code, or 

• Right-click on the collapsed code and select Overview of coded segments 

What information can be found in the columns of the overview? 
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Regardless of the document type, the following columns of the coding overview have the same sig-

nification: 

 Document group – document group from which the coded segment originates 

 Document – document from which the coded segment originates 

 Weight – weight of the coded segment (can be modified directly in the overview!) 

 Comment – comment on the coded segment (can be modified directly in the overview!) 

 Code – the code with which the segment is coded 

 Created – the date on which the coded segment was initially created 

 Author – user who initially created the coded segment 

Depending on the document type, the following columns have different significations: 

Text Documents 

 Start – paragraph in which the coded segment begins 

 End – paragraph in which the coded segment ends 

 Preview – the first 63 characters of the encoded text (when exporting the output contains the 

entire coded segment) 

 Area – number of characters in the coded segment (minimal variation may occur between Win-

dows and Mac) 

 Coverage – number of characters in the coded segment in relation to the number of characters 

of the text as a whole (minimal variation may occur between Windows and Mac) 

PDF Documents 

 Start – for text coding, the position of the character at which the coded segment begins. For 

image coding, the lower left corner of the segment. 

 End – for text coding, the position of the character at which the coded segment ends. For image 

coding, the upper right corner of the segment. 

 Preview – the first 64 characters of the coded text. For images, <IMAGE> will be displayed (upon 

exportation the entire coded text and image segment will be displayed) 

 Area – for coded text segment, the number of codes; for a coded image segment, the encoded 

area as measured in PDF units 

 Coverage – for text, the number of coded characters in relation to the total number of characters 

in the text; for images, the area of the encoded image in relation to the total area of the PDF 

Image Documents 

 Start – the upper left corner, at which the coded segment begins 

 End – the lower right corner, at which the coded segment ends 
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 Preview – always displayed as <IMAGE> (coded image segment will be displayed upon exporta-

tion) 

 Area – coded area, in pixel x pixel 

 Coverage – coded area in relation to the total area of the image 

Table Documents 

 Start – cell in which the coded segment is found 

 End – identical to “Start,” as coded segments are always in the same cell 

 Preview – displays the first 63 characters of coded text (when exported, will include the entire 

coded segment) 

 Area – Number of characters in the coded segment 

 Coverage – for text coding, the position of the character at which the coded segment begins. For 

image coding, the lower left corner of the segment. 

Audio and Video Files 

 Start – the time at which the coded segment begins 

 End – the time at which the coded segment ends 

 Preview – always displayed as <AUDIO> or <VIDEO> (image of beginning of clip will be displayed 

upon exportation) 

 Area – length of coded media clips 

 Coverage – length of coded media clips in relation to total length of the file 

Sort, Hide and Reveal Columns 

As with all tables, you can also organize the “Overview of retrieved segments” as you wish: 

 Drag & Drop columns to change their order. 

 Sort a column by clicking on the column heading. 

 Hide or reveal columns by right-clicking on the column heading. 

15.10 Table view of the “Retrieved Segments" 

The “Retrieved Segments” can be displayed in a table view. Click the Change to table view  icon 

at the top of the window. MAXQDA will then display the coded segments in the same manner as the 

“Overview of retrieved segments” in the preview window. This display is interactive: Click on a row 

to show the corresponding segment in the “Document Browser." 
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The “Retrieved Segments” in table view 

15.11 Printing and Exporting “Retrieved Segments”  

You may wish to continue to work with the retrieved segments that you have called up. MAXQDA 

makes it possible for you to print out these segments, copy them to the clipboard, or to export them 

as a file. 

To print out the retrieved segments, you have two options: 

 Select Print > Retrieved Segments from the Project drop-down menu. 

 Click on the Print retrieved segments icon  in the “Retrieved Segments” window toolbar. 

You will then see the standard option for selecting your printer. In this window, you can also select 

the print layout and choose to print out only certain pages. 

 

Printout of the “Retrieved Segments” window 
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If you want to be able to edit aspects of the formatting, it is recommended that you first export the 

retrieved segments, open them for edit in a word processor, and then print them out. 

To export the retrieved segments, choose Project > Export > Retrieved Segments from the main 

menu. You can then give the file a name and choose the format that you want the document to be 

saved in. Alternatively, you can click on the Export retrieved segments icon  in the “Retrieved 

Segments” window toolbar. The results are the same. The following options menu will appear: 

 

Options for the export of retrieved segments 

The following options are available: 

Include memos – When this option is selected, all memos that appear in the “Retrieved Segments“ 

window will be exported. For export in XLS/X or HTML format, memos will be attached to a coded 

segment in a cell. 

Include tooltip variables – When this option is selected, all tooltip variables that are selected in the 

„List of document variables“ will be exported. For export in XLS/X or HTML format, each variable will 

be assigned to its own column. 

Include list of other codes assigned to each segment – The export file will include any additional 

codes that were assigned to each coded segment being exported. Overlap with any other code, in-

cluding its weight, will be listed. If you select the additional option Only activated codes, the action 

will apply to activated codes only. 

Select one of the three export formats (Excel, HTML or RTF) as well as the saving location. When you 

click OK, the export process will being and the exported data will open in the appropriate program 

for the file type. 
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15.12 Coding “Retrieved Segments”  

MAXQDA makes it possible for you to code some or all of your retrieved segments in the “Retrieved 

Segments” window. In this way, you can search and code quickly within specific segments that have 

been called up. 

Let’s say you did a retrieval of the intersections between the codes “Health” and “Home life” for all 

the women in your interview sample. You can then choose to code all of these segments with a code 

called “Health + Home life + women.” 

To do this, you can … 

 select Code retrieved segments from the Analysis drop-down menu, 

 click on the icon in the “Retrieved Segments” window toolbar to Code retrieved segments, or 

 click on the  icon in the “Retrieved Segments” window toolbar to Code retrieved segments 

with a new code, if the code you wish to code with hasn’t been created yet. 

You will then see the following window: 

 

Autocoding the retrieved segments with a new code 

In the dialog window, you can choose a code from the quick list. The most recently-used code is listed 

at the top of the list. To open the quick list, simply click on the small triangle on the right. If the 

code you are looking for is not in the quick list, you will need to close the dialog window and click 

on that code in the “Code System” in order to add it to the quick list. Now you can once again click 

the Code retrieved segments symbol, whereby the selected code will be assigned to all segments in 

the “Retrieved segments” window. 

Note: If you encode retrieved segments with an existing code, existing encodings will not be changed. 

When you encode retrieved segments with a new code, in the case of overlapping coded segments, 

the outermost segment boundaries will be used. 

This action will be added to the list of coding actions in the Undo coding menu in the “Code” 

toolbar. When you open this list, you will see the most recent coding actions at the top with the 

number of segments coded in each action in parentheses after the code name. If you have coded 

many segments at one time with the autocoding function, they can all be removed at the same time 

by clicking once on the appropriate line in this list. 
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Undoing coding actions 

15.13 Copying “Retrieved Segments” with Source Information 

into the Clipboard 

In a research project, citations (e.g. interview passages) are often integrated into the final report. It is 

important to note the source information of these citations - the document and paragraph from 

which they were taken. MAXQDA simplifies this process with the function Copy segment with 

source information to Clipboard. You can access this function by right-clicking on the source in-

formation in the “Retrieved segments” window. 

 

Calling up source information from a context menu 

When you call up the function from the context menu, MAXQDA copies the selected segment into 

the clipboard. Now you can paste the citation into your word processing program by pressing Ctrl+V 

(Windows) or cmd+V (Mac). At the end of the citation, the document name from the “Document 

System,” as well as the paragraph, will automatically be inserted. 



Coding Query: Finding Coded Segments 

 

237 

 

Citation with source information in word processing program 
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16 Complex Retrievals 

16.1 Logical Combinations of Codes  

Different than with classic quantitative content analysis, the categorization of data in qualitative anal-

ysis is not the end of the document analysis; instead it is simply a step toward further interpretative 

analysis. The categories create a structure within the documents, but they don’t replace them. 

MAXQDA’s analysis functions are tools to help you navigate and further develop this structure. 

MAXQDA allows you to analyze the combination of activated codes in different ways, by taking into 

account the different groupings and positions of coded segments. In this section, we will discuss the 

complex combinations modes, of which MAXQDA has many to offer. 

To perform a complex retrieval you can call up the Complex Coding Query: 

 Select Complex Coding Query from the Analysis drop-down menu, 

 Click on the icon  in the status bar at the bottom of the MAXQDA screen, or 

 Right-click on the gray area in the “Retrieved Segments” window where the info boxes appear 

and choose Complex Coding Query from the context menu. 

 

Access to the Complex Coding Query in the context menu of the “Retrieved Segments” window 

The following dialog window will open: 
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Complex Coding query window 

The dialog window has the following aspects: 

 The Function field allows you to choose the analysis function. 

 Below that, there are three windows, labeled A, B, and C. 

 Window A is important for almost every retrieval option and holds the selection of codes to be 

included in the selection function. To add codes, activate them in the “Code System” and then 

click the button to add All activated codes. 

Tip: You can add codes directly from the “Code System” by using Drag & Drop to move codes to 

window A. 

 Window B is also for selecting codes, but you can do so from the quick list. Simply click on the 

 symbol to view the list. 

Tip: To make a code appear in the quick list, just click on it in the “Code System”. 

 Window C allows you to set certain parameters (e.g. the maximum distance between two coded 

segments). 
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The “Result” window at the bottom shows how many segments would be pulled up if the retrieval 

were carried out with the current settings in Windows A, B, and C. Under this window is a description 

of the retrieval function that is currently selected, and on the right side, there is a visualization of 

what that function does. 

The retrieval begins when you click on the Start button. 

The following table gives you an overview of the various functions: 

Name Description 

Intersection 

(”small picture”) 

Retrieve only the part segments that have all of the codes listed in "A" assigned 

to them. 

Intersection (Set) Retrieve only the part segments that have at least X of the codes listed in "A" as-

signed to them (the number X is specified in "C"). 

Overlapping 

(”big picture”) 

Retrieve the full segments where at least one part has all the codes listed in "A" 

assigned to it. 

Only one code Search for segments where only one of the codes listed in "A" is assigned (and 

none of the other codes listed in "A"). 

Only this code Search for segments where the code selected in "B" is assigned, but none of the 

codes listed in "A" are assigned. 

If inside Search for segments assigned to any one of the codes listed in "A" that are also 

completely surrounded by a segment assigned to the code selected in "B". 

If outside Search for segments assigned to any one of the codes listed in "A" that has no 

overlap or intersection with a segment assigned to the code selected in "B". 

Followed by Search for segments assigned to any one of the codes listed in "A" that is follo-

wed by a segment assigned to the code selected in "B" within no more than X 

paragraphs. The number X is specified in "C". (Does not work in image or PDF 

documents.) 

Near Search for segments assigned to any one of the codes listed in "A" that is prece-

ded or followed by a segment assigned to the code selected in "B" within no 

more than X paragraphs. The number X is specified in "C". (Does not work in 

image or PDF documents.) 

You can see which retrieval function is currently active in the status bar at the bottom of MAXQDA, 

in this case it is the “Near” function: 

 

Retrieval function in the status bar 

Note: If there are no segments shown in the “Retrieved Segments” window, it could be because a 

retrieval function was accidentally activated. You can quickly check for this in the status bar. 
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16.2 Detailed Information about Complex Retrieval Functions  

Intersection (“small picture”) 

Definition: Retrieve only the part segments that have all of the codes listed in "A" assigned to them. 

How it works: 

Activate documents and/or document groups that you want to include. 

Activate the codes in the “Code System” that you want and then click 

on All activated codes in the text retrieval dialog window to insert 

them in Window A. 

Tip: All codes in Window A must be attached to a segment for it to be 

called up! 

Changing the activations in the “Document System” immediately 

changes your results. 

It is often helpful for this function to include the subcodes, so that all 

combinations of intersections between each code (and its subcodes) are 

automatically included. The easiest way to include the subcodes is to 

click on the  symbol at the bottom of the screen. 

Example: 
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Intersection (Set) 

Definition: Retrieve only the part segments that have at least X of the codes listed in "A" assigned 

to them (the number X is specified in "C"). 

How it works: 

Activate documents or docu-

ment groups you want included 

in the retrieval. Activate the 

codes to be included in the 

“Code System.” Click on the 

button All activated codes to 

have the activated codes in-

serted in Window A. 

Set the minimum number of 

codes that must intersect in 

Window C. 

You can see in the “Results” 

window how many retrieved 

segments would be found 

based on intersections. 

Result: 

The intersecting segments are 

listed in the “Retrieved Seg-

ments” window. 

Example: 

If Codes 1, 2, 3, and 4 are entered in 

Window A, and you have entered in 

Window C that at least three intersec-

tions are required, the first two exam-

ples to the right would not be called 

up. The first doesn’t have any inter-

sections, and the second only has two 

intersecting codes. The third has the 

required three intersection codes, 

though, so it would be listed in the 

“Retrieved Segments” window. 

Only the section of the coded seg-

ments that is coded with all three 

codes is displayed. 
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Overlapping (“big picture”) 

Definition: Retrieve the full segments where at least one part has all the codes listed in "A" assigned 

to it. 

How it works: 

Activate documents or document groups you want included in the re-

trieval. Activate the codes to be included in the “Code System.” Click 

on the button All activated codes to have the activated codes inserted 

in Window A. 

Attention: Segments will only be listed if they are coded with all codes 

listed in Window A. 

The “Overlapping” function works just like the “Intersection” function, 

except that the results are displayed differently. The results of “Overlap-

ping” include the entirety of each coded segment that overlaps, rather 

than just showing the section that is coded with both codes. 

As with the “Intersection” function, it is often helpful to include sub-

codes in the retrievals. Then all combinations of subcodes are tested for 

overlap. 

Example: 
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Only One Code 

Definition: Search for segments where only one of the codes listed in "A" is assigned (and none of 

the other codes listed in "A"). 

Note: Think carefully before using this function as it could pull up a very large number of segments. 

How it works: 

Activate documents or docu-

ment groups you want in-

cluded in the retrieval. Acti-

vate the codes to be included 

in the “Code System.” Click 

on the button All activated 

codes to have the activated 

codes inserted in Window A. 

 

Example:  

If codes 1 and 2 are in Window A, the 

first two examples on the right would 

be included in the retrieval, because 

they don’t overlap each other. The fact 

that codes 2 and 3 overlap makes no 

difference, because code 3 is not in 

Window A. The third example would 

not be included in the retrieval because 

codes 1 and 2 intersect. 
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Only This Code 

Definition: Search for segments where the code selected in "B" is assigned, but none of the codes 

listed in "A" are assigned. 

This function is very similar to the “Only One Code” function, but it targets only one selected code. 

The target code is selected in Window B. The other codes are selected as usual in Window A. 

 

How it works: 

1. Activate documents or docu-

ment groups you want in-

cluded in the retrieval. 

2. Choose the code from the 

quick list in Window B that you 

want to call up. If the code is 

not there that you want to se-

lect, left-click on it in the “Code 

System” and try again. 

3. Now activate the codes for 

Window A in the “Code Sys-

tem” and click on the button 

All activated codes to have 

the activated codes inserted in 

Window A. 

Example: 

Code 1 is the selected code (Win-

dow B). Code 2 and 3 are the 

codes in Window A. When either 

Code 2 or Code 3 intersects with 

Code 1, Code 1 is not listed. This 

is the case in the second and third 

examples on the right. Only the 

first example shows an instance 

of Code 1 that isn’t intersected by 

Code 2 or Code 3. It would be 

listed in the “Retrieved Seg-

ments” window. 
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If Outside 

Definition: Search for segments assigned to any one of the codes listed in "A" that has no overlap 

or intersection with a segment assigned to the code selected in "B". 

 

How it works: 

1. Activate documents or docu-

ment groups you want in-

cluded in the retrieval. 

2. Activate the codes to be in-

serted in Window A in the 

“Code System.” Click on the 

button All activated codes to 

have the activated codes in-

serted in Window A. 

3. Pick the codes for Window B 

from the quick list. If they are 

not there, left-click on them in 

the “Code System” and try 

again. 

Example: 

This function would be helpful if 

you were looking for text seg-

ments in which people talk about 

what they consider possible, but 

don’t want to include those in-

stances that are in the context of 

these peoples’ wishes. 

Code 1 is in Window A, and Code 

2 is in Window B. This means you 

are looking for instances of Code 

1 that are completely outside of 

Code 2. In the example on the 

right, only the third example 

would be called up. In the first ex-

ample, Code 1 isn’t even there, 

and in the second, Code 1 is not 

completely outside of Code 2.  
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If Inside 

Definition: Lists segments where the code in Window A is completely surrounded by the code in 

Window B. Results can be the segments of the inner code (Window A) or the outer code (Window 

B). 

 

How it works: 

1. Activate documents or docu-

ment groups you want in-

cluded in the retrieval. Activate 

the codes to be inserted in Win-

dow A in the “Code System.” 

Click on the button All acti-

vated codes to have the acti-

vated codes inserted in Win-

dow A. 

2. Pick the codes for Window B 

from the quick list. If they are 

not there, left-click on them in 

the “Code System” and try 

again. 

3. You can then set what you 

want to view as the result of 

this function; you can choose to 

call up the segments coded 

with the code in Window A, 

those coded with the code in 

Window B, or both. 

Example: 

Let’s say you are interested in the 

things people said about criteria 

for success, but only in the con-

text of what they consider feasi-

ble. You could use this function, 

putting the “criteria for success” 

code in Window A and the “con-

sidered feasible” code in Window 

B. 

In the examples on the right, only 

the first shows a case where 

Code 1 (Window A) is found 

completely inside Code 2 (Win-

dow B). That is not the case in the 

second or the third examples. 
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Followed By 

Definition: Search for segments assigned to any one of the codes listed in "A" that is followed by a 

segment assigned to the code selected in "B" within no more than X paragraphs. The number X is 

specified in "C". (Does not work in image or PDF documents.) 

 

How it works: 

1. Activate documents or docu-

ment groups you want in-

cluded in the retrieval. Activate 

the codes to be inserted in Win-

dow A in the “Code System.” 

Click on the button All acti-

vated codes to have the acti-

vated codes inserted in Win-

dow A. These are the codes 

that will be looked for. 

2. Pick the codes for Window B 

from the quick list. If they are 

not there, left-click on them in 

the “Code System” and try 

again. These are the codes that 

must follow the Window A 

code(s) within a certain number 

of paragraphs. 

3. In Window C, you can insert 

the maximum number of para-

graphs to look for the Window 

B code(s) after finding a Win-

dow A code. 

4. Finally, you can choose what 

you want to view as the results 

in the “Retrieved Segments” 

window. 

Example: 

In the example on the right, we 

are looking for Code 1 (Window 

B) following Code 2 (Window A) 

within two paragraphs. 

Code 1 appears four times in the 

example, but only the third in-

stance would be included in the 

results, because it follows an in-

stance of Code 2 within two para-

graphs. 
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Near 

Definition: Search for segments assigned to any one of the codes listed in "A" that is preceded or 

followed by a segment assigned to the code selected in "B" within no more than X paragraphs. The 

number X is specified in "C". (Does not work in image or PDF documents.) 

 

How it works: 

1. Activate documents or docu-

ment groups you want included 

in the retrieval. Activate the 

codes to be inserted in Window 

A in the “Code System.” Click on 

the button All activated codes 

to have the activated codes in-

serted in Window A. These are 

the codes that will be looked for. 

2. Pick the codes for Window B 

from the quick list. If they are not 

there, left-click on them in the 

“Code System” and try again. 

These are the codes that must be 

near the Window A code(s) 

within a certain number of para-

graphs. 

3. In Window C, you can insert the 

maximum number of paragraphs 

away the Window A code can be 

from the Window B code. 

4. Finally, you can choose what you 

want to view as the results in the 

“Retrieved Segments” window. 

Example: 

We are looking for places where 

Code 2 (Window A) and Code 1 

(Window B) are found within 

two paragraphs of each other 

(Window C). 

Code 1 is found four times in 

the screenshot, but only the sec-

ond and third instances are 

within two paragraphs of Code 

2. 

We chose to view the Window B 

code in the Retrieved Segments, 

but we could have theoretically 

chosen to list the Window A 

code or even both of them. 
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17 Visual Tools 

17.1 Code Matrix Browser: Visualizing Codes per Document    

The Code Matrix Browser (CMB) offers you a new way of visualizing which codes have been assigned 

to which documents. The matrix provides an overview of how many document segments from each 

document have been assigned a specific code, and this for each existing code. 

The Code Matrix Browser is constructed as follows: Documents are listed in the columns while codes 

are listed in the rows. The symbols at the conjunction points represent the number of coded segments 

that are coded with a particular code. The larger the symbol, the more coded segments are assigned 

to the code in question. 

 

The Code Matrix Browser 

The Code Matrix Browser can be opened in the following ways: 

 Selecting Code Matrix Browser from the Visual tools drop-down menu, 

 using the keyboard shortcut Ctrl+Alt+M (Windows) or cmd+Alt+M (Mac) 

 clicking on the CMB symbol in the “Visual tools” toolbar. 

 

CMB symbol in the “Visual tools” toolbar 

Code Matrix Browser options 

After opening the Code Matrix Browser an options window will appear, which allows you to change 

display options. Often, only the activated documents might be of interest, for example. 
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Code Matrix Browser options dialog window 

First you have to decide whether the results should be grouped or not: 

Documents – No grouping, every document has a column. 

Document groups – The columns are made up of document groups. The coded segments of the 

documents in each group will be summed up. 

Document sets – The columns are made up of document sets. The coded segments of the documents 

in each document set will be summed up. 

Focus Group Participants – Focus group participants are displayed in the columns. 

Further options allow you to restrict and adjust the display: 

Only for activated documents – Only the activated documents will be displayed. (If there are no 

activated documents in a document group or document set, the CMB will be empty.) 

Only for activated focus group participants – Only activated focus group participants will be dis-

played in the columns. This option is visible only when the corresponding option above is selected. 

Only for activated codes – Only the activated codes will be displayed as rows. 

Use weight filter – Only coded segments with a weight within the limits of the weight filter will be 

used. 

Count hits per document only once – This option will be displayed only if a code occurs infrequently 

within a document. The unit of analysis is therefore not the individual segment, but rather the full 

document. 
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Code Matrix Browser Toolbar 

The first thing you will see at the top of the Code Matrix Browser window is the toolbar, which gives 

you access to the following functions: 

  Quote Matrix – Displays coded segments as an Excel file 

    Names, columns: none/short/full – Determines display of document names in column 

headers. 

  Calculation of symbol size refers to all coded segments. 

  Calculation of symbol size refers to the column. 

  Calculation of symbol size refers to the row. 

  Display nodes as squares. 

  Display nodes as circles. 

  Display nodes as values. 

  Count hits per document only once – The Code Matrix Browser display will be based not on 

the number of coded segments but rather on the full document, meaning it will display only whether 

the code occurs in the document or not. For collapsed subcodes, the code frequency of the subcodes 

will be aggregated. 

  Binarize view – Regardless of how many coded segments are present in a cell, this function 

displays only whether a coded segment is present or not; the symbol size is therefore unified. Even 

when a collapsed subcode with multiple encodings is present, only one will be counted. 

  Sum – displays the sum of rows and columns. 

  Refresh – updates display via the Refresh function. 

  Open as Excel table – Displays the matrix with the code frequencies of the Code Matrix Browser 

in Excel. The columns and rows are reversed to allow an easier import into SPSS. 

  Export – Exports the displayed matrix as values, meaning the number of coded segments per 

code and per document, in Excel or HTML format. The columns and rows are reversed to allow an 

easier import into SPSS. Export as a graphic file (Vector or Bitmap) is also possible. 

What is actually shown in the Code Matrix Browser? 

The size and color of the clusters in the matrix show how many document segments in each document 

have been assigned each particular code and subcode. The larger the cluster, the greater the number 

of segments that were assigned this code or category in this document. 

Tip: The sequence in which the documents are displayed is determined by their sequence in the 

Document System. If you wish to change the order of the documents, you must do so in the Docu-

ment System. 

When you move the mouse cursor over a cluster, a screen tip appears: 
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Tooltip in the Code Matrix Browser 

The name of the document, the code or subcode, and the number of coded segments assigned to 

the code are shown in the box. 

The document names in the column headers can be displayed in three ways: 

1.   without document names, 

2.   with short document names, or 

3.   with full document names. 

The number of documents that can be displayed as columns in the matrix depends on this setting. In 

most cases, it is sufficient to use short document names, showing only the first few letters, which 

nevertheless is enough for you to recognize it. If in doubt about a document, you can take a look at 

the screen tip, where the full document name is displayed. If necessary, the width of the columns can 

be adjusted by clicking on a dragging the lines between column headers. For focus group participants, 

the names of the participants will be displayed in the columns in the place of the document names. 

Tip: The columns can be easily moved with the mouse. In this way, you can easily compare the coded 

segments of two different documents or focus group participants. 

The codes are displayed in the CMB in the same way as in the “Code System,” in a tree structure 

similar to that of Windows Explorer or Mac Finder. Subcodes can be collapsed in the usual way, by 

clicking the – symbol. 

Tip: When the subcodes are collapsed, the number of coded segments is aggregated on the parent 

code level. If a parent code (that hasn’t been used in the document) has three subcodes with 10 

coded segments each, when you collapse the subcodes, the parent code will show 30 coded seg-

ments. 

How is the Symbol Size Determined? 

MAXQDA determines the minimum and maximum code frequency of all nodes shown and then di-

vides the difference between these two values in seven equal value ranges. The smallest value range 

is assigned the smallest symbol and the largest value range, the largest. By collapsing or revealing 

codes, you may change the smallest or largest value, and the overall display therefore may change as 

well. When all the numerical values are identical, a mid-size square will be displayed.  

If the Calculation of symbol size refers to the column/row option is selected, this mechanism is 

applied individually to the column or row. 

Jumping from the Symbol to the Coded Segment 

The document segments that have been assigned a particular code can be called up immediately by 

double-clicking on the symbol. The relevant document and code are then activated and the coded 
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segments appear in the “Retrieved Segments” window. It is possible to keep the CMB open, allowing 

one to easily view the contents of different symbols. 

Exporting the CMB as an Image File 

The Export symbol in the toolbar allows you to export the Code Matrix Browser as currently dis-

played. This file can later be inserted into a word processing program or Powerpoint slide. 

Tip: Click on the camera icon  to copy the actual view into the clipboard. Now you can open Word, 

PowerPoint, or other programs and paste the image into it by choosing Ctrl+V (Win) or cmd+V (Mac). 

17.2 Code Relations Browser: Visualizing Overlapping Codes  

A tool similar to the CMB is the Code Relations Browser (CRB). The CRB is a visualization of the 

relationships between codes. A table shows how many document segments any two codes are at-

tached to. The representation is similar to the Code Matrix Browser, but in this case, the little 

squares/circles stand for the number of co-occurrences of codes. 

You can open the CRB in different ways: 

 By selecting Code Relations Browser from the Visual tools drop-down menu, 

 with the keyboard shortcut Ctrl+Alt+R (Windows) or cmd+Alt+R (Mac) 

 by clicking on the CRB symbol in the “Visual tools” toolbar. 

 

Symbol in the “Visual tools” toolbar for opening the CRB 

The Code Relations Browser looks like this: 

 

An example of the Code Relations Browser visualization 
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Code Relations Browser options 

After opening the Code Relations Browser an options window will appear, which allows you to 

change display options. Often, only the activated documents might be of interest, for example. 

 

Code Relations Browser options dialog 

First you have to decide which codes will be shown as rows: 

All codes – All codes will be shown, the order being the same as it is in the “Code System” 

Activated codes – Only the activated codes will be shown as rows. 

A similar decision has to be made for the columns in the Code Relations Browser, with the added 

option of Choose top level code. Selecting this option will open another dialog window after press-

ing OK, allowing you to select as many top level codes as you want. The selected top level codes and 

their subcodes will be shown as columns in the Code Relations Browser. 

Under Type of analysis you can decide which relations MAXQDA will show, as well as how often a 

code was used in a document: 

Co-occurrence of codes – Only “real” overlaps of codes will be used, which means that a segment 

has to be coded with both codes and the codes need to overlap. 

Near (codes) – Alternatively the Code Relations Browser can analyze how many encodings exist in 

which two codes are present at a defined distance from one another. After clicking OK, you can 

define the desired distance. 
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Note: If you search with function „Near (codes)“ and chose distance „0“ you may find more hits 

than searching for Co-occurence of codes. The function „Near (codes)“ only evaluates if two codes 

are assigned somewhere in the same paragraph – not at the same segment. 

The option Only for activated documents will make the Code Relations Browser only look for rela-

tions in the activated documents. 

Count hits per document only once – The Code Relations Browser counts the number of docu-

ments in which an overlap or proximity (near) of codes exists. It does not matter how many times the 

overlap or proximity occurs within a document. 

Code Relations Browser toolbar 

At the top of the screen, you will find the toolbar with the following functions: 

  Quote Matrix – Displays coded segments as an Excel file 

    Names, columns: none/short/full – Determines display of document names in column 

headers. 

  Display nodes as squares. 

  Display nodes as circles. 

  Display nodes as values. 

  Co-occurrence of codes – Switches to an “overlap” type analysis. 

  Near (codes) – Switches to a “near” type analysis and displays a dialog window in which the 

maximum distance can be defined. (In table documents only the nearness of coded segments in the 

same column will be evaluated. Coded image segment will be ignored generally.) 

  Count hits per document only once – The Code Relations Browser display will be based not on 

the number of coded segments but rather on the full document, meaning it will display only whether 

the code occurs in the document or not. For collapsed subcodes, the code frequency of the subcodes 

will be aggregated. 

  Binarize view – Regardless of how many coded segments are present in a cell, this function 

displays only whether a coded segment is present or not; the symbol size is therefore unified. Even 

when a collapsed subcode with multiple encodings is present, only one will be counted. 

  Sum – displays the sum of rows and columns. 

  Refresh – updates display via the Refresh function. 
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  Open as Excel table – Displays the matrix with the code frequencies of the CRB in Excel. The 

columns and rows are reversed to allow an easier import into SPSS. 

  Export – Exports the displayed matrix as values, meaning the number of coded segments per 

code and per document, in Excel or HTML format. The columns and rows are reversed to allow an 

easier import into SPSS. Export as a graphic file (Vector or Bitmap) is also possible. 

What is actually shown in the Code Relations Browser? 

Each symbol in the matrix represents the number of intersections of the two codes. The larger the 

symbol, the larger the number of intersections. If you choose to switch to the Near function, the 

symbols represent the number of times two codes exist near to each other (within a certain number 

of paragraphs, defined in your settings). 

If you click on the Count hits per document only once icon in the toolbar, the symbols represent 

the number of documents that have at least one instance of an intersection or proximity between the 

two codes. It no longer matters how many times these intersections occur in each document. 

Tip: The order of codes in the Code Relations Browser will be identical to the order in the “Code 

System.” If you want to change the order in the graphic, you have to change the order in the “Code 

System” first. 

Jumping from the Symbol to the Coded Segment 

You can call up the document segments with overlapping codes by double-clicking on the node rep-

resenting them. The “Overlapping” retrieval function will automatically be activated, bringing up the 

segments in the “Retrieved Segments” window. The CRB can remain open, so you can quickly go 

from one set of overlapping codes to another. 

Note: If you are in mode „Near“ and double click on a node, that has collapsed codes, the collapsed 

subcodes will be expanded automatically and only the higher code will be evaluated, not the previ-

ously collapsed codes. 

Exporting the CRB as an Image File 

The Export  symbol allows you to save the current CRB display as a file, which you can then insert 

easily into a word processing file or Powerpoint slide. 

Tip: Click on the camera icon  to copy the actual view into the clipboard. Now you can open Word, 

PowerPoint, or other programs and paste the image into it by choosing Ctrl+V (Win) or cmd+V (Mac). 

17.3 Document Comparison Chart: A Visual Comparison of 

Coded Text 

This visualization works for a number of documents at one time and offers a sort of mix between the 

Document Portrait and the Codeline. Simply choose the documents and codes that you wish to in-

clude in the visualization by activating them before calling up the function. 
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The Document Comparison Chart shows the documents on the y-axis and the paragraph numbers 

on the x-axis, making it possible to compare the flow of codes in each document. The cells show the 

codes that exist in each paragraph of each document with a bar assigned the same color as the code 

it represents. Each code that is present in the paragraph is represented by a colored section of the 

bar. If a code is used more than once in a paragraph, it is still only visualized once. To give you an 

idea how this works, see the screenshot below. In this example, you can see 10 paragraphs for three 

different documents. You can see that there were no coded segments in any of the documents in the 

first paragraph. In “Doc 1,” the first coded segments are in paragraph two, where two blue and one 

red code are visualized. 

 1 2 3 4 5 6 7 8 9 10 

Doc 1  ■■■ ■■   ■ ■ ■■ ■  

Doc 2    ■ ■ ■ ■■   ■ 

Doc 3   ■    ■ ■ ■  

The principle behind the Document Comparison Chart 

If several codes with different colors appear in the same paragraph, the space available will be shared 

between the codes. Generally, the space is fixed to 50 pixels. These pixels will be allocated according 

to the size of the coded segments. If exactly the same segment is coded with a green and a red code, 

then 25 pixels will be colored red and 25 green. 

Like in Document Portrait, codes and colors must correspond in a meaningful way. Otherwise the 

diagram will have no meaning for you. 

You can call up the Document Comparison Chart: 

 by selecting Document Comparison Chart from the Visual tools drop-down menu, or 

 by clicking on the  symbol in the “Visual tools” toolbar. 

The visualization looks like this: 

 

Example of a Document Comparison Chart 
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The Document Comparison Chart is particularly useful for the analysis of structured documents. In 

this case, all the documents have the same number of paragraphs and allow for a direct comparison. 

You are more or less looking at a Document Portrait for each selected document at the same time. 

Active Symbols 

As in all visualizations, the symbols representing the coded segments are active, meaning you can 

jump directly to the coded segments in the original document in the “Document Browser” by double-

clicking on the symbol. 

Exporting the Document Comparison Chart as an Image File 

The Export  symbol allows you to export the current display of the Document Comparison Chart 

so you can later insert it into a word processing file or Powerpoint slide. 

Tip: Click on the camera icon  to copy the actual view into the clipboard. Now you can open Word, 

PowerPoint, or other programs and paste the image into it by choosing Ctrl+V (Win) or cmd+V (Mac). 

17.4 Document Portrait: Visualizing a Document  

This visualization is for a specific document, making it a case-oriented function. The document is 

shown as a picture of all the coded segments based on the order and colors of the codes. 

You can access the Document Portrait for the displayed document in the “Document Browser” win-

dow… 

 by selecting Document Portrait from the Visual tools drop-down menu, 

 by clicking on the appropriate symbol in the Visual tools toolbar. 

 

Symbol in the “Visual tools” toolbar for calling up the Document Portrait 

Alternatively, you can right-click on a document and select Document Portrait in the context menu 

that appears. 

The results of this function are only meaningful if you have made use of the opportunity to assign 

colors to codes. The visualization of a document can only be fruitful if this association of colors makes 

sense to you. Here are a few examples: 

 Imagine a psychologist has coded an in-depth interview in a way that categories related to aggres-

sion have red colors and categories for quiet and friendly behavior have green colors. Now a Doc-

ument Portrait would show with you in a single glance how often the interview shows aggressive 

behavior and when during the interview this happened. 

 In biographical research, the particular representations can be chosen for critical life events, thus 

making it easy to get an idea of the life course of a person and the concentration of critical events. 
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 For thematic analysis, it may be useful to associate different colors to different topics. Now, you 

can easily see which topics dominate the discussion and which topics are closely related. 

What Does a Document Portrait Display? 

A Document Portrait shows the sequence of codes for a selected document. To better understand 

what happens, it is useful to take a look at the “Overview of coded segments” for a selected docu-

ment. All coded segments are listed in this overview. The first column displays the color associated 

with the code. This is the material that is used to “paint” document portrait. Only those colors dis-

played in the first column of the overview table will appear in the visualization. In the overview table, 

all segments are equal regardless of their size. The Document Portrait, however, takes the size of the 

segments into account and “weights” the color according to the segment’s size. 

The color attributes of the codes associated with the document are displayed in a matrix with 1,200 

little squares (arranged in 30 rows, each one with 40 squares). The representation starts with the first 

square on the left in the first line, and ends with the last square on the right of the last line. The 

picture is set up in the same way as a television screen, where an electronic stripe goes along the 

screen from left to right. All 1,200 squares are divided up according to the share of the coded seg-

ments. If a document only had segment coded with a blue code, then the Document Portrait would 

be totally blue. If this segment were coded with two codes, red and blue, the Document Portrait 

would consist of 600 blue and 600 red squares. If two segments were coded (again with red and blue 

codes) and the first segment were twice as extensive as the second, the picture would start with 800 

hundred red squares followed by 400 blue squares. 

Thus, Document Portrait displays the structure of documents in terms of codes as a colorful picture. 

This helps to immediately identify the basic tone of a document, for instance, if emotions have been 

coded with meaningful colors (aggressive= red, tolerant= green, and so on). 

Try out the Document Portrait – right-click on a document of your choice in the “Document System” 

and choose Document Portrait. Of course, meaningful results can only be obtained if you have 

assigned colors that make sense for your codes. 
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Example of a Document Portrait 

Document Portrait Visualization Options 

  Visualize entire text document or coded text 

This button lets you toggle back and forth between the two visualization options. If you choose to 

visualize the entire document, the visualization will include white squares for sections of the docu-

ment that have no code assigned to them. The other options only visualize segments of the document 

that were coded. 

  Mixed colors for overlapping codes (yes/no) 

This setting decides how segments should be visualized that are coded with more than one code. If 

the above option is off, each of the colors of the codes used to code the same segment will be listed 

sequentially, one after the other, similar to how it works in the “Overview of coded segments.” If the 

option is turned on, the colors of each assigned code are mixed together. 

  Display nodes as circles (on/off) 

This icon lets you switch the symbols in the visualization back and forth between squares and circles. 

  Sorted by document 

The sorting of the coded segments visualized in the Document Portrait is determined by their occur-

rence in the document. 

  Sorted by color 

The coded segments are sorted by colors, same colors are grouped. 
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  Sorted by color frequency 

In this special display option the portrait will be “tidied up”: all symbols with same colors are stacked 

like in a bar chart and the bar with the most tiles is placed left. Only the most frequent 20 colors will 

be visualized. 

Interactivity 

The square or circle symbols in the Document Portrait are also directly connected to the original data, 

which means you can click on any symbol to call up that coded segment in the “Document Browser.” 

(This is not possible if you have chosen to mix colors for overlaps.) If you right click on a symbol you 

will find the option Retrieve coded segments with this color which will list all coded segments with 

the chosen color in the “Retrieved Segments” window. 

Exporting the Document Portrait as an Image File 

The Export  symbol allows you to export the current display of the Document Portrait so you can 

later insert it into a word processing file or Powerpoint slide. 

Tip: Click on the camera icon  to copy the actual view into the clipboard. Now you can open Word, 

PowerPoint, or other programs and paste the image into it by choosing Ctrl+V (Win) or cmd+V (Mac). 

17.5 Codeline: The Sequential Visualization of a Document  

The Codeline is a case-based visual function that displays a sequential view of a document’s coded 

segments. The Codeline vizualisation is available for text and PDF documents and also for videos. The 

picture is quite similar to that of a score of a piece of music. For a text, the x-axis displays its para-

graphs, starting with §1 and ending with the last § of the particular text. The y-axis displays the codes. 

The cells of the Codeline matrix are filled with a colored symbol, if the code has been assigned to the 

paragraph. 

The basic idea behind the visualization can be seen below. There are 12 paragraphs and three codes 

shown. You can see that nothing was coded in the first paragraph of any of the documents. In the 

second, eleventh, and twelfth paragraph, Code1 is used. In paragraph five, both Code2 and Code3 

were used. This shows you already how you can use this visualization. It gives you a vizual overview 

of a document, so for the phases of an interview you can quickly identify which codes appear and 

co-occur. 

 Paragraph 

 1 2 3 4 5 6 7 8 9 10 11 12 

Code1  ■         ■ ■ 

Code2     ■ ■ ■ ■   ■  

Code3    ■ ■     ■  ■ 

Schematic representation of the Codeline 
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The Codeline is called up … 

 by selecting Codeline from the Visual tools drop-down menu, 

 by right-clicking on a text or PDF document and choosing Codeline from the context menu that 

appears, or 

 by clicking on the appropriate symbol in the “Visual tools” toolbar. 

 

Calling up the Codeline visualization using the symbol in the “Visual tools” toolbar 

Codeline Options 

When you call up the Codeline, MAXQDA offers the following options: 

Only for activated codes – this limits the codes to be included in the visualization to those that you 

have already activated in the “Code System.” If you have activated a subcode, also its parents will be 

integrated in the vizualisation. 

Aggregate on the 1st level – this option means that only top-level/parent codes will be visualized. 

The subcodes of each parent code will be handled as if they were instances of the parent code. 

Use weight filter – if you select this option, MAXQDA will open another dialog after clicking OK, in 

which you can set a range for the coding weight. Only those segments, that fit into this range will be 

displayed in the Codeline. 

 

Options for the Codeline visualization 

Codeline Display 

Unlike the Document Portrait, the Codeline tool can be used even if you have not associated mean-

ingful colors to your codes. The Codeline graphics display the color, but if you have not selected 

colors, only green symbols will be displayed. The function of Codeline is to show where in a document 

the different codes have been applied, and this diagram also makes sense and can be interpreted 

without color differentiation. 

What can the Codeline be used for? 

 Codeline gives a good overview of the coding and can therefore be used universally. 
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 The diagram may be of use for exploration – just follow a particular code, see when it appears and 

which other codes appear near it. 

 The opportunity to display only selected codes enables comparing two or more codes in the course 

of an interview. 

 When analyzing focus groups, you can see at a glance which speakers react to each other and 

what the topics are in relation to the speakers. 

 

Example of a Codeline visualization 

The Codeline for a text creates a table with the codes on the y-axis and the paragraph numbers on 

the x-axis. The coded segments are shown in paragraph sequence, starting with the first. This means 

that the visualization has as many columns as paragraphs. If the code is used in a paragraph, the 

code’s color will be shown in the bar in the appropriate column. If a coded segment is more than one 

paragraph, the bar continues from one to the next. 

Codeline for Table and PDF Documents and for Audio and Video files 

The Codeline function is available for all document types that MAXQDA supports, with the exception 

of images. Depending on the document type, different units will be used for the columns: 

Text Paragraphs 

Table Rows 

PDF Pages 

Audio- und Videodatei Seconds or minutes, depending on the lenght of the document and the 

place available 

Display Options 

Above the Codeline you will see a toolbar, which offers several options for the display: 
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 Unit: paragraph – if you select this option all paragraphs will be displayed with the same width, 

independent from their content. Furthermore, the whole paragraph width will be filled with the color 

of the code, no matter how large or small the coded segments within this paragraphs are. 

If you deselect this option the Codeline will consider how many characters have been coded with a 

code and only those parts will be colored, not the whole paragraph. The column headers will display 

the number of the paragraphs, but the column width will be proportional to the length of the para-

graph. 

The option works identically for the other document types: selecting the option Unit: Row / Page / 

Second / Minute all units will be displayed with the same width and just a single coded segment in a 

unit will led to unit width that is filled completely. 

   Fit to window width – selecting this option will „compress“ the Codeline into the horizontal 

space of the window. This is very helpful for any publication in which you want to include an image 

of the whole Codeline, but in which the space is usually limited to a page size. The proportions of the 

visualized coded segments will stay the same, only very short coded segments get a special treatment: 

they will be reduced to a minimum of a thin vertical line only, but will not be excluded from the view. 

You can use the slider next tot he icons to adjust the column width. 

Active Code Symbols 

The display of the coded segments is interactive. If you hover the mouse over a symbol, a tooltip 

appears with the code or subcode name and the position. Double-clicking on the symbol highlights 

the appropriate segment(s) in the “Document Browser” or “Multimedia Browser”.  

Exporting Codeline as an Image File 

The Export  symbol allows you to export the current display of the Codeline so you can later insert 

it into a word processing file or PowerPoint slide. 

Tip: Click on the camera icon  to copy the actual view into the clipboard. Now you can open Word, 

PowerPoint, or other programs and paste the image into it by choosing Ctrl+V (Win) or cmd+V (Mac). 

17.6 Tag Clouds  

Tag clouds offer you a simple way to visualize the most frequently used words in a document or 

group of documents. The size of the font is dictated by the number of times it is found in the selected 

document(s). MAXQDA puts the words in alphabetical order, starting in the top left. 
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Tag cloud 

The tag cloud function can be called up for a single document, a document group, a document set, 

or all documents in a project. Simply right-click on the document/group/set in the “Document Sys-

tem” and choose Tag cloud from the context menu that appears. 

Tip: The tag cloud is interactive. Click on a word to list all origins. 

So that you don’t end up with a list of short words that have no meaning for your analysis (e.g. and, 

or, the, but), you can create a stop list, so that such words aren’t included. The easiest way to add 

words to a stop list is from the “Word frequency list.” This list shows all the most frequently-used 

words, sorted from most the most frequent to the least frequent. To the left of each word is a green 

symbol. If you want to add a word to the stop list, just double-click on this green symbol next to it. 

This word will now no longer show up in the word frequency list or the tag cloud. You can also add 

several words at the same time to the stop list by holding the Ctrl or cmd key, clicking on the words 

one by one, and then right-clicking on one of them and choosing Add to stop list from the context 

menu that appears. 

In the screenshot above, you can see the Edit stop list button at the bottom left of the tag cloud 

window. This button brings up a list of all the words that are currently in the Tag cloud of the current 

project. You can here add or delete words as well, although the double-clicking option described 

above is considerably easier. 

Tip: Users of products “MAXQDA Plus” or “MAXQDA Analytics Pro” can manage the stop list via 

MAXDictio > Stop list and interchange entries from differente stop lists very easily. 

If you select or deselect the option Case sensitivity the tag cloud will be refreshed immediately. 

The Copy button copies the tag cloud to the Windows clipboard, which makes it easy to then paste 

it into other programs, like Microsoft Word. 
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Word frequency list: double-click on the green symbol next to a word to add it to the stop list, or right-click on 

the word and choose Add to stop list from the context menu. 
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18 MAXMaps 

18.1 What Does MAXMaps Do? 

MAXMaps offers a new perspective on your data and the connections within it. The primary task of 

MAXMaps is to provide a graphical representation of the different elements within a MAXQDA pro-

ject. These “objects” can be inserted into the MAXMaps drawing pads, and connections can be made 

in order to visualize a complex graph of relationships. MAXMaps also allows you to design graphical 

models or networks that are completely independent of MAXQDA’s data. That’s why MAXMaps is a 

universal graphics software tool that is not only restricted to applications in qualitative research within 

the social sciences. All elements of MAXQDA, e.g. codes, memos, coded segments, and documents, 

may be imported into a map. In addition, MAXMaps also allows you to insert so-called free elements 

(text, pictures, and graphics) that can be chosen by the user. 

MAXMaps can be used for different purposes. Maps can help to explore and organize data. They 

allow you to develop your ideas and to communicate them to your research team. Maps can also be 

a valuable tool for scientific explanation and can help to visualize complex relationships and theories. 

For instance, you can create tables and worksheets to gain a better perspective of the different ele-

ments within a project. MAXMaps can also be used for presentations and lectures. The different layers 

of a map may be displayed in arbitrary order; thus, a variety of different options for designing presen-

tations are available. 

With MAXMaps, it is possible to display: 

 The relationships between different codes and categories. 

 An overview of different facts and phenomena within the research field. 

 The different memos belonging to a document or a group of documents. 

 The context or important facts of the research, e.g. photographs of locations or persons. 

 A graphical overview of the research methods used. 

 A research timeline. 

 The research design and characteristics of the sample. 

MAXMaps can also have different functions for researchers. You can, for instance, use MAXMaps to 

organize and manage your code system. Or you can link codes, text, and memos in a hypothetical 

order to then further test the relationships in a second step. 

MAXMaps is not merely a graphics tool that works with icons and symbols, though. All the elements 

used in a map are interactive, meaning they are connected to the MAXQDA project. Simply switch to 

“sync mode” to establish a connection to the MAXQDA database. This makes an icon that symbolizes 

a text document not only a passive icon, but allows you to double-click on the icon to open the 

document in MAXQDA’s “Document Browser.” Then you can read and browse through the docu-

ment. The same is true for memos. As soon as you click on the memo symbol, the memo appears 
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and can be read or even modified. In the case of symbols for coded segments, one click displays the 

segment, which allows you to examine and compare different segments of your map. 

MAXMaps allows you to define connections and relationships as you choose. These connections may 

be hypothetical -- they do not even have to be consistent in logic while you are designing the maps 

because you are always free to make changes. As a result, you can “play” with different models and 

relationships. For example, a code “attitude” may appear as a condition of another code “behavior” 

in Map A and as the result of the code “behavior” in Map B. Constructing, testing, and modifying 

different models is a an important aspect of analysis, thus making it counterproductive to be con-

sistent with links and relationships right from the beginning. 

MAXMaps not only allows you to define links and relationships, it also offers a way to make links and 

relationships that have already been implemented in your project visible. Examples are memos that 

have been assigned to a document: MAXMaps can import all the connected memos automatically. 

These memos are displayed as symbols and you can open and check them. The same is true for codes: 

If you have imported a code in your map, all the memos linked to this particular code can also be 

imported automatically. Moreover, you can search and insert all of the codes overlapping with a code 

on your map and automatically connect them to the code. 

These features do not establish new links or new relationships, but they allow for completely new 

perspectives to your data. Connections that have likely been hidden in listings or tables can now come 

to the foreground. New views and relationships become visually apparent and much easier to under-

stand. The connections between different elements of the diagram are not restricted to hierarchical 

relationships as with the “Code System” in MAXQDA. In MAXMaps, relationships can be represented 

in a more complex way, for instance as networks or any other type of model. 

This visual method of data display is supported by the variety and flexibility that characterizes MAX-

Maps. All elements used in a map may be designed individually. Codes, memos, and texts are not 

always displayed with the same symbols and colors. You can select different symbols, colors, fonts, 

and sizes, or even import your own symbols unique to each element of your map. All labels, images, 

and symbols can be managed individually. You can also import your own photographs, icons, or clip 

art. 

18.2 Getting Started – Creating a New Map 

MAXMaps is available as an option in MAXQDA’s Visual tools drop-down menu. The MAXMaps 

window is divided into two parts. The left part contains a list of your maps. The first time you work 

with MAXMaps, the list will only contain one entry, which is called “New map." The right part of the 

window is the place where you can create your map. Here, the different elements, such as codes or 

memos, are imported. You can also design your model by importing your project’s elements, linking 

them, and inserting labels, headings, graphics, and images. 

To create a new empty map, select New Map from the New drop-down menu. A new empty map 

will then be created with the default name “New map." You can modify the default name by right-

clicking on the name and selecting Rename from the menu that appears. 
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You can create as many maps as desired. All maps are stored in the MAXQDA project file. They can 

also be saved in the form of JPEG or SVG, files which can then be inserted into text files. Maps are 

automatically stored in the MAXQDA project file when you close the MAXMap window; it is not 

necessary to use an explicit save command. 

 

The MAXMaps screen 

18.3 Arranging a Map 

Working with MAXMaps: Two Work Modes 

When working with MAXMaps, you can switch between two different work modes: 

1. Selection Mode   

This main work mode serves to select objects from MAXQDA and to insert them into the model. In 

this mode, objects can be freely shifted on the work surface. 

2. Link Mode  

The link mode makes it possible to interconnect different objects contained within the model. The 

connecting lines can even be treated like objects, i.e. properties can be modified in any manner de-

sired. In the selection mode, the line type, color, label, and other characteristics of a connecting line 

can be modified. 
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How to select various modes from the drop-down menu 

18.4 Objects in MAXMaps  

A map consists of three different types of items: 

 Standard objects. 

 Free objects. 

 Connecting objects. 

Standard objects originate from MAXQDA, e.g. a code, a text, or a memo. They can only be inserted 

into a drawing pad once. 

A text, a code, or a memo can only be included one time in a map. 

Note: Modifications on standard objects have no effects on the MAXQDA project. 

For instance, if you modify the name of a text imported from MAXQDA, the name in MAXQDA’s 

“Document System” nevertheless remains the same. Objects removed from the drawing pad are not 

simultaneously removed from the MAXQDA project. 

No matter how you arrange an object, connections to the MAXQDA database will always be pre-

served. This also means that a text that is represented only as a picture will open via double-click in 

MAXQDA’s “Document Browser.” Free objects are not connected with items of the current MAXQDA 

project. In this sense, they are independent of the analyzed data. Connecting objects are lines, which 

interconnect two objects. 

Both standard and free objects consist of an object label and an object picture. Standard objects 

receive the appropriate icon from MAXQDA as a picture and the appropriate name from MAXQDA 

as a label. 
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For example, as with a MAXQDA document, the document name will be taken from the “Document 

System.” Connecting objects can likewise be provided with a label. You can also select the charac-

teristics and types of connecting lines. 

Importing Objects into a Worksheet 

Each object that is imported into the worksheet – be it a code, a memo, a text, a coded segment, or 

a so-called free object – consists of two elements: 

 A picture, and 

 A label. 

When importing a MAXQDA object, the MAXQDA default symbol is carried over as the picture and 

the MAXQDA name as the label. For example, when importing a code, the colored code symbol from 

the list of codes and the code name are carried over. 

The following figure shows three inserted objects (a code, a memo, and a text) immediately after 

being imported. They have not been positioned on the drawing pad. 

 

The MAXMaps window after importing a text, a code, and a document 

Something similar occurs with a memo. In the drawing pad, the assigned memo icon (in MAXQDA) 

appears as a picture of the object and the title of the memo appears as a label. Both the label and 

the picture can be changed, or a picture, a diagram, or a photo can be imported. The label can also 

be changed along with the font type, font size, and other properties. 

How to Import Standard Objects from MAXQDA 

To import an element from MAXQDA, hold down the Alt key and double-click on the selected 

object while in MAXQDA. 

Alternatively, you can select the element with the right mouse button and click the Insert in 

map option from the context menu. The chosen object is usually inserted in the drawing pad on the 

top left. 
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Inserting an element via the context menu 

The following MAXQDA elements can be inserted. The brackets state where the elements are located 

in MAXQDA: 

 a) Document groups (Document System). 

 b) Documents (Document System). 

 c) Codes and subcodes (Code System). 

 d) Code memos (Code System). 

 e) Memos attached to parts of documents (Document Browser). 

 f) Memos attached to documents (Document System). 

 f) Memos attached to document groups (Document System). 

 h) Coded segments (Retrieved Segments). 
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All of these functions listed are only available if the window “MAXMaps” is open. The object is im-

ported into the currently active map and displayed in the right part of the MAXMaps window. MAX-

Maps will inherit the same color of codes, subcodes, and coded segments that have been assigned in 

MAXQDA. This is also the case for memos and memo symbols. All elements are usually inserted into 

the upper left corner of the drawing pad if enough room is available. 

Tip: The fastest way to import objects is by holding down the Alt key and double-clicking on the 

selected item. 

The specific import procedures occur as follows: 

a) Document groups (Document System): 

Select the document group in the “Document System” first, then hold down the Alt key and double-

click on the name of the text group. The choice can alternatively be carried out via the right mouse 

button. 

b) Document (Document system): 

Select the document in the “Document System” first, then hold down the Alt key and double-click 

on the name of the document group. The choice can alternatively be carried out via the right mouse 

button. 

c) Codes and subcodes (Code System): 

Select the code or subcode in the code system first, then hold down the Alt key and double-click on 

the name of the code. The choice can alternatively be carried out via the right mouse button. 

d) Code memos (Code System): 

Select the code memo in the code system first, then hold down the Alt key and double-click on the 

memo symbol. The choice can alternatively be carried out via the right mouse button. 

e) Memos attached to passages of a document (Document Browser): 

Select the memo in MAXQDA’s “Document Browser” first, then hold down the Alt key and double-

click on the memo symbol. The choice can alternatively be carried out via the “Overview of memos” 

table and use of the right mouse button. 

f) Memos attached to documents (Document System): 

Select the memo in MAXQDA’s “Document System” first, then hold down the Alt key and double-

click on the memo symbol. The choice can alternatively be carried out via the “Overview of memos” 

table and use of the right mouse button. 

g) Memos attached to a document group (Document System): 

Select the memo in MAXQDA’s “Document System” first, then hold down the Alt key and double-

click on the memo symbol. The choice can alternatively be carried out via the “Overview of memos” 

table and use of the right mouse button. 

h) Coded segments (Retrieved Segments): 
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Select the coded segment in MAXQDA’s window “Retrieved segments” first, then hold down the Alt 

key and double-click on the info box on the left side of the coded segment. The choice can alterna-

tively be carried out via the right mouse button by clicking on the info box in front of the segment. 

In addition, coded segments can be selected directly from the different overviews which are available 

e.g. in the “Document System” or the “Code System.” 

How to Import Free Objects 

Elements of a drawing that don't have any relation to objects in MAXQDA are understood as free 

objects. Free objects, similar to standard objects, also consist of two parts, namely a picture and a 

label (name). Since only text fields are frequently required without a picture, such text elements can 

be inserted with a separate button. Thus, a free object can be a text field or a picture with a label 

(description) underneath it. To insert such a free element, MAXMaps must be in the selection mode. 

 

Click here to insert free objects and text fields 

The labels can be deleted or renamed by using the context menu properties. 

Arranging Connections between Objects 

The connection lines drawn between single objects can be edited similarly to standard objects and 

free objects. You can determine the connecting line properties in the connecting line menu by choos-

ing the selection mode and double-clicking on the connecting line. 

Deleting Objects 

Every object can be removed from the drawing pad. To do this, select the desired object with the 

mouse. Then press the Del key (Windows) or the Backspace key (Mac), or click on the Remove from 

Map  symbol. This removes the object and all its connections with other objects entirely. 

18.5 Object Properties  

Object properties can only be modified when the selection mode is activated. Objects can be placed 

in the desired position in the drawing pad by holding down the left mouse button and dragging the 

object to its new place. 

When you select an object with the right mouse button, a context menu will open that includes the 

option labeled properties. Here, you can determine properties of a single selected object. 

Tip: If the sync mode is turned off, the quickest method to access the properties dialogue window is 

double-clicking on the object in question. 



Object Properties 276 

 

The dialog window “Object properties” 

You can choose from the following properties, among others: 

“Label” Tab 

Label: i.e. the name of the object. This doesn't have any effect on the text name in the MAXQDA 

project. If you change the name of an object in a worksheet, e.g. the name of a text “Interview1” 

into “Peter Miller’s,” the name of the text in MAXQDA remains “Interview1.” 

Font, Font size, Font color: Diverse properties can be defined for the object, including font, font 

size, and font color. 

Borders: a frame is drawn around the object. 

 

“Image” Tab 

Visible: if this option is not selected, only the object’s label is shown. 

Form: For free objects, here you can define whether the object should be a circle, a rectangle or a 

rectangle with rounded corners. In addition, external graphics can be defined. 



MAXMaps 

 

277 

Shadow: a shadow is drawn around the object. This only applies to standard objects (not for imported 

bitmaps and graphics). 

 

“Link” Tab 

External link: Insert a reference to a local file here and it will be opened if you click on the object. 

Geo Link: Insert a path to a .kml/.kmz file with geoinformation and it will be opened if you click on 

the object. 

Format Painter to Copy Properties 

MAXMaps permits the transfer of properties from one object to other objects. This allows for a more 

uniform appearance among different objects. The function is applicable to all objects including con-

nection objects, and it also enables you to transfer the color and line type of one connecting line to 

another one. 

 

The “format painter” option: copy format 
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The “format painter” option: apply format 

How it works: 

1. Select the object whose properties you wish to assign to another object. 

2. Click on the option format painter  in the toolbar. 

3. Select the target object, i.e. the object to which the format shall be applied. 

4. Click on the option format transfer  in the toolbar. 

Subsequently, the same format can be applied to an arbitrary number of objects. You can do this 

simply by selecting these desired objects and then choosing the format painter option. If you 

wish to transfer the format to several objects at the same time, you must select all of them using the 

mouse and holding down the Ctrl key. 

Extending and Reducing the Size of Objects 

In the selection mode, every selected object can be extended or reduced by clicking on the “+” or “-

” symbols found in the toolbar. 

In the selection mode, you can jointly extend or reduce objects simply by drawing a frame around the 

objects with the mouse. You can then change the object size using the method described above. The 

relation between the size of the picture and the font size can be defined in the properties dialogue 

window. 

Grouping Objects 

Objects can be arranged into groups. To do this, use the mouse to first draw a frame around the 

object. The same can also be accomplished by holding down the Shift key and clicking on the desired 

objects one after another and clicking on the Grouping symbol, which can be found approximately 

in the middle of the toolbar. 

Grouped objects can be separated again in the same way: Select the group and then click on the icon 

Resolve grouping. Within an established group, the separate elements of the group can no longer 

be modified with the individual properties menu. If at any point later on, you wish to modify an 

element, you have to resolve the grouping first. 
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The buttons “Group objects” and “Ungroup objects” 

Picture Exchange - Importing Pictures 

When importing MAXQDA objects, initially the standard icon assigned in MAXQDA is transferred. It 

is then possible though to exchange the picture and to import another picture, clip art, or drawing. 

This works as follows: 

 Select the desired object with the right mouse button. Then, choose the option Change picture 

from the context menu. 

 Instead of the initial standard picture, the picture of your choice can be imported. JPG, PNG, and 

TIF are all permitted formats. 

Layer 

Objects can be assigned to different layers. If you ignore this option, all newly inserted objects will be 

assigned to the same standard “base” layer. The Layer option makes it possible to display or to remove 

parts of the drawing, so you can, for example, design a presentation that gradually increases in com-

plexity. You can start building a model with only a few elements and gradually increase the number 

of elements that are displayed, thus creating a structure that continually gains complexity. 

The Layer function can be called up by clicking the layer icon in the toolbar.  This will open a 

window in which the existing layers are listed. At first, this includes only the “Base” layer. You can 

define a new layer by clicking on the arrows to the right of the layer icon, then selecting “New”. 

 

Layer window 
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Any object on the drawing pad can be assigned to a certain layer. Just choose the option Layer after 

selecting the object with the right mouse button and assign the object to the desired level. 

 

Assigning an object to a layer 

To display a level, simply put a checkmark in front of the desired layer in the dialogue window. 

Moving Objects to the Foreground or Background  

To arrange the objects of a map according to your needs, it is necessary to be able to move objects 

from the foreground to the background and vice versa. The corresponding Bring to the front and 

Move to the back options are found in the toolbar. 

 

Buttons “Bring to the front” and “Move to the back” 

This procedure is arranged intuitively: 
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 Select the object whose position shall be changed. 

 Click on Bring to the front or Move to the back to achieve the desired position. 

18.6 The Object Library  

The object library is a helpful tool for simplifying the organization of your objects. The archive gives 

you access to all objects that you have added to it. If for example, you create a specific shape, and 

want to have this handy for future use, simply right-click on the object and select Add to library. 

 

A free object is customized 

 

Add the object to the library for future quick access 

This item is now in the object library. The entire library can be viewed by clicking on the library symbol: 

 

You will then see the library at the bottom of the MAXMaps window. 
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The MAXMaps Library at the bottom of the MAXMaps window 

You can then quickly add this object to your map by simply double-clicking on it. All formatting is the 

same as in the original. 

18.7 Link Mode: Linking Objects  

To be able to draw connections between objects, you must first switch to the link mode. You can 

choose between three different link types in the toolbar: 

1. A simple connection between two objects (no directional arrow). 

2. A directional connection (a directional arrow). 

3. A mutual connection (bi-directional arrows). 

Link a starting element to a target element to connect objects. Start the procedure by selecting the 

starting object and clicking on it. Step two is to select the desired type of connecting line. After that, 

draw the line from the starting object to the target object. Once connected on the drawing pad, the 

connections remain unchanged and move with the objects. You can determine the properties of the 

connection lines in the selection mode, including the style and weight, the line color, and the label of 

a connecting line. Similar to standard and free objects, you can open the connecting line properties 

menu by double-clicking on the connection line. 
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Dialog box for connecting line properties 

If in the link mode, it is not possible to extend or to reduce single objects. You can only change the 

size of the entire drawing. 

18.8 Exporting and Printing Maps 

Printing a Map 

Any map created in the MAXMaps module can be printed in high quality. To start the print procedure, 

click the Print symbol in the toolbar. 

Export a Map as a Graphic File 

Maps can be exported in different formats. Thus, you can use them with other software programs, 

such as Microsoft Word or PowerPoint. To start the export procedure, click the Save as picture sym-

bol in the toolbar. 

The following file formats are available: SVG, JPG, PNG and EMF for windows. For presentation post-

ers it is recommended you use the vector formats SVG or EMF, as these can be scaled. 

Teamwork: How to Export and Import a Map 

Maps can be exported and imported from one MAXQDA installation to a different one. 
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All the maps that you create will be saved in the MAXQDA project file (“mx12” format) along with 

the rest of your project data. The teamwork function works in a similar way as the other teamwork 

functions of MAXQDA, for instance, in the export of memos and codes. 

To export a map, right-click on the map title in the left pane of the MAXMap window and select 

Export Map. Maps will be exported with the extension .MOD. 

To import a map from another project, click the New button and select Import Map. 

18.9 Synchronization with MAXQDA  

The sync mode synchronizes your map with the MAXQDA project. For example, when in sync mode, 

if you hover the mouse over the icon associated with a document in the map, a connection to your 

project’s data is established. A tooltip with the first lines of the memo assigned to this document will 

appear, and by double-clicking on the icon you can open it in the MAXQDA Document Browser. 

You can switch the sync mode on and off by clicking on the corresponding icon in the toolbar. The 

sync mode offers the following features: 

Document Group and Document Set Symbols: 

 When you hover the mouse: A tooltip with a preview of the memo assigned to the Document 

Group or Document Set will appear (if memo exists). 

 When you click on the symbol: The corresponding Document Group or Document Set will be 

highlighted in the Document System. 

Document Symbols 

 When you hover the mouse: A tooltip with a preview of the document memo will appear (if memo 

exists). 

 When you click on the symbol: The document will be highlighted in the Document System. 

 When you double-click on the symbol: The document will open in the Document Browser. 

Memo Symbols 

 When you hover the mouse: A tooltip with a preview of the memo will appear. 

 When you click on the symbol: The memo will be highlighted in the Document System, Code 

System, Document Browser or Multi-Media Browser, depending on the type of memo. 

 When you double-click on the symbol: The memo will open. 

Code Symbols 

 When you hover the mouse: A tooltip with a preview of the memo will appear. 

 When you click on the symbol: The code will be highlighted in the Code System. 

 When you double-click on the symbol: The „Overview of Coded Segments“ for this code will open. 
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Coded Segment Symbols 

 When you hover the mouse: A tooltip containing a preview of the coded segment will appear. 

 When you click on the symbol: The corresponding element will be highlighted in the Code System, 

Document Browser or Media Browser, and move to the position of the coded segment. 

Functions in Sync Mode 

In addition to the options described above, the sync mode makes further functional connections pos-

sible between the Map and the MAXQDA database. 

In the context menus for documents and codes, overviews of coded segments and linked memos are 

available. These tables function exactly as elsewhere in MAXQDA, meaning you can click on an ele-

ment in the table to jump directly to the corresponding location in the document. 

Furthermore, a code, that you click once in the “Code System” window, will be selected in an opened 

MAXMaps – as long as it exitsts on the map. This will work also if you switch off the sync mode. 

Importing all of a Document’s Memos 

The option Import memos, which is available in the context menu of a document, allows you to 

import all the memos that have been attached to a document. The corresponding memo symbols 

now appear in the drawing pad. Connection lines link them to the corresponding document. 

 

All of the document’s memos displayed after import 

Importing Subcodes 

Right-clicking on a code displayed in the drawing pad causes the context menu to appear. It con-

tains the option Import subcodes, which causes all the subcodes of the selected code to be imported. 

The symbols for these codes can now be seen in the drawing pad, including the lines linking them to 

the corresponding parent code. 

When you select this option, MAXQDA will ask if you wish to use different line widths to reflect 

frequency. If you select Yes, subcodes with more coded segments will be represented with thicker 
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connecting lines than those with fewer coded segments. If a code already appears on the map, the 

connecting line will be supplemented if necessary. 

Importing Co-occurring Codes 

The context menu for a code also contains the option Import co-occuring codes. This option will 

insert all codes in the project that overlap with the selected code onto the work surface. All co-

occuring codes will be connected to the selected code with dotted lines. 

The same option is available from the MAXQDA Code System. When you click a code and select the 

Intersections option from the context menu, a list containing all the overlapping codes will appear. 

This list is effectively a preview of the codes that would be inserted in the map if you used the Import 

co-occuring codes function. 

When you select this function, MAXQDA will ask if you wish to use different line widths to reflect 

frequency. If you select Yes, codes with more intersections will be represented with thicker connecting 

lines than those with fewer intersections. 

If a co-occurring code is already present in the drawing pad, it will not be imported again. Yet, in any 

case, a connecting line will be drawn between this code and the co-occurring code. All code symbols 

will be inserted in the upper left corner of the drawing pad. Therefore, we recommend that you leave 

enough space there for the imported codes. 

Inserting Text of a Retrieved Segment 

When you right-click on a retrieved segment symbol in the map and select Insert text of coded 

segment as label, the complete text of the segment will be inserted in the map as a label. 

Importing Linked Memos  

This is another function for the automatic import of relationships that already exist in the MAXQDA 

project. All memos that are linked with the selected code will be imported into the drawing pad. 

Furthermore, to symbolize the link, lines will be drawn from each memo to the code. To avoid dupli-

cate copies of memos that are already part of the drawing, these will not be imported a second time. 

In this case, only a line will be inserted from the memo to the code, provided that it does not already 

exist. 

18.10 Model Templates in MAXMaps  

With the model templates, using the one-of-a-kind MAXMaps tool to visualize connections and pat-

terns in your data set is made even easier. During the research process, it is often the case that one 

focuses on a single part of the material: on a specific text, code, code overlap, or on a specific hy-

pothesis or theoretical aspect addressed in a memo. The new models offer quick, accessible solutions 

for these situations, and they can be tweaked to fit your specific data set and research focus. 

MAXQDA uses your settings and data to create an appropriate diagram in MAXMaps. This map can 

be edited, added to, or rearranged as you see necessary. It produces results that you can literally see: 

the graphics quality is superb, and with using a vector format for export (like SVG or EMF), you can 

even print out your maps as large posters for presentations. 
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There are five different models: 

1. One-Case Model – All relevant data attached to a document is illustrated in the map. This includes 

all appropriate memos, codes, and coded segments. 

2. One-Code Model – This model is very similar to the One-Case Model, except that a code is the 

focus rather than a document. The coded segments and memos attached to the code are included 

in this model along with any memos that are linked to the code. 

3. Code Theory Model – This model is especially helpful for the development of theory. It automat-

ically displays all memos (with their ideas and hypotheses) attached to a specific code. 

4. Code Co-Occurence Model – This model illustrates the associations and intersections between 

selected codes. One or more codes are selected and dragged onto the MAXMaps window. All 

codes that intersect with any of these selected codes are then automatically inserted with an arrow 

connecting them to the code with which they intersect. The width of this arrow is dependent on 

the number of intersections. The model can be made more complex by including the subcodes in 

the visualization. 

5. Code-Subcode-Segment Model – This is the most complex of the five models. The subcodes, 

connected memos, and the coded segments for all selected codes are illustrated in a single model. 

The models make it possible to explore the data in a unique way. All elements of the map are directly 

synchronized with the MAXQDA project, which means you can see the content of memos and coded 

segments by simply moving your mouse over the appropriate icons. By double-clicking, you’ll be taken 

directly to the appropriate part of the document. All model templates can be accessed in MAXMaps 

by clicking the New button. 

18.11 The One-Case Model 

Function of this model 

In this model, a document from the “Document System” is at the center of the analysis. After select-

ing the model from the menu, the document to be analyzed is dragged onto the MAXMaps work-

space. The purpose of the visualization is to make the memos, codes, and code segments for the 

selected document accessible. 

Model display in the map 

The elements of the model will be displayed in the map with the document in the middle of the 

workspace and the other elements arranged in a star pattern around it. If memos are included, they 

are positioned at the top of the map. 

The various elements are connected to the text by lines with seven levels of thickness. The thickness 

of each line is defined by the number of text segments coded with the particular code – the thicker 

the line, the higher the number of coded segments. It could be that in some cases a text has dozens 

and dozens of codes or memos, or that a very high number of text segments were coded. For this 

reason, you have the option of setting a maximum number of codes, memos, and text segments to 

be displayed, as well as the option of changing the exact search criteria. 
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An example of the One-Case Model 

Model Options 

In the One-Case Model, the following elements can be included in the visualization: 

1. Memos: both those attached to a text segment in the selected document and the memo attached 

to the document itself in the “Document System.” 

2. Codes that are used in the selected document. 

3. Segments that have been coded with the codes from point 2. 
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Model options in detail 

 

The One-Case Model options window 

Memo options 

 Memos. Here you can select each memo type to be included in the map: Document memos, 

Memos in document, code memos, Memos linked with code. 

Code options 

 Display only activated codes. Only those codes are displayed that you already activated in the 

“Code System” window. 

 Maximum quantity of codes to be displayed. If there are more codes than the set maximum 

quantity to be displayed, the codes will be ranked according to quantity. If, for example, there are 

11 codes, and the maximum is set to 10, the 10 most-used codes in the selected document will 

be displayed. 

 Display superordinated code. Top-level codes can be additionally displayed. 

Coded Segments options 

 Display coded segments. If this box is checked, the coded segments will be displayed for each 

of the codes. You can set the maximum number of coded segments to be displayed per code. 

 If there are more coded segments than the maximum to display, you have the option of setting 

the Priority of coded segments by weight (relevance) or by segment size. 
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18.12 The One-Code Model 

Function of this model 

A code is the focus of this model. After selecting the model in MAXMaps, the code must be dragged 

onto the MAXMaps workspace. 

The purpose of this model is to display the selected code with all its connected memos and coded 

segments. 

The One-Code Model is similar to the One-Case Model, except that a code is the focus rather than a 

document. 

Model display in the map 

In this model, the code memo, other memos linked to the code, and all the document segments 

coded with the selected code can all be displayed. The code icon is put in the center of the work 

space, and the other elements are arranged in a circle around it. Lines connect all the elements to the 

code. 

 

The One-Code Model 

Model options 

The following elements can be displayed in the One-Code Model: 

1. Memos: both the code memo and any memos linked to the code. 

2. Coded segments. 
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Model options in detail 

 

The One-Code Model options 

Memo options 

 Display memos. If this box is not checked, no memos will be displayed in the map. If the box is 

checked, you can also set the maximum number of memos to be displayed. 

Coded segments options 

 Display coded segments. If this box is checked, coded segments will be displayed for each of the 

codes. You can set the maximum number of coded segments to be displayed per code. 

 Display only coded segments in activated documents. 

 If there are more coded segments than the maximum to display, you have the option of ranking 

the coded segments by weight (relevance) or by length (measured in bytes) of the coded seg-

ments. 

In Sync Mode 

Memo icon 

 Mouse over: shows a preview of the memo. 

 Double-click: highlights the document in the “Document System,” opens the document in the 

“Document Browser,” and moves to the point in the document where the memo is positioned. 

 Second double-click: opens the memo. 

Code icon 

 Mouse over: shows a preview of the code memo. 

 Left-click: highlights the code in the “Code System” window. 

Coded segment icon 

 Mouse over: shows a preview of the code memo. 
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 Left-click: highlights the code in the “Code System” and the document in the “Document Sys-

tem.” 

 Double-click: opens document in the “Document Browser” and moves to the position of the 

coded segment. 

 Right-click: shows context menu, where you have the option of displaying the entire coded seg-

ment in the map. 

18.13 The Code Theory Model 

Function of this model 

A code, its subcodes (optional), and the memos attached to these code(s) are displayed in this model. 

Model display in the map 

The code icon is put in the center of the map with the subcodes arranged in a circle around it. Sub-

codes can be arranged on two hierarchical levels, with the first level forming an inner circle around 

the code, and the second level forming an outer circle. The memos are connected to the codes/sub-

codes with a line. Since memos can be linked to more than one code, each code may be connected 

with several lines. 

 

Code Theory Model without subcodes. Code memos and linked memos of subcodes will be displayed. 
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Code Theory Model with integration of subcodes on 1st level: subcodes are displayed in a circle around the 

code. Memos are displayed in an outer second circle. The code memos and linked memos are imported, too. 
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Code Theory model with integration of subcodes on two levels: The subcodes are displayed around the main 

code. 

Model options 

In the Code Theory Model, the following elements can be included in the visualization: 

1. Memos that are attached or linked to the selected code (and its subcodes, if desired). 

2. Subcodes of the selected code. 

Model options in detail 

 

The Code Theory Model options 

Memo options 
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 Display memos. If this box is not checked, no memos will be displayed in the map. If the box is 

checked, you can also set the maximum number of memos to be displayed. If there are more 

memos than the set maximum quantity to be displayed, the memos will be prioritized according 

to creation date (newer codes get priority) or according to the size (longer memos get priority). 

Subcode options 

 You can limit the visualized subcodes by only displaying those activated in the “Code System.” 

 You can also decide how many levels of subcodes are displayed (0 = no subcodes; 1 = only the 

first level of subcodes; 2 = two levels of subcodes). 

18.14 The Co-Occurrence Model  

Function of this model 

This model displays the intersections (or co-occurrences) of selected codes with other codes. It is also 

possible to make the model more complex by including subcodes. 

Model display in the map 

One or more codes are selected and dragged onto the MAXMaps work space. These codes are con-

nected with a black line to the code(s) with which they intersect. The thickness of the lines indicates 

the frequency of the intersections. If the two codes intersect many times, the line connecting the two 

will be thicker. Codes are connected to their subcodes with red lines. 

 

The Code Co-Occurrence Model 
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Model options in detail 

 

Code Co-Occurrence Model options 

Code/Subcode options 

 You can now select which codes are to be included in the map. 

 The visualization can be limited to include only intersections with activated subcodes. 

 You can select how many levels of subcodes are to be included (0 = none; 1 = only the first level; 

2 = the first two levels). 

 The minimum number of intersections can also be set. If this minimum number of intersections 

isn’t reached, the connections will not be included in the map. 

Co-Occurrence options 

 By selecting a certain required code weight, you can limit the displayed intersections according 

to its relevance. By setting the required weight to 80 to 100, for example, one would analyze only 

those codes, to which the researcher assigned such a high value. 

18.15 The Code-Subcode-Segments Model  

Function of this model 

This model creates a map with a selected code, its subcodes, and the segments coded with these 

codes. This model is similar in many ways to the One-Case Model except that a code is the focus, 

rather than a document. 
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Model display in the map 

Your selected code is placed in the center of the map with the subcodes arranged in a circle around 

it and connected to it with lines. All coded segments are then connected to the appropriate code/sub-

code. 

 

The Code-Subcode-Segments model 
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Model options in detail 

 

The Code-Subcode-Segments Model options 

Code options 

 Subcodes can be limited to those activated in the “Code System” window. You can also set 

the maximum number of subcodes to be displayed. 

Coded segment options 

 Display coded segments. If this box is checked, coded segments will be displayed for each of the 

codes. You can also set the maximum number of coded segments to be displayed per code. 

 You can also limit the coded segments by choosing to display only those that are found in 

the documents activated in the “Document System.” 

 If there are more coded segments than the maximum to display, you have the option of ranking 

the coded segments by weight (relevance) or by length (measured in bytes). 

18.16 Options in MAXMaps   

By clicking on the Options  symbol, a window will open where you can view and change standard 

settings. 
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The “Options” window 

Apply grid – this option “snaps” your objects to a grid, which is visualized in the background. This 

allows you to more easily line up objects in straight lines, and the grid will not be shown in exported 

pictures. 

Reduce imported images to this size – this setting determines how imported images are handled. 

You can select 300x300, 600x600, 1,200x1,200, or “Original size.” The longest side of an imported 

picture is then reduced to the maximum pixel size. Background pictures are always imported in their 

original size. 

Visualize document links – when this box is checked, document links are visualized by a blue line 

between documents. 
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19 Statistics and Graphics Functions 

19.1 Frequency Tables and Charts for Subcodes  

With the help of the Statistics and Graphics module, MAXQDA can create frequency tables and charts 

which indicate the frequency of subcodes. These functions can be accessed in the following ways: 

 From the menu Codes > Statistic of subcodes 

 or with the Statistic of subcodes  button in the “MAXQDA standard” toolbar 

The split “Choose Codes,” dialog box: on the left side, all existing codes that have subcodes are listed; 

on the right side selected codes appear. In the middle, arrow buttons allow you to transfer codes 

from one window to the other. Click on the column header of either list in order to alphabetize 

content. 

Note: To select multiple variables at once, hold down the Shift () key, Ctrl key (Windows) or cmd 

key (Mac) 

 

Statistics for subcodes: choose codes 

For codes containing subcodes, this function can also be called up directly from the Code System. 

Right-click on the code and select Statistic of subcodes. In this way, you can also access the statistics 

functions for codes that are not at the top level of the code system. 
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The analysis can be restricted to currently activated documents and subcodes. To do so, check the 

appropriate boxes. 

Select Unit of Analysis for Statistical Evaluation 

At the bottom of the screen, you will find options for the unit of analysis. The following options are 

available: 

Documents (count all subcodes) – This option corresponds, in principle, to an evaluation of multiple 

responses. In this case, the analysis is performed assuming that when several subcodes can be coded 

in a document, the subcodes are not mutually exclusive. MAXQDA analyzes the number of documents 

to which a subcode has been assigned. All subcodes that occur in a given document will be counted, 

on a per-document basis. This type of analysis would typically be employed to answer the question 

"What percentage of cases (= documents) mention the theme XY ?". 

Documents (count most frequent subcode only) – In this case, the analysis is performed under 

the assumption that subcodes are mutually exclusive, meaning that subcodes can be interpreted as 

categorical variables. MAXQDA analyzes the number of documents to which the subcode has been 

assigned. On a per-document basis, only the subcode that occurs most frequently is counted. If two 

or more subcodes occur with the same frequency within a document, a new “not defined” category 

will appear. 

Coded segments – This option analyzes the number of coded segments per subcode. As a rule, it 

makes sense to use this option only when the Only for activated documents option is also selected, 

otherwise the output frequencies simply correspond to the frequencies in the Code System. 

Note: Regardless of which unit of analysis is selected, not only the direct subcodes of the selected 

parent codes, but also the subcodes of subcodes, will be included in the analysis. All lower-level codes 

will be aggregated with the top-level code, and only this code will be displayed in the results table. 

Once you click OK, MAXQDA begins the statistical calculation, after which the results will be displayed 

as frequency tables and diagrams. 

The window shows the table view of the first selected variables: 

 

Frequency Table 
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The first column of the table lists the different subcodes of the table; the second column, the absolute 

frequency; the third column, the corresponding percentages. The fourth column shows the percent-

ages based on valid values, meaning missing values are not taken into account. If no missing values 

exist in relation to the relevant variables, then the percentages will be identical in the third and fourth 

columns. 

Tip: Click on the column headers of the first two columns in order to define row order. For example, 

you can sort in descending or ascending order of category frequency. 

Table Values 

The relevance of table values depends on the code selection option. 

Unit of Analysis: Document (count all subcodes) – The table will show the number of documents 

in which the respective subcode was assigned. For each document, all subcodes that occur in the 

document will be counted. The number of missing values corresponds to the number of documents 

to which none of the analyzed subcodes occur. 

Unit of Analysis: Document (count most frequent subcode only) – The table will show the num-

ber of documents in which the respective subcode was assigned. Subcodes are mutually exclusive. 

For each document, only the most frequently occurring subcode will be counted. The number of 

missing values corresponds to the number of documents in which none of the analyzed subcodes 

occur. 

Unit of Analysis: Coded Segments – The table will show how often a subcode was assigned, mean-

ing how many coded segments exist for this code. 

Example: In this MAXQDA project, five interviews were analyzed with respect to the issue “World 

Problems.” In total, 17 segments in nine documents were coded, and distributed among the three 

subcodes “Scarcity of resources,” “War” and “Egoism.” 

When “Coded Segments” is selected as the unit of analysis, MAXQDA generates a table which 

shows how often each of the three subcodes occurs in the nine interviews. Missing values are not 

taken into consideration with this option. The basis for the calculation of percentages is the total 

number of coded segments: In this example, 17: 

 

Unit of Analysis: Coded Segments 

If “Documents (count most frequent subcode only)” had been selected as the unit of analysis, the 

“Frequency” column would indicate the number of interviews in which the respective world prob-

lem was coded most often. As the table below reveals, the subcode “Scarcity of resources” was 
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awarded most often in 4 interviews. Note the category “not defined,” which occurs when two or 

more subcodes are present in equal frequency within a document; in this case, twice. In each doc-

ument at least one world problem was coded, otherwise a missing value would be displayed. The 

“Total” row indicates the total number of documents analyzed: In this case, nine. 

 

Unit of Analysis: Document (count most frequent subcode only) 

When the unit of analysis “Documents (count all subcodes)” is selected, MAXQDA counts the 

number of documents in which each world problem occurs. The upper “Total” row shows the 

number of documents in which at least one of the world problems is coded. The “Percentage” 

column shows the percentage of people who mentioned at least one of the respective world prob-

lems. 

 

Unit of Analysis: Document (count all subcodes) 

The following table schematically represents the structure:  

Subcode A Number of documents in which Code A occurs. 

Subcode B Number of documents in which Code B occurs. 

Subcode C Number of documents in which Code C occurs. 

Total (valid) Number of documents in which AT LEAST ONE of the analyzed subcodes occurs. 

Missing Number of documents in which NONE of the analyzed subcodes occurs. 

Total Number of analyzed documents in total.  
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Toolbars 

You will see a toolbar at the top of the results window. Here you can: 

 call up charts by clicking the  icon 

 flip forward  or back  between main codes 

 print results, or 

 export results as an Excel file. 

Charts 

Once you have switched to the Chart view by clicking on the  icon, a bar chart of the selected 

subcode appears in the place of the table view. 

 

Horizontal bar chart representation for the subcodes of the “World Problems” code 

Note: The order of columns, bars and segments is determined by row order in the frequency table. 

You will see two toolbars at the top of this window. The upper toolbar is the same as the frequency 

table, and you can switch at any time to the table view. On the right side of the toolbar you will see 

three buttons, with which you can choose between pie chart, horizontal and vertical bar chart. The 

chart can be customized using the options in the lower toolbar. 

  Display labels – hide or show categorical labels of bar and pie charts on the x-axis. 

  Display data values – hide or show the data label, meaning frequency of variable values or 

subcodes. 

  Display percentages – show relative, rather than absolute frequencies. 
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  Display missing values – hide or show missing values category. 

  Display legend – hide or show the legend, which is switched “off” by default in bar charts. 

  Display scale – hide or show the scale axis in bar charts. 

  Display title – hide or show diagram title. 

  Display text – hide or show textual description of diagram. 

  One color – use the same color for all pie or bar chart segments. 

  Color gradient – add color gradient to pie or bar chart segments 

  Change color scheme – opens window for color scheme selection. 

Customizing Chart Captions, Color and Font Sizes 

When creating charts, MAXQDA sets an initial color scheme. To customize your charts, double-click 

on the selected segment and choose your desired color. Click on the Change color scheme  but-

ton to select from among three preset color schemes. 

Double-click on the title or description to customize content. 

Formatting, such as font, font size and font style, can be changed via the dialog window that appears 

when you right-click on the title, description or another label. 

 

Customize color and font size 

Note: When window size is modified, font size will be automatically modified accordingly. 
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Printing and Exporting Charts 

Like frequency tables, charts can be printed and exported. Charts will be exported in PNG format, or 

as vector graphics in SVG format. 

19.2 Frequency Tables and Diagrams for Variables  

With the help of the Statistics and Graphics module, MAXQDA can create frequency tables and cor-

responding diagrams for code variables as well as document variables. These functions can be ac-

cessed in the following ways: 

 from the menu Variables > Statistic of document variables and Statistic of code variables, 

 or with the Statistic of document variables  button on the “MAXQDA standard” toolbar, 

The split “Choose variables” window is displayed below: On the left side, all existing variables are 

listed; on the right, the selected variables. The arrow buttons in the middle allow you to transfer 

variables from one window to the other, i.e. for selection for analysis or removal from the selection 

list. To select multiple variables, hold down the Shift (), Ctrl (Windows) or cmd (Mac) key. 

 

Statistics and Graphics: Choose Variables 

Note: System variables that are created and managed by MAXQDA are marked in red; codes that 

have been transformed into variables are marked in green. 
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Both lists can be alphabetized by clicking on the column headers. By selecting Only activated doc-

uments you can limit the analysis to currently activated documents, for example the transcripts of 

selected interviewees. The corresponding option Only activated codes is also available. 

Tip: The statistics functions for variables can also be accessed directly with the  button in the „List 

of document variables“ and „List of code variables“. MAXQDA then begins the statistical analysis for 

only the selected variables, then considers all documents or codes. 

When you click OK MAXQDA will begin the statistical evaluation and display the results as frequency 

tables and charts. 

The results window displays the results of the first selection of variables in a table. The “Frequency” 

column shows how many of the analyzed documents contain the variable value in question. 

 

Frequency Table 

Tip: Click on the column headers of the first two columns in order to modify the order of the table 

rows. For example, you can sort the frequency of categories in ascending or descending order. 

The first column lists the various categories of the variable; the second column lists the absolute 

frequency; and the third lists the corresponding percentages. The fourth column shows percentages 

based on valid values, meaning missing values are excluded. If there are no missing values among the 

variables in question, the percentages of the third and fourth columns will be identical. 

You can customize the order of the rows within the table by clicking on the column header of the 

first and second columns. For example, you can sort the table in ascending or descending order in 

regards to categorical frequency. 

The results window has a toolbar at the top. From here you can: 

 Call up the chart view by clicking the  button 

 Flip forwards  or backwards  between variables 

 Print results, or 

 Export results as an Excel file 
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Charts 

When you switch to the chart view with the  button, a bar chart of the variables in question appears 

in the place of the table view. 

 

Horizontal bar chart of the document variable “Age” 

Note: The order of chart segments is determined by the order of the rows in the table, and can be 

modified accordingly. 

You will see two toolbars at the top of this window. The upper toolbar is the same as the frequency 

table, and you can switch at any time to the table view. On the right side of the toolbar you will see 

three buttons, with which you can choose between pie chart, horizontal and vertical bar chart. The 

chart can be customized using the options in the lower toolbar 

  Display labels – hide or show categorical labels of bar and pie charts on the x-axis. 

  Display data values – hide or show the data label, meaning frequency of variable values or 

subcodes. 

  Display percentages – show relative, rather than absolute frequencies. 

  Display missing values – hide or show missing values category. 

  Display legend – hide or show the legend, which is switched “off” by default in bar charts. 

  Display scale – hide or show the scale axis in bar charts. 

  Display title – hide or show diagram title. 

  Display text – hide or show textual description of diagram. 

  One color – use the same color for all pie or bar chart segments. 

  Color gradient – add color gradient to pie or bar chart segments 
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  Change color scheme – opens window for color scheme selection. 

Customizing Chart Captions, Color and Font Sizes 

When creating charts, MAXQDA sets an initial color scheme. To customize your charts, double-click 

on the selected segment and choose your desired color. Click on the Change color scheme  but-

ton to select between three preset color schemes. 

Double-click on the title or description to customize content. 

Formatting, such as font, font size and font style, can be changed via the dialog window that appears 

when you right-click on the title, description or another label. 

 

Modify color and font size in charts 

Print and Export Charts 

Like frequency tables, charts can be printed and exported. Charts will be exported in PNG format, or 

as vector graphics in SVG format. 

Missing Values in Frequency Tables and Charts 

MAXQDA will treat the following as missing variable values: 

 For numerical and text variables, values set as “Missing values” in the “List of variables” will be 

treated as missing. 

 For text variables, blank fields will also be treated as missing. 

Descriptive Statistics  

When evaluating numerical variables the Descriptive statistics  symbol is appears in in frequency 

tables. Clicking on the icon produces an output of the usual parameters such including mean value 

and variance. 



The Idea behind the Summary Grid 310 

20 Summary-Grid 

20.1 The Idea behind the Summary Grid 

The systematic analysis of texts or other information is often about analyzing the data systematically 

within a structural framework, summarizing it and then grouping it in different categories. 

The idea is to look for theoretical explanations for certain phenomena as well as for similarities and 

differences between texts. In this process, it is important to focus on what the research participants 

precisely said. But on the other hand, the researcher should also detach from the participants own 

words. His aim is to sum up and express what was said abstractly, and to eventually present it in a 

way that is understandable for the recipient. During this analytical procedure, the “raw data,” that is 

for example interview transcripts, records, field notes etc., should be accessible at all times. 

The Summary Grid function of MAXQDA distinguishes two work stages and offers two individual 

working environments for these stages: 

The first stage is creating a summary and the second is creating result tables (so called “Summary 

Tables”) based on the summaries. 

These two functions are accessible from the Analysis drop-down menu: 

 

Menu item “Summary Grid” 
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In order to create summaries, the segments that you want to analyze must already be grouped the-

matically. This might have been done with the use of structured interviews, thematic coding, or au-

tomatic coding. If the text is already coded with a Code System, a structure texts * codes already 

exists; you can view it using the Code Matrix Browser. 

You can picture the summary level as a thematic grid, i.e. a matrix documents * categories (codes). 

MAXQDA has a matrix like this called the Code Matrix Browser (CMB). It displays the texts in the 

columns and the categories in the rows. 

The Summary Grid is a second analytical level that contains the summaries written by the user for 

every node of the CMB. The user writes individual summaries and can edit them later, e.g. by adding 

or altering the information. The idea is to present the summaries in overview tables at a later stage 

of the analysis. This grid allows every summary to stay linked to the original text segment from the 

raw data. 

20.2 Creating and Editing Summaries  

To create and edit summaries, 

 From the main menu, select Analysis > Summary Grid, 

 Or click the corresponding button  in the “MAXQDA standard” toolbar. 

MAXQDA then opens a new window called “Summary Grid.” The window itself is divided into three 

areas: 

 Left window: the thematic grid, the Code Matrix Browser display. 

 Middle window: the coded segments, so exactly what is normally listed in the “Retrieved Seg-

ments” window after double-clicking a node in the Code Matrix Browser. 

 Right window: the summary, this is where the summary is displayed, created and edited. 

 

Window “Summary Grid” 

You can adjust the content of the columns and rows of the grid on the left with two buttons: 
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  Only activated documents – only documents that have been activated in the “Document Sys-

tem” will appear as columns. 

  Only activated Codes – only Codes that have been activated in the “Code System” will appear 

as rows. 

Additional buttons offer the following functions: 

  Names, columns: none – in the left window, the document names will not be displayed in the 

column header. 

  Names, columns: short – in the left window, the document names will be appear in the column 

header in short form. 

  Names, columns: full – in the left window, complete document names will be displayed in the 

column header. 

  Display nodes as squares – existing codes will be symbolized as squares in the left pane. 

  Display nodes as circles – existing codes will be symbolized as circles in the left pane. 

  Summary tables – opens the “Summary Tables” window, described below. 

In the right window, you can write and edit a summary for the node you have selected in the left 

window. You can select a node by clicking on it. The summary will automatically be saved after se-

lecting a different node or closing the window. 

Tip: You can move text segments from the middle window “Coded segments” to the right window 

with the mouse. This way you can easily insert citations in the summary. 

20.3 Summary Tables  

A “Summary Table” is an overview table of summaries and document variables for selected docu-

ments and codes. It serves as a compilation of the summaries for selected topics. Summary Tables are 

a useful tool for presentations and publications. 

To create or view Summary Tables, 

 select the menu item Analysis > Summary Tables 

 or click the corresponding button . 

This will open the Summary Tables window. This window is structured similarly to MAXMaps. On the 

left side you find a list of the Summary Tables you have already created and in the window on the 

right you can view the Summary Table that is currently opened. 
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“Summary Tables” window 

To create a new Summary Table, click the button  in the toolbar. A dialog window will appear that 

offers three options: 

1. You can decide whether to include all documents or only activated documents. This defines the 

rows of the Summary Table. 

2. You can select any number of codes, to be displayed in the columns of the Summary Table. 

3. You can choose which document variables should be output as supplementary information. All 

variables that are placed in the “Variables for first column” pane will appear in the first column 

with the document name. All variables that are placed in the “Variables in own column” pane will 

appear in their own columns after the codes. 
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By clicking OK, the table will be created according to the parameters you have chosen: 
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Summary Table 

The Summary Table lists all summaries for the selected codes. 

In the first column of the Summary Table, you can see the document group and document name. In 

addition, the variable values of the variables chosen are displayed underneath each document. This 

enables you to receive further information about a certain case in the Summary Table. 

All table functions of MAXQDA are available: 

 You can change the order of columns by clicking and dragging with the mouse. 

 You can hide or display columns (right-click on the column header and choose Select fields). 

 You can order columns alphabetically by clicking on a column header. 

The table is in plain text format, so the entire table is formatted with the same font. 

Note: You can edit any cell of the Summary Table individually, that means you can modify the sum-

maries displayed. Changes in the content of the Summary Table will also affect the summaries. This 

means that the content of the corresponding cell in the Summary Grid will also change accordingly. 
You can also change the variable values of the variables that are displayed in their own columns – 

this has no effect on the document variables themselves. 

Each cell of the Summary Table is connected invisibly to the assigned coded segments. These can be 

viewed in the window “Retrieved Segments” by right-clicking in the cell of the Summary Table and 

choosing “Display associated coded segments.” 
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Interactive cells in the Summary Table 

Transforming a Column of the Summary Table as a Document Variable 

Let’s say one column of your Summary Table contains short and similar summarys for a topic in an 

interview study. This analytic work can be easily used as a document variable in MAXQDA, e.g. to 

activate interviewees where you have written the same summary: Right click on the column heading 

and chose Transform into document variable. MAXDA will now create a new document variable 

that contains the summarys as values and will be named as the column. If the variable already exists, 

MAXQDA will add a number to the name. Please note that the values will be shortened to 63 char-

acters. The column in the Summary Table remains. 

Swap Rows and Columns of a Summary Table 

You can use the icon  in the toolbar of the Summary Table to rotate the view by 90°, which means 

you swap the rows and the columns for display. The documents will be displayed in the columns then 

and the codes (and the variables displayed in an own column) in the rows. 

Opening, Deleting, Duplicating and Renaming Summary Tables 

To open an existing Summary Table, double-click on the name of the Summary Table in the left panel. 

You can also right-click on the name of a table to open a context menu that allows you to open, 

rename, duplicate or delete the table. 

 

Context menu on a table name 
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Note: The Summary Table is dynamically linked to MAXQDA data. As soon as you open a Summary 

Table, it scans your project for deleted documents, codes or variables, so that they can be removed 

or updated if necessary. Deleting variables in the project or changing variable values not only affects 

the first column, but also the variables in their own columns. 

20.4 Overview of Summaries  

The "Overview of Summaries" allows quick access to the summaries of selected documents. It is 

accessible from the context menu at all levels of the Document System. Right-click on a document, 

document group, document set, or the root of the Document System and select “Overview of Sum-

maries." A listing in table form will appear, as is typical in MAXQDA, and which contains all existing 

summaries of the documents in question, displayed in the upper pane. As usual, the context of the 

listing will be noted in the upper left corner. 

The “Document” and “Code” columns contain information on the "node" from which the summary 

is derived, the “Preview” column contains the first 63 characters of the summary, and the “Position" 

column lists all the positions from which the underlying coded segments originate. The figure below 

illustrates the first summary from the document "Joanna" and is part of the code "Significantly Pos-

itive." In this document two text segments were coded with this code, namely in paragraphs 27 and 

29. 

 

Overview of summaries 
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21 Mixed Methods Functions 

21.1 General  

MAXQDA is one of the pioneers of method integration. Functionality for working with both qualita-

tive and quantitative data was already available in the very first version of the software, which came 

out in the late 1980s. The option to view a matrix of quantitative data parallel to the texts has been 

a keystone of these mixed methods. In the previous version, MAXQDA 10, the option to create code 

variables was added, which makes it possible to assign variable values to different sections of a single 

document. 

Functions that link documents and variables, for example themes from qualitative interview material 

with the variables from standardized interviews, are available in the Mixed Methods drop-down 

menu: 

 Activate by document variables – lets you activate documents to be included in the Coding 

Query based on document variable values. You could, for example, use this function to identify 

what men between the ages of 40 and 50 said about migration issues. 

 Quote Matrix – creates a Word file showing what different groups said about a theme based on 

certain variable values that you specify. Each group’s coded segments for the specified codes are 

in a different column. You could, for example, choose to see how those with various levels of 

education differ on their approach to combating homelessness. 

 Crosstabs – works parallel to the Code Matrix Browser, except that this function doesn’t work on 

the document level. Instead, you can create groups based on your variable values and compare 

how often each of these groups talks about each theme. You could, for example, compare how 

often men talk about relationships in your life satisfaction interviews in comparison to women. 

 Typology Table – shows an overview of variable values for qualitative typologies that you have 

created (e.g. for people with various views on combating their own homelessness). You could see, 

for example, what the mean age, gender breakdown, and average time already homeless is for 

the “apathetic pessimists” in comparison to the “proactive optimists.” 

 Configuration Table – this table shows which combinations of codes exist in selected documents. 

 Similarity analysis for documents – selected documents are analyzed on the basis of existing 

coded segments and document variables for their similarity, and the results are presented in a 

similarity or distance matrix. 

 Joint Displays – MAXQDA offers a variety of displays that integrate qualitative and quantitative 

data and that are related to often used mixed methods designs. “Side-by-side displays” array qual-

itative and quantitative results, “Qualitative themes for quantitative groups” display coded seg-

ments or summaries in a table for groups that have been defined by document variable values, 

and the display “Statistics for qualitative groups” divides documents into groups by the docu-

mentts’ variable values and compares mean, standard deviation and relative frequencies for se-

lected variables. 
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In the “Code System” window there are functions available, that allow you to use the code frequen-

cies for each document as document variables: 

 Transform code into document variable or categorical document variable – Codes can be 

converted into a document variable that specifies how often the code occurs in the document or 

which subcode occurs most frequently in a document. The latter is particularly useful for evaluative 

content analysis. 

21.2 Activation by Document Variable: Variables as Selection 

Criteria for the Coding Query  

The Coding Query function in MAXQDA makes it possible for you to call up segments with selected 

codes in selected documents. For simple retrievals documents and/or document groups are activated 

manually in the “Document System.” For example, you can activate all the documents in a project, 

the documents of a specific document group, or individual docments based on specific criteria. This 

type of selection is sufficient so long as you wish to retrieve only coded segments belonging to a 

specific code. More complex, selective retrievals, however, can’t be done as easily with this method. 

In addition to manual activation, there are also automatic activation options. With the Activate by 

document variable function, you can choose to activate documents based on the variable values 

that have been assigned to them. If you have defined variables for gender, age, and education level, 

for example, you could choose to select only those documents that represent women over the age of 

40 that have at least a high school education. These activations can be made by entering the appro-

priate formulas. The formula syntax in MAXQDA is similar to that of statistics programs like SPSS. 

The “Activate by document variables” function always processes the entire project. You can access 

the function by choosing Activation by document variables from the Mixed Methods drop-down 

menu or by right-clicking on the Documents icon in the “Document System” and choosing Activate 

by document variables from the context menu that appears. 

 

Accessing the function from the context menu 
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After clicking on the appropriate button, a dialog window will appear where you can enter the for-

mulas for activation. In the example mentioned above, we would want to activate only document 

with women over the age of 40 with a high school education. The dialog window is made up of the 

following sections: 

 A section for the logical formulas and the buttons to create a new formula, delete the currently 

selected formula, or delete all formulas. 

 Checkboxes for selecting operators. 

 Buttons for opening or saving formulas. 

 Buttons for carrying out the activations. 

 

Dialog field for activation by variable 

All logical conditions must have the following components: 

variable name / operator / value 

If you have created a variable called “gender” and used the characters “m” for male and “f” for 

female, we would use the following formula in order to activate those documents that are interviews 

with women: 

gender = w 

Example 

Let’s say a study was conducted about the effects of the Gulf Oil spill on the reputation of offshore 

drilling companies, and all documents have already been coded. A variable was created based on the 

presence or absence of a critique of drilling company management (”Criticism”). If there was such 

critique in a document, the variable value was set to “Y.” Otherwise it was set to “N.” 

Now, if we only wanted to activate those documents that included critique of company management, 

we would use the following formula: 
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Criticism = Y 

To do this, you would follow these steps: 

Double-click on the variable Criticism from the list of variables. You will now see the following text 

in the formula window: 

[Criticism] = <empty> 

The only thing that is missing at this point is the variable value. On the right side of the screen you 

will see a field where you can enter the value. Here you could enter “Y,” or simply click on the arrow 

to open the drop-down menu and select a value from the list of all the values that have been entered 

for a document up to that point. In our example above, both “Y” and “N” would be in the menu. 

Using this menu helps you to avoid any typos. 

Be careful when typing in values: MAXQDA variable values are case sensitive, so it makes sense to 

simply pick the value from the drop-down list. 

Since the “=” operator is used most often, it is automatically selected when you start a new formula. 

If you want to use a different logical operator, simply choose it from the right side of the window. 

The operators have the following meanings: 

= Selects variable values that are the same as the formula value. 

<> Selects variable values that are not the same as the formula value. 

< Selects variables values that are smaller than the formula value. 

> Selects variable values that are larger than the formula value. 

In our example, we wanted to activate those documents where the person did include critique of the 

company management, so the “=” operator is appropriate. We would want to see those documents 

with the variable value equal to the formula value (”Y”). 

If you are starting a formula with a numerical variable, a “0” is inserted automatically until you change 

it. When working with variables of type “Boolean” you can use “0” for “false”and “1” for “true”. 

Tip: It is possible to specify the condition that a non-numerical variable value should be <empty>. 

Then all documents to which no variable value was assigned will be selected. 

Results of Activations by Document Variable 

Once you have entered the correct logical formulas, you can start the automatic activation. Click on 

the Activate button. 

MAXQDA then checks the variable values assigned to each document to check whether it matches 

the formulated criteria. The automatic activation window is closed, and you will be brought back to 

the standard MAXQDA four-window interface. The documents that matched the criteria are now 

activated (marked red) in the “Document System.” 

Tip: The status bar at the bottom of the MAXQDA window shows you how many documents have 

been activated. 
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If you also had codes activated, you will immediately see results of your retrieval in the “Retrieved 

Segments” window. 

If you want to activate documents frequently based on the same criteria, it is recommended that you 

save the activation model as a document set. To do so, select the option Activate and create set 

from the dialog window. MAXQDA will then activate not only all the documents that meet the de-

fined variable conditions (formulas), but also create a document set containing the activated docu-

ments. This new document set can be activated at any time in the Document System, without having 

to call up the function for automatic activation via document variables. 

Changing and Saving Formulas 

After starting the automatic activation process, the dialog window is no longer seen. The formulas, 

however, will still be in that window the next time you open it. 

You can change the logical formulas (operators and values) at any time: 

 Click on the Formula in the dialog window, and select another operator. 

 If you want to change the value, simply enter the new value or select it from the drop-down menu. 

After you have changed the formula, click on the Activate button to restart the activation. 

You can also save a formula, so that you can have quick access to it at a later time. Just click on the 

Save  symbol at the bottom of the dialog window. You can then give it a name and choose where 

you want to save it. 

Files for saved logical formulas are saved by MAXQDA as .LOA (logical activation) files. To open a 

saved formula, choose Open and navigate to the place you saved the .LOA file. It makes sense to set 

up a folder for all of your LOA files, so they are easy to find. 

Complex Logical Formulas 

It is also possible to combine various logical formulas. The basic units of these combinations are still 

the formulas in their basic form: 

variable name / operator / value 

Combining formulas just means that you are connecting two of these basic formulas with an opera-

tor. 

In the above example, we activated documents where the value for the variable “Criticism” was “Y.” 

If you want to further limit the results, so that you only see what women that critiqued management 

had to say, we would want to include a second formula where the value for the variable “Gender” 

is “f” for female. 

This second formula would just need to be added and given the AND operator, so that documents 

will be found that have variable values indicating that it is a woman, and the woman critiqued man-

agement. The second formula, then, would be created as follows: 

Double-click on the variable Gender from the list of variables. 

The new formula should now look like this: 
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[Gender] = <empty> 

 Enter the value f in the dialog field, or select it from the list of values. 

 MAXQDA automatically inserts the “OR” operator. To use the “AND” operator instead, select the 

appropriate option in the right-hand pane. According to the schema, any number of other logical 

combinations can be added. Click the Activate button to begin. 

In this way, you can add as many combinations of logical formulas as you want. You can then click 

Activate to start the activations. 

The combination operators OR and AND have the following affect on the results of your activation 

process: If you choose the OR option, MAXQDA looks for documents that meet at least one of the 

various formulas’ criteria. If you entered the formulas “Criticism = Y” OR “Gender = F,” you will get 

all the documents that included critique of management as well as those that were women. For our 

example, then, the OR option would not be appropriate. We want both formulas to be met, so we 

would need to use the AND operator, so that it looks as follows: 

 

A complex logical formula 

Deleting Formulas 

It is possible to go back and delete a formula at any time: 

 Click on the row you wish to delete. 

 Click on the  Delete button. 

Using Code Variables for Activation by Code Variable 

It is not only possible to activate documents based on their document variables; you can also activate 

codes based on their assigned code variables. The Activate by code variable function can be ac-

cessed by right-clicking on the Code System icon and choosing the appropriate option in the con-

text menu that appears, or by clicking the icon in the “Code System” window toolbar. 
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Activate by code variable function in the “Code System” icon’s context menu 

21.3 Crosstab  

The Crosstab function has some similarities to the Code Matrix Browser, except that documents are 

analyzed grouped by document variable. Social groups, such as men and women, or people with 

different personal background, etc. can be compared based on variable values. All of the variables 

that are in your project can be used to set up a group. 

Crosstab is a visualization of the relationship between document variables and codes. The following 

example displays the number of times each code was assigned woman or men. 

 

Crosstab example based on gender 

The Crosstab function can be accessed from the Mixed methods menu or from the context menu 

of a code. 

The Crosstab toolbar at the top of the window offers the following in addition to the usual export 

functions: 

  Quote Matrix – Displays the coded segments as a matrix in Excel. 
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  Number of segments – Displays absolute frequencies, meaning the number of segments of the 

respective codes for the variable form of the respective column. 

  Row percentage – The percentage share of the cell calculated across the row (horizontal per-

centage calculation). 

  Column percentage based on the sum of coded segments (row “SUM”) – The percentage 

share of the cell calculated across the column (vertical percentage calculation). 

  Column percentages based on the number of documents “N (documents)” – The column 

percentage in terms of the number of documents in the column (the option Count hits per document 

only once will be selected automatically). 

  Count hits per document only once – The unit of analysis is set to Document. Each document 

is analyzed based only on whether the code has been assigned or not; the frequency with which a 

code occurs within a document is not taken into account. 

  Refresh – recalculates the values in the table. 

Crosstabs are well suited for the analysis of sub-categories and their distribution in sub-groups of the 

sample. Imagine you have asked how students prepare for examinations, and the different options 

(e.g. reading books, working together with colleagues, etc.) are defined as codes. With the Crosstab 

function, you can compare various groups with each other. Are female students participating more 

in training groups? Do male students read more text? The options to view the values as row or column 

percentages make the interpretation of the data even easier. 

Selection of Codes and the definition of Columns in Crosstabs 

As usual in MAXQDA, the selection of codes is done via activation. The selection should be completed 

before using the Crosstabs function, otherwise all codes will be displayed in the Crosstab. 

The definition of the columns is done by defining appropriate variable conditions (formulas) in the 

dialog window, which is similar to the “Activate by document variables” dialog window. 

After activating codes and selecting Crosstab, you will have the option to create logical conditions 

that will be used to assign documents to each column. The window is broken up into the following 

sections: 

 A list of all the document variables in the project. 

 A section for the definition of logical conditions (formulas). 

 Buttons for selecting operators and values. 

 Buttons for opening and saving logical conditions (formulas). 

 Further functions, for example starting Crosstabs calculation or cancelling the action. 
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The Crosstab dialog window 

All logical formulas must have the following components: 

variable name / operator / value 

If you have created a variable called “Gender” and used the characters “Male” for male and “Female” 

for female, we would use the following formula in order to create one column of the Crosstabs to 

represent women: 

Gender = Female 

If you wish to record all occurrences of a variable in the table (e.g. gender) as a column in the crosstab, 

you would follow these steps: 

1. Select the option Insert all variable values as conditions. 

2. Double-click the desired variable in the left pane of the window. 

MAXQDA then lists the formulas that you have set up in the middle pane of the window. In the 

example, it would look as follows: 

[Gender] = Female 

[Gender] = Male 

The Crosstabs created in this way would look as follows: 
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Crosstabs comparing the number of coded segments for each code by women and men 

If there are many different possible values for a certain variable, you can choose to delete those that 

you don’t want to include in the visualization. If, for example, you had a variable “level of organiza-

tion” with possible values “very high,” “high,” “medium,” “low,” and “very low,” you might only 

want to compare the two extremes. To do so, click on the element you wish to remove from the list 

in the Formula row and click the Delete  symbol. 

You can also compare groupings based only on specific variable values by not checking the box to 

Insert all variable values as conditions. Instead, you would simply create a formula and add single 

values by following these steps: 

1. Double-click on the desired variable in the list of variables to set it as a condition (formula). 

2. Insert the appropriate variable value in the field on the right side of the window or choose it from 

the drop-down list. The drop-down list will have all the values that were assigned to the chosen 

variable. Choosing the value from the list helps you avoid any typos that would cause you to get 

false results. 

3. Repeat the first three steps to set up each column of the Crosstabs. 

When you click OK, the table will be displayed. 

You can also save formulas, so that you can have quick access to them at a later time and don’t have 

to reenter them one by one. Just click on the Save button at the bottom of the dialog window. You 

can then give it a name and choose where you want to save it. 

Files for saved formulas are saved by MAXQDA as .LOA files. To open a saved set of formulas, choose 

Open and navigate to the place you saved the .LOA file. 

21.4 Quote Matrix  

The Quote Matrix is based on the same idea as the Crosstabs function, i.e. to create a joint display of 

themes and quantitative variables. The Quote Matrix does this on a more detailed, non-aggregated 

level. Here the coded segments themselves are listed in the cells of the matrix, not only the number 

of coded segments for that particular cell. In the example below, we can see a comparison about 

what married and single people said about certain themes. 
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Code Family status = married Family status = single 

emotions  Happiness does not remind me of one 

event. It makes me think of my life.  Even 

though there are bad times, overall I am 

very happy with the way I turned out as a 

human being and I like were my life is 

headed. 

New York/Joanna: 34 - 35 (100) 

Sadness reminds me of the death of my 

grandmother (Dec. 90') and my grandfather 

(June 96'). Their deaths effected my life 

greatly.They were like my second parents. 

These two times were definately the worst 

times of my life 

New York/GINA: 12 - 12 (100) 

I feel as if I am very healthy and I know that I 

have a firm background on what being healthy 

means because of my interest in Nutrition and 

Exercise. I always to try to eat better and make 

the right choices and exercise on a regular ba-

sis. I really think that those two components 

contribute highly to health. But, health also 

means emotionally, mentally and even spiritu-

ally. I feel like my spiritual life really contributes 

to the rest of my health because I take care of 

my body because God tells us to in the Bible 

and everything else falls into place. 

New York/Milly: 11 - 11 (100) 

 

educa-

tion 

My career now is college. I am graduating 

this weekend from my Community Health 

Undergraduate program at Hofstra Univer-

sity. I am continuing my undergraduate 

studies at CW Post in the fall to get a BS in 

nutrition. Getting my RD is my major career 

choice. My satisfaction level on my career is 

only a 7 because I am not looking forward 

to going back to undergrad college but it is 

the only way I can achieve a license. 

New York/GINA: 17 - 17 (100) 

 

Overall I am pretty happy with my mental, 

social and physical health. I would like to im-

prove my dedication to working out. I am 

the type of person who will work out 5 

times a week for a month staight and then 

is slowly turns into less days a week until it is 

none. I get distracted by school work, my 

job or just being tired. 

New York/Silvia: 42 - 42 (100) 

My major is Dietetics and I am planning on 

working with children at either a center or a 

Children's Hospital and do meal plan counsel-

ing for children that need special diets because 

of sickness, or whatever the case may be. 

I know that will not be happy in my occupation 

unless I work with children. I have a heart for 

kids and I found this out by working a summer 

camp for kids for the past 2 summers. 

I started taking a Nutrition class last year and 

decided that it interested me and found out 

what kind of jobs that I could get involved with 

by talking with my counselor and it all worked 

out great. 

(…) 

New York/Vincent: 12 - 12 (100) 

 

Example of a Quote Matrix with source references (document, position, weight) 

MAXQDA creates a table that shows the same coded segments that would be numerically listed in 

the Crosstab, but here they are displayed as text. In theory, it would be possible for you to create a 

Quote Matrix on your own by doing retrievals in MAXQDA for each group and copying them from 

the “Retrieved Segments” window into a table in Word, but the resulting table would contain only 

the segments themselves and no source data. 

To create a Quote Matrix, proceed as follows: 

1. First, activate the codes you wish to include in the Quote Matrix. 
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2. From the main menu, select Mixed Methods > Quote Matrix. The following dialog window will 

open, in which you can define the columns of the matrix: 

 

Defining columns for the Quote Matrix 

When you click OK, a dialog window will open in which you can create a file name and select the 

location where the Quote Matrix will be saved. The matrix can be saved as an Excel, HTML or RTF file. 

For a matrix with many columns, Excel format is recommended, for a matrix with few columns, RTF 

format is recommended. The file will open automatically upon export. 

Tip: You can also generate a Quote Matrix directly from the Code Matrix Browser or Code Relations 

Browser or Crosstab by clicking the Quote Matrix symbol. 

21.5 Typology Table  

This function offers yet another way to combine quantitative data and your codes or categorical var-

iables. It is called a Typology Table, because it is able to calculate various variables and their percent-

ages (means, standard deviations, etc.) for qualitative typologies. 

The table is set up similarly to the following example from Creswell and Plano’s book “Designing and 

Conducting Mixed Methods Research” (2010: 292): 



Typology Table 330 

 

Example of a Typology Table 

This table shows a comparison between two types of patients, “Depressed” patients (27 persons) and 

“Not Depressed” patients (21 persons). The last column p-Value shows the statistic significance of 

the mathematical means. The first row shows the average age of both groups and the standard 

deviation in brackets. 

The row “Women” contains the number of women and their percentage. This means that of the 27 

depressed persons 21 are women, which is exactly 79%. 

As we can see, the rows consist of variables, metric variables to be exact, and specific values of cate-

gorical variables – either text or numerical variables. The columns follow the pattern of Crosstabs, 

meaning the values of any categorical variables can be selected. 

 

Example of a Typology Table 

To create a Typology Table, proceed as follows: 

1. Select Mixed Methods > Typology table from the main menu. 
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Select variables in the rows for the Typology table 

2. For categorical variables, all respective variable values are listed in the dialog window. For non-

categorical (metric) variables, the variables themselves are listed. For easy differentiation, non-cat-

egorical variables appear in red. Check the variable values and variables you would like to include 

in the Typology table and to compare between groups. 

3. Select the Exclude missing values option when the missing values of non-categorical variables 

should be ignored. This will usually be the case. 

4. When you click Continue a second dialog window will appear in which you can define the col-

umns of the Typology table, and where you can specify the elements that should be compared 

with one another. 
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Defining the columns of a Typology table 

5. Create a variable condition (formula) for each desired column, for example “Depressive = Yes” 

and “Depressive = No”. The quickest way to do so is by double-clicking the variable in the variable 

column. When you click OK, MAXQDA will display the Typology table. 

The Toolbar 

At the top oft he typology table you will find a toolbar that offers the following fucntions: 

  Highlight lowest value per row – for better interpretation of the results the value highest in 

row is highlighted in green. 

  Highlight highest value per row – for better interpretation of the results the value lowest in 

row is highlighted in red. 

  Refresh – updates display via recalling the function. 

  Open as Excel – generates an Excel table containing the content of the typology table. It will be 

opened with the assigned program for Excel files directly. 

  Open as HTML – generates a HTML table containing the content of the typology table. It will be 

opened with the standard browser directly. 

  Export – exports the typology table in Excel format or as a Webseite. It may also be exported as 

an image file. 

Interactivity 

The typology table is linked to the data in MAXQDA interactively: 
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• Double click on a cell, that shows the number of documents (and no mean value), to activate 

these documents in the „Document System.“ 

• Double click on a cell of of the first column, where the cell shows a variable value, to activate all 

documents that fit the clicked variable criteria. 

21.6 Configuration Table  

The Configuration Table is a Mixed Methods tool that shows you at a glance how frequently a set of 

codes appears in a document. 

To create a new Configuration Table, go to Mixed Methods > Configuration Table. 

This will open a dialog window. You can pull up to 10 codes from the “Code System” into this 

window via Drag & Drop. You can also insert your activated codes in this window by clicking the 

button Paste activated codes. If you have activated more than ten codes only the first ten will be 

inserted in the Code System. You can delete one or more codes with the button Delete code(s). 

 

Selecting codes for the Configuration Table 

You can restrict the evaluation to the documents you have activated with the option Only for acti-

vated documents. 

Click OK to view the result of the evaluation. It is made up of two results tables: the Configuration 

Table and the Configuration Table – detail view. 

1. Results Table: Configuration Table 

In this table the columns contain the codes you have chosen as well as two additional columns con-

taining “Frequency” and “Percent.” Every row contains one possible combination of codes. 
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Note: A combination of codes that does not occur will not be displayed in the table. 

For example, a results table for the combination of three major global problems could look something 

like this: 

 

An example for a Configuration Table 

Looking at this table, you can see that two documents exist which contain the first code “Scarcity of 

resources” and the code “Egoism.” There is one document with the code “War” and none of the 

other two codes and another document containing the codes “Scarcity of resources” and “War.” 

There is also a document containing all three codes. 

The column “Frequency” tells you how many of the evaluated documents contain a certain combi-

nation. The sum row also tells you how many documents were evaluated – in the example shown it 

was five documents. 

In the top right corner you see the number of combinations that actually exist in your documents and 

– in brackets – the number of all possible combinations. In the example above it says 4(8) which 

means there are four rows for the existing four combinations. And – because we evaluated three 

codes – mathematically, there are 2
3
 = 8 possible combinations. 

Note: In the configuration table it does not matter how often a code was assigned in a document. 

The table only shows you if a certain code was assigned in any of the documents at all. 

The table is automatically sorted by the frequency. You can also sort it by a different column by 

clicking a column header. You can also adjust the order of the columns via Drag & Drop. 

Tip: The Configuration Table is interactive. When you double-click on a cell containing a blue square, 

all of the corresponding coded segments will appear in the Retrieved Segments window. 

If you click on the Statistic  symbol, a frequency table in which all existing code combinations and 

their frequencies are listed. In the <no codes> row you can see the number of analyzed documents 

in which none of the selected codes occur. 
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2. Results Table: Configuration Table – detail view 

The second results table lists all evaluated documents and shows whether the selected codes appear 

in these documents or not. So this table corresponds to the (binarized) Code Matrix Browser, only 

that you can also sort it by columns. 

The table has as many rows as documents were included in the analysis. The first two columns contain 

the document group and the name of the document. Next to these columns you see the columns for 

the selected codes. The column on the far right gives you the sum of the selected codes that appear 

in the respective document – regardless of how often those codes appears in the document. 

The following screenshot shows an example of the detail view table: 

 

Example for a Configuration Table 

Looking at this table we see that, in the document “B01 Tyler,” the codes “Scarcity of resources” 

and “War” appear. In the document “B02 Maria” only the code “War” appears. All three codes 

appear in the “B03 Jennifer” document. In “B04 Michael” and “B05 Garnett” both “Scarcity of 

resources” and “Egoism” appear. 

The table is automatically sorted in order of the “Document System.” You can adjust the order by 

clicking the header of a column. You can also adjust the order of the columns via Drag & Drop. 

Tip: The detailled view of the Configuration Table is interactive. Double-clicking on a row activates 

the document in this row as well as all analyzed codes which occur in the document. The correspond-

ing coded segments will be displayed in the Retrieved Segments window. 

21.7 Similarity Analysis for Documents  

The Similarity Analysis for documents can be used to check the similarity or dissimilarity of various 

documents in terms of code frequency. The values of document variables can also be included. 
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Starting the Similarity Analysis 

1. Activate all documents you would like to include in the Similarity Analysis. 

2. It is also helpful to activate all codes you wish to use for determining similarity. 

3. From the main menu, call up Mixed Methods > Similarity analysis for documents. A window 

will appear that contains all previously created similarity and distance matrices. 

4. Click on the New Similarity/Distance matrix  symbol to begin the similarity analysis. 

Setting the parameters for the analysis 

A dialog window will appear in which you can select the codes and variables and specify the type of 

analysis. 

 

Setting options for the analysis 
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In the upper section, you can add the codes you wish to include in the analysis. You can add all 

activated codes directly via the Paste activated codes button. 

Next, select the type of analysis: 

Existence of code – Generates a similarity matrix that considers only whether the selected codes 

occur in the document or not. 

Code frequency – Generates a distance matrix that takes the distance of individual codes into con-

sideration. 

Similarity Measures with the Option “Existence of Code” 

To calculate similarity, various options are available. All of the calculations are based on a four-field 

table of the following type that is generated for each paired combination of documents (in the back-

ground): 

  Document A 

  Code/Variable value 

exists 

Code/Variable value 

does not exist 

 

Document B 

Code/Variable value ex-

ists a b 

Code/Variable value 

does not exist c d 

a = Number of codes or variable values that are identical in both documents. 

d = Number of codes or variable values that do not exist in both documents. 

b and c = Number of codes or variable values that exist in only one document. 

The calculation options differ in, among other things, the extent to which field "d", or non-existence 

in both documents, is considered a match. 

Simple match = (a + d) / (a + b + c + d) – Both existence and non-existence are counted as a match. 

The result is the percentage match. 

Jaccard = a / (a + b + c) – Non-existence is completely ignored. 

Kuckartz & Rädikers zeta = (2a + d) / (2a + b + c + d) – Existence is counted twice, non-existence 

once. 

Russel & Rao = a / (a + b + c + d) – Only existence is considered a match, but non-existence reduces 

the similarity. 

Distance Measures with the Option “Code Frequency” 

To calculate the distance between two documents based on “Code frequency”, the following options 

are available in which the code frequencies of two documents will be compared: 

Squared euclidean distance = The sum of squared deviations (higher deviations will be rated higher 

as lower ones because of squaring the deviations). 

Block distance = The sum of absolute deviations. 
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Note: Since it is also possible to include variable values in the analysis, all code frequencies and variable 

values are z- standardized previously beforehand. 

Including Variables 

If you want to include variables in addition to codes in the similarity analysis, click the Integrate vari-

ables button. If you selected “Existence of code” as the type of analysis, you can then select which 

variable values MAXQDA should evaluate in the dialog window. If the selected variable value exists 

in both documents, this is evaluated as a match (type "a"). In the dialog window, only variables of 

type "text", "true/false", "Date" as well as categorical integers or floating-point numbers are listed. 

 

Selecting variable values in the “Existence of Code” analysis 

If you selected "Code frequency" as the type of analysis, another dialog window will appear that 

contains only integer or floating-point variables, that are not marked as "categorical". 
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Selecting variable values in the “Code frequency” analysis 

Dealing with Missing Variable Values 

You can choose how missing values are handled: 

Set missing values to 0 – If a variable value does not exist, it is set to 0 due to the z- standardization 

of the average. In this option, the document with the missing value is taken into account in the 

analysis. 

Ignore documents with missing values – If in a document of one of the variable values is missing, 

the entire document will be ignored in the analysis. 

The Final Similarity or Distance Matrix 

The following figure shows a similarity matrix for five interviews. The selected documents are listed 

both in the rows and in the columns: 

 

Similarity matrix for five interviews 
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The default shadowed color helps to interpret the cells, which in a similarity matrix can have a value 

of 0 (no similarity) to 1 (identical): The darker the green, the more similar the two documents are in 

terms of the selected code and variable values. In the figure, for example, you can see that "Joanna" 

completely coincides with "Kelly" both in their codes and their variable values. 

The matrix is sortable: Click on a column header to sort the documents in the rows according to their 

similarity to the clicked document. 

The Similarity Analysis Toolbar 

In addition to the usual export options, the following functions can be accessed from the toolbar: 

  New similarity/distance matrix – Calls up the dialog window where you can create a new ma-

trix. 

  Delete – Deletes the selected matrix. 

    Names, columns: none, short, full – Controls column width. 

  No color highlight – Turns off green highlighting. 

  Color highlight refers to whole matrix – The highlight color takes into account the value of 

the cell. The same values will have the same highlight color in the table. 

  Color highlight refers to columns – In each column, the colors are graduated from white to 

green. In this way, you can see at a glance which documents are particularly similar to the document 

in the column. The same values in the matrix may be different colors. 

  Color highlight refers to rows – In each row, the colors are graduated from white to green. In 

this way, you can see at a glance which documents are particularly similar to the document in the 

row. The same values in the matrix may be different colors. 

Distance matrices look identical to similarity matrices, however their interpretation is the reverse: The 

lower the value in a cell, the more similar the two documents are. 

The List of Existing Similarity and Distance Matrices 

In the left pane of the window you can see the similarity and distance matrices created earlier in the 

project. They can be renamed with a double-click, or deleted by clicking the Delete icon in the 

toolbar. 

Tip: In order to ensure the transparency of the analysis process, the matrix name and selected settings 

will be displayed in the tooltip if you hover over a matrix name. 

21.8 Joint Displays 

Joint Displays are used to display, integrate and analyze qualitative and quantitative data and results. 

MAXQDA offers multiple Joint Displays for commonly used Mixed Methods designs, as described by 

Guetterman, Creswell and Kuckartz (2015) in their article on using MAXQDA to represent the results 

of Mixed Methods research using Joint Displays. These designs are: 
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• Convergent Design (qual. and quan. study parallel) 

• Explanatory Design (qual. study after quan.) 

• Exploratory Design (qual. study before quan.) 

Side-by-Side Display of Results  

Definition: The purpose of the Side-by-side display is to array quantitative and qualitative data to-

gether. 

Side-by-side displays are used to display the results of a qualitative and a quantitative study together 

by sorted themes. The display is structured like this: 

 Qualitative Results 

(Document A) 

Quantitative Results 

(Document B) 

Theme 1 

(Code 1) 

Coded segments / Summaries Coded segments / Summaries 

Theme 2 

(Code 2) 

Coded segments / Summaries Coded segments / Summaries 

Theme 3 

(Code 3) 

Coded segments / Summaries Coded segments / Summaries 

The Side-by-side display has two columns. Each column displays coded segments or summaries for 

each of the two studies. The rows of the table are made up of themes, in this case your codes. 

This Joint Display is especially suitable for convergent designs, where a qualitative and a quantitative 

study are conducted independently or for the final integration of an explanatory or exploratory design. 

Creating Side-by-Side Displays 

Open the corresponding entry from the Mixed Methods > Joint Displays menu and MAXQDA will 

open the following dialog: 
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Creating a Side-by-side display 

1. Drag and drop a document from the “Document System” into each of the fields for “Qualitative 

study” and “Quantitative study” with your mouse. Drag another document into a field to replace 

a document you already selected. 

2. Drag and drop any number of codes from the “Code System” into the “Themes” box on the left. 

Codes can be rearranged with the mouse. Codes can be removed from the “Themes” box by 

dragging the code out of the box or selecting the code and pressing Del key (Windows) or cmd-

Backspace (Mac). 

3. Check the box next to Include comments of coded segments to include comments. If a com-

ment exists, it will be displayed below the coded segment in the final display. This option is not 

available for S 

4. ide-by-side displays created for summaries. 

5. After clicking OK, a dialog window will appear where you enter a file name and select the location 

on your computer to save the display to. 

MAXQDA writes the Side-by-side display into a RTF document which can be read by Word and opens 

the document. 

Qualitative Themes by Quantitative Groups  

Definition: This joint display integrates data by arraying the qualitative data (segments or summaries) 

as one dimension and the groups formed by the quantitative data as another dimension. 

This Joint Display is used to compare coded segments or summaries for groups of documents. Docu-

ments are grouped based on variable values. The following table is a schematic representation of a 
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Joint Display for the document variable “Occupation”. Document groups are created based on their 

occupational status: 

 Document variable: Occupation 

 unemployed 

(N = x documents) 

employed  

(N = y documents) 

self-employed 

(N = z documents) 

Theme 1 

(Code 1) 

Coded segments /  

Summaries 

Coded segments /  

Summaries 

Coded segments /  

Summaries 

Theme 2 

(Code 2) 

Coded segments /  

Summaries 

Coded segments /  

Summaries 

Coded segments /  

Summaries 

Theme 3 

(Code 3) 

Coded segments /  

Summaries 

Coded segments /  

Summaries 

Coded segments /  

Summaries 

Each column displays coded segments or summaries from those documents with the corresponding 

variable value, separated into rows by themes (= codes). 

This Joint Display is especially suitable for explanatory designs, but could also be useful for convergent 

(parallel) designs. 

Creating a new display 

Open the corresponding entry from the Mixed Methods > Joint Displays menu and MAXQDA will 

open the following dialog: 

 

Creating a Joint Display „Qualitative themes by quantitative groups” 

1. Select which groups to compare by selecting a document variable and up to four variable values 

from the drop down menus. MAXQDA will include all documents with the corresponding variable 

value in the final columns of the display. 
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2. You can limit the display to only include currently activated documents by checking the box next 

to Only for activated documents. 

3. Drag and drop any number of codes from the “Code System” into the “Themes” box on the left. 

Codes can be rearranged with the mouse. Codes can be removed from the “Themes” box by 

dragging the code out of the box or selecting the code and pressing Del key (Windows) or cmd-

Backspace (Mac). 

4. Check the box next to Include comments of coded segments to include comments. If a com-

ment exists, it will be displayed below the coded segment in the final display. This option is not 

available for displays created for summaries. 

5. After clicking OK, a dialog window will appear where you enter a file name and select the location 

on your computer to save the display to. 

MAXQDA now writes the Side-by-side display into a RTF document which can be read by Word and 

opens the document. 

Statistics by Qualitative Groups  

Definition: This joint display integrates a qualitative typology as one dimension with the quantitative 

data as another dimension. 

This Joint Display is used to compare types that have been constructed from the qualitative data by 

statistical values such as mean, standard deviation, etc. The types are created based on the existence 

of codes in each document. The following table is a schematic representation of this kind of Joint 

Display: 

 Coded with … 

 subcode A subcode B subcode C 

Variable 1 

(numerical) 

Mean (Standard deviation) Mean (Standard deviation) Mean (Standard deviation) 

Variable 2 

(categorical) 

Total (%) Total (%) Total (%) 

Documents N (%) N (%) N (%) 

Each column holds all documents, in which the selected subcode occurs. It is therefore important that 

only one of the subcodes is assigned to each document. An example could be an evaluative qualitative 

text analysis where the code “self assurance” has the subcodes “low,” “medium,” and “high”. If 

one of the subcodes is assigned to each document, they can now be used to create this Joint Display. 

This Joint Display is suitable for convergent (parallel), as well as explanatory and exploratory designs. 

Creating a new display 

Open the corresponding entry from the Mixed Methods > Joint Displays menu: 
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Creating a Joint Display „Statistics by qualitative groups“ 

1. Create groups by dragging a code that has subcodes (but no sub-subcodes) from the “Code Sys-

tem” window to the “Groups” field at the top of this window. Select up to 4 subcodes from the 

drop down menus below. 

2. You can limit the display to only include currently activated documents by checking the box next 

to Only for activated documents. 

3. Click the “Choose document variables…” button to call up the variable selection window. Select 

which variable values to include for categorical variables. 

 

Choose document variables for the Joint Display „Statistics by qualitative groups“ 
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4. Click OK to include your selection and click OK again to create the Joint Display. 

21.9 Transforming a Code into a Document Variable  

A code in the “Code System” can be transformed into a document variable, indicating how often the 

selected code appears in each document. The document variable is dynamic. MAXQDA will automat-

ically update the document variable, i.e. increasing the variable value if a new segment is coded with 

the code. This feature is particularly useful as it allows the user to export code frequencies along with 

variables, or activate documents based on certain code frequencies for analysis. 

To transform a code into a document variable, right-click the code and select Transform into a doc-

variable. MAXQDA will generate a document variable, with the same name as the code, as a numeric 

variable. The program will automatically insert the code frequency of each document into the appro-

priate cell of the column. It opens along with the “Data editor” of the document variable and posi-

tions it in the appropriate column. 

 

Transform a code into a document variable 

In the overview of document variables the code could be binarized using the Transform into binary 

variable button. The variable is thereupon no longer indicated according frequency of an associated 

code in a given document, but rather whether it occurs in a document (= “1”) or not (= “0”). 
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Transform into binary variable 

21.10 Transforming a Code into a Categorical Document 

Variable  

Evaluative Categories in Content Analysis 

In many research projects, forms of evaluative content analysis are used. The standard steps are to: 

(1) define evaluative categories, usually with ordinal variables, (2) code text segments, and (3) analyze 

the data descriptively and statistically. A good example of this form of analysis process is found in 

Philipp Mayring’s chapter on qualitative content analysis found in “A Companion to Qualitative Re-

search” (Flick, et al., 2004), which describes scaled variations of structure content analysis. 

In one of Mayring’s detailed examples from a study on student teachers, a category called “self con-

fidence” is created with three options: “high,” “medium” and “low” (see below). These categories 

were developed from the material – one can see from the following figure that the categories are not 

only precisely defined, but also empirically supported with the help of the anchor examples in the 

material. 
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Coding guidelines for the category “self-confidence” (from Mayring 2000:16) 

The coding process, which is standard procedure for content analysis, has the researcher working 

through the entire data set and assigning evaluative codes to appropriate text segments that have to 
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do with “self-esteem.” This means that every single text segment that connects to self-esteem will 

be assigned the code “high,” “medium” or “low” on the basis of the coding guidelines established. 

At the end, each case (in the case of interviews, a case would be an interviewed person) can be 

analyzed as a whole and given a summary characterization as having “high,” “medium” or “low” 

self-esteem. Cases characterized as having high self-esteem can then be compared with those with 

low self-esteem. Code frequencies can also be compared and used in combination with other cate-

gories in crosstabs. 

Principles of Application in MAXQDA 

The method for evaluative content analysis can be done in MAXQDA in the following way. First, the 

category “self-esteem” is created as a code with the subcodes “high,” “medium” and “low.” The 

definitions of these codes along with anchor examples can be created as code memos. 

Now the material will be analyzed, meaning that each document is read line by line. The text segments 

that have to do with self-esteem are identified and then coded with the appropriate code (e.g. “high” 

self-esteem). After an entire text has been worked through in this way, the researcher will have one 

of the following situations: 

 Text segments about self-esteem in this document were all coded with the same subcode (e.g. 

“medium” self-esteem). In this situation, the entire case can be said to have a medium level of 

self-esteem. 

 Text segments about self-esteem in this document were coded with various subcodes, but one of 

those subcodes obviously occurs more often (e.g. three with “high” self-esteem and one with 

“medium” self-esteem). In this situation it makes sense to give the whole case that level of self-

esteem that is coded most often. 

 Text segments about self-esteem in this document were coded with various subcodes, and none 

of them clearly occur more often than the others (e.g. two with “medium” self-esteem and two 

with “high” self-esteem). In this situation, a quick categorization cannot be made, so the coded 

segments should be compared to one another by the coders, who then make a decision about 

which categorization is more appropriate. 

 No text segments were coded with self-esteem subcodes, meaning the document does not contain 

any information about this theme. None of the subcodes can be used to categorize this document, 

and will need to be treated as a “missing” value. 

The “Transform into a Categorical Variable” Function 

After coding the appropriate text segments, the “Self-esteem” code can be transformed into a cate-

gorical variable by right-clicking on the code and selecting the appropriate option in the menu that 

appears. 



Transforming a Code into a Categorical Document Variable 350 

 

Calling up the “Transform into a categorical doc-variable” function in a code’s context menu 

After this option is selected, MAXQDA performs the following actions: 

1. A new categorical variable is created in the List of document variables with the name of the code 

that it was created from (in this case, “Self-esteem”). 

2. All cases (documents) in the “Document System” are evaluated according to the rules explained 

above. 

a. Each case is assigned the value of the subcode that occurs the most often. 

b. If there are two or more subcodes used the same numbers of time, it is labeled “unde-

fined.” 

c. If none of the subcodes are used at all, no value is assigned. If the table is exported to a 

statistical software, empty values are usually treated as “missing.” 



Mixed Methods Functions 

 

351 

 

Variable matrix with the new categorical variable “Self-esteem” 

Dynamic Properties of Categorical Variables 

In MAXQDA‘s List of document variables, the categorical variables have a special status. One recog-

nizes them in the list, because they have a green square in the first column and are created from a 

“Code” as seen in the “Source” column; categorical variables are defined as text variables, and the 

texts are taken from the “Code System” (in this case “high,” “mid” or “low”). 

 

The newly-created categorical variable “Self-esteem” in the List of document variables 

Categorical variables are dynamic, which means they are updated automatically when new segments 

are coded in the documents. This is also the case for documents that are imported after the categorical 

variable has already been created; when one codes this new document, the variable label changes 

accordingly. 

Tip: If a subcode has further subcodes, they will not be included for the evaluation of categorical 

variable values. Only direct subcodes of the codes that were transformed into a categorical variable 

are evaluated. 

Categorical Variables in the Context of Mixed Methods Functions 

Categorical variables lend themselves very well to use with MAXQDA’s mixed methods functions. 

With the Activate by document function, for example, one can choose to activate only those doc-

uments with a certain variable value. This is helpful for answering research questions such as “How 

do student teachers with low self-esteem experience their situation in the school system? How do 

they approach disciplinary issues?” 

The Crosstabs function offers an aggregated overview of the number of coded segments in certain 

categories in the “Code System” for each of the three self-esteem variables. The self-esteem charac-

terizations are shown in the columns on the x-axis, and the selected codes are shown in the rows on 



Transforming a Code into a Categorical Document Variable 352 

the y-axis. Using the self-esteem example, the Crosstabs function could count the number of times 

that student teachers with low self-esteem talk about disciplinary issues in comparison to the number 

of times student teachers with high self-esteem talk about the issue. One can then easily call up the 

document segments counted in each cell in the “Retrieved Segments” window. 

One can also use the Quote Matrix to see a detailed table of the document segments, each column 

holding those segments that occur in documents with a specific categorical value. In our self-esteem 

example, one column could hold those statements about a certain topic that come from student 

teachers with high self-esteem, and the other column could display those statements from teachers 

with low self-esteem. 

The Typology Table uses categorical variables similar to the way the Crosstabs function does; a table 

is created with the categorical variable values in the columns. In this case, however, the variables are 

analyzed rather than the categories. One could look, for example, what percentage of people with 

high self-esteem are men and what percentage are women, or whether good grades in teacher cer-

tification exams seem to connect in any way to self-esteem, etc. 
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22 Importing and Analyzing Twitter Data 

22.1 What Possibilities does MAXQDA offer for Analyzing 

Twitter Data? 

MAXQDA allows you to import data directly from Twitter into an open project, and analyze this data 

using known MAXQDA tools. Using advanced options, you can search for tweets and selected 

hashtags, usernames or terms, and import these into your MAXQDA project. 

A notable feature is that you can automatically code the tweets with up to 100 author names and/or 

with up to 100 hashtags during the import process (and later if necessary). This automatic coding 

function is an advantage for researchers, as it saves a great deal of time in preparatory work that can 

be allocated instead to the actual analysis. 

Researchers that analyze social media data can use MAXQDA to provide answers to such questions 

as “What content has a user, user group, company or institution posted in a given time period? How 

have other users reacted?” 

Note: In order to use this function, a Twitter account is required. 

22.2 Importing Twitter Data  

To import Twitter data into a MAXQDA project, select Documents > Import data from Twitter 

from the main menu. 

 

Importing data from Twitter 

The following dialog window will appear: 
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Dialog window for importing data from Twitter 

Twitter Login 

In order for MAXQDA to import data directly from Twitter, you must first link your Twitter account 

to MAXQDA. To do so, click Connect to Twitter at the top of the dialog window. 

 

Connect to Twitter 



Importing and Analyzing Twitter Data 

 

355 

A new browser window will open where you can enter the login data of your Twitter account. Then, 

click Authorize App to allow MAXQDA to receive Twitter data from your account. 

 

Authorize MAXQDA for Twitter 

After registration, you can close the browser window and return to MAXQDA to start importing data. 

Note: MAXQDA uses the connection to Twitter only for importing tweets. When you close MAXQDA, 

the connection will be cancelled, meaning you must reconnect to Twitter each time you restart 

MAXQDA. 

Searching for Twitter data 

The original dialog window that you opened in MAXQDA will remain open, indicating whose account 

is connected to MAXQDA. You can now check the box below the login button, which was previously 

greyed out. Only once you have agreed to the terms of using Twitter data neither for advertising 

purposes nor for personal identification can you start your search on Twitter. Once you agree to the 

terms, the search fields will become available. 

The complex search follows the same principle as the advanced Twitter search. In the top fields, you 

can enter words or strings that must appear or not appear in the tweets. In the middle and lower 

sections, you can set define specific conditions for the search and the accounts to be searched. 

From these accounts – searches for tweets from specific users. Multiple usernames can be entered, 

separated by commas. 

To these Accounts - searches for tweets in which the entered username appears at the beginning 

of the tweet. Multiple usernames can be entered, separated by commas. 

Mentioning these Accounts - searches for tweets in which the entered user name appears some-

where in the tweet. Multiple usernames can be entered, separated by commas. 

Further parameters can be set in the lower section: 

Language: Limits the search to the selected language (the assignment of tweets to a language is 

done by Twitter itself and is not verified by MAXQDA). If you wish for tweets in all languages to be 

taken into account, allow the default parameter “Any language” to remain. 

From/to: The default search period is set at seven days, becuase this is the maximum period allowed 

by Twitter’s search function. You can reduce the search period, for example to one day, by adjusting 

the dates accordingly. 
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Include retweets: By default, this option is not selected. If you wish to include retweets in your 

analysis, simply place a check mark in the appropriate checkbox at the bottom of the dialog window. 

(The inclusion and exclusion of retweets is managed by Twitter.) 

Note: All search criteria are linked with the search operator AND. This means that only tweets that 

meet all of the conditions entered will be retrieved. 

 

Search window for importing data from Twitter 

After clicking the Run Search button, a preview window with the first 100 search results will appear. 

The number of tweets found is displayed on the lower left. When more than 100 search hits are 

found, the display is updated approximately every 10 seconds. 



Importing and Analyzing Twitter Data 

 

357 

 

Preview of search results 

When you click Import data, MAXQDA will begin the importing the tweets. 

Note: An import operation is limited to 10,000 tweets. 

Immediately after import, a dialog window will appear with the functions for autocoding tweets. 

Twitter data in MAXQDA 

During the import process MAXQDA creates a new document group in the Document System, in 

which a table document is generated for every 1,000 tweets. 

 

Table document with Twitter data in the Document System 

To ensure transparency of the research process, the name of the document group contains the import 

date. A memo will also be created for the document group in which the search query is stored. 
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Memo of a Twitter import with the exact search query 

When you double-click on the document in the Document System, the Twitter data will be displayed 

in the Document Browser: 

 

Table document with Twitter data in the Document Browser 

Each imported Twitter document contains 16 columns, each of which are named in the top line. 

Columns 1 to 3 relate to each tweet. Columns 4 to 14 contain information about the author. Column 

15 shows how many times the Tweet was retweeted and column 16 informs you about the number 

of likes for the Tweet. 
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22.3 Autocoding and Analyzing Twitter Data  

MAXQDA can automatically code the text of up to 100 authors and 100 hashtags from imported 

Twitter data. When you import Twitter data, a dialog window will appear in which you can enter the 

author names and hashtags you wish to autocode. Alternatively, you can call up the function from 

the main menu Analysis > Autocode Twitter data. 

 

Autocode Twitter data dialog window 

In the dialog window, all exisiting Twitter document are listed. From here, you can choose which 

documents you wish to autocode. If the dialog window was opened automatically following an 

import, the most recently imported documents are already preselected. Before you can start the 

autocoding process, you must first select the hashtags or author names you wish to encode. To do 

so, use the Select hashtags and Select Authors buttons. A new dialog window will appear, in which 

the selected hashtags and author names are listed: 
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Selecting hashtags for autocoding 

In the "Hashtag" column, the different hashtags are listed, and in the "Tweet" column you can see 

the number of tweets in which the hashtag appears. In the upper left corner you can see how many 

different hashtags were found in total; the top right shows how many of these hashtags are currently 

selected. 

How do you select the entries with the hashtags that are relevant to your analysis? 

1. Select the desired row. As usual, you can select multiple rows by holding down the Ctrl key (Win-

dows) or Command key ( Mac ). Your selection will be highlighted in green. 

2. Click the green checkmark  symbol in the upper toolbar. A green checkmark will appear in front 

of the the selected hashtags. 

This procedure can be repeated as desired, or reversed by selecting a row and clicking on the Stop 

icon to deselect an entry. Note that a maximum of 100 entries can be selected. 

When you click OK, you will return to the Autocode dialog window, where you can proceed in the 

same manner with author names. When at least one hastag or author name is selected, the Autocode 

button becomes available and can be clicked. MAXQDA then begins the autocoding process, which 

may take a moment depending on the number of entries. The resulting new code “Autocode Twitter 

data” with the date will be inserted at the top of the Code System. 
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The automatically inserted code in the Code System 

In the automatically generated code, "Tweet hashtag" and "Tweet author" appear as  subcodes of 

the selected hashtags and author names. For the analysis, they are automatically sorted in descending 

order of frequency. The hashtags and author names that appear most often in the tweets are at the 

top. The codes can be managed like any other code -  for example, you can change the color or 

arrangement, depending on what makes the most sense for your analysis. 

Note: From the main menu Analysis > Autocode Twitter data you can call up the autocode func-

tion as often as desired. It is therefore not necessary to perform the autocoding process immediately 

after import. 

Analyzing Twitter Data 

For the analysis of Twitter data, all the usual MAXQDA tools are available. For example, you can use 

the Simple Coding Query to determine which tweets were written by specific authors: 

1. Activate one or more documents with Twitter data in the Document System. 

2. Activate the codes with the relevant author names in the Code System. 

The result will be a compilation of all relevant tweets, which will appear in the “Retrieved Segments” 

window. If you are using MAXQDA Plus and therefore have MAXDictio available, you can use this 

compilation of tweets to perform a simple word frequency analysis. Select MAXDictio > Word fre-

quencies and check the option "Only in Retrieved Segments". 
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23 Focus Group Analysis 

23.1 How can MAXQDA support Focus Group Analysis? 

Conducting focus groups and group interviews occupies an important role in social and market re-

search. Focus groups offer a high potential for diverse analyses, therefore in MAXQDA 12, many new 

features have been developed that allow for the simple and effective analysis of focus group data. 

For simplicity we use only the term “focus groups” in MAXQDA and in this manual, although the 

functions are all suitable for the analysis of group interviews as well. 

• Transcripts of focus groups can be imported so that the contributions of the participants are 

automatically coded while importing.. 

• Individual participants can be activated directly in the "Document System", so you can easily 

compile the statements of individuals on selected topics. Background information on the partici-

pants, such as age and professional experience, can be stored as variables for focus group partic-

ipants and used for the specific and comparative analysis of participant groups. 

• The "Overview of focus group participants" can be used to answer questions such as the follow-

ing: Who has spoken at what frequency? How extensive are the contributions of each participant, 

in words or characters? 

• Use the Code Matrix Browser and the Crosstab for focus groups to create visualizations such as 

"Themes x Participants", with which participants or groups of participants can be compared by 

diverse themes, arguments, positions, and viewpoints in the allocation of codes. 

23.2 Importing Focus Group Transcripts 

To import a focus group transcript to MAXQDA, select the Main Menu function Documents > Im-

port focus group transcript. Alternatively, this function is available in the context menu at the top 

level of the "Document System”. The transcript can be stored in all MAXQDA readable text formats, 

which include DOC/X, ODT, RTF and TXT. When importing MAXQDA automatically generates a 

unique code for each participant in the Code System, and for the following evaluation and differen-

tiation automatically codes all contributions of a given participant with this code . 

To ensure that the automatic import process goes smoothly, MAXQDA requires the following in terms 

of composition and structure of the transcript: 

• Each contribution begins in a new paragraph. At the beginning of each contribution the name of 

the participant appears, followed by a colon. Using bold type or special fonts for the names will 

not affect the import process, however upper and lowercase will be taken into account. Names 

like "Lisa B." or "Gábor" with spaces and special characters are not a problem when importing. 

The subsequent text will be coded with the names of the participants, up to the point where the 

next speaker is indicated. 
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• MAXQDA will tolerate a space that is accidentally set before a name or in front of a colon, and 

treats the associated names to be identical. 

• The names of the participants that appear before the colon can be a maximum of 63 characters 

in length. 

• Sections of text at the beginning of the transcript (in which no colon occurs within 63 characters) 

will not be coded. This provides the opportunity for you to include a title and general information 

about the focus group for easy recognition. 

• Timestamps originating from the transcription software F4 or F5 will be treated as usual: 

MAXQDA will ask if you wish to associate the corresponding audio/video file with the transcript. 

The timestamps will be integrated into the MAXQDA project and removed from the text. 

Let’s take the following interview with multiple participants as an example: 

Moderator: So would you say you are actually insecure job-wise – or is it just something that comes from a bit of 
negativity at the moment? 

Lucas: Actually I think my job is actually safe because they would find it hard to replace me – not just saying that 
but it’s true.  And – and they do try to improve morale and there’s plenty of awards they dish out for employee 
of the month etc.  That’s sort of text book stuff though do you think? 

Moderator: Anyone else with anything to say about their own careers or current employment anyway? 

Miles: I’m an artist – just commercial – but even a commercial artist hasn’t got much job security.  But I’m lucky 
to have a job at all.  Don’t knock it.  – Most of the people I graduated with are still messing around looking for 
something permanent or retraining or doing nothing at all. 

Lisa: Yes I am carer.  I work for XXX home care staff agency.  I am not really happy with that.  I tried to get per-
manent job with Nursing homes, but my papers – they needed NVQ, I have right experience you know but.  So 
the agency not so well paid but its job so I must take.  The council I think they pay agency £35 an hour for me.  I 
only get 8.  I would like leave but cannot maybe when I get proper job.   

Excerpt from an optimally prepared focus group transcript 

Following a successful import, MAXQDA opens the transcript immediately in the "Document 

Browser", and from the coding stripes in the margin you can see that the speech contributions have 

already been coded. During the import MAXQDA creates a new document in the "Document System" 

with the filename of the transcript. This document has its own symbol, which allows you to immedi-

ately recognize that it relates to a focus group. Below the document, the participants of are listed 

individually, with the number at the end of the line indicating the number of contributions. The par-

ticipants are attached to their transcripts. If you move the document, the participants will move with 

it. Only the order of participants can be adjusted with the mouse. Like other documents, focus groups 

documents can be assigned to a document group or set. 
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MAXQDA view after importing a focus group transcript [must be able to view Document System, Code System 

and Document Browser with the above transcript] 

In the “Code System” you will see a very similar listing: At the top of the Code System a code with 

the name of the imported data will appear, with the participants listed as subcodes, and the same  

symbol as in the “Document System”. Participant codes and the participants in the document are 

attached: If you change the order of the participants or their names in the Code System, their order 

will also change in the Document System, and vice versa. This also applies when a focus group tran-

script is deleted: If you remove a transcript from the “Document System”, the corresponding code 

and its subcodes will be deleted from the “Code System”. 

The fact that the participants are available both in the "Document System" and in the "Code System” 

opens up extensive possibilities for the analysis, as the participants can be activated as independent 

codes and as document subsets. 

Tip: After importing the transcript you should check the names of the participants for typographical 

errors. This will avoid frustration later, in the case that the same person appears twice under different 

names because the name was written or spelled differently. Since the participant code cannot be 

deleted, you would have to make the appropriate modifications in a word processing program and 

then import the transcript again. 

When you import multiple transcripts, a unique code will be assigned to each focus group along with 

subcodes for the respective participants. The top-level codes can be moved within the same Code 
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System, but the participant codes are firmly attached to their top-level code, and their order can be 

modified only under this top-level code. 

Tip: The automatic coding function for participants may be useful for other types of documents in 

which multiple individuals interact, for example forum discussions or comments on YouTube videos. 

23.3 Tranforming an already imported text into a focus group 

transcript 

Sometimes you realize that it would have been better to import a text as a focus group transcript 

after you have already imported and coded it as a normal text document. In this case you can use the 

function Insert displayed text as focus group transcript, which is available in the main menu of 

MAXQDA. First, open a document and then start the function from the menu. MAXQDA will insert a 

copy of the text as a focus group document: 

• The participants contributions will be coded automatically and corresponding codes for each par-

ticipant will be created in the „Code System“ window. 

• MAXQDA will copy all existing coding information and memos into the newly created document, 

also the variable values and the summarys. 

• A linked media file will be linked to the new document, too. 

• The links in or on the document will not be transfered. 

23.4 The “Overview of Focus Group Participants”  

The "Overview of focus group participants" provides important information about the individual par-

ticipants, such as the number and scope of their respective contributions, and also allows you to store 

additional information about each participant in the form of variables. To access the overview, right-

click on a focus group in the "Document System" and choose Overview of focus group partici-

pants. 

The following window will open: 
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The “Overview of Focus Group Participants” provides important information 

The first two columns are used to identify the participants and their respective focus group transcript. 

The percentages of contributions and the characters always appear in the displayed table. If you have 

assigned a particular color to a participant, it will appear in the first column of the table. 

In top of the window are several buttons, whose special functions in relation to the focus group 

analysis are explained here: 

 Only activated focus group participants - Reduces rows to those of participants activated in 

the “Document System”. This is especially handy if you want to exclude Moderators from the over-

view: Activate only the other participants and click the button. 

 Statistics - Presents the values of all the columns displayed in a frequency table or chart, excluding 

the “participants” and “focus group” columns. More information on frequency tables and charts can 

be found here >> LINK. 

 Data Editor - Turns on the Variable View, in which the variable values are visible. 

 List of variables - Switches to Variable View, where you can define new variables and adjust and 

edit existing variables. More information on the use of variables in focus group analysis is provided in 

the next section. 

Tip: You can call up the summary table not only for individual focus groups transcripts, but also for 

the participants of all the focus groups in the MAXQDA project. To do this, click at the top level in 

the "Document System " with the mouse and select the appropriate entry. A corresponding overview 

is also available in the context menu of an individual participant, referred to here as “Overview of 

participant variables”. 

Editing Variables for Focus Group Participants 

You can store background information for each participant in a focus group for selective analyses and 

comparisons; for example, comparing the statements of older and younger participants. First open 

the "Overview of focus group participants" from the context menu in the "Document System" (either 

at the top level for all focus groups in the project, or at the level of a single focus group). 
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As seen above, the default overview contains multiple columns of information that MAXQDA com-

piles for the participants. You can add more columns for information such as, for example, age, 

profession, or professional rank. 

Creating new variables 

Adding new variables is done in the same way as in other overviews of variables in MAXQDA: 

1. Click on the List of Variables button  to switch to Variable View. 

2. Next, click on the New Variable  button. 

A new window will appear, in which you can define the name and type of the new variable. 

 

Creating a new variable 

After clicking OK, you will see that a line has been added with the newly added variable in Variable 

View. 

 

Newly added variable in Variable View 

Entering values for the participants 

Click on the button  Overview of focus group participants to return to the normal view. On the 

far right you will see a newly added column, in which you can enter values for each participant. The 

editable column can be easily recognized by its blue column heading, unlike the black headings of 

the columns automatically generated by MAXQDA. 
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Entering data for a variable 

The variable values for participants can be used: 

 To activate only selected participants with specific values for further analysis or 

 in a Crosstab for focus group to compare groups of participants. 

23.5 Coding Query for Coded Segments 

The central principle for the compilation of coded segments in MAXQDA is the activation of codes 

and documents. This principle also applies to the analysis of focus groups, however in this case you 

have the possibility to activate not only the focus group transcript as a whole, but also all or certain 

participants in the Document System. In this case, only the contributions of activated participants will 

be taken into account in the analysis. 

Selecting Participants for Analysis through Activation 

To activate a participant in the "Document System" for analysis, proceed exactly as when activating 

a document . You can right-click the on participants and select Activate from the menu, or simply 

click on the gray circle by icon of the participant. To activate or deactivate all the participants in a 

focus group, you can use the commands Activate all participants or Deactivate all participants 
in the context menu of the focus group. 
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Activate all participants of a focus group 

MAXQDA analysis of focus groups applies either to the entire document or to individual participants 

of the selected focus group, but never a mix of these two levels. For this reason, the transcript and 

the participants can never be activated together, following the principles below: 

• When you activate a transcript, its participants will be deactivated. 

• When you activate a participant, its transcript will be deactivated. 

 When you activate a document group or all documents, focus group participants will be disre-

garded or deactivated if necessary. 

During the search for participant statements, MAXQDA can help you by performing the following 

standard tasks: 

Find everything that the participant Lucas said in a focus group 

1. Activate the corresponding focus group in the “Document System”. 

2. Activate “Lucas” in the “Code System”. 

MAXQDA will list all of the contributions from Lucas in the “Retrieved Segments” window. 

Find everything that the participant Lucas said in multiple focus groups 

1. Activate all focus groups in the “Document System”. 

2. Activate all codes for “Lucas” in the “Code System”. 

MAXQDA will list all of the contributions from Lucas from all focus groups in the “Retrieved Seg-

ments”. 
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Find everything that Lucas said regarding a particular theme, for example “Stress due to the 

financial crisis”: 

1. Activate “Lucas” in the “Document System” in all of the transcripts you wish to include. 

2. Activate the theme code “Stress due to the financial crisis” in the “Code System”. 

MAXQDA will list all of the contributions from Lucas related to this theme in the “List of Coded 

Segments”. The participant is also indicated in the indication of origin, so you can easily associate the 

contribution with the participant. 

 

Statements of a participant on a topic in the “Retrieved Segments” window 

Find everything that multiple participants said in a focus group 

You can always activate multiple participants simultaneously. MAXQDA takes all activated participants 

into account during the Coding Query. 

Complex Coding Query 

The Complex Coding Query function also allows you to limit the search to the statements of a partic-

ular participant as coded segments. This function follows the same logic as the simple Coding Query: 

When you activate the focus group transcript, the search takes the whole document into account, 

whereas when you activate an individual participant, this participant’s contributions are treated as a 

document. 

Suppose you have assigned thematic codes in a transcript, and also coded the communication se-

quence so that there is a Code System of the following type: 

Themes 

 Financial Crisis 

 Sense of Security 

 … 

Communication sequence 
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 Objections 

 Support for the statement 

 … 

If you want to find all the statements in which Lucas presents an objection to an earlier statement 

about the "financial crisis", you can do so using the Complex Coding Query: 

1. Activate the participant “Lucas” in the “Document System”. 

2. Activate the codes “Financial Crisis” and “Objections”. 

3. Call up the Analysis > Complex Coding Query function. 

4. Select the “Overlapping” function, which searches for instances in which two codes, namely “Fi-

nancial Crisis” and “Objections” occur simultaneously. 

5. Ensure that the Only activated documents and focus group participants function is selected. 

6. When you click on Start, MAXQDA will list the results in the “Retrieved segments”. 

23.6 The Code Matrix Browser: View Coded Segments per 

Participant 

MAXQDA’s Code Matrix Browser is the ideal tool with which to illustrate and analyze the distribution 

of coded segments in different documents. This tool is in the form of a table, in which the documents 

make up the columns and the codes make up the rows. In the analysis of focus groups, often it is not 

the transcript as an individual document that is the central focus, but rather the analysis of the con-

tributions in multiple documents, to be considered separately from each other. 

The MAXQDA Code Matrix Browser therefore offers the opportunity to automatically perform exactly 

this analysis and visualize the distribution of codes per participant: 

1. Call up the Code Matrix Browser from the Visual Tools Menu. 

2. In the window that appears, select the option Focus Group Participants. If you would like to 

visualize the codes of an individual participant (or to exclude the moderator from the visualization), 

you can activate these elements in advance, and additionally select the option Only for activated 

focus group participants. 
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Code Matrix Browser options 

When you click OK, MAXQDA will open the Code Matrix Browser, whose columns are made up of 

the participants. 

 

Codes per participant 

The size of the squares provides information about how many coded segments from the four thematic 

codes are present in the contributions of each participant. The image above demonstrates the fre-

quency of encodings on the four issues made by Lucas, Miles, Lisa, Casey, and Parker. The larger the 

square, the more encodings have been made with the code in question. It is evident from the image 

that Lucas a high amount of coding occurred regarding "Stress due to the financial crisis", whereas 

Parker made no contribution to this theme. 

In the presentation of focus groups, The Code Matrix Browser operates in the same manner as usual: 

Double-clicking on a cell will display the corresponding coded segments in the “Retrieved Segments” 

window and clicking on the Display nodes as values  presents the information as code frequencies 

rather than square. The functions of the other buttons in the Code Matrix Browser are described here 

>> LINK. 

Note: If a project has multiple focus groups, all or all activated participants from all focus groups will 

be displayed in the Code Matrix Browser. The order of participants from left to right corresponds to 

their order in the "Document System" from top to bottom. 
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The Segment Matrix for focus group participants 

Using MAXQDA’s Quote Matrix, you can synoptically compile coded segments. This can be illustrated 

as follows: Behind every square in the image above is a certain number of coded text segments, which 

can be easily compiled by, for example, double-clicking on the square. A Quote Matrix contains not 

only the text segments that lie behind a square, but also compiles the text segments of all the squares 

together in a table. 

To create a Quote Matrix, click the Quote Matrix  button in the Code Matrix Browser toolbar. 

MAXQDA will open a window where you can select a location and an output format, which include: 

Excel, RTF, HTML, and TXT. The Excel format is suitable for tables with many columns; otherwise the 

RTF format, which can be opened with all standard word processing programs such as Word, is rec-

ommended. 

 

Excerpt from a Quote Matrix in Excel 

An indication of origin appears below each segment: The contribution in the upper left is from a 

statement by Lucas from paragraph 11 of the transcript, and encoded with a weight of 0. 
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23.7 Crosstab for Focus Groups 

MAXQDA offers the opportunity to save background information on each focus group participant in 

the form of variables. Suppose you have divided participants into two age groups: With the Crosstab 

for focus groups, you can easily compare the thematic coding for these two groups. The Crosstab for 

focus groups functions essentially the same way as the “normal” crosstab: The codes form the col-

umns and the groups of focus group participants form the rows, while the respective code frequencies 

are presented in the cells. 

The function is located under Mixed Methods > Crosstab for focus groups. The following window 

appears, in which you can define the participant groups. 

 

Define participant groups for the columns 

Each line in the middle column of the window forms a column in the final crosstab. In the image 

above, the option Insert all variable values as conditions has been selected and the variable "age 

group" has been automatically transferred to the middle pane with the blue arrow. MAXQDA has 

automatically inserted a row for both occurring values, "20 - 29" and "30 - 39". 

Note: In the crosstab, MAXQDA evaluates all participants that meet the conditions in the second 

column of the window - regardless of whether they come from one or more focus groups. You can 

restrict the evaluation to include only currently activated participants using the Only activated focus 

group participants option. 

The final crosstab appears as follows: 
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Crosstab for focus groups 

The example is read as follows: 25% of the 20- to 29-year-olds have been assigned the code “Finan-

cial issues,” and 100% of the 30 to 39-year-olds. 

23.8 Using the Lexical Search for Contributions from 

Participants 

MAXQDA’s lexical search can be limited to individual contributions from participants: 

1. Activate the participants whose contributions you would like to search in the “Document System”. 

2. Access the function via Analysis > Lexical Search. 

3. In the window that appears, enter the desired search terms and select Only activated documents 

and focus group participants. 

 

Search the contributions of focus group participants 
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23.9 Notes on Teamwork and Exporting Code Systems 

With the function Project > Merge projects, existing focus groups in a project will be transferred 

automatically. Coding with participant codes will also be transferred when using the Export team-

work and Import Teamwork functions, as long as both projects contain identical focus group tran-

scripts. 

When codes are exported using the function Codes > Export Code System (MAXQDA format) the 

participant codes will be exported as normal MAXQDA codes. 

When you open a MAXQDA 12 project with automatically coded focus groups in MAXQDA 11, the 

codes remain with the contributions in the Code System, however the document is treated as a nor-

mal text document. If you transfer the project back to MAXQDA 12, the documents will remain in 

the form of normal text documents; the additional functionality will no longer be available. 
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24 Transcribing and Coding Audio and Video Files 

24.1 General Information about the Analysis of Audio and 

Video Files  

MAXQDA supports the transcription of audio and video data with basic functions. For example, you 

can define the playback speed, volume, and rewind interval. In addition, you can insert timestamps 

into your transcripts to create a link between transcript and voice-over. In addition, with MAXQDA 

you can work with transcripts that were created with the software f4 / f5, wherein the existing 

timestamps will be converted into MAXQDA internal timestamps. 

MAXQDA allows you to code audio and video files directly without having to provide a transcript. 

The coded segments are treated like any other segments in MAXQDA. You can retrieve, comment 

and assign a weight to these segments in the same way as with other segments. With the help of 

these MAXQDA functions, you can analyze a wide range of different types of data – text, tables, 

PDFs, audio and video files – all within the same program. 

24.2 The “Media player” Toolbar  

To transcribe or code an audio or video file with MAXQDA, you need to work with the “Media player” 

toolbar. This toolbar offers various functions such as playing media files. In order to work with it, you 

should become familiar with this toolbar and understand how it works. 

To open this toolbar, go to View > Media player. 

 

“Media player” toolbar 

The symbols in the toolbar give you access to the following functions (from left to right): 

  Media Player: switch on/off – turns on the media player and loads the media file into the Mul-

timedia Browser. You can compare this to turning on a CD player and inserting a CD. 

  Multimedia Browser – Switches the Multimedia Browser on, in which videos are displayed and 

in which you can code media files. 

  Control Panel – Calls up the Control Panel, in which the options for volume and playback speed 

are located. 

  Overview of timestamps – Displays or hides the table view of the timestamps in the current 

media file. 

  New timestamp F6 – Inserts a timestamp of the current playback position of the media file in a 

transcript. 
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  Sync mode – turns on/off sync mode, which causes the text to follow the media file, comparable 

to a teleprompter. 

  Previous timestamp Shift+F3 – Rewinds the media file to the previous timestamp. 

  Stop – stops playback and jumps back to the beginning of the file. 

  Play/Pause F4 or F5 – pauses playback at the current position and resumes playback at that same 

position. You can set a rewind interval to resume playback from an earlier position. 

  Next Timestamp F3 – fast forwards the media file to the next timestamp. 

On the right next to these icons, you see the time elapsed and total time of the media file. You can 

jump easily to a certain position using the slider on the right. 

24.3 Inserting Audio and Video Files in a MAXQDA Project 

Audio and video files are not imported into MAXQDA but are saved in the MAXQDA Externals data 

files folder and are linked with a text document. Documents with an assigned media file are marked 

with a symbol in the “Document System:” a musical note  for audio files and a camera  for video 

files. 

There are different ways of making audio and video files available for use in MAXQDA: 

 Select Documents > Import document(s) from the main menu, 

 Or right-click on the root of the “Document System”, or a document group, and select Import 

document(s), 

 Or click on the button Import Document(s)  in the “Document System.” 

A dialog window will appear which shows all files that MAXQDA can read. Select a media file and 

click Open. 

Tip: You can also easily insert audio and video files from Windows Explorer or Mac Finder into the 

“Document System” via Drag & Drop with the mouse. 

This creates a new document named like the media file; this document is linked to the media file. The 

media file itself is saved in the MAXQDA Externals data files folder which you can set in the main 

menu by selecting Project > Preferences (Windows) or MAXQDA 12 > Preferences (Mac). If a file 

with the same name already exists, MAXQDA will ask you if you want to replace the existing file. 

You can also assign a media file subsequently to an existing document. To do so, right-click on the 

document in the “Document System” and select Properties. Here, you can insert or change a link to 

a media file. 

MAXQDA supports the following file formats: 
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Audio 
Windows: MP3, WAV, WMA, AAC, M4A 

Mac: MP3, WAV, AAC, CAF, M4A 

Video 
MP4, MOV, MPG, AVI, M4V, 3GP, 3GGP 

Windows: additionally WMV 

For video, a MP4 file with the video codec H.264 / AVC is recommended. 

 

Windows can also support other file formats if the required codec is installed. Normally this is however 

not necessary. 

Assigning Audio/Video files to a Text Document 

It is possible to retroactively assign a media file to an existing document. To do so, right-click the 

document in the Document System and select “Properties”. From here you can link a media file at 

any time. 

Alternatively, you can right-click the document and select Link Audio/Video file 

 

Assigning an audio or video file subsequently to an existing document 

Note: When you first open a media file, MAXQDA creates a file with the extension .DAT in the folder 

for externally saved files. This file has the same name as the media file. MAXQDA requires this .DAT 

file in order to quickly display the media file, and it should therefore not be deleted. 

24.4 Playing Audio and Video Files in MAXQDA 

To execute playback of the sound of a media file in MAXQDA: 

1. Ensure that the “Media player” toolbar is visible. It can be accessed through View > Media Player 

in the main menu. 

2. Double-click on the document to which the media file is assigned in the Document System to open 

it. 
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3. Click on the icon Play/Pause  on the “Media player” toolbar or press the F4 or F5 key. 

4. To display the image in a video file, click the Multimedia Browser  symbol in the "Media Player" 

toolbar. 

Note: If a transcript is empty, the Multimedia Browser will open automatically when you double-click 

on the text document to which the video file is assigned in the Document System. In this case, 

MAXQDA assumes that you wish to work directly with the video file. 

24.5 Notes on Synchronizing Transcripts and Media Files 

You can use timestamps – which are visualized similar to the way memos and coding stripes are seen 

in the “Document Browser” – to synchronize your transcripts with the original audio or video files. 

These audio and video files can even be played in MAXQDA in the integrated media player. A 

timestamp table also lets you insert comments for each section of your transcript represented by that 

timestamp, so you can later search for these comments and go directly to that section of the text or 

audio and video file. 

There are three different ways to work with text and audio and video files: 

Option A 

First you do the text transcription with whatever transcription software you want to use, import the 

transcription as a document in MAXQDA, and then link the document to the original audio/video file. 

At this point, there aren’t any connections between specific segments of the transcript and parts of 

the external file. These connections have to be created with timestamps within MAXQDA. 

Option B 

The first step in this variation is to transcribe the file with a professional software, for example f4 (for 

Windows) or f5 (for Mac) (http://www.audiotranskription.de/english/home), in which you can create 

timestamps as you transcribe. You can then export the transcript in RTF format and import it into 

MAXQDA, and the timestamps are imported along with the text. You will then already have the 

connection between your text and the audio or video file. 

Option C 

In this variation, you transcribe the file within MAXQDA. 

The second variation is the most efficient, because you have the advantage of a professional tran-

scription software, and – as opposed to in the first variation – you don’t have to create the timestamps 

within MAXQDA. The option to transcribe audio and video files directly in MAXQDA doesn’t have as 

many features as a program that is designed to only do the specific task of transcription. It is, however, 

possible since MAXQDA 10. 

http://www.audiotranskription.de/english/home
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24.6 Importing Transcripts without Timestamps and 

Subsequently Inserting Timestamps  

This variation will be explained with a song as an example. Let’s say we wanted to have a synchronized 

connection between the text and the audio for the song “I Want You” by Bob Dylan. To save us the 

time of doing the transcription, we can get the text from Dylan’s website. We can then either copy 

and paste it into a document in MAXQDA, or we could paste the text into an RTF or DOC/X file and 

import that file into MAXQDA. For this example, we’ll name the document “Dylan: I want you.” Once 

the text is in MAXQDA, we need to create the connection to the audio file. 

 Right-click on the document in the Document System and select Link audio/video file. 

 In the dialog window that appears, select the audio/video file you wish to assign to the document. 

This assignment can later be modified by selecting Properties in the context menu of the docu-

ment. In the dialog window that appears, you can click on the three dots in the “Media file” row 

to reopen the file. 

The MAXQDA document with the Dylan text is now linked to the audio file, but the audio file wasn’t 

actually imported as part of the MAXQDA project. You will now see that the symbol next to the 

“Dylan: I want you” document has changed. This is the symbol for a document linked to an audio 

file: 

 

Insert timestamps into a MAXQDA transcript 

Double-clicking on this document opens it in the “Document Browser” (see below). A new column 

has been inserted between the text and the paragraph numbers, which will show your timestamps. 

The document only has one timestamp at this point, representing the very beginning of the song, 

since we haven’t added any yet. To play the song with the internal media player, you need to activate 

the “Media player” toolbar from the Toolbars drop-down menu. You can then click on the Media 

Player switch on/off  button in this toolbar to activate the media file. 
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Imported transcript with media file connection 

Next, we would want to put the cursor at the beginning of the actual song text, right before “The 

guilty undertaker …” and start playback of the song. We can do this by clicking on the Play  button 

or using the F4 or F5 key on the keyboard. We would then let the song go until right before the 

singing begins and insert a timestamp by clicking on the New timestamp button or by pressing the 

F6 key. We want to do this same thing for the beginning of each verse. We would then see a 

timestamp symbol next to the first line of each verse. 

 

Timestamp in front of the verses 
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We can now use the synchronized text and audio together. By clicking on any of the timestamps, 

we will hear the song played from that point. If you do this with an interview transcript, you can in a 

similar way get back to various sections that you may want to hear again for tone or emphasis. 

If you turn on the Sync mode in the toolbar and click on the timestamp next to the first verse, the 

text follows the song, meaning the section of text being sung will be highlighted, similar to the way 

karaoke works. You can then follow along with the song text as you hear it. 

Note: You can display and hide the timestamps by right clicking in a document and (de-)selecting the 

option Display timestamp column. 

24.7 Importing f4/f5 Transcripts with Timestamps 

When transcribing with f4/f5, it is recommended that you set up a standard structure of timestamps. 

The easiest way to do this is to set the program to automatically insert a timestamp every time you 

hit the Enter/Return key. It is also recommended that you take advantage of the shortcut keys to mark 

which sections are being spoken by different people (e.g. in group discussions). This is accomplished 

selecting Insert time stamp at the end of each paragraph in f4/f5. 

 

f4/f5 option for automatically inserting time stamps 

Furthermore, when transcribing, it is useful to make use of f4 keyboard shortcuts in order to differ-

entiate between speakers, for example in group discussions or interviews. 

To import the transcript including timestamps and media files into MAXQDA, follow these steps: 

1. Save the transcript in f4/f5 as a RTF file. Ensure that the option Save with time stamps is selected. 

Timestamps will then remain in the text, marked with a “#” symbol at the beginning and end. 

2. Insert the file into the “Document System” in MAXQDA by selecting Documents > Import docu-

ment(s), or with the Import document(s)  button in the “Document System.” Alternatively you 

can use the function Documents > Import f4/f5 transcript. 

3. When the file is imported, MAXQDA automatically recognizes that it contains timestamps and 

prompts you to select the appropriate media file. Choose the appropriate file from the dialog 

window and confirm your selection by clicking OK. 

4. When the file is imported, MAXQDA formats and inserts timestamps into the timestamps table, 

removing them from the text for improved readability. 
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Note: The timestamps are only imported when a media file is selected. Subsequent automatic 

linking of transcripts with media is not possible! 

5. Open the imported document by double-clicking it in the “Document System.” 

Note: Documents with associated media files are marked with special symbols:  for audio files and 

 for video files. 

When imported, timestamps from text, audio and video files will appear in the corresponding column 

before the text in the “Document Browser.” 

 

Timestamp display in MAXQDA 

The audio or video file will not be loaded automatically when you open MAXQDA, but only when it 

is activated in the “Media player” toolbar – the “Media player” toolbar must therefore be displayed 

first (via the Toolbars drop-down menu). To load the media file click on the Media Player: switch 

on/off  button. 

Texts that already contain timestamps upon import can be divided further, if necessary, with other 

timestamps. 

24.8 Transcribing Directly in MAXQDA: Transcription mode 

It is also possibly to transcribe audio and video files directly in MAXQDA. To do so: 

1. Call up the function via Documents > Transcribe audio/video data. This option can also be 

accessed by right-clicking on a document group or the root of the Document System. 

2. You will then see a dialog field, in which you can select the file to be transcribed. 
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MAXQDA automatically creates an empty document named like the media file, connects it with the 

media file and opens it in the Edit mode in the “Document Browser.” You can now play this file in 

MAXQDA’s media player and start the transcription in the empty document. 

Tip: If you have already imported the media file into the "Document System" and have transcribed 

a part of the file, right-click on the document and select the entry Transcribe audio file/video file. 

A small dialog window entitled “Transcription Mode“ will open, which remains visible throughout 

the transcription. 

 

Empty transcript in the “Transcription mode” window 

From this point on, you can play data on MAXQDA's Media player, and begin the transcription pro-

cess. You can process media files and insert timestamps using the icons in the Multimedia Browser 

and “Media player” toolbar, playback options in the “Transcription mode” toolbar as well as various 

keyboard shortcuts: 

  New timestamp F6 – inserts timestamp into the transcript at the current playback position. You 

can insert a timestamp between two existing timestamps, so long as the current playback position is 

located between them. 

  Previous timestamp (Shift+F3) – jump to previous timestamp in the media file. 

  Stop – stops playback and returns to the beginning of the file. 

  Play/Pause (F4 or F5)– stops playback at the current position and continues at the same point – 

using the rewind interval. 

  Next timestamp (F3) – jump to next timestamp. 
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You can also access further transcription options in the “Transcription mode” window. 

 

Set options for playing media files and transcribing 

 Volume – set volume from 0 to 100 percent. 

 Playing Speed – allows adjustment of playing speed from half to one-and-a-half times. 

 Rewind Interval – Sets number of seconds to rewind from 0 to 10 when you start playing a media 

file. 

 Timestamp on enter – If this option is selected, a timestamp will automatically appear in the 

“Document Browser” each time you press the Enter key. 

Note: The latest state of the transcription text is saved every 5 minutes automatically in the MAXQDA 

project file. You can adjust this time interval under Project > Preferences … (Windows) or 

MAXQDA12 > Preferences (Mac). 

End transcription and continue transcription 

As soon as you have clicked the Button End Transcription the transcript text will be saved in the 

MAXQDA project file, the options window will be closed, and the transcription mode will be closed. 

To continue a transcription right click on a document in the “Document System” window and 

select the menu option Transcibe audio file / Transcribe video file. 

Transcription using foot pedals 

For faster and easier transcription, MAXQDA supports the foot pedals “Science” and “Science II” 

from the company audiotranskription.de/english: 

http://www.audiotranskription.de/english
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 The yellow “Science” switch has the same functionality as the F4 or F5 key (depending on the 

software setting inside the foot pedal): press once to play, and a second time to stop. 

 The black “Science II” switch must be held down to play media data, and will stop playing when 

released. 

24.9 Synchronizing Transcribed Text with Audio/Video files 

MAXQDA allows you to play an audio or video file at the same time as the transcript. You can view 

media files synchronized to their transcribed texts, like a teleprompter for a television presenter, or 

karaoke, in which you can read the text on the screen while listening to the music. 

To start a synchronized playback, click on the Sync mode button in the “Media player” toolbar. 

 

Activate Sync mode from the “Media player” toolbar 

Begin by clicking the Play button or the F4 or F5 key. You can also click on a timestamp in the 

document. 

24.10 The “Overview of Timestamps”  

The “Overview of Timestamps” has as many rows as there are timestamps in the document, and 

every row has three columns. The first two columns contain the start and end points of that segment. 

In the third column, you have the option of writing in a short comment about that particular segment. 

The “Duration” column provides the length of the respective segment. 

 

The Overview of Timestamps 
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These Overview of Timestamps table and the “Comment” column function just like any other 

MAXQDA table. It is possible to sort the comments or to search for a comment. 

Tip: To search for a comment, right-click on the “Comment” column and select Search.` 

If you are importing a document with timestamps, you still have the option to add new ones once it 

has been imported into MAXQDA. The option to write your comments in the list of timestamps also 

gives you a new way to find sections of your media file. Double-clicking on a row takes you to that 

section of the text in the “Document Browser” and starts playback of the media file from that point. 

24.11 Coding Audio and Video Files in the Multimedia Browser  

The Multimedia Browser Window 

Using the Multimedia Browser you can easily play and code audio and video files. To open the Multi-

media Browser, click the Multimedia Browser icon  on the “Media player” toolbar. To do this, 

the Media Player has to be turned on by clicking the  icon (you can only do this when a document 

with a media file assigned to it is displayed in the “Document Browser”). 

The following screenshot shows the structure of the Multimedia Browser: 
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The Multimedia Browser window 

For video files, the Multimedia Browser consists of five panels: 

 The upper panel shows the video. 

 Underneath, there is a toolbar containing the functions to adjust the view and playback and the 

functions for coding. Here, you can also see the current playback position and the total time of 

the media file. 

 Beneath the toolbar, preview pictures are shown. 

 Underneath, you can see the waveform of sound of the media file, and below this, there is a time 

line where you can see the current playback position precise to the second. 

 Under the time line there is a bar for the timestamps of the transcripts. 

 At the very bottom is an area where the coded segments are visualized by bars. 

For audio files, the video window and preview pictures are not shown. 

The blue vertical line and the blue bar underneath the time line indicate the current playback position. 

The following functions are available on the toolbar: 
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  Control Panel – opens the window with playback options 

  Copy video image to the clipboard – saves a screenshot of the current video image in the 

clipboard, which can then be pasted, for example, directly in a Word file. 

  Insert video picture as an image in ‘Document System’ – the currently displayed video image 

is inserted as a new document in the Document System, in order to, for example, code image seg-

ments. 

  New memo – creates a new memo in the current playback position 

  Set clip start – sets the beginning of a clip segment at the current playback position 

  Set clip end – sets the end of a clip segment at the current playback position 

  Play clip – plays the segment selected on the waveform 

  Remove clip – removes current clip marks from the waveform 

  Go to beginning – jumps back to the beginning 

  Previous timestamp – rewinds the media file to the previous timestamp. 

  Stop – stops playback and jumps back to the beginning 

  Play/Pause – starts/pauses playback 

  Next timestamp – fast forwards the media file to the next timestamp. 

  Go to end – jumps to the end 

  Slider – helps you jump to a certain position 

On the far right of the waveform, there are other icons that you can use to adjust the zoom for the 

waveform and for the preview pictures of videos. The icons are hidden in order to not cover the 

waveform. They appear as soon as you move the cursor over this area. 

 

 

  zooms out of the waveform, reduces the number of preview pictures for videos. 

  zooms the view to 100%. This view is configured by default and is usually ideal for coding. 
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  shows the complete media file in the Multimedia Browser; this gives you an overview of the 

waveform of the complete file. This view is usually not suitable for coding. 

  zooms into the waveform, increases the number of preview pictures for videos. This makes it 

easier to navigate to single pictures and words. 

  hides the preview pictures bar. 

Note: These thumbnails are generated upon the first showing. For large video files, this may take a 

few moments. 

Coding in the Multimedia Browser 

You can code audio and video files in the same way as texts in MAXQDA. You start by marking a 

segment of the waveform (a so called “clip”). Typically, you will want to set the beginning and end 

of a segment in a media file precisely to the split second as the scene and content can change com-

pletely from one moment to the other. For this reason, MAXQDA offers a number of functions that 

allow you to mark an audio or video clip: 

 To roughly mark a segment, keep the left mouse button pressed and select the segment by drag-

ging the cursor over the waveform. The time limits are displayed underneath the beginning and 

end marks. 

 You can easily alter the time limits of the clip by moving the whole blue-marked segment or by 

clicking and dragging the outer borders of the segment in the waveform. 

 By using the right and left arrow keys, playback is moved by one tenth of a second. If the playback 

precisely matches the beginning or end of a clip, the clip is enlarged or reduced accordingly. 

 To play the marked clip, click the icon Play clip or press the F9 key. 

 

Marking a clip 

 You will usually play a media file and then pause exactly at a position where you want to set a 

new coding. To do this, use the button Play/Pause  or the F4 key. 
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 When the playhead is at the designated position, click the button Set clip start  or press the 

F9 key. 

 Now resume playback and pause at the position where you want to end the coding. Click the 

button Set clip end  or press the F10 key. 

 

Setting the clip limits at the current playback position 

You can now code the selected segments as usual, for example by (a) dragging and dropping the 

marks on to a code, (b) clicking on an emoticode, or (c) by clicking a color code. Right-clicking on a 

marked segment opens a context menu that contains three options that are relevant for coding: 

 

Context menu on a marked clip 

When coding is completed, it will be indicated by a horizontal coding stripe in the Multimedia 

Browser. Below it, on the left, the code name is displayed. The coding will also be indicated by the 

color of the waveform (green for standard codes, other colors for color codes). If various codes are 

layered on top of each other, the color of the waveform is a mix of the colors. Segments coded with 

an emoticode are indicated by the Emoticon next to the coding stripe. 

Clicking on a coding stripe selects the coded segment on the waveform. Double-clicking plays the 

clip. 
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Visualization of codings in the “Multimedia Browser” 

Right-clicking on a coding stripe opens a context menu containing the usual options: 

 Modify weight 

 Edit comment 

 Delete 

Coded segments that have a comment are marked with a white square on the left hand side of the 

coding stripe. 

Audio and Video Clips in the “Retrieved Segments” 

In the “Retrieved Segments” window, video clips are shown using the first picture of the video clip. 

For audio clips, a picture of a waveform is shown. 

The time indication tells you when an audio or video clip starts and ends. 
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Audio and video clips in the “Retrieved Segments” 

Attaching Memos to Audio and Video Clips 

You can attach memos for notes to any playback position. To attach a new memo, 

 Right-click a position of the waveform 

 Or click the button New memo  in the Multimedia Browser toolbar. 

 

Creating memos 
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25 Teamwork: Using MAXQDA as a Team 

25.1 How can MAXQDA support Teamwork?  

In the context of scientific research, the evaluation of documents is often a collective, rather than 

individual endeavor. This raises the question how MAXQDA allows for teamwork. 

Important: MAXQDA is a single-user, not a multi-user program. Simultaneous use of the same pro-

ject file at the same time is not possible. Various people cannot make changes to the same file at the 

same time. 

The sort of functionality that is currently available in MAXQDA does not blend with the logic of multi-

user software. A typical example of a multi-user program is the kind used by airlines for flight book-

ings. Such programs only work when one user’s ability to change something requires that the other 

users be given read-only permissions. MAXQDA, though, is set up so that a user can write or change 

a memo, modify coded segments, etc. at any time. All of these functions would be limited – if not 

made impossible all together – with a multi-user system. For these reasons, one has to accept that 

simultaneous work by various team members on the same project file is not possible. MAXQDA does, 

though, make it easy to separate a project into various files, have team members work on them at 

the same time, and then later bring them together in one file. 

This teamwork is possible in three principle forms, depending on how the team members want to 

work together. 

 Handing over a complete MAXQDA project to another team member – Different people 

work with the same master version. They perform online searches, text retrievals, and other kinds 

of analysis with this master version. But, they do not perform code and memo procedures simul-

taneously on the master version. The MAXQDA project is therefore passed from team member to 

team member, each time for further processing. 

 Exchanging coded segments, memos, summaries, etc. of a single document, document 

group or entire project among team members – A MAXQDA project with all the documents 

to be processed is duplicated for each team member. Each member works on a pre-arranged part 

of the project, for example only segments coded with selected codes, or only certain documents. 

At the end, the coded segments, memos, etc. are transferred from the respective projects into a 

master project. 

 Merging MAXQDA projects – Members of the team edit the documents of a MAXQDA project 

in collaboration. For example, team member A codes as document 1 , 5 , 6 , 7 and 9, team member 

B codes documents 2 , 3 , 8 and 10, and team member C edits documents 4 and 11. Each member 

is working in a separate project that contains only the documents that he or she is responsible for. 

At the end, all three projects are merged. 
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25.2 Transferring a MAXQDA Project to Other Team Members  

The first case is the easiest, because here you can always transfer the entire project as a MAXQDA 

project from one computer to another, knowing that all team members always have the same data 

pool. However, you can never have two people coding project documents or creating memos simul-

taneously on different. Evaluation in which no new codes are created, no variable values are changed 

and no new memos are assigned can of course be carried out simultaneously. 

The transfer of MAXQDA projects is very easy: MAXQDA saves all aspects of the project in a MX12 

file. If you name a project “ForumAnalysis,” it will be saved on your computer as “ForumAnaly-

sis.mx12.” 

The project file contains all … The project file does not contain … 

 Documents 

 Codes 

 Memos 

 Variables 

 Coded segments 

 Summaries 

 Document links 

 Text links 

 External links 

 Diagrams made in MAXMaps 

 Similarity and Distance matrices 

 The MAXDictio dictionary 

 External documents (e.g. PDF files, images, audio 

and video files) 

 Externally saved geographical references (KML files) 

 Saved search formulas (SEA files = search files) 

 Saved selections for logical activations and other  

mixed methods functions (LOA files = LOgical Activa-

tion files) 

 Saved Code Systems in MTR format 

The project file can be transferred to other team members in the form of a single file. It can also be 

sent by email. It can also be saved in the shared folder of a cloud system, such as Dropbox or Onedrive. 

If the MX12 project file is opened on any other computer where MAXQDA 12 is installed, the entire 

project appears with all its components. 

If you want to set up the project, so that various members of the team can work on it at the same 

time, it is recommended that you start by importing all documents into a MAXQDA project on one 

computer, and then sending a copy of that file to everyone in the team. This saves you the work of 

importing the files on each individual’s computer and guarantees that everyone will have the exact 

same data set. 
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Sharing Projects that have External Files 

If you have associated audio or video files to documents or if you did not import very large PDF or 

image files, they will not be saved in the project file, but rather in a folder for external files (path listed 

under Project > Preferences (Windows) or MAXQDA 12 > Preferences (Mac)). If you want to 

share these files along with the project file, follow these steps: 

1. Send the project (MX12) file. 

2. Group all the external files together by selecting Project > Bundle external data files. A com-

pressed ZIP folder with those files attached to the project will then appear in the same folder as 

your MX12 file, which you can then send to your team members 

3. Pass on this file to your fellow researchers. The file can be very large, especially if it contains audio 

and video data. It can therefore not be sent via email but rather using a cloud system or USB stick. 

Procedure for Receiving the Files 

1. Open the MX12 file. 

2. Select the Unpack bundled data files option from the Project drop-down menu and choose the 

ZIP file that was sent with the external files. MAXQDA unpacks these external files and puts them 

in the appropriate folder, so that they are connected to the newly-opened project. 

25.3 Transferring Coded Segments, Memos, Variables, etc. 

from one Project to another MAXQDA also supports another type of 

teamwork, which allows people in the team to work on documents at the same time. It is 

required that everyone has the same exact data set, meaning that each person has a copy 

of the project on their own computer. However, different team members are not required 

to process the documents in the same order, nor must the number of documents be the 

same on each computer, meaning different computers can have more or less documents 

available in the “Document System.” 

Tip: Each document must be identical in form for all team members or computers, meaning the 

number of paragraphs and the actual text must correspond completely and accurately. The format-

ting, however, for example font type and size, does not need to be the same. 

The following example is set up for only two different computers, but the same principle works for 

as many computers as you require. 

Computer 1 

Project with documents A, B, C and D 

Computer 2 

Project with documents A, B, C and E, F 

The document pool does not need to be exactly the same, in the sense that all documents available 

on computer 1 must also be available on computer 2. 

The codes do not need to be the identical, but in a research team you should of course ensure that 

the same category, meaning the same code, is assigned the same name and does not differ among 

each team member. 
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Exchange of Coded Segments, Memos, Variables, etc. for a document 

If “Interview 1” was coded on Computer 1, how do you make this work available to someone else in 

your team? And what if new codes were created during this process? In this case, it doesn’t make 

sense to send the project file, because the work that the person has done on Computer 2 would be 

lost. It is necessary in this case to simply transfer the work done on that single document. 

In MAXQDA, you can do this as follows: 

1. The person working on Computer 1 right-clicks on the text “Interview 1” in the “Document Sys-

tem” 

2. He then selects the option Export Teamwork from the context menu, and selects the file name 

and saving location. The document name will be proposed as the name for the saved file, which 

in general should be used. 

3. MAXQDA then saves a file containing all the information about this document, including coded 

segments information, memos, variables, and external links. All codes, coded segments, memos, 

variables and external links will be included in the file. The file will have the extension (Max-EX-

change format), allowing for easy recognition later. 

 

Choosing to export the information for the document “Teresa” 

If you want to document all of the coded segments that you are exporting for the person that will be 

receiving it, you can do so by right-clicking on the document a second time and choosing to see the 

Overview of coded segments. You will then have a list of the segments in the following form: 
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List of coded segments in the “Overview of Coded Segments” 

You can then export this table and/or copy it to the clipboard and paste it into a word processing 

document, so you can print it out. 

Note: The “Teamwork export” file contains all coded segments, memos, variables, summaries, and 

external links for a document regardless of what you may have activated. This means that it is not 

possible to export only those segments coded with a certain code. The rule is: all or nothing. 

The MEX file can then be sent as an email attachment or transferred with a flash drive. It is recom-

mended here again that you first compress it as a ZIP file, so that the email program is sure to be able 

to read it. 

Import the MEX File into the target project 

The exported file can be imported on any computer where the same document with the same text 

structure is present in the “Document System.” This works in the same way as the “Teamwork ex-

port.” Right-click on the document in the “Document System” on Computer 2. Then choose Team-

work import and choose the appropriate file in the dialog window. You will then see a dialog field 

where you can check the source and target documents. As long as the documents on Computer 1 

and Computer 2 have the same names, you don’t need to change anything, since MAXQDA will 

already assume this is the document for which you wish to import the MEX file. If the documents 

have different names, this will need to be corrected. 
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Options for importing teamwork 

Important: The document that you are importing the coded segments, memos, and variables to must 

have the exact same structure as the document that is receiving the information. To make sure you’re 

not importing a completely different document, MAXQDA will ask you once again to confirm the 

import. 

You can then decide what exactly you want to import: coded segments, memos, variables, and/or 

external links. You can also choose to view a protocol after the import, so you can later document 

exactly what was imported. The standard settings are to import all aspects of the document. 

When you import a coded segment it may occur that at the same code has already been assigned to 

the respective coded segment, perhaps with slightly different segment boundaries. Since in MAXQDA 

a document segment can be coded only once with a code, you can decide which segment boundaries 

should be maintained via the drop-down menu: 

Segment boundaries of imported file – This is the default selection: In case of conflict the newly 

added coded segment and its boundaries are adopted. 

Segment boundaries of the opened project – In case of conflict the existing coded segment will 

be retained, so it will not make any change to the code. 

OR-combination of segment boundaries – In case of conflict, the outermost boundaries of both 

coded segments will be adopted. 

AND-combination of segment boundaries – In case of conflict, the intersecting area of both codes 

is adopted as the coded segment. 

When importing summaries, you can also control how MAXQDA should proceed in case of conflict: 

Existing summaries will not be changed: With this setting, only empty summaries are imported. 

In case of conflict imported summaries are therefore ignored. 
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Imported summaries overwrite existing ones – In case of conflict, existing project summaries will 

be deleted and overwritten with imported summaries. 

Add imported summaries to existing ones – In case of conflict the imported summaries will be 

added tot he existing summaries. 

Click on Import to begin the process. 

MAXQDA’s Import Process for Coded Segments and Memos 

MAXQDA proceeds as follows with the imported coded segments: 

 All coded segments existing in documents before the import procedure will be maintained or ad-

justed, depending on the selected option. 

 Previously non-existent encodings will be inserted into the open project. 

 If in the Teamwork file a segment coded with a code or subcode not yet in the Code System is 

found, this code will be recreated and inserted in the appropriate position in the Code System. 

Codes with the same name at the same position will thereby be regarded as identical; their color 

will not be taken into account. 

 Coded segment comments will not be included if a coded segment with the same segment bound-

aries already exists. 

Document memos within a document are always imported (exception: memos at the same start po-

sition with the same title). The memos that are attached to a document or document group in the 

“Document System” as a document memo or attached to codes in the “Code System” as a code 

memo are handled differently. Since there can’t be more than one of each of these memos, one of 

the versions of the memo has to be kept, and one has to be ignored. If a memo already exists in the 

project, the memos from the imported project will not be included. 

Variables are handled slightly differently. Variables that did not previously exist in the project are 

automatically created, and the variable values are inserted. If the variables already exist, their values 

will be updated and consequently overwritten. 

To make sure that the import procedure was carried out correctly, it is recommended that you open 

the document in order to review of the newly inserted coded segments. You can also obtain a list of 

all coded segments with the “Overview of coded segments”. 

Exchanging Coded Segments, Memos, and Variables for Document Groups or the 

Entire Project 

In MAXQDA, the document-related exchange of coded segments, memos, and variables is possible 

for document groups or even the entire project. 

The same rules will apply as with individual documents. To start the import function, right-click on 

the document group, or, if you wish to exchange the entire project, on the root of the Document 

System, and choose Export Teamwork from the context menu that appears. 

When importing, therefore, the document group, rather than the single document, must be clicked. 

Once you have selected Import teamwork and selected the MEX file format, a dialog window will 

appear which lists the assignment of source and target texts. Here you have the option to make 
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changes to the automatic assignment by MAXQDA. In order to do so, double-click the text in the 

target column. You can access a list with all the texts of the document group by clicking on the small 

triangle in this field. Here you can optionally select a different text as the target of the import.. 

 

Options when importing teamwork for an entire project 

25.4 Merging Two MAXQDA Projects  

Another teamwork feature in MAXQDA is the option to merge two projects. The “Merge projects” 

function causes all elements of a second project to be added to a project you currently have open. To 

do this, follow these steps: 

1. Open the larger of the two projects you want to merge. 

2. Choose Merge projects from the Project drop-down menu. 

3. Select the second project from the dialog window, which will be in the form of an MX12 file. 

The following dialog window will appear: 
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Options for merging projects 

Because a MAXQDA project can contain only one project memo, one memo per code, and one Log-

book, you can choose, in the top section, what content should be kept and what should be overwrit-

ten. When the default settings are left as is, the existing data in the already opened project will remain 

unchanged. 

In the bottom section, two options are available that allow you to determine how MAXQDA should 

handle documents whose identical name already exists in the project. 

Don’t import already existing documents – When the projects are merged, by default, all docu-

ments from the imported project are inserted into the open project. When you select this option, 

already existing documents will be ignored, thus not imported. For example, if the open project con-

tains the document group “Interviews” with documents A, B, and C, and the imported project con-

tains the document group “Interviews” with the documents A, B, and D, document D will be imported 

and inserted into a second document group. 

Merge document groups with same name – This option is available only when the previous option 

is selected. In this case, no further document groups with the same name will be created, and the 

imported documents will be integrated into the already existing document group. This means if the 

document group “Interviews” with documents A, B, and C already exists, only document D will be 

imported. 

When you click OK, MAXQDA then starts the merging process, which may take some time, depending 

on the size of the two projects. 

Note: Before merging the projects, MAXQDA automatically creates a backup of the current project 

in the selected backup folder. 

The merge function is carried out in the following manner: 

 All document groups of the imported project will be inserted with their documents, possibly gen-

erating duplicates. If a text group entitled “Interviews” exists in both projects, the resulting merged 

project will have two text groups of this name. The options above can be set so that already 

existing documents are ignored and so that no duplicate document groups are created. 
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 All memos of both projects will be inserted. 

 Coded segments will be merged; in the case that a code or subcode does not exist in the new 

project, it will be created. Codes with the same name and same position will be considered iden-

tical; their color is not relevant. 

 Summaries will be imported. 

 All internal and external links will be imported. 

 Each variable will be analyzed to determine if it already exists in the project. 

If the variable does not exist in the open project, a variable of that name will be created. The 

variable values of the documents in the open project will be set to 0 or to the preset missing value 

for numerical variables, or empty for text variables. 

If a variable exists with another type declaration, it will be created. Suppose the open file contains 

the text variable "marital status" and the file to be added contains a numerical variable of the 

same name. The result is that after import two variables entitled "marital status" will exist; for 

the old project the numerical variable will be set to 0 and for the new project the text variable will 

be left blank. 

 Codes that have been transformed into variables will be ignored. 
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26 Admin System for User Management  

26.1 Calling Up and Activating User Management  

MAXQDA supports teams working on projects with an optional user management system, in which 

you can set different rights for different groups of users. 

Note: The admin system is not designed to ensure secure of your projects, just for working together 

in teams. 

To activate user management, select Project > Activate user management from the menu. 

 

Activating user management 

The user who activates the user management will automatically become administrator and has to set 

a password for his user name. 

 

Set admin password 
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Caution: Note your password carefully! Without this password, the MAXQDA project can no longer 

be opened. 

Once the administrator has been established, user management can only be opened with a valid 

administrator name and password. The next time the project is opened a login window will appear 

and you'll be prompted for a valid user name and password. 

 

Login window 

In the default configuration, only administrators are able to open the user management, 

add users or change rights. 

26.2 The Main User Management Window  

In the main user management window, you can create new users, remove existing users, and define 

the rights of individual user groups. 
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Main user management window 

On the left side of the user management window, the various levels (Admin and Levels 1-3) are dis-

played. The right side of the window contains information about each user, which can be created or 

edited here; it is also here that users can be assigned to one of four user groups. 

Adding a New User 

Click on the Add user  button to add a new user. The new user settings can subsequently be 

edited: 

User: Here you can set the user name (= Login name), with which the user can log into the project. 

Group: Here you can set the level within the hierarchy to which the user is assigned. 

Name: Here you can enter the user's real name. 

Comments: In this field, you can post comments regarding the user. 

The properties of a user can be modified at any time by clicking on the user name in the left side of 

the window. 

Deleting Users 

To delete a user, select the user name in the left side of the window and click the Delete user  

button. You will be required to confirm your selection. 
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User Passwords 

User passwords can be managed in two ways. If no password has been set by an admin, each user 

must first log in and set his own password. Alternatively, the administrator can set an initial password 

and communicate it to the other users. In order to set the initial password, click the Set initial pass-

word  button. The users can then access the MAXQDA project with this password, and set their 

own passwords upon first use. Only the user will know this new password. If a user forgets his pass-

word, the administrator can reset it by clicking the Reset user password  button. The administrator 

can also reset the initial password in this way. 

Initial Password 

The purpose of the initial password is to act as a barrier to entry into the project. New users must 

enter this password the first time they log into a locked MAXQDA project, before setting their per-

sonal passwords. 

Hierarchical Levels 

When you click on a particular level in the left side of the window, the rights of the users at this level 

will be displayed on the right side of the window. Aside from the Admin Level, users can be placed 

in three different groups, from Level 1 to Level 3. In a research project, the levels can be established, 

for example, in the following way: 

 Level 1: Project leaders 

 Level 2: Research associates, who can import and delete texts, work with the “Code System,” 

and write, edit and delete memos 

 Level 3: Student associates, who work primarily on the coding of material 

The following image displays the default Level 1 functions. For example, the top three functions are 

reserved by default for the Admin Level. User rights can be modified at any time by clicking on the 

red or green icon in front each program function. Any number of users can be assigned to each level, 

including the Admin Level. At least one administrator must be defined in any case, meaning the last 

entry in this list cannot be deleted. 
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Define user rights for various levels of the hierarchy 

Modify User Settings 

Click on a user name in the left side of the window in order to modify settings in the right side. 

Importing and Exporting the Entire Admin System 

It is possible to export the entire Admin System of a MAXQDA project, including user names, pass-

words and user rights. Click on the Export  button on the lower edge of the main window. The 

data will be saved in MXUSR format, which is, of course, encrypted. This file can be imported into 

another MAXQDA project by clicking on the Import  button, thus saving the administrator a lot of 

time. 

Deactivating User Management 

It is possible to deactivate user management at any time by checking the corresponding box at the 

lower edge of the window, then closing the window. 

 

Option “Deactivate user management” 
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All user names and passwords will be saved in the project, so it is possible to reactivate the user 

management at any time. 
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27 Reports 

27.1 Smart Publisher 

Using Smart Publisher  

Smart Publisher is a convenient report generator. It exports selected retrieved segments in a formatted 

Word document report, including title page and table of contents. The structure of the report is 

determined by the “Code System:” 

 An individual chapter will be created for each top-level code. 

 A subchapter will be created for each subcode. 

 Coded Segments of each code form the content of each (sub)chapter. 

Opening Smart Publisher 

Smart Publisher can be accessed by clicking the icon in the main menu, or Reports > Smart Pub-

lisher. 

 

Opening Smart Publisher 

Note: To use Smart Publisher with Windows, Microsoft Word Version 2003 or more recent must be 

installed. 

When Smart Publisher is called up, a dialog window will appear in which you can select the codes to 

be included in the report. When top-level codes are selected, their corresponding subcodes will au-

tomatically be included in the report. You can also choose to include coded segments only from 

activated documents. 
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Selecting top-level codes for Smart Publisher 

Smart Publisher Settings 

The following dialog window displays the various options available when creating a report. For easy 

navigation, Smart Publisher settings are displayed in seven tabs: 



Reports 

 

413 

 

Smart Publisher settings 

“Title“ Section 

Title – The title, which will appear on the first page of the report. 

Subtitle – The subtitle, which will appear on the first page of the report. 

Image files 1 and 2 – Selection of up to 2 image files, which will appear on the first page of the 

report. If the field is left blank, no image will appear. 

”Header and Footer” Section 

Reports can be formatted to include headers and footers, which will appear on each page after the 

title page. 

Header – Header text 

Footer – Footer text 

“Options” Section 

You can limit the output to segments where a weight was assigned in a defined area. 

Comment – Below a coded segment, its comment is also output. 

Use code alias instead of code name – The code alias will be used in the place of the code name 

as a heading, if defined for the respective code (see Creating a Code Alias). 
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“Source information” Section 

In the “Source information” you will find numerous options for the presentation of coded segments 

in the report. 

Quotation marks – text segment will be placed in quotation marks 

Document – Document groups and document names will be displayed in the references below the 

segments. 

Position – The beginning and the end of the coded segment (as well as paragraph numbers for 

textual data) will be included in the list of sources. 

Creation date – The date on which the segments were coded will be included in the list of sources. 

Author – The name of the user who coded the segments will be included in the list of sources. 

Weight – The weight of the coded segments will be included in the list of sources. 

The following figure shows an extract from a report that was generated using Smart Publisher. The 

displayed segment comes from the paragraphs 35-36 of the document “Jon” from the document 

group “New York.” It was encoded with a weight of 100. The segment was assigned the code “Sig-

nificantly Positive:” 

 

Extract from a Smart Publisher report 

Word template section (available only in MAXQDA for Windows) 

Here you can indicate which Word template Smart Publisher should choose. The Word template de-

termines the appearance of the report and can be easily modified (see below) 

After clicking OK and choosing a file name and location, Smart Publisher starts to create the report. 

This may take a moment to complete depending on the number of coded segments to be exported. 
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Note: While the Smart Publisher creates your report, you should not use Word, as the preparation of 

the report could be affected. 

The Finished Report 

The finished report is in the form of a Word document (for Windows in DOCX format, for Mac in RTF 

format), which includes a title page, table of contents, a page that lists of all the documents included 

in the report, and the main section including all of the exported segments. If a header/footer was 

included, it will appear on all pages aside from the title page. If an end page was included, it will 

appear at the end of the report. 

All elements of the report are formatted using the Word template (DOT format). Formatting 

of the final report can be modified; for example, you can easily insert additional pages or 

content. 

Alias Names for Codes 

Smart Publisher uses the code names from the “Code System” as headings for the individual sub-

chapters of the report. However, you may wish to assign an alternate name to some or all of the 

subchapters in the report. This may be the case if the 63 characters per heading allowed by the system 

are not enough, and you wish to create a longer name, or if, in other cases, a shorter heading would 

be more appropriate. For this reason, MAXQDA allows you to create a “code alias” of up to 225 

characters. 

In order to assign a code alias, right-click on the code in the “Code System” and select “Properties”. 

A dialog window will appear, in which you can enter the code alias. 

 

Assigning a code alias in the Code properties window 

From the menu Codes > Code alias table you can call up a table, in which you can conveniently 

create code aliases for multiple codes, and can see for which codes a code alias has been assigned. 
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Code Alias Table 

The Word Template for Smart Publisher (only for Windows) 

Upon installation of MAXQDA for Windows, two document templates named “MXReport_A4.dot” 

and “MXReport_Letter.dot” will be installed in "MAXQDA12" folder (or on the USB device with a 

portable installation). These templates can be opened with Microsoft Word and edited. As the file 

name indicates, one document is set to A4, while the other is set to letter format. You can create 

multiple versions of the Word templates for different occasions and customize them according to 

your needs. 

Placeholder for Customization of Word Templates 

The Word templates contain placeholders, for example for titles and subtitles written as <Title>. These 

placeholders can be modified just like any other content in a Word document. The position of the 

placeholders can also be modified as desired. 

If a placeholder is deleted, it can no longer be inserted by Smart Publisher. 

The following placeholders can be used: 

 <Date> = Creation date of the report 

 <Title> = Title assigned on the “Title Page” tab for the report 

 <Subtitle> = Subtitle assigned on the “Title Page” tab for the report 

 <Image 1> = Image file 1 

 <Image 2> = Image file 2 

 <ContentTable> = Table of contents 

 <DocumentList> = Document list 

 <Documents> = List of documents in table form 
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Placeholders for Word templates 

Format Templates 

The Word templates contain predefined format templates, which should not be deleted: 

 MX_Header1–9 (chapter titles according to the position of codes in the code system) 

 MX_Standard (textual content from coded text segments) 

 MX_Numbering (numbering of individual text segments within the chapter) 

 MX_Table (list of documents in table form) 

The format templates can be customized directly in the Word templates. Formatting of content can 

also be customized here. 

Note: The template contains some example text, including headlines and text segment presentation, 

which can be easily adapted to suit your needs. You can modify the sample texts, however, when the 

report is generated, only the tags will be applied and all other text will automatically be deleted. 

27.2 Creating a Codebook with Category Definitions  

The “Export Codebook" function allows you to automatically generate a Codebook – i.e. a category 

manual. The codebook lists all or selected codes in the order of the Code System and also outputs 

the associated code memo for each code. The completed Codebook therefore contains the cat-

egory definition of each individual code, provided that this was recorded in the code memo. 

This saves a lot of work in the creation of the annex for a research report, especially since it 

provides the opportunity to unify the font for all memo text. 

The Codebook is created in RTF format and can therefore easily be opened with word processing 

programs such as Word. It includes a cover page with the title "Codebook", the project name and 



Creating a Codebook with Category Definitions 418 

the creation date. On the following page, the Code System is listed in a table. In the main section, 

the respective codes with their associated memos are listed in the order of the Code System. 

The Codebook function is accessed through the menu Reports > Codebook. A window will appear 

in which you can specify the Codebook options in more detail. 

 

Setting options for the Codebook 

In the top section of the window, you can specify which codes should be included in the Codebook. 

Only top level codes - If you select this option, only the codes in the top level of the Code System, 

with their associated code memos, will be included. Subcodes will not be included. 

Only activated codes - In this case, only activated codes will be included in the Codebook. You can 

decide whether (inactivated) subcodes should also be included: Include subcodes. This option is not 

available if you have selected Only top level codes. 

Note: In general, only codes that include a code memo will be exported. 

Other options can be set in the lower section: 

Standardize memo fonts - If the font, font size, etc. varies between memos, they can be uniformly 

displayed in the Codebook using this option. 

Number Codes - If this option is selected, the listed codes will be numbered according to their hie-

rarchy in the Code System. 

Include parent code in code name - If this option is selected, the code path will be specified as a 

heading for the subcodes. 

Export code system with frequencies - If this option is selected, a column containing the code 

frequency will be added in the table overview of the code system. 

After confirmation, select a name and location for the file before the Codebook is created and ope-

ned. 
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27.3 Code Frequencies per Document, Document Group and 

Document Set 

How frequent is a code in a document, a document group or a document set? The Reports menu 

contains three functions that are designed to answer these questions: 

1. Code Frequency per Document 

2. Code Frequency per Document Group (available only when document groups exist) 

3. Code Frequency per Document Set (available only when document sets exist) 

In principle, it is a shortcut to the MAXQDA Code Matrix Browser, which provides report 

output with the following options: 

• Code frequencies will be displayed in the intersections of documents and codes. 

• Only activated codes and documents will be displayed. When no codes are activated, all will be 

included in the display; the same applies for documents. 

• All codes will be collapsed, regardless of their status in the Code System, and their code frequen-

cies will be aggregated. 

• The columns will contain either documents, document groups or documents sets, depending on 

the function that was called up. For document groups and document sets, the code frequencies 

of the respective associated (eventually activated) documents will be aggregated. 

• The sum row and sum columns will be displayed. 

 

Code frequency per document 
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27.4 Project Information  

The function Reports > Project Information collects information about the current project and 

shows the completed report in a separate window. Specifically, Project information contains the fol-

lowing data : 

• Report date 

• Name of the MAXQDA 12 project file 

• Project Memo (from the root of the Document System) 

• Number of document groups, document sets, and the individual document types 

• Number of codes, coded segments, and code sets 

• Number of memos 

• Number of document and code variables 

• Number of document links 

Project information can be copied to the clipboard with the Copy button, and from there transferred 

into another program such as Word. 

 

Project information 
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28 Project Organization and Data Security 

28.1 Renaming, Deleting, and Duplicating Projects 

Creating a New Project 

MAXQDA allows you to work with as many different projects as you want. If you want to work 

separately with a secondary data set, you just need to create a new project for it. 

This is how it’s done: 

1. Click on the Project drop-down menu. 

2. Select New project. 

3. Navigate to the folder where you would like to save this new project 

4. Give the project a name and click Save. 

Every project in MAXQDA is given the ending MX12. In order to secure your work, it is recommended 

that you back up this file regularly on an external backup device, such as a USB stick, external hard 

drive, or cloud location. Qualitative data analysis is a lot of work, but it only takes a minute to back it 

up and avoid risking a loss of your work if something happens to your computer. 

Deleting a Project 

If you want to delete a project, you can do so in the same way you would delete any other file in 

Windows Explorer or Mac Finder. MAXQDA 12 projects always have the file ending MX12, (or the 

file type “MAXQDA 12 Project) and the projects from previous MAXQDA versions have the endings 

MX11, MX5, MX4, MX3, MX2, or M2K. It is not possible to delete a project directly from the 

MAXQDA interface. 

Whether or not it is possible to undelete a project depends on your Windows or Mac Recycle Bin 

settings, but MAXQDA does not have any control of these operations on the operating system level. 

Renaming a Project 

Renaming a project can also only be done from Windows Explorer or Mac Finder, not within 

MAXQDA. Right-click on the project file and select Rename from the context menu that appears. 

Duplicating a Project 

A copy of your project, for example for backup purposes, can be generated easily in Win-

dows Explorer or Mac Finder. Alternatively, you can duplicate the project directly in 

MAXQDA: 

1. From the main menu, select Project > Duplicate project. 

2. Choose the folder that you would like to save the file in. 

3. Assign a name to the file. 
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To work with the copy of the project, you will need to open it; unlike the “Save as …” function in 

programs like Word, the newly-created file isn’t opened automatically. However, MAXQDA will ask 

if you would like to work with the duplicate project. 

28.2 Manual and Automatic Backups for Projects 

Manual Backup 

It is strongly recommended to make regular backup copies of your project and save them on an 

external device in case of computer damage or failure. Backup copies should be saved in a different 

location than your computer in case of theft, water damage, etc. 

You can transfer your MAXQDA data onto an external device with the help of Windows Explorer or 

Mac Finder. Alternatively, you can open the project in MAXQDA and select Project > Duplicate 

project. Then select the destination location and file name and click OK. 

Automatic Backup 

MAXQDA allows you to save projects automatically. Open a project that has a set time limit (default 

14 days) and is not automatically saved by MAXQDA. A message will appear asking if you would like 

to save the project now. When you accept, MAXQDA will save a copy in a selected directory. 

MAXQDA automatically provides the backup file with a date and time stamp. 

Both the time interval, meaning how often the project will be saved, and the directory for the backup 

files, can be set in Project > Preferences (Windows) or MAXQDA 12 > Preferences (Mac). There, 

you can also disable the function entirely. 

Note: Automatic backup is an extra security measure, but by no means replaces the regular backup 

your project files to external media, such as a portable hard drive! 
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29 Import/Export Options 

29.1 Overview of Import and Export Options 

MAXQDA offers a variety of options for exporting data to other software programs like SPSS or Mi-

crosoft Office programs. The following table gives an overview of the different options. 

Data Type Option in MAXQDA Format 

Single document Project > Export > Displayed document 

Right-click on the document name 

Or select everything in the “Document 

Browser” with Ctrl+A and copy it to the 

Windows clipboard. 

RTF, XLS/X for tables, PDF for 

PDF files and original image 

formats for images 

Highlighted document segment Highlight and copy the selection with 

Ctrl+C (Windows) or cmd+C (Mac) or by 

selecting Copy from the Edit drop-down 

menu. 

Formatted text in the clip-

board 

One or more coded segments Highlight the segments by clicking on 

them while holding the Ctrl or cmd button 

and choose the export option or copy with 

Ctrl+C or cmd+C 

XLS/X, HTML, RTF, clipboard 

All coded segments in the “Ret-

rieved Segments” window 

Project > Export > Retrieved Segments or 

with the icon in the “Retrieved Segments” 

window  

 XLS/X, HTML, RTF, clipboard 

Coded segments for a single 

document (teamwork) 

Right-click on the document and select Ex-

port teamwork 

.MEX (internal format) 

Memos Export in the Overview of memos RTF, XLS/X, HTML 

Memos for a particular 

document (for teamwork export) 

Right-click on the document and select Ex-

port teamwork 

.MEX (internal format) 

Memos for a particular 

document 

Right-click on the document and select 

Overview of memos 

RTF, XLS/X, HTML 

Text of a memo Copy to clipboard with Ctrl+C or cmd+C Windows clipboard 

List of variables Variables > List of document variables or 

code variables and then click on the icon 

in the toolbar for HTML or XLS/X table 

.HTML, XLS/X 

Variable table (export) Variables > Export data (document variab-

les) or (code variables) or click on the Ex-

port icon in the “Data editor” 

.TXT (tab-delimited), HTML, 

XLS/X 

Variable table (import) Variables > Import data (document variab-

les) or (code variables) 

XLS/X or TXT (tab-delimited) 
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Variables and variable values for 

a document (teamwork) 

Right-click on the document and select Ex-

port teamwork 

.MEX (internal format) 

Export variable values for a 

document 

Right-click on a document, select Over-

view of variables, and click on the Export 

icons in the toolbar 

TXT (tab-delimited), HTML, 

XLS/X, RTF 

Code frequencies table Codes > Overview of coded segments and 

click the Export icon 

or 

highlight the cells of the table that you 

want to copy and hit Ctrl+C or cmd+C to 

copy them to the clipboard  

TXT (tab-delimited), HTML, 

XLS/X or clipboard 

Code frequencies Codes > Overview of codes then export 

symbol 

TXT (tab-delimited), HTML, 

XLS/X 

29.2 Print Preview  

You can start a print process from within lots of functions and windows in MAXQDA. A preview 

window will appear that allows to set borders, headers and footers etc. 

For some functions – e.g. when printing the document displayed in the „Document Browser“ 

window“ – some additional settings are offered in the left window pane. 

29.3 Opening Projects from Earlier Versions (MAXQDA 11 or 

older)  

To open a project that was created in an earlier version of MAXQDA, launch MAXQDA and select 

Open project. A dialog window will appear, from which you can select the file type which corre-

sponds to your project. 
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Open projects from previous versions in MAXQDA 12 

MAXQDA 12 for Windows can read the following project formats: 

• MAXQDA 12 (Ending: MX12) 

• MAXQDA 11 for Windows (MX5) 

• MAXQDA 10 (MX4) 

• MAXQDA 2007 (MX3) 

• MAXQDA 2 (MX2) 

• MAXQDA (M2K)   

• MAXQDA Exchange files (MEX), that were created with MAXQDA for Mac versions 11.2.2 or 

newer. 

• MAXQDA Exchange files (MEX), that were created with MAXQDA for Windows 

MAXQDA 12 for Mac can read the following file formats: 

• MAXQDA 12 (Ending: MX12) 

• MAXQDA 11 for Mac (MX11) 

• MAXQDA Exchange Files (MEX), that were created with MAXQDA for Mac version 11.2.2 or 

newer. 
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• MAXQDA Exchange Files (MEX), that were created with MAXQDA for Windows version 11.1.0 or 

newer. 

Note: MAXQDA 12 will install a copy of the project in the new MX12 format in the folder where the 

project is located. Please note that the conversion process may take several minutes to complete. The 

progress of the conversion process will be displayed on your screen at all times. 

29.4 Opening MAXQDA Projects in MAXQDA 11 

MAXQDA 11 for Windows (as of version 11.1.1) and MAXQDA for Mac (as of version 11.2.3) can 

open MAXQDA 12 projects using the MAXQDA exchange file format. To open a MAXQDA 12 project 

in MAXQDA 11, proceed as follows: 

1. Open the project in MAXQDA 12. 

2. Select Project > Export MAXQDA exchange file. If the project accesses files that are stored in 

the remote data folder, MAXQDA will ask if these files should be bundled in a compressed ZIP file. 

If you select Yes, and have saved a large amount of data externally – such as large video files – this 

process may take a long time to complete. 

3. Open MAXQDA 11 and select Open existing project and click OK. 

4. Select MAXQDA Exchange file as the file type, navigate to the saved file and click Open. 

MAXQDA will search in the folder where the exchange file was saved for the compressed ZIP file, 

and automatically decompress the file in the remote data folder. 

Note: MAXQDA 11 creates a new MAXQDA 11 project in MX11 format in the folder where the 

selected file is located. Please note that the conversion process can take several minutes to complete. 

MAXQDA will constantly display the progress of the conversion for your information. 

Should MAXQDA 11 already open with a project, you can choose to open it directly through the main 

menu Project > Open MAXQDA Exchange File. 

The following modifications will be made when the project is converted: 

 Overlapping codes from PDF files will be split into multiple codes. 

 Focus group documents and codes will become “normal” text documents and codes. 

 The default color for codes will change from grey to green. 

 Tables in text documents are counted as paragraphs in MAXQDA 12 and MAXQDA 11. In 

MAXQDA 11 for Windows paragraphs are also counted within a table. Therefore, please note 

when you open a project in MAXQDA 11 for Windows, the source data for coded segments in 

text documents that contain a table may change. 
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29.5 Importing Projects from MAXApp 

In the main toolbar, you will find the option to Import MAXapp Projects. With this function, you can 

import documents that you created with MAXApp on your mobile device into the currently opened 

MAXQDA project. The documents will be imported into a new document group with their document 

memos, coded text segments precoded with emoticodes, and geographical references where it ap-

plies. 

Export project from MAXApp 

Open the project you want to export in MAXApp. 

Android 

Export the project via Dropbox or via the internal memory of the device. For the last option you need 

to connect your device with a USB cable to your computer. 

iOS 

Export the project via Dropbox or via iTunes. For iTunes export you need to connect your device with 

your computer first. 

Import Project into MAXQDA 12 

 

MAXApp project import icon 

In the main toolbar, click on the Import MAXApp Project button and a file dialog will appear. 

Navigate to the folder that is labeled identical as the MAXApp project. (If you have exported to Drop-

box a folder labelled “MAXApp …” has been created on the top level of your Dropbox. If you have 

exported to device a folder labelled “MAXApp …” has been created on the internal storage of your 

device.) 

Open the ZIP or XML file inside the folder that is labeled with the project name and choose Open. 

The documents will be imported into your project and placed in a new document group that is named 

exactly like your MAXApp project. 
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30 Special Features and General Options 

30.1 The Logbook  

The logbook is a feature in MAXQDA that lets your write a sort of journal to keep track of your 

analysis work. The term “logbook” is usually used in connection with ocean navigation, which was 

used to record meaningful happenings and observations, and it can be used in a similar way for your 

project. The logbook is set up to have the newest entries at the top. 

You can open the Logbook from the main menu Analysis > Logbook or with the keyboard shortcut 

Ctrl+Alt+B (Windows) or cmd+alt+B (Mac). 

 

Calling up the logbook 

The logbook window is a simple RTF window with a toolbar, which is fairly self-explanatory, and lets 

you format the text as you want. You can, for example, edit the font style and size; use bold, under-

line, and italics; and change the text color. The icons on the far left let you create a new entry and 

print or export the logbook. 
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Logbook 

To create a new entry, click on the New logbook entry  button on the far left of the toolbar. This 

automatically inserts a date and time stamp at the top of the page, and you can enter your text 

directly below it. 

30.2 Checking for Updates 

Each time you start the program, MAXQDA will check the MAXQDA website to see if an updated 

version is available. If an update is available, it is recommended that you download it in order to 

benefit from interesting new features and enhancements. 

Under Project > Preferences (Windows) or MAXQDA 12 > Preferences (Mac), you have the options 

to Search for updates automatically. 

If you have opted to skip an update, you can later request it manually by searching for the item in the 

Help menu. 

30.3 General Preferences  

In Project > Preferences (Windows) or MAXQDA 12 > Preferences (Mac) you can find the general 

program settings. The window that appears lets you view and edit your options. Some changes that 

you make might require a restart of MAXQDA. 
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Preferences window 

The following settings can be changed: 

”General” settings 

No duplicate code names 

If this option is checked, you will not be able to create more than one code in the “Code System” 

with the same name on the same hierarchy level. 

Ignore images and objects when importing text documents 

Graphics, especially photos, can be very large and take up a lot of memory. Furthermore, there will 

be situations in research where you are only interested in the pure text, not in the images. In this case 

you can select this option and MAXQDA will ignore images when importing a text. 

Default weight 

The default weight score for newly-created coded segments is 0, but can be changed here. 
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Max. number of codes in Quick List 

This setting determines the maximum number of codes that can be added to the Quick List, which is 

found in the “Code” toolbar. The default is 20. 

Folder for externally stored files 

Here you can set the location for all of your externally-linked files to be stored. These include audio 

and video files, for example, that are too big to be included in the project file. Image and PDF files 

might also be stored here, depending on their size and your settings (see below). 

Sum up subcodes in the Code System 

When this option is turned on, code and subcode frequencies of all compressed codes will be auto-

matically counted and displayed in the “Code System.” If this option is turned off, the displayed code 

always corresponds to the number of segments that have been encoded using this code. Frequencies 

of compressed subcodes will not be counted. 

Autosave documents in Edit mode and memos 

Here you can specify the amount of time after which the project is saved automatically during editing 

of documents and memos. 

”User interface” settings 

Reset user settings (restart of MAXQDA required) 

This is an emergency option of sorts that you can use if you have somehow altered your settings in a 

way that makes MAXQDA unusable and can’t figure out how to undo these settings. If you check 

this box, MAXQDA will need to restart, and all of your settings will then be reset. 

Large font (only for Mac, restart of MAXQDA required) 

The size of the text in the “Document Browser” can be adjusted as you wish, but you can’t control 

the exact text size in MAXQDA menus and toolbars. With this option, though, you can switch all of 

these user interface texts to a larger size. MAXQDA will need to restart. 

”PDF and image documents” settings 

Do not embed if larger than [MB] 

This value determines the size at which an imported PDF or image file will be saved not in the 

MAXQDA project file, but instead in the folder for externally stored files, with only a reference to the 

document created in the project. The default size is 5 MB. If necessary, you can adjust this value to 

be higher or lower. 

“Media files” settings 

Distance of video preview images (seconds) 

Here you can define the interval at which MAXQDA generates thumbnails for video files. 

The shorter the interval, the more images are generated. 
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Width of video preview images (pixel) 

This setting allows you to control the width of the thumbnails for video files. 

”Export” settings 

Excel Format 

You can set here whether you want to export Excel files in XLS or XLSX format. 

”Program updates” settings 

Search for updates 

The default setting is for MAXQDA to automatically search for updates. If you don’t want this to 

happen, you can uncheck this box. 

”Automatic project backups” settings 

If this option is selected, every time you open a project, MAXQDA checks when it was last saved by 

MAXQDA and creates a backup in the backup folder after the specified Time interval (days). After the 

set time interval [days] to demand the backup folder a backup of the project. 
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31 Keyboard Shortcuts  

The following keyboard shortcuts are available in MAXQDA. 

General 

Windows Mac  

F1 cmd + shift + ? Opens the MAXQDA help system. 

Ctrl + N cmd + N Creates a new project. 

Ctrl + O cmd + O Opens an existing project. 

Ctrl + A cmd + A Highlights the entire text. 

Ctrl + C cmd + C Copies the selected segment to the Windows clipboard. 

Ctrl + X cmd + X Cuts out the selected segment and puts it in the Windows clip-

board. 

Ctrl + V cmd + V Pastes the selection from the Windows clipboard. 

Ctrl + Alt + B cmd + alt + B Opens the logbook. 

Ctrl + Alt + M cmd + alt + M Opens the Code Matrix Browser. 

Ctrl + Alt + R cmd + alt + R Opens the Code Relations Browser. 

Ctrl + F cmd + F Opens the search toolbar for the current window or the table 

overview. 

Ctrl + Shift + F cmd + Shift + F Opens the lexical search. 

Ctrl + P cmd + P Prints the focused window or view. 

Alt + Double-click alt + double-

click 

Inserts a MAXQDA object (e.g. a document or code) into MAX-

Maps, if MAXMaps is open. 

„Document System“ 

Windows Mac  

Double-click Double-click Opens a document.  

Shift + double-

click 

Shift + double-

click 

Opens a document in a new tab. 

Ctrl + click cmd + click Activates or deactivates a document. 

F2 Enter Renames a document. 

Del cmd + Backspace Deletes a document. 

Alt + UpArrow 

Alt + DownArrow 

alt + UpArrow 

alt + DownAr-

row 

Moves a document or document group up and down in the 

“Document System“.  
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Strg + Drag & 

Drop 

alt + Drag & 

Drop 

Creates a copy of the document without coded segments (start 

dragging and then hold Strg/cmd) 

Ctrl + T cmd + T Creates a new document and opens it for editing in the “Docu-

ment Browser“. 

Ctrl + D cmd + D Opens the dialog window for importing documents. 

Alt + Shift + M alt + Shift + M Creates a new memo or opens an existing memo for a docu-

ment. 

„Code System“ 

Windows Mac  

Ctrl + click cmd + click Activates or deactivates a code including the subcodes. 

Shift + click Shift + click Activates or deactivates a code without subcodes. 

F2 Enter Renames a code. 

Entf cmd + Backspace Deletes a code. 

Alt + UpArrow,  

DownArrow 

alt + UpArrow,  

DownArrow 

Moves a code (possibly with subcodes) up and down in the 

“Code System“.  

Alt + RightArrow,  

LeftArrow 

alt + 

RightArrow,  

LeftArrow 

Increases and decreases the level of hierarchy of a code. 

Alt + Drag & Drop alt + Drag & 

Drop 

Creates a copy of the code without coded segments. 

Alt + N cmd + alt + N Inserts a new code on the chosen level. 

„Document Browser“ 

Windows Mac  

Ctrl + E cmd + alt + E Starts and stops Edit Mode. 

Alt + L cmd + alt + L Codes the selected segment with the most recently used code. 

Alt + W cmd + alt + W Opens the dialog window for creating a new code, which will 

be used to code the selected segment. 

Alt + C cmd + alt + C  Codes the selected segment with the code shown in the Quick 

List. 

Alt + I cmd + alt + I Codes the selected segment with a newly-created code named 

after the first 63 characters of the selected segment (in-vivo-

coding). 

Strg + L cmd + L Inserts an internal link at the location of the selected segment. 

The location it is linked to is set by highlighting another seg-

ment in that document or another one in the project and hit-

ting Ctrl + L again. 
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PgUp, PgDn PgUp, PgDn Moves to the next/previous page of a PDF document. 

Pos1, End Pos1, End Moves to the beginning or the end of a text document. 

Strg + Plus, 

Strg + Minus 

cmd + Plus, 

cmd + Minus 

Zooms in or out of the document. 

Strg + Zero cmd + Zero Zooms the view to 100 %. 

Alt + Tab, 

Alt + Shift + Tab 

alt + Tab, 

alt + Shift + Tab 

Jumps to the next/previous tab. 

Strg + F4 cmd + w Closes the current tab or the current view. 

„Media player“ toolbar [not available in MAXQDA Base] 

Windows Mac  

Strg + Alt + P cmd + alt + P Activates/deactivates the media player. 

Shift + F3 Shift + F3 Jumps to the previous time stamp. 

F3 F3 Jumps to the next time stamp. 

F4 or F5 F4 or F5 Plays or pauses the media file. 

F6 F6 Inserts a time stamp. 

„Multimedia browser“ [not available in MAXQDA Base] 

Windows Mac  

F7 F7 Sets a clip start. 

F8 F8 Sets a clip end. 

F9 F9 Plays a clip. 

F10 F10 Cancels the clip mark. 

Table overviews, e.g. „Overview of coded segments“ 

Windows Mac  

Ctrl + Shift + E cmd + Shift + E Opens the table as Excel file in the standard program. 

Ctrl + Shift + H cmd + Shift + H Opens the table as HTML file in the standard internet browser. 

Ctrl + E cmd + E Opens the dialog window for exporting the table or view. 

Del cmd + Backspace Deletes the chosen row/s. 

MAXDictio Dictionary [only available in MAXQDA Plus and MAXQDA Analytics Pro] 

Windows Mac  

Ctrl + Shift + N cmd + Shift + N Creates a new category. 
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Ctrl + Alt + N cmd + alt + N Creates a new search item. 

Ctrl + E cmd + E Opens the dialog window for exporting a dictionary. 

Del cmd + Backspace Deletes the chosen category. 

MAXDictio Stop list [only available in MAXQDA Plus and MAXQDA Analytics Pro] 

Windows Mac  

Ctrl + N cmd + N Creates a new word to be excluded. 

Ctrl + E cmd + E Opens the dialog window for exporting the stop list. 

Del cmd + Backspace Deletes the focused items. 
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32 Troubleshooting  

If the results of a Coding Query don’t match your expectations, the first thing you should always do 

is reset the retrieval functions by clicking Reset Coding Query in the “MAXQDA standard” toolbar. 

 

Icon for resetting the Coding Query 

This function takes you back to the standard OR retrieval settings, removes any weight filters, and 

undoes all activations in the “Document System” and “Code System.” If you are still having problems 

after resetting and starting again, go to the menu entry Project > Preferences (Windows) or 

MAXQDA 12 > Preferences (Mac) drop-down menu and check the box next to Reset user settings. 

You will then be prompted to restart MAXQDA, which will have all of its original settings after the 

restart. 

A selection of other quickly-remedied problems is listed in the following table: 

Problem Solution 

In Windows, DOC/X documents can't 

be imported. 

A Microsoft Office Installation for Windows 2003 or later is needed 

for this function. Please save your file as a RTF file and import it 

again. 

A document can’t be imported. Are you sure that it is not open in another program? Open it in your 

word processor, save it as an RTF file, close it, and try importing it 

into MAXQDA again. 

Your imported document isn't shown. To view the document, you need to double-click on it in the 

“Document System.” It will then appear in the “Document Brow-

ser.” 

You want to import a document into 

a document group, but MAXQDA says 

that the document can’t be imported. 

It could be that the document is still being used by another program 

(e.g. Word). Make sure to close the document in these other pro-

grams and then try again. 

 

Your documents aren’t shown in the 

“Document System.” 

It could be that you’ve chosen to collapse certain document groups. 

Click on the + symbol in front of a document group to view the 

documents in it. 

No segments are shown in the “Ret-

rieved Segments” window even 

though you’ve activated documents 

and codes. 

Make sure you haven’t accidentally chosen an advanced retrieval 

function (e.g. Near or Followed by). 

Check to make sure you haven’t accidentally turned on a weight fil-

ter. 

Both of these things can be checked in the status bar at the bottom 

of the MAXQDA window. 

Some of your codes aren’t shown in 

the “Code System.” 

It could be that you’ve collapsed certain codes, hiding their sub-

codes. Click on the + symbol to show subcodes for a code. 
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You accidentally coded a segment in-

correctly. 

Click on the Undo button in the “Code” toolbar. A list of recent 

coding actions will appear, with the most recent action at the top. 

To undo your most recent coding, click on the first string in the list. 

Or: Right-click on the coding stripe and choose Delete. 

 

Tip: If you aren’t able to solve your problem, don’t hesitate to contact our online support. 
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33 Technical Data and Information 

33.1 Limitations and technical information 

MAXQDA sets very few limits. The following table informs about importable file formats and some 

limits within MAXQDA. 

Text length: No set limit, but it isn’t recommended that you import texts larger than 

1 MB 

Importable Text formats: RTF, DOC/X, ODT, PDF, TXT, HTML 

Importable Image formats: 

Importable Table formats: 

JPG, GIF, TIF, PNG 

XLS/S 

Supported Audio formats:  Windows: MP3, WAV, WMA, AAC, M4A 

Mac: MP3, WAV, AAC, CAF, M4A 

Supported Video formats: MP4, MOV, MPG, AVI, M4V, 3GP, 3GGP 

Windows: WMV 

recommended Codec: H.264/AVC 

Number of projects: No limit 

Number of document groups: No set limit 

Number of documents: 99,999, but check performance before working with several thousand 

documents 

Number of codes: No set limit, but check performance before working with several 

thousand codes 

Number of coded segments No set limit, but check performance before working with several 

thousand segments and please note that above 200,000 coded seg-

ments the stability of MAXQDA cannot be guaranteed (if your computer 

has less than 4 GB RAM this threshold may be lower) 

Code System levels Max. 10 

Numerical data: 10 characters 

Number of variables No set limit, but more than 250 is not recommended 
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33.2 File Management 

MAXQDA works with the following file types: 

.MX12 MAXQDA 12 project file for Windows and Mac 

.MX11 MAXQDA 11 project file for Mac 

.MX5 MAXQDA 11 project file for Windows 

.MX4 MAXQDA 10 project file 

.MX3 MAXQDA 2007 project file 

.MX2 MAXQDA 2 project file 

.M2K MAXQDA 1 project file 

.LOA Saved formula files (activation by variables) 

.SEA Saved search files (SEArch file) 

.TXT Exported table file 

.RTF Exported texts, coded segments, and memos 

.MTR Exported “Code System” 

.MEX MAXQDA Exchange file (MAX EXchange) 

33.3 System Requirements 

 Operating System: Microsoft Windows from version 7, or Mac OS X from version 10.8 

 Processor: 1,3 GHz with 2 cores, recommended: 2 GHz or more with 2 cores or more 

 RAM: 2 GB RAM, recommended: 4 GB or more 

 Monitor: 1.024 x 768, recommended: 1.280 x 768 or more 

Note: If you are working with challenging projects and/or large media files adequate computer hard-

ware is recommended. 

To use the following features with Windows, Microsoft Word 2003 or later and .NET 3.5 or newer 

must be installed on the computer: 

 Import of DOC/X or ODT files 

 Smart Publisher export 

 Import of web pages from MAXQDA Web Collector 


